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Introduction 

Let's skip the lofty phrases normally reserved for book introductions and 
get right to the point: This is a book about applying real power to 
Microsoft Works 2.0 for the Apple Macintosh. But that's not all. This is 
also a book for stretching Works to its design limits, squeezing out every 
last byte, and making it do things you may not have thought possible. And, 
this is a book on using Works as a dependable productivity tool in bus~ess. 

With Inside MS Works 2 for the Macintosh, you '11 find concrete hints and 
tips for getting the most from Microsoft Works, handy shortcuts for saving 
time, useful recommendations for adapting Works to your work environ
ment, and clarifications of many of Works' more ambiguous features and 
commands. 

Microsoft Works is a multifaceted program, combining four of the most 
commonly used business productivity applications in one easy-to-use 
package: 

• Word processing 

• Electronic spreadsheet calculation 

• Data management 

• Communications 

You'll learn how to get the most from these four core Works modules, 
as well as how to use them effectively to create a complete Works power 
system. 

What Works can do, it does with simplicity and grace. But Works can't 
do everything-you've probably realized that by now. If you are like most 
Works users, you may often find yourself frustrated and stymied by one of 

xiii 
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the program's many "limitations." Inside MS Works 2 for the Macintosh 
provides guidance, suggestions, and "work-arounds" for many of the most 
troublesome limitations, offering step-by-step help for setting up a func
tional "Works station," using optional utilities to boost the power of Works, 
and customizing Works to your own specifications. 

WHO SHOULD USE THIS BOOK 

This is not a beginner's book on Microsoft Works. It does not teach the 
fundamentals of Works and how to use its basic features, but it does review 
some of these features as they relate to advanced Works use. 

You should have at least a rudimentary working knowledge of Works 
before you use this book. You needn't be a Works wizard, but you should 
know how to write and edit text, how to format text using Works com
mands, how to enter data in the spreadsheet and database modules, and 
how to conduct a conversation with another computer user with the com
munications module. 

Knowledge of the program's more advanced features, such as the 
spelling checker, homonym fmder, spreadsheet functions, database report 
generator, and drawing tools is also valuable. 

New to Microsoft Works? Then you are urged to read the manual that 
accompanies the program. The Works manual isn't large, but if you don't 
want to wade through it, use the Works tutorial to learn the basics. Works 
also comes with a guided tour that will help you get acquainted with the 
rudimentary capabilities of the program. 

If you are familiar with Works, but are not an expert user, you '11 want to 
keep a copy of the manual beside you as you read this book. If you come 
across a technique or concept that is unfamiliar, pause to read about it in 
the manual before proceeding. 

As of this writing, the latest release of Works is version 2.0. This book 
offers hints, tricks, and shortcuts as they apply to version 2.0, but many of 
the techniques will also work, with some modification, when using ver
sions 1.0 and 1.1. 

HOW THIS BOOK IS ORGANIZED 

Here is a brief summary of the contents of each chapter. 

• Chapter 1-General Tips for Using Microsoft Works. Mastering 
Works by learning keyboard shortcuts, effectively using on-line help, 
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optimizing Works windows, sharing data between Works modules, 
saving and· maintaining documents, using the Works Desktop fJ.le. 

• Chapter 2-Writing with Works. Methods and shortcuts for writing, 
editing, and selecting text, formatting the document, sharing data 
between Works word processing documents, using the Works speller, 
preparing boilerplate texL 

• Chapter 3-Drawing with Works. All about the Works drawing tool, 
using the tools to create shapes, enhancing word processor text with 
drawn boxes and rules, using the drawing tools for writing in columns. 

• Chapter 4-Spreadsheet Strategies. Spreadsheet tips and tricks, for
matting the worksheet, manipulating cell contents, a simplified 
approach to writing formulas, working with number formats. 

• Chapter 5-Charting Your Course with Works. How to effectively use 
charts (created with spreadsheet data), simplified chart making, chang
ing appearance of charts, editing charts. 

• Chapter 6-Keeping Tabs on Data. Setting up a Works database form, 
shortcuts for entering and manipulating data, effective organization of 
database records, using calculated fields, formulas, and functions, 
using database selection criteria, effective form layouts, formatting 
database records for forms and presentations, principles and practice of 
merge printing. 

• Chapter 7-Communicating with Works. Applications for computer 
communications, hardware requirements, technical overview of com
munications standards and protocols, sending and receiving files, using 
Works modem commands, controlling a modem manually, using 
Works with non-Hayes compatible modems. 

• Chapter 8---Saving Time with Macros. What is a macro, how to record 
and play back macros, creating macro "sets," gallery of useful Works 
macros, special uses for macros. 

• Chapter 9-Managing Works. Using Works with your Macintosh, 
floppy and hard disk management, methods of starting Works, using 
RAM disk and RAM cache, applying Finder macros with Works, 
explanation of Works files. Using "add-ins" with Works, desk acces
sories, RAM-resident utilities, FKEY s, some popular add-ins and how 
to get the most out of them, guidelines for using add-ins. 

• Chapter 10--Customizing Works. You can customize Works using 
readily available Macintosh editing utilities, changing menus, altering 
pointer shapes, working with icons, reorganizing dialog boxes, attach
ing special fonts and desk accessories directly to Works. 

• Chapter 11-Using Works with Other Programs. Importing and 
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exporting word processing, spreadsheet, and database data, copying 
and editing chart graphics, using stand-alone drawing programs with 
Works, importing graphics to Works. 

• Chapter 12--Printing with Works. Using Works with all popular types 
of Macintosh printers, selective printing, understanding and using the 
Print and Page Setup dialog boxes. 

• Appendix A-sources for Products and Information. Names and 
addresses of companies mentioned in this book. 

• Appendix B-Table of Character Sets. Complete printable character 
sets for four common Macintosh fonts. 

• Appendix C-Editable Works Resources. Brief description of editable 
Works program resources. 

• Index 

CONVENTIONS USED IN THIS BOOK 

This book uses several conventions to make your reading go faster. You 
should know the basic functions of the Macintosh before using this book, 
and understand instructions such as click, double-click, drag, and so forth. 
If you are unfamiliar with any of these terms, take a moment to study the 
Macintosh user's manual. 

Many of Works' features, such as its drawing tools, are referenced by 
their function names and are treated as if they are real-life objects. In text, 
you may see, Click the arc tool or simply, Click the arc. 

Menus and commands vary from module to module. H you cannot fmd 
the proper command or menu, check to be sure you are using the correct 
module. 

Keyboard shortcuts and some supplementary commands are invoked by 
pressing two or more keys at the same time. In text, instructions on which 
keys to press will be indicated by a phrase like Press the Command, 
Option, and S keys or, more simply, Press Command-Option-S. In both 
cases, you depress all the keys simultaneously to achieve the desired effect. 
From now on, keys you press will be shown in bold, such as Command. 

The labeling of keys on various versions of Macintosh keyboards may 
differ. This book uses these standard references for the keys. 



Key 
Esc 
Tab 
Command 

Option 
Shift 
Spacebar 

Return 
Enter 
Delete 

Right cursor 
Left 
Up cursor 
Down cursor 

Meaning 
Escape 
Tab express 

Introduction xvii 

Command (may be marked with cloverleaf 
and/or open apple symbol) 

Option 
Key shift 
Spacing bar at bottom of keyboard (usually 

unmarked) 
New line key, at right edge of alphabet keys 
Enter key, in numeric keypad 
Delete key, usually key on top row, next to 

"+/="(called "Backspace" in MacPlus and 
older Macintosh models) 

Right cursor key, marked with right arrow 
Left cursor key, marked with left arrow 
Up cursor key, marked with up arrow 
Down cursor key, marked with down arrow 

Works does not make specific use of the function keys (Fl through F12) 
found on extended keyboards. However, you may use these keys with vari
ous desk accessories and utility programs, such as Quickeys. In text, the 
control key is noted by Ctrl; the function keys are noted by Fl through 
Fll. 
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C H A P T E R 1 

General Tips for Using 
Microsoft Works 

Microsoft Works is comprised of four modules: word processor, electronic 
spreadsheet, database, and communications terminal, plus two additional 
"mini-modules" for free-hand graphics and business charting. Works com
bines these capabilities into one package that permits text and numbers cre
ated in one module to be readily exported and used in another. 

Works is known for its simplicity and ease-of-use; unlike some other 
programs for the Macintosh, Works doesn't provide a half-dozen ways to 
accomplish the task or invoke a command. This isn't to say that Works is 
without its shortcuts, or that all of Works' features are equally logical and 
understandable. 

In this chapter, you '11 learn about many shortcuts that apply to Works in 
general-some you may have found on your own, and some may be com
pletely new to you. And, you '11 discover how Works best shares data 
between modules, how to properly save and maintain documents from 
within Works, how to set up Works Stationery, and how to assemble Works 
document sets. 

BASIC WORKS REVIEW 

Following is a basic review of Works icons and startup procedures. If you 
are already familiar with this information, you may want to skip directly to 
the section on keyboard shortcuts. 

1 
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Meaning of Works Icons 
Works creates files with up to 16 different icons, some of which are very 
similar to one another. Here's a rundown on Works icons, and the meaning 
of the files they represent. 

Main Works program-Contains all of the Works applications. 

IZJ 
Works on-line Help-Provides help summary when using Works. If this 
file is not available, Works can't provide help. 

~ 
Works Desktop document set-Works remembers up to 16 previously 
saved documents so that you can easily open them again at a later time. 
The default name for this file is Works Desktop, but there can be any num
ber of Desktop files on the disk, each with a different name. 

l~w·~~ 
Word processing document-Created with the Works word processing 
module, and saved in the Nonnal file fonnat. 

Database document-Created with the Works database module. 

~ 
Hilllll 
Spreadsheet document-Created with the Works spreadsheet module. 

l!ld 
Communications document-Created with the Works communications 
module. Can contain communications setup parameters and/or text. 
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llw; 
Word processing Stationery document-Word processor template document 

Database Stationery document-Database template document 

~~ 
Spreadsheet Stationery document-Spreadsheet template document. 

~ 
Communications Stationery document-Communications template document 

Text-only file-File saved either with the word processor using the Export 
or RTF options, or with the Save Text command in the communications 
module. Also used to save homonym and user dictionary files. 

[) 
Spelling dictionary-Contains the main Works spelling words. 

tl 
Preference file-Record-keeping preference file used to monitor and 
remember certain options with the spelling checker. 

Macro file-One or more recorded Works macros. 
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D 
Undefined flle--One of many types of undefined flles Works creates. The 
homonym table is one example. Others are PostScript files 
saved to disk (instead of printing directly on the Lase~;.Writer). One or more 
of Works, other icons may take this form after a serious disk error, although 
the program will usually continue to function. 

HyperCard stack-A programmed application in HyperCard as a guided 
tour for using Works. The HyperCard program is required to use this f:ale. 

Starting Works 

You may start Works in a number of ways. As an application on the 
Desktop, you can click on the Works icon to select, then choose the Open 
command from the File menu. Or, more simply, just double-click on the 
Works icon. If Works is the main program you use, you should consider 
making it the Startup application. This is done with the Set Startup com
mand in the Special menu (at the Desktop). See Chapter 9, "Managing 
Works," for more information on this topic. 

Opening Documents 

When Works loads, it frrst displays a copyright page, pauses, then displays 
its Open File dialog box, as shown in Figure 1-1. There, you can open an 
existing Works document, or create a new one. 

• To open an existing Works document, fmd it in the file list window 
(click one of the icons once to identify a document type; All Works 
Types displays all Works documents, except Text-only files). 

• To open a new Works document, double-click on one of the applica
tion icons (word processor, database, spreadsheet, comunications). 
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Open File: • 
Cltclc here to 
display ell 
document types 

Clfck hero to dfsplay 
WP documents only; 
doublo-cltck to stert 
a nw WP doc 

~ 
~ 

Rll Worts Data 
Types Processor Base 

Spread Communications 
Sheet 

Doublo-cltck 
herotoopon 
crocumont or 
folder 

I e worts 2.D I 
D Mdl I (1\ :!1 
CJ Tutorial 
C Works Desktop 

Works Dictionary 
Worts Documents 

CJ Works Tools 

Open 

N~w 

cancel 

D Import file 

Figure 1·1 Open Dialog Box with Callouts for Shortcuts 

G:l Number SIH 

EJ~cf 

Ortu~ 

The Open File dialog box automatically appears when all document win
dows are closed in Works. 

KEYBOARD SHORTCUTS WITHIN DOCUMENTS 

Works is designed for almost total mouse control. an unusual characteristic 
since Microsoft has made considerable· efforts to imbue keyboard equiva
lents for mouse commands in all its other Macintosh applications. Though 
Works lacks a great number of keyboard equivalents for mouse commands, 
those it does have can, over the long run, save you a great deal of time. 

Keyboard Shortcuts for the Document Window 

Works provides no direct means of manipulating the currently active docu
ment window by keyboard control. You must use the mouse to move, 
resize, or scroll windows. However, Works does let you easily cycle 
through several open documents using just the keyboard, and permits use 
of a few keyboard "modifiers" that change the way mouse movements 
affect the window. 



6 Inside MS Works 2 for the Macintosh 

• When more than one Works document is open, pressing Command-, 
(Command and comma key together) activates the next available 
window. "Next available" means the window immediately below the 
currently active one. The Command-, shortcut is an alternate method 
of activating the specific window you want from the Wmdow menu. 
Note that the currently active window is shown with a striped title bar, 
shown in Figure 1-2. The Works menu bar changes depending on the 
type of document currently active. 

• Pressing and holding the Shift key while you click the up or down 
scroll arrows in the Works word processor scrolls the window in 
"micro steps." Normally, pressing the up and down scroll arrows 
moves the document 1/2 inch. With the Shift key depressed, scrolling 
is limited to 1/6 of an inch, or approximately one line. The technique 
can also be used when using the right and left scroll arrows. Normally, 
horizontal scrolling moves the contents of the window one inch at a 
time; with the Shift key, scrolling is limited to approximately 
l/16th inch movements. 

• Enhanced keyboards contain additional keys that Works uses in 
many of its modules: 

Key 
Home 

End 

Page Up 
Page Down 

Action 
Moves mouse pointer to top of scroll bar. Makes mouse 

pointer disappear, but scrolls to top of document. 
Moves mouse pointer to bottom of scroll bar. Scrolls 

window to bottom of document. 
Moves insertion point up one page. 
Moves insertion point down one page. 

Keyboard Shortcuts for Menus and Commands 

Works offers keyboard equivalents for some of its menu commands. These 
are invoked by pressing the Command key with a letter key. The equiva
lent keys change depending on the currently active module. Table 1-1 pre
sents a list of the command key equivalents using the various modules of 
Works (note that Draw is treated as a separate module). 

In addition to these keyboard shortcuts, Works supports special com
mand equivalents when using the macro and communications tools. 
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,. • File Edit Window Search Format Spell Macro 

For hord drive users only: Although 
System version 5.0 or greeter, for moxlm 
recommend using System 6.0.2. Contec~ 
upgrede to System 6.0.2. 

If you ere following the procedure, "To 
Lossons(pege xvO, end your existing 
your de!!ler for the new lnstelter oroor11m 

Figure 1-2 Windows with Title Bars Active and Inactive 

Key 

Option-= (equal) 
Option-- (hyphen) 
Option-Delete 
Command-. (period) 

Macro Key Equivalents 

Result 

Start recording 
Stop recording 
Play back macro 
Stop macro in progress 

Communications Key Equivalents 

Command-Option-3 Break 
Command-Option-Delete Delete 
Command-Option-[ Escape 

, 

Additional information on the use of these command shortcuts, and what 
they do, can be found in Chapter 7, "Communicating with Works," and 
Chapter 8, "Saving Time With Macros." 
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Key WP ss DB COM Draw 

A Absolute Cell Sort 
Ref/Relative 
Cell Ref 

B Bold Bold Send to 
Back 

c Copy Copy Copy Copy Copy 
D Fill Down Enter Date Dial 
F Find Find Cell Find Field Bring to 

Front 
G Go to Page# Go to Cell Group Pic 
I Italics Insert Insert Record 
J Draw On/Off Draw On/Off Draw Off 
K CopyFonnat 
L Show List/Form 
M Prepare to Match Records 

Merge 
N Normal Text Nonnal Text 
0 Open Open Open Open 
p Print Print Print Print 
Q Quit Quit Quit Quit 
R Replace Fill Right 
s Save Save Save Save 
T Enter Time 
u Underline Underline Ungroup 

Picture 
v Paste Paste Paste Paste Paste 
w Close Close Close Close 
X Cut Cut Cut Cut Cut 
y Paste Format 
z Undo Undo Undo 

= Calculate Now Hang Up 
Duplicate 
field in 
previous record 

+ Hang Up 
Switch Doc Switch Doc Switch Doc Switch Doc 

Table 1-1 Command-Key Equivalents, AU Modules 
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Keyboard Shortcuts for Dialog Boxes 

Unlike many other Microsoft applications for the Mac, Works lacks the 
fundamental ability to control dialog boxes via the keyboard. Even so, 
Works does support some keyboard shortcuts, many of which are standard 
to just about any Macintosh program. They are worth reiterating here. 

• Pressing the Return or Enter key selects the the action button, typi
cally labeled OK or Cancel. The default action button is normally 
shown with a double-outline. 

• Pressing the Tab key expresses the insertion point to the next text field 
box, if any. Text field boxes hold text you write from the keyboard. 

• The text field boxes support traditional Macintosh writing and editing 
standards. That is, use the mouse to indicate a new insertion point, 
select text, delete text, or backspace over previously written text. 

• Pressing Command-O from within the New dialog box (from the File 
menu) displays the Open File dialog box, where you can choose from 
among Works documents you've already created. 

• Pressing Command-Q from within some dialog boxes (like Open and 
New from the File menu), activates the Quit command. So be careful! 

• In a few dialog boxes, pressing Command-. (Command and period) 
is the same as selecting the Cancel button. These dialog boxes are: 

General Menus (all applications) 

• Open (File menu) 

• Save (File menu) 

• Save As (File menu) 

• Delete (File menu) 

• Save Works Desktop (File menu) 

• Playback And (Macro menu) 

• Open Macro File (Macro menu) 

• Save Macro File (Macro menu) 

• Save Macro File As (Macro menu) 

Word Processor 

• Dictionary (Spell menu) 

Communications 

• Capture Text (Communications menu) 
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• Send Text (Communications menu) 

• Receive File (Communications menu) 

• Send File (Communications menu) 

Additional keyboard shortcuts are available in Open and Save dialog 
boxes, which show a list of folders and files saved on disk. 

• Press the Left and Right arrow keys to move the insertion point right or 
left in the Text Entry box (Save Files dialog boxes only, such as Save, 
Save As, Save Macro, etc., when there are already characters in the box). 

• Press Up (Up arrow) to move up one ftle or folder in the List File box. 

• Press Down (Down arrow) to move down one file or folder in the List 
File box. 

• Press Command-Up to move up one level of folders. 

• Press Command-Down to move down one level of folders (open the 
folder). 

• Press a letter key (A through Z) or a number key (0 through 9) and the 
first available file or folder that begins with that letter is selected. Press 
additional keys within the delay time you have set in the Control Panel 
desk accessory (usually 1/4 of a second or faster), and you can narrow 
the selection to the specific file or folder you want. 

• Press A or the Spacebar to shuttle to the beginning of the list; press 
the \ (backslash) character to go to the end. 

• Press Tab for the same effect as pressing the Drive button. 

• In an Open Files dialog box, the Return and Enter keys are equivlent 
to the Open button. 

• In a Save Files dialog box, the Return and Enter keys are equivalent 
to the Save button. 

• Press Command-Shift and number 0, 1, or 2 to eject disks from one 
of the floppy disk drives, depending on the model of Macintosh (the 
Mac beeps if the computer lacks the drive specified; for example, 
pressing Command-Shift-0 when using a Macintosh SE without an 
external drive causes an error beep): 

Command-Shift-# 

0 

MacPius 

n/a 
Internal 
External 

SE 

External 
Lower 
Upper 

TIIIIx 
n/a 
Right 
Left 

1 
2 
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Although not a keyboard shortcut, clicking on the disk icon above the 
Drive and Eject buttons in Open and Save dialog boxes brings you directly 
to the top of of the disk folder hierarchy. 

OPTIMIZING DOCUMENT WINDOWS 

Moving through the various Works documents involves almost exclusive 
use of the mouse. Depending on available memory, you can have up to 16 
windows open at the same time. Critical components of Works windows 
are shown in Figure 1-3. 

Each window is initially opened to "98 percent" full size; that is, the 
edges of the window almost touch the borders of the screen. Clicking in 
the zoom box of the window (upper right comer) enlarges it to 100 percent. 
The zoom box actually toggles between full-size and one preset size (the 
preset size is initially preset by Works as "98 percent"). Double-clicking 
the window title bar or within the size box (lower right-hand comer) also 
zooms the window. 

Close 
box 

Menu ber 

,.. a File Edit Window ~orch Formot Spell Mocro 

Cursor erro'<l 

Horizontal 
scroll bar 

/ 

Vertical scroll 
ber 

. :::. i:; . i • .: : : • : • ' : I ~- ;. . ; : • !' : ~ : • • ; : 

Thumb 
box 

Figure 1-3 Sample Window with Callouts 

, 
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You can manually resize any window by dragging in the size box, locat
ed in the lower right comer. Then, you can click the size box to toggle 
between full-size and your preset size. You can also tug the window to a 
new location by dragging it by the title bar. Works remembers both the size 
and placement of the window. 

You can use this feature to toggle between full-size and a preset size and 
position. With four word processing windows open, you can adjust their 
size and position so that each takes up one quadrant of the screen. Because 
the windows are no longer stacked on one another, it can be difficult to tell 
which one is currently active. But one indicator will never let you down: 
the currently active document is the one with the striped title bar. To acti
vate a different window, simply click anywhere on it with the mouse. 
Alternatively, you may select the document you want to use from the 
Window menu, or press Command-, (Command and comma key) until 
the desired document is active. 

When you wish to work with a window full-size, click the zoom box and 
the document will return to fill the entire screen. 

Usually, you will have only one window open and it will fill the entire 
screen. Assuming there is already text in the document, the most basic 
form of moving around within the window is by using the scroll bars. The 
scroll bars may not appear when the window is very small. 

The vertical scroll bar takes you through the length of the document, 
from one page to the next. Note that unless you are using a large screen, 
the Mac display shows a little less than half of the depth of a page. You 
need to use the vertical scroll bar to see both the top and bottom of the 
page, as well as to "flip" through successive pages of the document. 

The horizontal scroll bar lets you scan a document from left to right, in 
case it is wider than the 6 3/4 inches that can be displayed on the standard 
9-inch Macintosh screen. 

The remaining chapters in this book provide specific information on 
using windows with the various Works modules. 

CHOOSING INITIAL FONTS 

Works initially chooses the _following fonts when working in the word pro
cessor, database, and spreadsheet modules: 

Module 
Word processor 
Database 
Spreadsheet 

Initial Font 
Boston 
Geneva 
Geneva 

Initial Size 
10 point 
9 point 
9 point 
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If Boston is missing from your System file, Works selects Geneva instead 
Works uses these initial fonts for each new document you open. Works 

also initially selects Boston 10 point when using Draw, but remembers your 
font choice if you tum Draw off and on during a single editing session. 

Boston is a special font that has been optimized for best appearance on 
both the Macintosh screen and on paper when printed with the 
Image Writer. It comes on the Works distribution disk from Microsoft. If 
you don't use the system file supplied with the distribution disk on your 
Works setup, Boston will be missing from the available fonts, and Works 
will default to Geneva 10 point instead. You can always transport Boston 
to your working disk with Apple's Font/DA Mover. The Boston font is not 
designed to be used with the LaserWriter, and has no direct substitution. 
You should designate either a LaserWriter font (such as Times or 
Helvetica) or use a substitutable font (New York, Geneva) when printing 
with a LaserWriter. 

You can change the initial font selected by application by using a suit
able utility program, such as ApFont (Shareware). Application font 
changes, like ApFont, provide a means to designate any currently installed 
font as the default font. To work with Works, you must remove all Boston 
fonts; otherwise, Works overrides the application font information and uses 
Boston for the word processor module. Assigning a new application font 
affects the word processor module only. The Geneva fonts specified for the 
other modules are not changed. Be sure to use application font changers 
carefully; the effects may be unpredictable. 

ACCESSING HELP 

Although the Works on-line help is a basic feature that needs little explana
tion, many users are confused about how to use it best. 

Module-Specific Help 

Pressing Command-? (or Command-/ activates Works' on-line help sys
tem (there's no need to depress the Shift key to obtain the question mark). 
Alternatively, you can access help by choosing the Help command in the 
Window menu. 

The general help topic reflects the current Works module you're using. 
When using the word processor, for instance, Works opens the WP Help 
window. 

You'll note that the individual help topics are arranged in menu/com-
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mand order (starting from the Apple menu), and start with a brief intro
duction on using the help feature. The help topics are not organized in 
alphabetical order. 

You may review the contents of the Help window by using the scroll 
bars. To see more of the help text, click the zoom box in left upper right 
comer of the window. You can also manually adjust the size of the window 
with the size box, located at the lower right comer of the window. 

At any time, you can quickly go to a specific help topic by choosing a 
menu command with the mouse (within Help, the pointer is shaped like a 
question mark, as shown in Figure 1-4). You can also go to a specific help 
topic if the desired command has a key equivalent. Press the appropriate· 
keys (such as Command·N for new), and the desired help text will be dis
played in the window. 

To close the Help window, click the close box (upper left comer of the 
window). You can also switch to another open Works window by click
ing outside the Help window, or by activating another window in the 
Window menu. 

Unt1o , '(. ... , . 

[ ut :a;}J 
[ 0()~4 '•'(' ' , , 

Paste xu 
t: h~nr 
Select All 

Orau' On I') :#:J 
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t>r•~t)nr•~ to ~•~r~Je...... :•:M 
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~ul tit)h~ t. <Jbel~ 

Figure 1-4 Accessing Help with Question Mark Pointer 
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Command-Specific Help 

If you already know the command you want help on, you can activate the 
Help window and go directly to the desired topic. Here's how: 

1. Highlight the command with the mouse. 

2. Press Command-?. 

For example, to fmd help on the Close command, highlight the command 
in the Edit menu (to highlight, keep the menu drawn down; don't release 
the mouse button). Then, press Command-?. 

Many Macintosh keyboards have only one Command key located to the 
left of the Spacebar. This can make it tough for people with small hands to 
press the Command and ? keys together. But with a bit of practice, you 
should be able to master it. 

SHARING DATA BETWEEN MODULES 

The ability to share data among the various Works modules is perhaps the 
program's strongest feature. Sharing data within a particular module is a 
rather simple task of copying and pasting. But because each Works module 
generates data in a unique format, transferring data between modules 
!equires a bit of planning and careful execution. 

Within a Document 

Follow the standard procedure for copying and pasting data within a single 
document. Before you can issue the Copy command, you must first indi
cate the data (word processor text, graphics, spreadsheet formula, etc.) you 
want to duplicate. The exact method of selecting data differs from Works 
module to module. 

Once the desired data is selected, issue the copy command (press 
Command-C or choose Copy from the Edit menu). Select an insertion 
point elsewhere in the document, then paste (Command-V or choose Paste 
from the Edit menu). 

As with most Macintosh applications, Works maintains a single 
Clipboard that can hold one clipping. Once the data is in the Clipboard it 
can be pasted as many times as you like. The Clipboard can hold a maxi
mum of 32K of data at one time. 
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If you wish to move data within a Works document rather than copy it 
from place to place, use the Cut command instead (Command-X or choose 
Cut from the Edit menu). 

Between Like Documents 

Transferring data between like Works documents (word processor to word 
processor, for example), requires that you cut or copy the desired data 
from one document, open or activate a different document, then issue the 
Paste command. You might use this method to transfer standard "boiler
plate" text from a glossary document into the current document (such a 
method is fully explained in Chapter 2, "Writing with Works"). As long 
as the data remains in the Clipboard, you can paste it into as many docu
ments as you wish. 

Between Unlike Documents 

The format of text created in the word processor is significantly different 
than the format of data created in the spreadsheet. Though Works allows 
you to cut and paste data between modules, you must account for the vari
ance in formats. 

In general, Works creates three different types of data: 

• Non-delimited text, as created in the word processor and communica
tions terminal. 

• Tab-delimited text, as created in the spreadsheet and database. 

• Object-oriented graphics, as created with the Draw and business 
graphics "sub-modules." 

Figure 1-5 shows the interaction of these data types and Works modules. 
Data transfer isn't always a two-way street. Charts can be copied from the 
business graphics component to the word processor, but text from the word 
processor can't be pasted into a chart. 
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Non-delimited text 

Tab-delimited text 

WPText ss 

~ Object-oriented graphics 

Figure 1·5 Chart of Data Types and Relationships 

An Explanation of Data Types What is "non-delimited" text? In certain 
data formats, individual pieces of information are divided into compart
ments or parcels. The parcels are separated by delimiters, usually either 
commas or tabs (Works uses tabs). Text in the word processor may contain 
commas or tabs, but neither serves to compartmentalize the text you write. 
In other words, non-delimited text is simply a set of characters that flow 
from the beginning of the document to the end. 

Tab-delimited text, on the other hand, is divided into discrete units, each 
unit separated by an invisible tab character. Tab-delimited text is used most 
often to mark the boundaries of cell contents in spreadsheet or database 
applications. If more than one cell in a particular row of cells is selected, 
the spreadsheet program separates the contents of each by automatically 
inserting invisible tab characters. 

This maintains the compartmentalization when the data is copied into 
other cells, and produces tab spaces when the data is copied to a word pro
cessor, as shown in Figure 1-6. Further, the individual rows of cells from 
the spreadsheet are separated by invisible return (new paragraph) characters. 

r- "· 
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Figure 1-6 Data from SS to WP 

When spreadsheet data is transferred to a word processor, cell rows are sep
arated by hard returns. Works uses tab-delimited formats with both its 
spreadsheet and database modules. 

From Spreadsheet to Word Processor If you're pasting tab-delimited data 
from the Works spreadsheet or database to the word processor, set up the 
ruler with tabs where you want the contents of the cells to be positioned. 
When the data is pasted, it will conform to the tabs you set. If you like, 
once the data has been transferred, you can adjust the positioning of the data 
by shifting the tabs along the ruler. The formatting may be disrupted if one 
or more of the cells contains more text than will fit between the tab markers. 

You can also apply these instructions for transferring text from the 
database to the word processor module. View the database document in 
List form, and select the fields and records from there. 

From Word Processor to Spreadsheet Going from the Works word pro
cessor requires you to prepare the data before cutting and pasting. 
Attempting to transfer unformatted text to the spreadsheet module results in 
a hodgepodge, as shown in Figure 1-7, allowing only about 65 or 70 char
acters to be placed in each cell. Prior to selecting the data, add tabs and 
hard returns so that Works will correctly transfer the data into individual 
columns and rows in the spreadsheet. 
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Figure 1-7 Hodgepodge Transfer into SS 

Data tables are perhaps the most common data you '11 be transferring 
from word processor to spreadsheet. These tables may have been drafted in 
the word processor, or captured from an on-line information service using 
the communications module. In any case, before attempting to transfer the 
table from the word processor to spreadsheet, be certain that it is in the cor
rect tab-delimited format. Even though the table may appear in table form, 
the columns of data may not be separated by tabs. 

Here's a real-world example. Let's say you've downloaded a set of 
fmancial quotes from Dow Jones News and Retrieval. The individual parts 
of each quote are separated by a blank space, not true tabs. In order to 
transfer the data to the spreadsheet, you must edit the downloaded docu
ment with the Works word processor and replace the spaces between each 
part of the quote with a tab. (Note: Works will also treat two or more 
spaces as the equivalent of tabs, but you may still want to exchange the 
spaces for tabs to make formatting in the word processor easier.) You can 
do this manually by selecting the blank spaces between quotes and pressing 
the Tab key, or by taking advantage of the word processor's Replace com
mand. Specifically: 

1. Count the number of spaces between two quotes. 

2. Choose the Replace command from the Search menu. 

3. Type the desired number of spaces into the Find What: entry box. 
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4. Move the insertion point to the Replace With: entry box (use the 
mouse or press the Tab key). 

5. Enter a Tab character by pressing the Tab insert button, located above 
the Cancel button (alternatively, press Option-t (lowercase t) to man
ually enter the Tab character. 

6. Click the Replace All button. Works beeps and displays a dialog box 
when it has found all occurrences of x number of spaces. 

Remember that Works replaces the indicated number of spaces with Tab 
characters throughout the entire document, even if the table is only a small 
part of a larger document. You can limit the replace range by selecting 
just the table. 

If necessary, you may replace each occurrence of spaces under your 
control. Instead of choosing Replace All, click the Find Next button while 
in the Replace dialog box. This finds the next occurrence of the spaces, 
but doesn't replace anything. You can skip the spaces by pressing Find 
Next again, or substitute the spaces for a Tab character by pressing the 
Replace button. 

You can also apply these instructions for transferring text from the 
word processor to the database module. View the database document 
in List form. 

From Graphics to Word Processor Charts made with the spreadsheet 
module can be readily copied to the word processor or over spreadsheet 
cells. To copy a chart into the clipboard, display the chart, then choose the 
Copy command from the Edit menu (or press Command-C). Note that the 
contents of entire chart window are copied, including chart elements, text, 
and legends. 

To paste the chart, open a word processor or spreadsheet document, tum 
Draw on, select a location for the graphic by setting an insertion point, and 
choose the Paste command from the Edit menu (or press Command-V). 
Note that all of the chart elements are grouped together, and that one of the 
chart elements is an invisible white background. This background corre
sponds to the size of the chart window, as shown in Figure 1-8. 
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Figure 1-8 Chart Transfer, with Background, to Word Processor (black squares 
indicate edge of background) 

You can now use the Draw tools to edit, move, or resize the pieces of the 
chart. Specific details on working with and editing charts can be found in 
Chapter 5, "Charting Your Course with Works." You'll also want to refer to 
Chapter 3, "Drawing with Works," for more information on the Draw feature. 

Between Spreadsheet and Database The spreadsheet and database mod
ules share the same type of data format: tab-delimited. You can readily 
transfer data between spreadsheet and database documents. For ease of 
use, view the database as a list, not as a form (choose Show List from the 
Format menu). 

When transferring data from the database, select just the fields and 
records you want to move. Don't try to include the field headings in the 
selection; Works won't let you, and in any case, will automatically add 
them when the text is copied to the Clipboard. 

To paste the data into the spreadsheet, select just one cell (the upper left 
cell of the pasted range, as shown in Figure 1-9), then invoke the Paste 
command. Note that if you paste data over filled cells, Works will erase 
the old data. If necessary, insert new columns or rows to make room for 
the pasted data. 

When transferring data from the spreadsheet, Works automatically adds 
the required number of new records to hold the pasted data. There is no 
need to create new, blank records first. 
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Figure 1-9 Readying Spreadsheet for Pasted Text, and Result 
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Using Draw Pictures you create using the Works Draw tools aren't really 
pasted from Draw to another module. Rather, Draw paints graphic images 
over word processing and spreadsheet documents. That is, you enter Draw 
from within either the word processor or spreadsheet modules. You then 
compose squares, circles, and other shapes over a document. When you 
exit Draw, these shapes remain but you can't edit them. In fact, you can't 
even select them with the mouse unless you tum Draw back on. 

The pictures created using Draw are technically known as object-orient
ed graphics. An object can be a line, circle, square, or other shape. It can 
also be one or more lines of text. These graphic objects, also called ele
ments or shapes, are created inside the Macintosh, through a set of 
QuickDraw software routines in the Macintosh's read-only memory (ROM) 
chip. Works Draw serves to pull the objects out of the computer and lay 
them on the electronic drawing surface of the video screen. Each object is 
defined mathematically. 

Object-oriented graphics are different from the way pictures are made in 
programs like MacPaint. In MacPaint, images are defmed by their position 
on the screen. They are produced with paintbrushes, spray cans, pencils, 
and other tools that lay down an ink composed of small dots. These dots 
are akin to the grains of sand in a sand painting. 

To change a picture using MacPaint, you dust off sand or add more on 
top, using the program's various tools. In computer parlance, MacPaint is 
referred to as a bit-mapped graphics program, because its pictures are a 
map of the bits on the screen. 

Object-oriented graphics you create with the Works Draw feature can be 
edited by other object-oriented programs, such as MacDraw. Likewise, 
pictures produced by these programs can be imported directly into Works 
(more on this in Chapter 11). Even though these imported graphics were 
not produced using the Draw tools, pasting them into a word processor or 
spreadsheet document automatically invokes the Draw mode. You then use 
the Draw tools to edit and position the imported graphic. 

Note that Works also uses Draw when importing bit-mapped graphics. 
However, these bit-mapped graphics cannot be edited-other than simple 
resizing-using the Draw tools. See Chapter 3 for more information about 
using Draw. 

USING UNDO 

When you tell a computer program to get rid of a sentence, it does so 
leaving no trace of the unwanted words. But what if you didn't really 
want to delete that sentence? What if you issued the delete command by 
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accident, and you can't remember the wording of the sentence to type it 
back in again? 

Works provides a handy undo feature that reverses the previous 
action. To undo, choose Undo from the Edit menu (or press Command
Z) immediately before doing anything else. Works keeps only the last 
activity in its undo memory, so you can undo only the very last action. 
To Works, an action is: 

• Typing text (almost any length). 

• Pressing the Enter or Return keys. 

• Issuing a command from the keyboard or mouse. 

Note that scrolling windows, setting a new insertion point, and pressing 
the Delete key are not considered actions, so Works doesn't undo them. 

Unlike some other Macintosh applications, the Undo command is not 
context sensitive, so you have no idea exactly what Works will undo when 
you issue the command. The Works undo feature is also not as sophisticat
ed as you '11 find in some other Mac programs. For example, activating 
Undo after typing a line or two of text erases the line. If that's not what 
you had in mind, you're out of luck: Undo removes the text you wrote and 
fails to remember it. When the Undo command is shown dimmed in the 
Edit menu, it means there is no action to undo. 

More surprisingly, Works doesn't consider the Delete key an undo-able 
action. This can cause some serious side effects if you're not careful. For 
example, let's say you write a couple of lines of text, then use the Delete 
key to erase the word you just wrote. Then you decide you really want that 
word, so you try the Undo command. Bad news: Works misunderstands 
your intentions and undoes all of the lines of text you just wrote. Once 
erased with Undo, you cannot retrieve the text. Perhaps this more-than
serious fault in the Undo command will be repaired in a future revision of 
the program. 

Works doesn't undo all keyboard or mouse commands, such as any com
mand in the File menu. Fortunately, such commands can often be reversed 
simply by clicking the Cancel button in a dialog box. 

SAVING AND CLOSING DOCUMENTS 

Works can keep up to 16 documents open at the same time, depending on 
the length of the documents and the amount of free memory in your 
Macintosh. You '11 most likely want to save your Works documents onto 
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disk for later recall or when Works can no longer support all the documents 
you have open. 

Choosing the Save command from the File menu saves the currently 
active document only (the currently active document is always shown with 
a striped title bar, and is the frrst one listed in the open documents tally in 
the Windows menu). If you are saving the document for the frrst time, 
Works asks you to provide a name. You can optionally designate a differ
ent folder or disk to hold the file. Works automatically updates previously 
saved documents without asking for the file name or storage destination. 

Works won't let you unintentionally close a document without first sav
ing it (unless, of course, there have been no changes to a previously saved 
document since you opened it). Works will ask if you want to save the doc
ument before closing the window. The dialog box that appears provides 
three choices: 

• Yes tells Works you do want to save the document before closing it. 
If the document has not been previously saved, Works asks for a 
name and destination; otherwise, the file is updated with the changes 
you've made. The previously recorded file (the version before you 
made the changes) is lost. 

• No closes the window without a second chance. There is no way to 
retrieve the contents of the document if you accidentally press No 
instead of Yes (Undo won't work). 

• Cancel returns you to the document. 

Use the Close All command from the File menu if you have many docu
ments open and don't want to close and save each one manually. A dialog 
box appears (see Figure 1-10) that asks if you really want to close all the 
currently open Works documents. Answer OK or Cancel, accordingly. 
Normally, Works will prompt you at each document and ask if you want to 
save the document before closing. You can bypass the prompt by clicking 
the Save All Changed Files Without Further Prompting option before 
pressing OK. 

If you are saving a document for the frrst time, Works will prompt you to 
name it and indicate where you want the file saved. Note that pressing the 
Cancel button in the Save file dialog box will cancel the Close All com
mand, not just the document saving routine for the current document. 
Works doesn't allow you to skip a file without saving it. If you are closing 
any files without saving them, you need to close them one at a time. 
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Figure 1-10 Close All Dialog Box 
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Works allows a rudimentary form of file management. This is particularly 
handy if you do not wish to return to the Finder to delete or move files 
between disks and folders. 

Saving Routine 

When saving a file, you have a choice of selecting a different disk or direc
tory than the one that holds the Works program and its support files. To 
choose a different disk, click on the Drive and Eject buttons as necessary. 
Note the currently active drive is listed above the Drive and Eject buttons. 

You '11 be saving most of your Works documents in folders. The current 
folder (the one that the saved file will be placed inside) is identified at the 
top of the dialog box, over the File List window. You can easily have fold
ers within other folders, for a hierarchy of document storage. Clicking on 
the folder name over the File List window shows the hierarchy of folders, 
with the innermost folder on top. The name of the disk is listed last. 

Choose the folder you want to place the file in by selecting it with the 
mouse. Should you wish to place the document in a folder that is not yet 
open, fmd it in the File List window and double-click on it. 

Once the proper disk and folder is selected, enter a name for the file in 
the Text Entry box and click on the Save button. 
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Renaming or Copying Documents 

Once a document has been saved, Works no longer asks for a name, or 
for a disk or folder for storage. Occasionally, however, you may wish to 
rename the file, or move it to another disk or folder. The Save As com
mand performs the same function as Save, but allows you to store a doc
ument under a new name, as well as on a different disk or folder. 
Initially, Works offers the same name as the document, but you are free 
to edit it as desired. 

Though you will probably want to use the Finder to copy many files 
between disks and folders, the Save As method is particularly handy to 
move or copy one or two documents to another location. 

When transplanting a document from one disk or another, or from one 
folder to another, you'll probably want to delete the original after making 
the copy. Works lets you remove unwanted files with the Delete command, 
found under the File menu. The dialog box for Delete lists all of the files 
available on the current disk/folder, as shown in Figure 1-11, whether or 
not they are Works documents. 

Beware of using the Delete command. Although the command gives 
you one last chance to change your mind before the file is erased, disposing 
of a wanted or needed file can cause a grand headache. And while some 
Macintosh utilities, such as MacTools, can be used to revive previously lost 
files, such utilities are not foolproof, nor are they always easy to use. Your 
best defense is to use the Delete command wisely, and with prudence. 

Delete File: 

101 Works 2.0 I 
D Macros :!1 
[l MsWorksHelp 
CJ Tutorial 
[) Works Desktop 
CJ Works Dictionary 
CJ Works Documents 
CJ Works Tools 

Free Space: 15368K 

Figure 1-11 Delete Dialog Box 
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WORKS DESKTOP FILES 

Works allows a convenient method of recording a set of open documents 
for later retrieval. The Works Desktop file contains the names of up to 16 
documents. When the Desktop file is opened, Works searches for these 
documents and opens them. You can use this feature to quickly and effort
lessly open commonly used documents, or to effortlessly return to a set of 
documents that you were working with in the last session. 

You must frrst make a Works Desktop file before you can use it and 
that's easy. With the documents you want named and open within Works: 

1. Choose the Make Works Desktop command from the File menu. 

2. Provide a name for the file. Works initially offers the name Works 
Desktop. 

Note: Works won't record any untitled documents in the Desktop set. 
You can readily locate the Works Desktop file from the Finder; it's 

shaped like an office desk. Keep in mind that the Works Desktop flle sim
ply records the name and location of the files in the set; it doesn't record 
the actual contents of the documents. Therefore, if any of the documents 
are subsequently renamed, moved, or deleted, Works won't be able to fmd 
them. The program will indicate that one of the files in the Desktop set 
can't be found, then open the rest. 

To open the documents in the set, simply open the Desktop file. You can 
do this in two ways: 

• From the Finder, locate the Desktop file and double-click it. Works 
starts, and all the documents in the set are loaded. 

• From within Works, choose the Open command and be sure that the 
All Works Types icon is selected. Locate the Desktop file within the 
list and double-click on it. Previously opened documents are unaffect
ed, but note that Works can open only a maximum of 16 document 
windows, depending on available memory. 

Being able to "instantly" open a set of Works documents is power 
enough. But Works Desktop files go beyond that. ~y simply giving differ
ent names to the Desktop files, you can create as many document sets as 
you like. The names of the Desktop files can be as descriptive as you like, 
as shown in Figure 1-12. 
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Figure 1-12 Folder of Desktop Files 

USING STATIONERY 

Blank Works documents can be saved as Stationery, and used as templates 
for subsequent documents. Stationery can contain character, paragraph, 
and page formatting, standard text (like common headers or footers), 
spreadsheet formulas, communications settings, graphics, and anything else 
you care to throw in. Works Stationery mes also remember the position of 
the insertion point when the document is saved. When the Stationery me is 
reopened, the insertion point flashes where you left it. 

To create Works Stationery: 

1. Make the desired formatting and setting changes and write the text 
you want to serve as standard boilerplate elements. 

2. Choose the Save command from the File menu. 

3. Enter a name for the document, such as "Letter/Form." 

4. Click the Stationery button at the bottom of the dialog box, as shown 
in Figure 1-13. 

5. Click the Save button; the Stationery me is recorded on disk. 

The original document window remains untitled. Works never lets you 
edit Stationery files. Close the window without saving it again. 

Works uses a slightly different Desktop icon for Stationery than it does 
for regular documents: you can always tell a Stationery file by its upturned 
lower right corner. 
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Figure 1-13 Save Box with Sllltionery Clicked 

Stationery files can be opened in either of two ways: 

• From the Finder, locate the Stationery file and double-dick it. 

• From within Works, choose the Open command. Locate the Desktop 
file within the list (select a document type to help narrow the search, if 
desired) and double-click on it. 

Even though you have opened a Stationery document, Works only uses a 
copy of it, so the original is never altered. If you do need to change the 
original, open the Stationery document as described above, make the 
desired changes, and save the document under the same name. Works dou
ble-checks to make sure you really want to overwrite the old file. Answer 
Yes to the prompt. 
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Writing with Works 

Word processing is the cornerstone of many businesses. With a word pro
cessor, the once tiresome chore of writing memos and letters becomes a 
simple effort. Granted, the Works word processor is not the most powerful 
word processor in the world. It lacks many of the fmer features found in 
stand-alone programs. Yet it provides more than 90 percent of the most 
often desired features of a word processor, and even offers some powerful 
graphics and layout tools for creating desktop published documents. 

While there are few truly "hidden" features of the Works word processor, 
there are a number of fme-tuning adjustments you can make to use the 
word processor more efficiently. In addition, you '11 be pleased to discover 
many gimmicks and work-arounds for adding power to the Words word 
processor-capabilities that you may not have thought possible. 

WORD PROCESSOR BASICS 

Figure 2-1 shows the basic function of the Works word processor scroll 
bars. Note the different actions of the scroll boxes and arrows. Works also 
has a nifty feature for "micro-scrolling," introduced in Chapter 1. When 
holding down the Shift key, clicking the scroll arrows moves the contents 
of the window just a fraction of an inch at a time. This feature is most 
helpful in the word processing module. 

31 
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Figure 2-1 WP Window with Callouts for Operation 

Selecting Text 

In Works, as in most other Macintosh applications, you first select the text 
you want to manipulate, then you specify what you want to do. Works lets 
you select text in a variety of ways. Some of these methods require that 
you click in the selection bar, an invisible section on the far left side of the 
document window. The pointer must be arrow shaped for the selection to 
work. 

To select 
An insertion point 
One or more characters 
A whole word 
One line 

One paragraph 

A range of text 

Entire document 

Do this 
Click at the desired spot 
Drag over them. 
Double-click on the word. 
Position the pointer in the selection bar 

next to the line and click. 
Double-click in the selection bar next to the 

paragraph. 
Position the pointer at the start of the 

section of text and drag to the end, or, 
click at the beginning section of text, 
press and hold the Shift key, and click at 
the end. 

Choose Select All from the Edit menu. 
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Using Shlft·CIIck 

Shift-clicking is one of the most convenient ways to select text. You click 
once to set a starting point (called an anchor), press and hold the Shift key, 
and click at the ending point. The second click can actually be before or 
after the anchor. 

To see exactly how this works, click within a paragraph of text. This 
sets a new insertion point and also the anchor for the Shift-click selection 
method. Press and hold down the Shift key (remember to keep it depressed 
during all this), then click a few lines below the anchor. Notice the text is 
selected from the anchor point to where you clicked a second time. 

You can extend or retract the selection by holding down the Shift key 
again and clicking somewhere else. You can actually keep the mouse 
button depressed as you extend or retract the selection so that you can visu
ally see the effect of the highlighted text. 

Another way to select text using Shift-click is to extend a selection one 
word, line, or paragraph at a time. Let's say you have highlighted one 
word by double-clicking on it. Depressing the Shift key while clicking on 
adjacent words selects these words as well (the entire word is automati
cally selected). 

The process also works when extending a selection by lines or para
graphs. To extend by lines, select one line (~y clicking within the selec
tion bar next to the paragraph, as outlined above), press Shift, and click 
adjacent lines. Conversely, to extend by paragraphs, select one paragraph, 
press Shift, and click other paragraphs. Remember to select words, lines, 
and paragraphs using the methods described earlier, or this technique 
won't work. 

Insertion Point Shortcuts 

Normally, you '11 use the mouse to scroll through a document or to select a 
new insertion point. But Works also supports the cursor arrows, found on 
enhanced and extended keyboards, and on the separate Macintosh numeric 
keypad available for earlier Mac models. 

• Pressing the Right and Left cursor keys moves the insertion point one 
character at a time. 

• Pressing the Up and Down buttons moves the insertion point one line 
at a time. 

You may wish to use these keys to maneuver the insertion point over a 
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small area instead of grabbing the mouse and carefully setting a new inser
tion point manually. 

Using Go To Page 

The current page number of the word processing document is shown in the 
scroll box in the vertical scroll bar. The number reflects the page as viewed 
in the window, not the current location of the insertion point, as shown in 
Figure 2-2. As you scroll the document with the vertical scroll bar, the 
number changes as each new page advances in the window. 

You can use the scroll box page number to fmd a specific page you want, 
but an easier way is to use the Go To Page command in the Search menu. 
Choose the command (by the menu or by pressing Command-G), then 
enter a page you want to shuttle to. 

The page range must be between 1 and 2000. If you exceed the total 
number of pages in the document, Works will respond with the appropriate 
range to use, such as "Document contains pages 1 through 5." When shut
tled to the desired page, Works leaves you at the very top of the page. 
Clicking the Up arrow once reveals the page break, indicated either by you 
or by Works. 

- - -_ -- ~---==---=-------~--

- ---- ----- -----

Prominent bicycle magazines are planning cover stories 
President Wheeler and the race. We hope to get feature 
articles in all the mejor magazines world-wide. 

French, SWiss, and Italian regional leaders plan to attend the 
fireworks ceremonies in their respective countries, and are 
lending their support to the success or the race. They hope 
the race will promote bicycle touring in the more rugged 
rectons of their countries, so that those areas will receive 
more tourist dollars. 

Figure 2-2 Concept of Page Number and Current Insertion 
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Saving Documents 
Works word processing documents can be saved in any of four fonnats: 

• Nonnal 

• Export Text-only 

• ExportRTF 

• Stationery 

You select the flle format you wish to use when saving a document with 
the Save and Save As commands in the File menu. 

Normal 
The Normal flle format saves word processing documents with all text and 
formatting intact, just as you wrote it. Works automatically selects the 
Nonnal fonnat when saving a document. 

Export Text-only 
The Export Text-only format is used with documents you expect to use 
with other word processors or Macintosh applications. Works saves all text 
(including special characters), but ignores formatting. 

Export RTF 
RTF stands for Rich Text File, a f11e format pioneered by Microsoft for eas
ier conversion of documents between applications and computers. Export 
RTF documents contain the text of the document, as well as English-like 
formatting instructions, as shown in Figure 2-3. Programs that support 
RTF reconvert the RTF file, exchanging the instructions with the proper on
screen formatting. To save a file in Rich Text File format, click the Export 
button in the Save or Save As dialog box, then check the RTF box. 

Stationery 
Stationery documents contain all the text and formatting of a Normal file, 
but in a special read-only document that Works opens as a template. You 
can use the text and formatting of the template to write and edit another 
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By Gordon McComb \par 
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\tab From phone tines and videodiscs to surgical procedures and 
optical computing -- the laser is one of the most important 
inventions to come along during this half of the 20th Century. The 
Laser Cookbook, ~~ Practical Projects, gives you the opportunity to 

. ! 

Figure 2-3 Sample RTF File 

document. Stationery files can't be edited unless you specifically save a 
new document (Stationery or otherwise) with the same name as the original. 

SETTING PLACE MARKERS 

Not all reports, articles, and novel chapters are written in one sitting. 
Sometimes, you must leave your writing in mid-thought, then pick up again 
at some later time. Returning to the right spot in the file is no trick when 
you are simply adding more text at the end of the document But what if 
you want to return to the middle of the document, and you are afraid of for
getting where you were? Simple. Set a place marker before you quit the 
document, then use Works' search feature to find the marker on your subse
quent return. 

Works lacks a place marker feature (such as that found on WordStar for 
the mM PC), but you can readily improvise one of your own. Here's how 
to do it: 

1. Select one or more characters for your place marker, such as @@ or 
~~. The characters should not normally appear in your document, but 
should be simple enough so that you won't forget them. 

2. Type the characters at the spot to which you want to return. 
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3. Save the document and quit Works. 

4. On your return to Works, open the document and choose the Find 
command from the Search menu. 

5. Enter your place marker characters in the Find What box (such as 
@@). 

6. Press Find Next and Works takes you to the location of the place 
markers. 

7. Press the Cancel button to exit the Find dialog box. 

Works automatically highlights the place marker text; press the Delete 
key to erase the marker text. 

Setting place markers is an excellent application for Works macros. You 
can find full details on macros, as well as how to build a set of macros for 
setting place markers, in Chapter 8. 

SPLIT WINDOW TRICKS 

The Works word processor has no provision for split windows. That is, 
you can't divide one word processing document into two discrete views, 
and toggle between them. However, you can approximate a split document 
by creating two separate documents filled with the same text. There are 
several limitations to this approach-edited text in one window is not 
reflected in the other, for example-but it can do in a pinch. It is particu
larly helpful if you need to examine two physically distant parts of the 
same document. 

Suppose that you are writing a business review, and you want to con
clude the review by summarizing the main points you've discussed in the 
article. By copying the article to a second document, you can scroll 
through the document and examine portions of it while writing the summa
ry. You can keep full paragraphs in full view during writing, so you can 
capture entire thoughts at a time. 

Ideally, Works ought to let you save your document on disk, then open a 
second copy of it. Alas, it does not allow you to do this. Instead, you must 
copy the contents of the document to a second, separate window. 

1. With the original document in view, choose the Select All command 
from the Edit menu. 

2. Adjust the size of the window so that it fills just the top portion of the 
screen. 

3. Press Command-C to copy the document to the Clipboard. 

4. Press Command-N to open a new document. 
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5. Click the WP icon to open a new word processing document. 

6. Adjust the size of the new document so that it fills the bottom of the 
screen. 

7. Press Command-V to paste the contents of the Clipboard into the 
new document. This may take a while, depending on the size of the 
original document. 

An example of a "split-screen" Works window is shown in Figure 2-4. 
Another method for copying the contents of the original document into a 

new window is to use the Save As command. This method records the doc
ument with a new name. You then retrieve the flle again by opening the 
original document. 

1. Make any desired changes or editing to the original document and 
save it. Provide a name if you haven't done so already. Let's say, for 
example, that the name is Test. 

2. Choose the Save As command from the File menu and resave the 
document, this time under a different name. For the example, we'll 
call the file Test-1. 

3. Adjust the size of the document so that if fills just the bottom portion 
of the screen. 

4. Press Command-O to open a document. 

,. • File Edit Window Search Format Spell Macro 

T.H.E L.A.S.E.R C.O.O.K.B.O.O.K 
88 Practical Projects 
By Gordon McComb 

From phone lines and videodiscs to surgical procedures and 
optical computinr - the laser is one of the most important 

cunnery practice, even becinnfnr and advanced holography. H1ch 
-quality laser art illustrates instructions, and detailed projects 
(complete with parts lists) put all the information you need to ret 
starting right at your fingertips. You'll even find information onl I 
electronic construction techniques ... how to buy laser 
components ... when and where to buy surplus or new ... and how to 

what want! of the covered are ideal 

Figure 2-4 Example of Split-screen Window 

., 
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5. Locate Test from the f11e list and double-click on it. 

6. Adjust the size of the document so that if fills just the top portion of 
the screen. 

Use the mouse to move back and forth between the windows, or use the 
Command-, shortcut. 

THE WORKS CAST OF CHARACTERS 

The keyboard of your Macintosh is your gateway to entering chara'iters 
into Works. The keyboard represents the alphabetic, numeric, and punctua
tion characters that appear on any typewriter keyboard. 

However, Works offers many special characters that a typewriter and 
many other word processors don't. Here is an overview of producing spe
cial characters in Works, and how to enhance them by taking advantage of 
the program's font and style features. Though these characters can be pro
duced in any of the Works modules, they have their primary use in the 
word processor. 

Special Font Characters 

Works comes with several fonts (also called typefaces) that comprise 
standard alphabetic, numeric, and punctuation characters, plus some addi
tional ones. Use the Key Caps desk accessory to view the characters in a 
given font. When Key Caps is open, a new menu appears in the menu bar 
where you can choose the font you want to examine. Only those fonts cur
rently installed in the System file are shown in the font list. 

With the Caps Lock key up (deactivated) and no other keys depressed, 
the Key Caps window shows unshifted or lowercase characters (for all 
keys, including the number keys on the top of the keyboard). Press the 
Shift key (or tap on the Caps Lock key) and the window shows shifted or 
uppercase characters. 

To see the special characters, hold down the Option key or the Shift and 
Option keys, as shown in Figure 2-5. Almost every font has slightly dif
ferent special characters so you may not see the same characters as those 
shown in the figure. 

The boxes are not true characters, but undefined keys. Pressing one of 
these keys will enter a box in the Works document, but the box may not 
appear when using some printers, especially the Laser Writer. If you need a 
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Figure 2-5 Key Caps Option and Shift Option Windows 

character that looks like a box, use one of the many symbol fonts, such as 
Symbol, Zapf Dingbats, Cairo, or Taliesin. 

Diacritical Characters 

Works-and the Macintosh-are designed for international use. You can 
readily add accent (diacritical) marks to certain characters by pressing the 
following key combinations. The accent is added to the next character 
typed; pressing the Option key combination twice creates only the accent 
character. 



Press 
Option-' 
Option-e 
Option-i 
Option-n 
Option-u 

To get 
'(grave accent) 
'(acute accent) 
" (circumflex or caret) 
-(tilde) 
··(umlaut) 
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These special accent keys produce diacritical marks only on those char
acters where it is appropriate to do so. For example, pressing Option-e, 
then a lowercase 1 will not add an acute accent over the letter, because there 
is no language that uses this character (instead, Works prints '1). The list in 
Appendix B shows all of the possible accented characters you can create on 
the Macintosh, as well as the keys you press to get them. 

If you absolutely must create a non-standard diacritical character you can 
purchase fonts with zero-width characters, such as the foreign language 
fonts offered by Ecological Linguistics and Linguists' Software. 'JYping 
one of these characters produces a symbol that overlays the next character 
typed. These can be helpful if you need to create an obscure or special-pur
pose character that Works otherwise doesn't support. 

If you can't locate any zero-width fonts that suit your tastes, a last resort 
is to create your own using a font editing program. The editing program 
must match the type of font you are using, either LaserWriter or 
Image Writer. Basic editing instructions for Image Writer fonts are provided 
in Chapter 10, "Customizing Works." 

Ligature Characters 

Akin to diacritical characters is the ligature-two characters spaced closely 
together so that they look like one. Ligatures are rarely used today except 
in special circumstances and Works and Macintosh routinely support only 
four: IE, a, CE, and a!. 

Hidden Graphics Characters 

Nearly all Apple-provided Image Writer fonts also include a couple of "hid
den" graphics characters. The chart in Figure 2-6 shows some of the char
acters found in common fonts (special graphics characters are also some
times included with third party fonts). You obtain these graphic characters 
by pressing Shift-Option-' (grave accent). As the chart shows, the actual 
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9 12 14 18 24 36 48 72 

Seattle D 0 [] D D D D D 
New York • i f.J • i • I I . 

Geneva 0 .... .L. Q - Q ,. ,_ 
Monaco a [] (] - D D D D 
Chicago 0 D D D D D D D 
Venice • 0 Oo 6 0- o- 0- 0-

.-=. .~ a-:. . ":. • • . , • .. ollO I .-:. Athens • " •• o:. ... .-=. e.· • .. ~ .. • • • 
Figure 2-6 Hidden Font Characters 
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graphic, as well as its size, depends on the font and font size you have cur
rently chosen. 

Non-alphabetic characters are also available in so-called picture fonts, 
such as Cairo, Taliesin, Symbol, and Zapf Dingbats (both Cairo and 
Taliesin are Apple fonts; Taliesin is no longer distributed with the Finder 
and System, but you can occasionally find a copy of it at Macintosh users 
groups and public domain exchanges). 

Hyphens and Dashes 

Use hyphens to join two or more words together or to hyphenate words at 
the ends of lines. Works recognizes one hyphen character, the -, produced 
by pressing the hyphen/underline key, located next to the zero key on the 
top row of the keyboard. 

Works will never chop up a word if the word is too long to fit at the end 
of the current line. Instead, it wraps the entire word to the beginning of the 
next line. Works considers a complete word any set of characters that 
doesn't include a space, punctuation mark, or hyphen. Therefore, you can 
use the hyphen character to break a word at the end of the line, such as: 

knock-

down 

or 

He was wearing a three piece all

season suit. 

You do not need to manually type a space character to force Works to 
break the word after the hyphen. 

Unlike some other programs, Works will not remove the hyphen if you 
subsequently edit the line and make it shorter. For ease of use, you should 
always write, edit, and spell check the entire document before hyphenating 
it. Otherwise, you may end up with words in the middle of lines that are 
separated by an unwanted hyphen. 

Similar to hyphens are the typographical en (-) and em (-) dashes. The 
en dash, so called because it is the approximate width of the letter N, is 
often used to hyphenate compound words, and fmds its usual application in 
desktop publishing. The em dash (the approximate width of the letter M) is 
generally used to separate parenthetical phrases, such as: 

And the writer-altogether out of his mind-decided to do a book 
on mastering the fine points of using Works. 
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Regular hyphen
The en dash 
The em dash 

Untitled (WP) §I 
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(hyphen key only) 
(Option- hyphen) 
(Shift-Option-hyphen) 

Figure 2-7 Examples of Hyphens, EN and EM Dashes 

Examples of the differences among hyphens, en dashes, and em dashes, are 
shown in Figure 2-7. 

• To create an en dash, press Option- - (Option and hyphen). 
• To create an em dash, Press Shift-Option- - (Shift, Option, and 

hyphen). 

Works considers the en and em dashes real characters. The program will 
not break a word at the end of a line at an en or em dash. 

Spacing and Microspacing 

Pressing the spacebar prints an invisible space in the document. The actual 
width of this space is dependent on the font you are using, as well as other 
variables such as font size and style. 

You can force Works to print a "mini-space," or a microspace, by press
ing the Option key and tapping on the Spacebar. The resulting space is 
only about a third the width of a regular space. You can use this technique 
to add slight spaces between characters (for added impact, for example), or 
to indent text a specific distance from the left indent or a tab stop. 

The actual distance of the microspace depends on the font, size, and 
style you are currently using, but with a normal font such as Boston 12 
point, you can pack about 72 microspaces into one inch (compared to 12 
regular spaces, as shown in Figure 2-8). The size of the microspace 
increases as you select larger fonts, but in direct proportion to the size of 
the font. For example, with 24 point Boston, you can squeeze 36 
microspaces into one inch. 

Typographically speaking, there are 72 points to the inch, so using 
microspacing can prove a real boon in desktop publishing and graphics 
applications. (As an aside, the Macintosh screen is composed of 72 dots, or 
pixels, to the inch.) As long as you know the ratio of microspaces to the 



Single space between words 
lmicrospaces between words 
2 microspaces between words 
3 microspaces between words 
4 microspaces between words 
5 microspaces between words 
6 microspaces between words 
7 microspaces between words 
8 microspaces between words 
9 microspaces between words 
0 microspaces between words 
Figure 2·8 Comparison of Regular and Microspacing 
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inch with the font you are using, you can apply microspacing in order to 
manually count the distance between characters, graphics, and lines. 

Other Special Characters 

The Macintosh is capable of producing a number of special-purpose char
acters. All are available by pressing Option or Shift-Option, and a letter, 
number, or symbol key. Appendix B provides a complete listing of all the 
characters available with several popular fonts, but here's a rundown of the 
most commonlt used characters, and how to create them. 

Press Character 
Option-] 
Shift-Option-] 
Option-[ 
Shift-Option-[ 
Option-\ 
Shift-Option-\ 
Option-; 
Option-S 
Shift-Option-S 
Option-2 
Option-R 
Option-G 
Option-6 
Option-7 
Option-3 
Option-Y 
Option-4 

Character 

" , 

« 
» 

• 
0 

TM 

® 
© 
§ 

~ 
£ 
¥ 
¢ 
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FORMAT POWER 

Works deals with three kinds of formatting: character, paragraph, and 
document. These correspond to the smallest unit your word processing 
documents can contain-the single character-to the largest-the entire 
document itself. All of the following options can be accessed from the 
Works Format menu. 

Character Formats 

Character formats are the size, shape, and features of the individual letters 
and numbers in your Works document. Specifically, Works lets you adjust 
the font, size, style, and color of each and every character in a Works word 
processed document. Let's take a closer look at these character formats, 
and what they mean to you as you build Works documents. 

• Font. Though the Works word processor initially chooses the Boston 
font for all new documents, you are limited only by the number and 
variety of fonts installed in the System file on your Works disk or 
hard disk. 

• Font size. The size of a font can vary between 4 and 72 points. 

• Font style. You may choose from among eight font attributes, includ
ing underline, outline, bold, italic, and more. You may even combine 
the styles to produce up to several thousand variations. 

• Color. If your Mac is equipped with a color monitor, you may choose 
from among eight colors for text display. The color choices are also 
retained when printing with an output device that supports color (color 
PostScript, Image Writer ll, for example). 

Character formats are established with the Font, Size, Style, and Color 
commands in the Format menu, either as you write text, or after. 

• When the insertion point is a single, flashing line, changes you make 
with the Format menu affect the text from then on. The new formats 
stay in effect until you change them again. 

• When one or more characters have been selected with the mouse, 
choices you make from the Format menu affect only the highlighted 
text. Previously selected formats remain in effect for text you subse
quently type. 

The insertion point is always between two characters (even if one of the 
characters is a blank space and the other the invisible marker at the end of 
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the word processing document). The fonnat of text you write at the inser
tion point is determined by the preceding character format. That is, if you 
click at the space immediately after a character formatted with the under
line style, new text you enter will also be underlined. 

Although there really are no restrictions as to the number of character 
formats you can select for a document, good design dictates that you use as 
few different fonts, font sizes, styles, and colors as possible. You should 
also consider the effect different fonts and sizes have on the way the 
Macintosh manages its memory. Changing fonts and sizes consumes extra 
memory, which you may need to create longer documents. 

Fonts are provided as font resources, and are installed in the System file 
of your Works disk or hard disk. One font may have several resources, 
each with a different point size, ranging from nine to 24 points (a few spe
cialty fonts for the Image Writer come in sizes up to 36 and 48 point). 

Most fonts, however, are not distributed in all of the common sizes (9, 
10, 12, 14, 18, and 24 points), even though Works lets you use any font size 
from 4 to 72 points (in whole numbers). If the specific point size you want 
is not installed in the System file of your disk, Works scales the font to fit 
your request. 

Scaled fonts may look jagged and uneven, as shown in Figure 2-9, 
because the scaling is not always perfect. To scale a font, the Macintosh 
takes an existing font resource, and enlarges it to the desired size. If the 
desired size is not an even multiple of the original font resource, the result 
will be jagged and sloppy. For example, a 12-point font scaled up to 24 
points looks better than a 12-point font scaled to 18 points. 

For speed and appearance, you should strive to use only font sizes that 
are installed on the disk. Scaling-sizes of even multiples-consumes 
valuable processing time inside the Macintosh. With only onefont in a 
couple of sizes, the wasted time may not be noticeable. 

Untitled (W~ 

> 

This is: an eHample of a staled font I 
i 
~ .................................................................................................................................•.........•. , 

Figure 2-9 Scaled Font 
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But sluggish performance becomes very noticeable if you scale many 
fonts, in many different sizes. 

Scaled fonts look somewhat better when printed on the Image Writer than 
they do on the Macintosh screen. Still, you '11 probably want to stick with 
font sizes that are installed in the System ftle to ensure the best quality 
print. Scaled fonts make little difference when using the LaserWriter 
because the fonts are properly enlarged or reduced with greater precision. 

How can you be certain which fonts are installed in the System file, and 
which ones will be scaled if used? When you choose a font from the Pop
up Font menu, some of the sizes may be outlined while others are plain, as 
illustrated in Figure 2-10. The outlined fonts are the ones installed in the 
System ftle on your Works disk. The non-outlined fonts are not installed 
on the disk; choosing one of these displays the font scaled from one of the 
sizes available. 
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Format Spell Mocro 
., 

Hide Ruler --------

................................................................... ~====:;===;:::;.=t 
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Style ~ D 00 lPmHiiltl 
Color ~ ~n ~ lPmHmtl 

................................................................ D I(} lPCDHiiltl 
Copy Formot X 
l>ns1 <~ formn t :•:Y 

Justificotion ~ 
Spocing ~ 

I ns<~r1 P<t~J<~ ElnwJ( 
Title Poge 
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Other ••• .,.. ____ ... 

Figure 2-10 Outlined Font Sizes 
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If you need an in-between font size not given in the Pop-up Size menu, 
choose the Other command, then enter a whole number from 4 to 72. 

Paragraph Format Hints 

To Works, a paragraph can contain no characters, or it can contain many, 
spanning dozens of lines on the page. New paragraphs are created by 
pressing the Return key. Each paragraph you write with Works can con
tain its own distinct formatting, including indention, tab stops, line spacing, 
and alignment. 

• Indention. Many Works users confuse indention (or indentation) with 
margins. To Works, margins are set as a document format (see 
below), and determine the area on a piece of paper for possible print
ing, as illustrated in Figure 2-11. The indention, as set by the indent 
markers in the Works ruler, formats the text within the boundaries of 
the margins. 

• Tab stops. Works has default tab stops every half inch on the ruler, but 
you can add your own. You have a choice of left-, centered-, right-, 
and decimal-aligned tabs. 

• Line spacing. Works permits you to control the spacing between lines: 
single, one and a half, and double space . 

Left 
indent 

........................... 
i 
: 
: 

i 

1/ 
i Right I indent 

: 0 

'·········································' 

Margin 
(print area) 

Figure 2-11 Concept of Margins and Indents 
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• Alignment Alignment determines how the text confonns to the left 
and right page margins. Works calls alignment "justification," but that 
term has a specific meaning in typography, so we '11 refer to it as align
ment. Four choices are available: right-aligned, left-aligned, centered, 
and justified (aligned on both right and left margins). 

Tips for Tabs and Indents The Works ruler controls tabs and indents. 
Works automatically opens the ruler with each new word processing docu
ment, but you have the choice of hiding or displaying it at any time. 
Choose the Hide Ruler or Show Ruler command in the Fonnat menu, as 
desired. 

Setting Indents The ruler provides three markers for setting indents, as 
shown in Figure 2-12. 

Marker 
Left triangle 
Left square 
Right triangle 

Sets 

Left paragraph indent 
First-line indent 
Right paragraph indent 

The purpose of these indent markers is fairly self-explanatory, but as 
examples, Figure 2-13 shows three possible arrangements of the markers, 
and their effect on text. Note that the left and right paragraph markers 
indent text aligned to the top and bottom points of the triangles, not to the 
points on the side. This factor is important when creating some types of pre
cision documents. 

While there's no real trick to using the Works ruler and its indent 
markers, there are a couple of hints and tricks you may not know about. 

• Many times, tugging at the left indent markers moves the wrong mark
er. You can be assured of moving the marker you want by following 
these two simple rules: Drag at the top of the left paragraph indent 
marker and you move that marker only. Drag at the bottom and you 
move the frrst-line indent Practice for a few minutes and you '11 get 
the hang of it. 

• You may, on occasion, attempt to position the right paragraph indent 
marker outside the boundary of the right margin (as set in the Page 
Setup dialog box). Obviously, this would cause Works to print text 
outside the margins you have set, and perhaps even off the page. 
Works doesn't give a noticeable warning when you do this, but does 
provide a visual indication of this situation by turning the right indent 
marker hollow. You will be warned that text may be lopped off when 
printing or previewing the document. 
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Figure 2-12 Ruler with Indents, Callouts 

Using Tabs Tabs lets you indent text to a specified spot on the line, or to 
align text along some common point. As stated previously, Works assigns 
default tab stops every half inch along the length of the ruler, so that every 
time you press the Tab key, the insertion point is expressed one-half inch to 
the right (unlike some word processors for the Mac, pressing Shift-Tab 
does not release the left margin and express the insertion point to the left). 
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crowded brick buUdings, tattered and worn from age; mudied 
from the recent rains. 
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Figure 2-13 Sample of Alignment Settings and Effects 

Obviously, Works' preset tabs may not suit your needs, so the program 
allows you a way to conveniently set your own. To set a tab, simply click 
below the tape measure part of the ruler. A tab stop appears there. Now, 
pressing Tab expresses you directly to the new tab stop. Default tabs to the 
left of the one you set are ignored. 
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How do you produce these different tab stops? Easy. Just click the 
mouse from one to four times to set each type of tab stop. 

Click 

1 time 
2 times 
3 times 
4 times 

To produce 

Left-aligned tab 
Right -aligned tab 
Decimal-aligned tab 
Centered tab 

Clicking a fifth time returns you to a left-aligned tab, where you can start 
all over again. Each type of tab stop has its own special marker, as shown 
in Figure 2-14. The figure also shows the effect of tab stops on text. 

Though it may not be obvious, you have complete control over tab stops. 
Moving a tab stop is as simple as dragging it with the mouse. Tab stops no 
longer needed can be removed by dragging the tab stop marker away from 
the ruler. The stop disappears when you release the mouse button. 

Actually, Works produces four types of tab stops. Each one aligns text to 
the stop in different ways: 
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• Left-aligned tabs arrange the left edge of the text to the tab stop. This 
is the default tab stop. 

• Right-aligned tabs arrange the right edge of text to the tab stop. 

• Decimal-aligned tabs arrange the decimal point (period) of numbers 
under the tab stop. 

• Centered tabs center text evenly to the right and left .of the tab stop. 

You will often use centered and right-aligned tab stops to create profes
sional-looking tables. The decimal tab stop is ideal for presenting numbers 
in an orderly, well-defmed fashion. You can have any number of digits to 
the left and right of the decimal point, yet all the decimal points line up at 
the tab stop. 

Line Spacing Works can separate lines into three distinct spacings: single
space, space-and-a-half, and double-space. The actual distance is deter
mined solely by the choice of font, size, and style. 

Line spacing is set with the Spacing command in the Format menu. 
Selecting this command pops up a secondary menu where you may choose 
among the three line spacings. 

Works provides an additional spacing command useful when filling out 
preprinted forms designed for a typewriter. Choosing the Six Lines Per 
Inch command overrides normal font spacing and places lines one-sixth of 
an inch apart. For best results, use a font 12 points or smaller. 

Alignment Alignment is how the right and left edges of paragraphs line up 
with the right and left indents of the document. You can choose from 
among four types of paragraph alignment, as depicted in Figure 2-15. 

• Left aligned. Lines are even with the left indent and their right edge is 
ragged. 

• Centered. Lines are centered over the midpoint between left and right 
indents. 

• Right aligned. Lines are even with the right indent, and their left edge 
is ragged. 

• Justified. Lines are even with both the left and right indents. Works 
expands the spaces between words to push the ends of lines to the left 
and right indents. 

To set the alignment, choose the Justification command from the Format 
menu; a smaller sub-menu pops into view providing the four choices out
lined above. 

The default paragraph alignment is left aligned, which corresponds to the 
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Figure 2-15 Alignment Samples 

format of most documents, including letters, memos, and reports. 
Since the advent of personal computers and word processing, many users 

choose the justified format for the paragraphs of their documents. While 
there is nothing intrinsically wrong with this, you must be careful that the 
printed document doesn't look stilted and awkward. Justified margins nec
essarily cause extra gaps between words, which can be unsightly when pre
sented in printed form. If you wish to use justified alignment, be sure to 
check the document for large word spaces and make adjustments by adding 
hyphens, where possible. Of course, over-hyphenating a document can 
lead to an even worse appearance, so exercise restraint. 

Works automatically left aligns paragraphs when a document is saved in 
Text-only (Export) format. 

Different Formats Between Paragraphs Like character formats, para
graph formats can be chosen before text is written, or after. When the 
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insertion point is a single, flashing line within the paragraph, changes you 
make with the Ruler or Format menu alter the current paragraph and all 
those thereafter. These new formats stay in effect until you change them 
again. Similarly, the format of the entire paragraph already written is 
changed if the insertion point is flashing anywhere within the paragraph 
(the entire paragraph need not be selected). 

When two or more paragraphs have been selected with the mouse, choic
es you make from the Format menu affect only the highlighted paragraphs. 
Previously selected formats remain in effect for paragraphs you subse
quently type. 

Suppose you have formatted the frrst paragraph in your document as dou
ble-spaced, centered. This sets the format for the frrst paragraph and-ini
tially at least-sets it for subsequent paragraphs. Pressing the Return key 
starts a new paragraph, and the formats are repeated. Now suppose you 
change the formatting for the second paragraph. The formats in the frrst 
paragraph are unaffected, but the second paragraph is now altered. 

Each paragraph you write could theoretically have a different format, 
though odds are you will write paragraph after paragraph with the same 
formats. Macros can greatly speed up the reformatting process if you need 
to produce documents with many formats-all of which repeat throughout 
the ftle. See Chapter 8 for more details on using Works macros. 

Works lacks a means to visually display the marks that indicate the end 
of a paragraph (Microsoft Word, for example, allows you to view or hide 
paragraph and formatting marks). This is unfortunate, because it is the 
invisible paragraph marker that actually "holds" the formatting for the pre
ceding paragraph. You can verify this by creating two adjacent para
graphs, each with different formats. Then place the insertion point imme
diately before the first character in the second paragraph, and press the 
Delete "key until" the insertion point is at the last character of the frrst 
paragraph. This erases the paragraph mark of the frrst paragraph, not 
only deleting the paragraph mark, but erasing its formatting. (Works may 
not always refresh the screen so the text may look distorted and some may 
even disappear. Manually restore the screen by scrolling down a few 
clicks, then back up again.) 

Formats from one paragraph can be copied to another with the use of the 
Copy Formats and Paste Formats commands, both in the Format menu. To use: 

1. Click anywhere in the paragraph you want to copy the formats from. 

2. Choose the Copy Formats command from the Format menu. 

3. Locate the cursor in the destination paragraph (or just click in the 
window if you are starting a new paragraph). 

4. Choose the Paste Formats command from the Format menu. 
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The Copy Formats and Paste Formats commands work with paragraph 
formats only. Character formats are ignored. 

Document Formats Document formats determine the overall look of a fm
ished memo, report, or letter. Document formats consist of: 

• Paper size. The size of the paper dictates how much text you can get 
on a single page. 

• Page margins. The page margins set the boundaries for printing, usu
ally within an inch of the edges of paper. 

• Print orientation. Works lets you select between portrait (tall) or 
landscape (wide) print orientation. 

• Headers and footers. A header is a line of text that repeats at the top 
of each page; a footer is a line of text that repeats at the bottom of 
each page. 

All document formats in Works are set from the Page Setup dialog box 
(choose Page Setup from the File menu), as shown in Figure 2-16. The 
exact contents of the dialog box varies somewhat depending on the version 
of System software you are using, as well as whether you are using a 
Laser Writer or Image Writer printer. Works stores all the page setup set
tings you specify in the dialog box with the document. 

Additional special effects options are available when formatting documents 
for printing by a Laser Writer or Image Writer. As these options affect all mod
ules of works, they are discussed in Chapter 12, "Printing With Works." 
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Paper Size Works offers five paper sizes, chosen by clicking one of the 
radio buttons in the top of the Page Setup dialog box. When using the 
Image Writer printer, you also have a choice of defming a custom page size 
by entering a new paper width and height in the entry boxes provided (the 
Custom option is automatically selected). You can specify custom page 
dimensions of 273 inches wide by 273 inches high (assuming all margins 
are set to 0), but the word processor will accommodate documents up to 15 
inches wide. 

The minimum height for printing is one inch (with 0 top and bottom 
margins), meaning you can use Works to prepare labels on inch-high label 
stock. See Chapter 12 for more information on printing with Works. 

With the exception of Custom, the five Paper options have preset 
dimensions, all of which are applicable to word processing. Clicking one 
of these options places the following dimensions into the Width and 
Height edit boxes. 

Paper 
US Letter 
us Legal 
A4Letter 
International Fanfold 
Computer Paper 

Width 

8.5 
8.5 
8.25 
8.25 

14 

Height 

11 
14 
11.66 
12 
11 

Page Margins Works calculates margins from the edges of the paper. 
Margins set the printing area for the body text (minus header and footer) 
of the document. With one-inch margins all around, the main body text of 
the document is printed no closer than one inch all around the paper. The 
printing area on 8 1/2-by 11-inch letter-size paper using standard one-inch 
margins is 6 1/2 by 9 inches. Headers and footers are placed 1/2-inch 
from the top and bottom of the paper, so they are effectively outside the 
margin area. 

Setting new margins is easy: Simply click in one of the margin editing 
boxes in the Page Setup dialog box, and enter a new number. By double
clicking within a box, you select the number, so anything you type from 
the keyboard completely erases the old entry before adding the new one. 

Print Orientation The two unmarked icons in the Page Setup dialog box 
determine the orientation of the fmished document on the page. Clicking the 
Portrait (or Tall) icon prints the document in normal fashion, lines of text par
allel to the short edge of the paper. You'd use the Landscape (Wide) orienta
tion when printing with computer paper (using a printer with a wide car
riage), or when you need to create a tum page for reports or presentations. 
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Headers and Footers Works accepts only one line of text (no graphics) for 
headers and footers. Still, the header and footer options offer extra flexibil
ity that you will want to use from time to time. 

In addition to the text of the header and footer, you may enter special 
codes to automatically print such things as page numbers, dates, and times. 
These codes are preceded by an ampersand, which tells Works to treat the 
character that follows as a formatting instruction, not as a letter to print in 
the header or footer. 

Type 

&L 
&C 
&R 
&P 
&D 
&T 
&F 
&B 
&I 
&& 

To 
Align the characters that follow at the left margin. 
Center the characters that follow. 
Align the characters that follow at the right margin. 
Print the page number. 
Print the current date. 
Print the cuaent time. 
Print the name of the document. 
Print the characters that follow in bold. 
Print the characters that follow in italics. 
Print a single ampersand character. 

Though the list shows the formatting codes as capital letters, you can use 
upper- or lowercase. Feel free to use any combination of formatting codes 
within a single header or footer, but note that some combinations (like cen
tering and right alignment) may cause Works to overprint some of the text. 

In addition to these codes, you can use the Format, Style, and Color 
commands from the Format menu to specially format the header and footer 
text. Actual format changes aren't shown in the entry boxes in the Page 
Setup dialog, but you can double-check that the formatting is acceptable to 
you by using the Print Preview feature avalable in the Print dialog box. 

GETTING THE MOST FROM THE WORKS SPELLER 

Misspellings and typographical errors are unnecessary as long as you have 
the Works spelling checker to rely on. Because the spelling checker is a 
part of Works, you don't have to quit the program and start up another 
application in order to check for spelling and typos. This means you can 
call up the spelling checker at a moment's notice and quickly check your 
document, or even parts of the document or single words. 

The Works spelling checker is not complicated, but it does have several 
features that are not intuitive, as well as a number of capabilities that aren't 
obvious. You can perform a spelling check and not use the advanced 
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speller features or capabilities, of course, but that would be wasting a great 
resource. 

About the Speller 

The speller needs a main dictionary, called MSWorksDict, to operate. This 
file contains more than 100,000 words Works uses to check for errors. 
Works assumes the MSWorksDict file is on the same disk as Works, and in 
the same folder. If this is not the case, the first time you use the speller you 
are asked to help Works locate the file. This location is stored in the 
MsWorksPref preference file (which is tucked inside the System Folder on 
your Works disk or hard disk. 

Works records the location in the preference flle when you quit the pro
gram, so if you use the speller more than once in the initial editing session, 
you '11 need to relocate the speller flle each time. 

Setting Options 

The preference file also contains the settings you choose in Options com
mand (under the Spell menu), as shown in Figure 2-17. The Options dialog 
box offers the following choices. Activate those options you desire and 
tum off those you don't want. 

Options: 

181 Must capitalize after period 

~ Proper noun capitalization 

IZI MiH numbers and letters 

181 Double word errors 

IZI Two spaces after period 

DHomonyms 

181 Treat hyphens as spaces 

( Concel ) [ OK D 

Figure 2-17 SpeUing Options Dialog Box 
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• Must capitalize after period (initially on). Works questions any 
uncapitalized word that follows a period, question mark, or exclama
tion point. 

• Proper noun capitalization (initially on). Works questions proper 
nouns, such as names and places. 

• Mix numbers and letters (initially on). Works questions words that 
have numbers in them, such as Wo5rks. 

• Double word errors (initially on). Works questions double words, such 
as the the. 

• Two spaces after period (initially on). Works questions sentences 
(period, exclamation point, question mark) that aren't followed by two 
spaces (typing standard, but not desktop publishing standard). 

• Homonyms (initially off). Indicates sound-alike and spell-alike words 
as possible errors, such as their, there, and they're. 

• Hyphens as spaces (initially on). When turned on, Works questions 
each part of the hyphenated word independently, but doesn't question 
proper hyphenation. When turned off, Works checks for proper 
hyphenation. 

Performing a Spell Check 

After selecting the spell options (which remain until you change them 
again), you are ready to check the spelling of your document. Follow these 
basic steps: 

1. Choose the Correct Spelling command from the Spell menu. Works 
will then scan the entire document. If the document is large, this 
could take some time. 

2. After scanning is complete, Works presents the frrst word it finds as 
potentially misspelled (called a "suspect" word). You have three 
choices: a) skip the word (it's spelled correctly), b) replace the word 
with the entry currently in the Replace With text box, or c) add the 
word to the Works dictionary flle. 

3. Continue the process until all words have been verified. 

Works normally offers a suggested correct spelling when it encounters a 
suspect word. The Correct Spelling dialog box is shown in Figure 2-18. 
The suggestion is automatically inserted in the Replace With text box. If 
you want to use the suggestion, simply click the Replace button. The initial 
suggestion by Works is the word closest to the spelling of the suspect word. 



Dictionary: 

time 
time-honored 
timed 
timekeeper 
timeless 
timelessly 
timelessness 
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Figure 2-18 Correct Spelling Dialog Box 

Adjacent words in the speller are shown in the Dictionary window on the 
left side of the Spelling dialog box. If you see another word in the window 
that you want, double-click on it and it will be entered into your document. 
Use the scroll bars to leaf through the dictionary: 

• The vertical scroll bar scans through the closest 100 or so words. 

• The horizontal scroll bar scans the dictionary through about 400 words 
at a time. 

Works can also make suggestions based on sound-alikes and likely mis
spellings. You can view a more extensive set of suggestions by clicking 
the View Suggestions button. Works then analyzes the suspect word and 
finds words in its dictionary that it believes are close to the one you want. 
The suggested alternatives are shown in the word list (in some cases, 
Works cannot provide a suggestion, particularly if the suspect word is 
totally unintelligible). Double-click on the one you want and it is inserted 
into the document. 

Double-clicking within the word list (when viewing either the dictionary 
or word suggestions) places the selected word in your document. But what 
if the word in the list is close, but not exactly the one you want? Simply 
click once to place the word in the Replace With text box, then make any 
changes you like. Press the Replace button to transfer the corrected word 
to the document. 
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In some cases, the word is misspelled only slightly, missing just a char
acter or two. Rather than spend time looking for a replacement in the word 
list window, click the misspelled word in the Unknown text box; this 
transfers the word to the Replace With box. Once there, you may make 
your changes. 

Of course, there will be times when the suspect word is grossly mis
spelled, and Works can't find a suitable replacement. In these cases, it is 
easiest to completely rewrite the word in the Replace With text box. 

Works double-checks the spelling of the new word you have provided in 
the Replace With text box. H the word doesn't match one Works has in its 
spelling file, the program asks if you want to add the word to the dictionary. 
This is a clue that the new word may itself be misspelled. You have two 
choices: either add the word to the dictionary, or do not. But in both cases, 
Works inserts the word in the document. 

Unfortunately, Works does not provide a means to cancel word replace
ment so that you can reenter a corrected spelling. H you notice that you 
added an incorrect word to your document, make a note of it and correct 
the misspelling after spell checking is over. 

Adding and Deleting Dictionary Words 

You can add a new word to the Works dictionary at any time. Press the 
Add button when you are presented with a word you want to add to the dic
tionary. Works inserts the word in the Ms WorksDict file for use in subse
quent spell sessions. 

Conversely, you may delete any word (including those you didn't enter) 
by selecting the word in the word list window, then clicking the Delete but
ton. The Add and Delete buttons have additional options you may want to 
use; see the section below for more information. 

Using Add and Quick Options 

The Skip, Replace, Add, and Delete buttons in the Check Spelling dialog 
box have additional options. These options are set for each word checked. 

• The All box next to the Skip button lets you choose to skip all the 
occurrences in the document of the suspect word, or just the current 
one. The Skip All option is normally on unless you tum it off. 

• The All box next to the Replace button lets you choose to replace all 
the occurrences in the document of the suspect word, or just the cur
rent one. The Replace All option is normally off unless you tum it on. 
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Adding word to Dlctlonory 

lEI! loser D Must Copltollze 
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losers 

loseres 

lose red 

loserd 

loserlng 

loserer 

loserlst 

loserly "" 
loser's 

( Add Word Now ] 

Figure 2-19 Add Dialog Box 
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loserol 

loserless 

loserness 

loserlilce 

loserment 

loseroble 

loserlble 

loserolly 

loserous 

Cancel 

• The Quick box next to the Add button lets you choose to add just the 
current word to the dictionary, or the base word and some or all of its 
possible suffixes (see Figure 2-19). The Add Quick option is normally 
on (no suffixes) unless you turn it off. 

• The Quick box next to the Delete button lets you bypass the prompt 
Works presents to ask if you really want to eradicate the word. Be sure 
that the exact word you want to delete is shown in the Replace With 
entry box, including proper capitalization. The Delete Quick option is 
normally off unless you tum it on. 

Checking a Portion of the Document 

Works will normally check the entire document, even if the insertion point 
is at the end of the file when you begin the spelling check. You can narrow 
the check by selecting text with the mouse, then choosing the Check 
Spelling command. This may be helpful if you have added or edited just a 
few paragraphs of a large document and you don't want to take the time to 
check the whole me. 

Checking One Word 

At times, you may want to check the spelling of one word that you've just 
typed. You can test the single word by double clicking on it, then 
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choosing the Check Spelling command. Works provides no response if the 
word is spelled correctly. The rotating beach ball indicator disappears and 
you can continue writing and editing. If Works can't fmd a match for the 
word in its dictionary, the Check Spelling dialog box appears, where you 
can correct the spelling, check for suggestions, and so forth. 

Keeping a Skipped Words File 
Often, a tenn on which Works stops is spelled correctly but is not in the 
MsWorksDict dictionary file. The word may be a proper noun or a special
ized tenn used in your field or profession. If the word is one you are likely 
to use again, you can add it to the Works dictionary, or store it in a skipped 
words file. 

Works remembers those words you skipped, and on leaving the program 
or closing the document, you are asked if you want to save the bypassed 
words in a skipped words document. Answer Yes and Works saves the file 
under the same name as the document you checked (therefore, the file 
should be named and saved before exiting), along with a .diet file extension. 

Skipped words files are stored as Text-only (Export) documents, which 
means you can open and edit them with Works. The data format of skipped 
words files is simple: each word is separated by a return, with no spaces or 
other special characters in any lines, as shown in Figure 2-20. 

You may even create a skipped words file from scratch, and use it during 
spell checking. Just enter the words one at a time, each on a separate line. 
If the word requires capitalization, type it that way. You may wish to gen
erate the list using the spreadsheet module, then alphabetize the list for eas
ier lookup. Once sorted, select the· words and transfer them to an empty 
word processing document. Save the document using the Export option 
(this is very important) and add a .diet file extension at the end. 

To use a skipped words file, choose the Dictionary command from the 
Spelling menu before starting a spell check. Locate the file you want to 
use and double-click on it to load it into memory. You can repeat this pro
cess to load into any of several skipped words documents. For example, if 
you know the document you are checking contains legal and technical 
terms (a patent application, for example), load both the Legal.Dict and 
Technical.Dict files. 

Should you fmd you have too many skipped words files, you can consol
idate them into one easy-to-handle document. 

1. Open one of the skipped words files. 

2. Open another skipped words file and select all of the words. 
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Figure 2-20 Sample Skipped Words File 
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3. Press Command-C to copy the words into the Clipboard. 

4. Switch to the first skipped words file and move the insertion point 
immediately after the last word in the document. 

5. Press Command-V to paste the words into the document. 

Repeat the process for each additional skipped words file you want to merge. 
Since you can readily edit skipped words files, you '11 want to maintain 

them so they don't contain any duplicates or unwanted words. This is most 
easily done by transferring the word list to a blank spreadsheet document, 
sorting the list, and looking for duplicates. When you are satisfied the list 
is in the form you want, transfer the words back to the word processing 
document and save it. 

Skipped words files are opened in a new, untitled document. Works does 
not load the original because it thinks you don't want to edit it. When re
saving a skipped words file, you must go through the extra steps of naming 
the file and clicking the Export option. 

Works uses the same basic format for skipped words files as other 
spelling checkers. Word files for special applications, such as medical, 
dental, or legal fields, are available from many sources. As long as these 
files are saved in Text-only (Export) format, and lack special formatting 
codes, Works will be able to use them as skipped words files. 
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Using the Homonym Option 

Not all writing errors are misspellings. Some are legitimate words, but 
used in the wrong context. Homonyms are words that sound the same, but 
have different spellings. Click Homonym in the Spell Options dialog box, 
and Works checks for homonyms along with other typographical errors. 

When using homonyms, Works requires the file MsWorksHymn, which 
it expects to find with the Works program. If it can't locate the f!le, you are 
asked to help find it. As with the speller file, Works records the location of 
the homonym file for future reference in the MsWorksPref file. 

The MsWorksHymn file can be edited, if desired, by following the for
mat conventions shown in Figure 2-21. Each homonym group entry is 
bounded by a set of two asterisks, and each spelling is on a single line (with 
variations, when applicable), a tab, and a short sentence showing the proper 
usage of the words. The MsWorksHymn document is a text-only file, so 
you must click the Export button in the Open dialog box to find it. 

After you've added your own homonyms, or edited the existing ones, 
save the document in Export format, with the name MsWorksHymn. 
Works creates a compiled version of the MsWorksHymn document as 
MsWorksHymn Table. After editing the MsWorksHymn text file, you 
should delete the existing MsWorksHymn Table so that Works won't use it. 
The program automatically creates a new MsWorksHymn Table using the 
updated homonym file. -

When Works spots a homonym, it displays a dialog box where you can 
review the word, and make changes if necessary, as shown in Figure 2-22. 
The controls in the homonym dialog box are self-explanatory, but note 
these shortcuts and observations: 

= Unt itled (WP) = a = 
10 I 11 I 12 I 13 I 14 I jS, I 16 I ~ 
> • l .... lj1il 
air, aired He aired the room out. 

11

1
11' error He made an er r or. 

111,1 err , erre d To err is human. :;jl' 
...... ~h! 
ant, ants The ants made an ant h Ul. ~!!i 
aun t, aunts My aunt loves me . 

1111· 
.... 
ante, a n ted He tossed in h is a n te t o play p oker. 

"'I' ''II' •I . 
a untie He t ossed his aunt ie . She objected. Iii! 
"'"' 'I J ·----·------

Figure 2-21 Format of Homonym File 
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Hltemotlue spelling for: erred 

DUair He aired the room out. 

Dl error He mode on error. 

Dl err To err Is human. 

D'--1 ____ __, 

OK 

Figure 2-22 Homonym Dialog Box 

( Stop Checking These Homonyms ) 

( Stop Checking HLL Homonyms ) 

• If the suspect word is correct, do nothing; press Return to continue. 
• To select another word in the list of homonyms displayed, click any

where on the word or in the check box. Click OK or press Return. 

• An additional control button is displayed to the left of the homonym list 
if there are more than four works. Click the button to see more words. 

• If one of the homonyms is the correct usage of the word you need, but 
lacks the proper prefiX or suffix, edit the word by clicking anywhere in 
the text entry box. 

Speller Keyboard Shortcuts 

The Works speller includes several handy keyboard shortcuts that will help 
simplify your proofreading chores. Note that these shortcuts are available 
only when the Correct Spelling dialog box is displayed: 

Jrey Sho~ut 

Command-A 
Command-C 
Command-O 
Command-G 
Command-H 
Command-O 
Command-R 
Command-S 

Same as Add button 
Same as Cancel 
Same as Delete button 
View Suggestions 
Options help screen 
Displays Spelling Options dialog box 
Same as Replace button 
Same as Skip button 
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SAVING TIME WITH BOILERPLATE TEXT 

In the old days, when steam boilers were common, manufacturers found 
that they could use the same basic metal sheets-known as boiler
plates-to construct boilers of all sizes and types. The term boilerplate 
was later used in the newspaper industry to mean any journalistic material 
in readily available form. 

In word processing, as it relates to Microsoft Works, boilerplate text is 
any collection of characters-words, phrases, common sentences, para
graphs, even whole reports-that you can easily insert into a document. 
You can save generic text, such as your name and address, and call it up as 
needed. 

Works lacks a convenient glossary feature in which you can store pieces 
of text for instant recall into a document. But you can approximate the 
function of glossaries by storing common text in separate documents, and 
either accessing the text manually, or using the Works macro feature to 
automate the process. 

Inserting boilerplate characters from some common "text storage tank" 
involves the following steps: 

1. Switch to the boilerplate document. 

2. Find the text you want. 

3. Select it. 

4. Switch back to the document you were writing. 

5. Paste the captured text into the document. 

The same general techniques can be invoked for commonly used graph
ics that you store as boilerplate picture elements. For example, suppose 
you have the job of preparing a four-page newsletter each month. The 
newsletter uses the same basic format from month to month, and you fmd 
you reuse a number of the graphic elements, such as logo, rules, table of 
contents box (with drop-shadow), and more. Rather than generate these 
each time you prepare a new newsletter, you store them in a common boil
erplate graphics document. Retrieving them is a simple matter of copying 
and pasting. 
Boilerplate text can be held in a word processing document, in a spread
sheet document, or in a database document. Each method has its distinct 
advantages. Only the amount of available RAM in your computer 
limits the amount of text you can enter into a word processing document. 
You can store individual words, lines, or paragraphs, and access as much of 
the text at one time as you like. If desired, you can also include character 
and paragraph formatting with the boilerplate text. The formatting is 
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included with the text when pasted into the destination document. 
Spreadsheet cells can contain no more than 238 characters, so that limits 

boilerplate text to about 37 words per cell. Database fields can contain no 
more than 250 characters, which equals about 40 words. However, each 
cell or field may contain one complete paragraph, and all the text for the 
paragraph appears on just one line. Finding and selecting the paragraph 
you want is somewhat easier than the steps involved in fmding and select
ing paragraphs in the word processor. 

Word Processor Boilerplate Storage 

While you can have any number of documents designated as boilerplate 
files, let's assume that you are using just one. Using default formatting 
(single-spacing, standard margins, etc.), type the boilerplate text as single 
words, lines, sentences, or complete paragraphs (see Figure 2-23). 
Separate each entry with an empty space (two returns). Save the document 
with a descriptive name, such as Text.Boil (the .Boil extension identifies 
the file for what it is). If you don't want to risk accidentally altering this 
file, save it as stationery. 

I look forward to your reply. 

Please reply at your earliest convenience. 

Won't you please reply as soon as possible? 

I thank you for your prompt and courteous attention. 

We thank you for your prompt and courteous attention. 

Thank you, in advanced, tor your prompt and courteous attention. 
It is much appreciated. 

Figure 2-23 Boilerplate WP Example 
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To use the boilerplate file: 

1. Open it and locate the text you want (or switch to it if it's already 
open). 

2. Use the selection techniques described earlier in this chapter for high
lighting single words, lines, and paragraphs. 

3. Press Command-C to copy the selection into the Clipboard. 

4. Switch to the destination document, make sure the insertion point is 
located as the spot you want to paste the text. 

5. Press Command-V to paste the text into the document. 

Since each entry ends with a paragraph mark, you must be careful about 
copying the invisible paragraph mark with the rest of the text. If you cap
ture the paragraph mark at the end of the selection, it will be pasted with 
the rest of the text and the insertion point will appear on the next line. This 
is not desired when pasting single words, sentences, or lines (but is when 
you want to include a complete, stand-alone paragraph). There are two 
ways to overcome the paragraph mark: 

• Copy the entire entry as a paragraph (double-click in the Selection 
Bar), and paste the text as is. After pasting, press the Delete key to 
backspace over the paragraph mark. 

• Select just the text you want, and exclude the paragraph mark. This is 
easiest with single words-simply double-click on the words. With 
phrases, sentences, and lines with two or more words, you must use the 
mouse to drag over the desired text. Alternatively, use the Shift-click 
method of defming selected text. 

Spreadsheet Boilerplate Storage 

Each spreadsheet cell contains one entry, whether it be a single word, a 
phrase, a line, or a paragraph (remember the 238 character limitation). 
While you could use separate columns to store entries, a better approach is 
to use just one column, like column A. 

Expand the width of the column so you can see as much of the entries as 
possible, as illustrated in Figure 2-24. The maximum width of any spread
sheet column is 40 characters, so you won't be able to see all of the entry. 
Save the document with an identifying name (as stationery, if desired). 

To use the boilerplate file: 

1. Open it and locate the text you want (or switch to it if it's already 
open). 
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·- - _ - - Untitled 
B C 

Figure 2-24 Boilerplate SS Example 

2. Click on the cell to select it. 

3. Press Command-C to copy the cell into the Clipboard. 

4. Switch to the destination document, make sure the insertion point is 
located as the spot you want to paste the text. 

5. Press Command-V to paste the text into the document. 

There is no way to avoid including the paragraph mark with imported 
spreadsheet data. Use the Delete key to remove the mark should you not 
want it. 

Database Boilerplate Storage 
Database boilerplate storage functions almost identically to the spreadsheet 
method, especially if you view the database as a List rather than a Form 
(choose View List or View Form from the Format menu). The boilerplate 
database contains one field for text entries. Expand the width of the col
umn as much as possible. When typing entries, remember the 250 charac
ter limit. 

When using the database boilerplate storage system manually, it's best 
that you view the text entries as a list. 

MERGE TECHNIQUES 

Print merging is the process of combining a form letter word processing 
document with the data in a database document. Each record of the 
database creates a separate personalized letter. One letter may be addressed 
to Joe Smith, and include various information about Mr. Smith that you 
included in his record in a database file. Another letter may be addressed 
to Jane Brown, and so forth. 

Print merging need not be limited only to creating personalized form let-
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ters. You can use print merging to produce several versions of any kind of 
document. For example, suppose you need to produce a dozen instruction 
manuals for a product you manufacture for retailers. Although each instruc
tion manual includes the same information, you have to change the retailer 
name in each one. The process is simple: write one instruction manual 
where the retailer name is a placeholder, or variable, and create a database 
that includes, as separate records, the name and particulars of each retailer. 
When merged, Works creates separate printed instruction manuals for every 
retailer in your database. 

Print merging (also called mail merging) is child's play with Microsoft 
Works. Unlike many word processors, Works greatly simplifies and auto
mates the print merging process. Here are some details on print merging 
you will want to consider. 

Setting up for Print Merge 

Before you can actually merge a word processor document and database 
records, you must create a merge template. This merge template is a word 
processing document that contains the basic text that will be repeated in 
each document, as well as placeholders that indicate where variable data 
from the database is to be entered. 

To enter placeholders, open the database document that contains the 
records you want to use. Then open a new word processing document 
and write the basic text (or open an existing document if the text 
already exists). 

With the database document open and available, and with the word pro
cessing document active, choose the Prepare To Merge command from the 
Edit menu. A dialog box appears that allows you to select the merge 
database (this shows all of the actively open and named database docu
ments), and merge fields for the selected database. 

To enter placeholders, merely click on the merge field you want, and 
press the Merge button. The placeholder is entered at the current insertion 
point position in the word processing document. 

Initially, Works enters the contents of the frrst record of the selected 
field. You'll probably want to view the placeholder as a field name, so 
choose the Show Field Names command from the Edit menu. 

Note that you cannot edit the text in placeholders, whether the text shows 
a field name or actual field contents. Database placeholders are treated as 
complete units, and when you select even one character in the placeholder, 
the entire placeholder is highlighted. You can use this to your advantage to 
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copy and paste the placeholder to other parts of the document, delete place
holders you don't need, and so forth. 

The font, size, and style of placeholder text can be changed just like any 
other text. If you want to see how the merged text will look with the sur
rounding word processor text, choose the Show Field Data command in the 
Edit menu to display the actual text from the database records. 

When selecting merge fields from the Prepare To Merge dialog box, you 
needn't use all the fields, nor do you need to use them in any specific order. 
You can also use merge fields as many times as you like in the same docu
ment. Of course, the same database fields can be used in many separate 
word processing merge documents. 

Performing a Print Merge 

With the basic text and placeholders set in the word processing document, 
you now have a print merge template ready for printing. Choose the Print 
Merge command from the File menu, make the desired changes in the Print 
dialog box, and printing will commence. As with printing of regular word 
processing files, you can preview the merged document by clicking the 
Preview button inside the Print dialog box. 

Missing Database Files and Records 

You may have occasion to reprint a word processing merge document, 
using the same database document and placeholders you entered in a previ
ous session. Before reprinting, be sure the database document is on the 
desktop, or Works will not be able to fmd the data. When printing, Works 
extracts the data directly from the selected database file and enters the 
information at the appropriate ptaces in the word processing document. If 
you have since edited the database document-you've added some records, 
for example-these new records will now print. 

While there's nothing wrong with adding new field columns to database 
files used in merge printing (they are ignored along with any other fields 
you didn't use in the document), you should avoid deleting field columns 
that you have used as placeholders. 

Obviously, Works cannot enter non-existing text into a placeholder that 
no longer corresponds to a working database field column, so if a necessary 
field has been selected, Works displays a warning box and cancels merge 
printing. When viewing the word processing template fJ.le, Works displays 
a "Field Not in DB" error in the appropriate placeholder. 
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Selecting Database Records 

You can choose only certain records to merge by first setting up a selection 
criteria in the database. See Chapter 6, "Keeping Tabs on Data," for more 
information on database selection criteria. With only some records select
ed-for example, only those records with the STATE field equal to 
California-Works will only print the records that match your criteria. This 
is an excellent way, for instance, to prepare form letters for customers who 
live in certain parts of the country, or have a balance due on their charge 
accounts, or meet any other criteria you have chosen. 

Multiple Labels 

Ordinarily, Works starts a new page for each record it merges in from the 
database-helpful when preparing form letters for individual customers. 
Multiple Labels is an optional command (found in the Edit menu) that 
allows you to turn off the new page function every time Works starts a new 
record. While the main use of this feature is to prepare mailing labels on 
continuous form stock, you can also use it to prepare customer lists, cata
logs, and formatted database reports. Works lacks a means to format reports 
in anything but simple rows and columns; you can position placeholders 
anywhere on the page and use the Multiple Labels command to design just 
about any type of unique form you desire. 
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Drawing with Works 

Although Microsoft Works is neither a graphics nor a desktop publishing pro
gram, its built-in drawing features allow you to use it as both. With just a few 
simple sketching tools and commands, you can transform lines, squares, and 
shapes into a myriad assortment of professional-looking, top-quality docu
ments. With Works and its Draw "sub-module," you can create: 

• Forms 

• Newsletters 

• Signs and labels 

• Stationery (including logos, letterheads, business cards, envelopes, and 
personalized note pads) 

• Reports 

• Booklets 

• Electronic circuit board layouts and schematics 

• Architectural drawings (including renderings, elevations, and floor plans) 

• Product sketches and patent drawings 

In addition, you can use Works' Draw tools to enhance and embellish charts 
created with the spreadsheet chart tools feature. This technique is discussed in 
detail in Chapter 5, "Charting Your Course with Works." 

By itself, Works Draw is capable of little more than drawing lines, circles, 
and squares on the Macintosh screen. Your creativity and skill transform these 
simple objects into pictures and images, whether they be a page of your in
house company newsletter, a report for the boss, or a schematic for the latest 
electronic marvel. 

75 



76 Inside MS Works 2 for the Macintosh 

The creative part of designing graphics with Works Draw is up to you. 
You have to provide the brain power. The skill part you can develop with 
the help of this chapter, and others throughout this book. In this chapter, 
you '11 learn what the Draw feature is, how to use it, and the secrets of its 
various tools. 

DRAW BASICS 

Works' drawing feature is a "sub-module" of the word processor and 
spreadsheet. Draw is available only when using either the word processor 
or spreadsheet. Pictures created with Draw are pasted over the text of a 
word processor or spreadsheet document in a special drawing layer. 

Draw works with objects. An object can be a line, circle, square, or 
other shape. It can even be a line or two of text. You create a complete 
picture by combining these objects into something meaningful, as shown in 
Figure 3-1. You edit the picture by changing the shape of the objects, by 
moving them around, or by removing them altogether. 

The advantages of an object-oriented program like Works Draw is the 
ease of editing and changing. Once the shapes are on the Draw electronic 
vellum, they can be manipulated as if they were made of rubber. You can 
even individually edit objects that are partially covered by other objects. 

While the dots in a MacPaint picture are all scrambled together on the 
same plane, each of Draw's objects occupies a plane of its own. This con
cept is called stacking, and it allows you to precisely position and overlap 
any object in the drawing window. Objects are placed on the top of the 
stack as they are created. 

I 

/ 

0 
'1l 

I 
Figure 3-1 Assembling Objects to Make Complete Pictures 
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Drawing ped 

Top V1ew Side View 
Figure 3-2 Concept of Stacking 

The fmal view of the Draw graphic is two-dimensional, of course, but if 
you were to turn the picture on its side, you'd see objects stacked on top of 
one another. An example is shown in Figure 3-2. As you will see later in 
this chapter, Draw allows you to control the stacking order of the objects. 

Activating Draw 

To activate Draw, choose the Draw On command in the Edit menu (or press 
Command-J). Remember: this command is available only when working 
in the word processing and spreadsheet modules; the command is dimmed 
in the menu when working with other Works modules. To deactivate Draw, 
choose the Draw Off command. 

Works lets you draw only on the portion of the word processing docu
ment that has text written on it. The exception to this is the first window of 
a new WP document. You may draw pictures anywhere in this window, up 
to the width of the current margin settings. 

If you'd like to draw on more of the page, but don' t want to write any 
text, press the Return key the desired number of times to create blank 
lines. Assuming single spacing, Boston 10 point font, and one inch top and 
bottom margins, you need to press the Return key 45 times to create a 
complete page of blank lines. 

DRAW TOOLS 

Works Draw has a relatively small collection of drawing tools, located in a 
movable Tool Palette, normally placed on the left side of the drawing win
dow. If the palette, shown in Figure 3-3, gets in the way of your drawing, 
drag it to a new place with the mouse. 
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Tools 
Selection Arrow Rectangle 

Text Round Reta ngl e 

Angle Line oval 

Free-form Polygon 

Ruler Line """) Arc 

Fill Pattern Indicator Line/Border Pen Indicator 

Positioning Cursr 

... 
! Ill Line Widh i 
~ 
• 
~- Plain/Arrow Line __., 

Figure 3-3 Tool Palette, with Callouts 

The drawing tools are selected by clicking on their icon. When selected, 
tools appear with a gray background. The pointer takes the shape of a 
small cross when using all but the text and Selection Arrow tools. And as 
shown in Figure 3-4, the pointer appears as the standard arrow when using 
the Selection Arrow; a large I-beam when using the Text tool. 

After you have used a tool, the object you've created is automatically 
selected, and handles-small black squares-appear around it. The object 
remains selected until you click in another part of the document or choose 
another tool to use (a small "bug" in Works 2.0 sometimes prevents the 

~ Selects objects 

+ Draws objects 

I Sets text insertion 
Figure 3·4 Shapes of Pointers and What They Do 
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handles from disappearing completely; you can make them vanish by click
ing once or twice in the vertical scroll bar). Once the object has been creat
ed, Draw reverts to the Selection Arrow. 

If you want to continue using the same tool to make additional objects, 
hold down the Command key while using the tool. As long as you hold 
down the Command while making shapes, the same tool will remain 
active. 

a 
Selection Arrow 

The Selection Arrow tool lets you point and click on Draw objects to select 
them. Selected objects appear surrounded by handles. Once an object has 
been selected, it can be deleted, moved, or edited. To select most objects, 
click anywhere within them. For lines or arcs, click directly on the line. 
For objects filled with the transparent pattern, click on a border (see Figure 
3-5 for examples). To deselect an object, click anywhere on a blank por
tion of the drawing window, or select another tool. 

Selecting Several Objects Selecting more than one object lets you work 
with them together. It also lets you take advantage of Draw's more 
advanced features, like grouping. There are several ways to select more 
than one object: 

1. Hold down the Shift key while clicking each object. To dismiss a 
selected object, Shift-click on it again. 

2. Use the Selection Arrow to enclose the group of objects you choose 
with a selection rectangle, as shown in Figure 3-6. Start from one 
comer of the group, and drag to the opposite comer. Keep in mind 
that you must drag completely around the boundaries of each object 
that you select. If you wish, Shift-click on any object to deselect it. 
You can also use this method to select stubborn objects (like oddly 
shaped objects with thin borders). 

Moving Objects To move objects to other parts of the drawing, place the 
selection arrow within the object and drag (by the border on unfilled 
objects). When moving objects, don't drag by a handle, or you'll change 
the object's shape. 
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Figure 3-S Where to Click to Select 

------------------------------------------------------------------------------~ 

Figure 3·6 Selecting Around Objects for Grouping 

Reshaping Objects Drag a handle to reshape an object. Lines and arcs 
have two handles (one at each end); as shown in Figure 3-7, all other 
objects have four or more handles. When reshaping an angled line, you can 
change its length or angle. You cannot change the angle of a horizontal or 
vertical line made with the Ruler Line tool. 

Arcs, polygons, and freeform objects can be totally reshaped by dragging 
at their handles. 

Deleting Objects There are two ways to delete an object: 

• Select it and press the Delete key. 

• Select it and choose the Clear command in the Edit menu. 

You can delete several objects at once by selecting all of them, then 
pressing Delete or choosing the Clear command. 

Figure 3·7 Handles and Assorted Objects 

• • • .sample t:wxt block • 
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Use the Text tool to add or edit text. The text can be any: 

• Font that's currently installed on the Works disk. 

• Size from 4 to 72 points. 

• Of six font styles. 

• Of eight foreground or background colors. 

Text can also be right justified, left justified, or centered, but can only be 
single-spaced. 

To write text, simply click the Text tool and click the 1-beam pointer any
where in the window. A three-inch-wide, one-line box appears on the 
screen (see Figure 3-8), with an insertion point blinking at the left edge. 
Text writing and editing is similar to the Works word processing module; 
words that are too long to fit a line are wrapped to the next. Pressing the 
Return or Enter keys moves the insertion point to the next line. When 
you are fmished writing, select another tool or click anywhere outside the 
text box. 

Figure 3-8 Writing Text in Text Box 
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Works initially provides a three-inch-wide text box, but you can make it 
any width you like. There are two ways to change the width of a text box: 

• Select the Text tool, click on a starting point for the box in the docu
ment window, and drag to the opposite corner until the box is the 
desired dimension. The length of the box is really unimportant, as 
Works will adjust it after you finish writing. 

• After writing, choose the Selection Arrow and click anywhere on the 
text. Handles will appear that denote the boundaries of the text box. 
Lengthen or shorten the width by pulling at the center right handle. 

Works also has a hidden text feature called column text, used to create 
multiple-column documents such as newsletters and menus. See the sec
tion "Working with Column Text" later in this chapter. 

Editing Text Editing text in Draw is simple and straightforward. 

• To add characters to a text block, click where you want the characters 
inserted with the Text tool !-beam pointer. Start typing. 

• To delete characters, set an insertion point and press the Delete key, 
or drag the !-beam pointer across the text to be deleted, then press the 
Delete key. 

• To cut and paste text, select the text block by clicking it with the 
Selection Arrow, or select the portion you want by dragging over it 
with the !-beam pointer. Use the Cut or Copy commands from the Edit 
menu as usual. To paste text back into the document, set an insertion 
point with the !-beam or Selection Arrow pointer, then choose the 
Paste command. 

• To change the font, size, style, or color, select the text and choose the 
appropriate command from the Fonnat menu. If the entire text object 
is selected, the format change affects all of the characters. 

Text grouped to other objects (with the Group Picture command in the 
Format menu) must be ungrouped before it can be edited. 

Changing the Background Pattern of Text Objects Works Draw treats 
text blocks as objects, so you can fill the blocks with any pattern. Text 
appears on top of that pattern, as shown in Figure 3-9. When you write 
text, Draw automatically chooses the transparent pattern as the background. 
To change the fill pattern, select the text block and choose another pattern 
from the Fill Pattern menu. 
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0 utli ne text, 
grey background 

Shedo\o/ text, Bold text, Outline text, 
hashed background dotted background light grey background 

Figure 3-9 Sample Background Patterns Under Text 

Lines I"-I 
The Ruler and Angle Line tools both make lines, and they work in much 
the same way, except for one major difference: The Angle Line tool draws 
lines at any angle; the Ruler Line tool draws lines horizontally or vertically 
only. Constraining the Angle Line tool provides the same results as using 
the Ruler Line tool (see "Constraining Shapes," below, for more informa
tion on constraining Draw objects). With both tools, the width of the lines 
can be changed at any time. 

To draw with either tool, click it, then position the shape at the start of 
the line. Drag to the end of the line and release the mouse. With the Ruler 
Line, the direction of the line (vertical or horizontal) is determined by the 
first movements of the pointer. 

Resizing a Line The length and angle of lines can be altered. Change the 
length or angle of the line by selecting it, then pulling on a handle. The 
line will be anchored at the other end. You can't change the angle of a line 
made with the Ruler Line tool. 
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Figure 3-10 Lines with Arrows 

Making Arrows with Lines Besides offering different line widths, the line 
selection options in the Tools Rack lets you tum lines into arrows. You can 
put arrowheads on either or both ends of the line by clicking one of the line 
options at the pattern of the tool palette. The size of the arrowhead depends 
on the width of the line. Figure 3-10 shows some examples. 

Rectangles and Ovals 

The rectangle and oval tools can make boxes and circles of all sizes and 
shapes. One of the rectangle tools is for creating boxes with square cor
ners; the other makes rounded comer boxes (see Figure 3-11). 

To make a rectangle or oval, click the tool you want, position the pointer 
where the object is to start, then drag the mouse. 

Resizing a Rectangle or Oval The size and shape of rectangles and ovals 
can be altered once they are made. To reshape or resize the object, select it 
by clicking it (click the border of the object if it is not filled with a visible 
pattern). Drag one of the eight handles that appear. The object is anchored 
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Figure 3-11 Square and Round Rectangle 

at the handle opposite the one you're pulling. The object is extended or 
retracted from this anchor point. 

Free-form and Polygon Tools 

The Free-form tool makes closed or open objects of your own design. The 
Polygon tool makes multi-sided shapes. Using the choices in the Line 
Pattern menu and line/border width options in the Tool Palette you can vary 
the border thickness and border pattern of free-forms and polygons. 
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PolygoN 
Figure 3-12 Samples of Free-forms and Polygons 

Patterns can be used to fill the contents of the drawn shapes, as selected 
with the Fill Pattern menu. 

Free-form To make a free-fonn shape, click the Free-form tool, position 
the pointer where the object is to start, then drag the mouse around the 
drawing window to construct the object. The shape is completed when you 
release the mouse button. 

Polygon To make a polygon, click the Polygon tool and position the pointer 
where the object will start, then click and drag the mouse. A line will 
extend from the start point. To start a new line, click the mouse button 
again. Draw finishes the polygon when you return to the start of the shape, 
double-click the mouse button, or click twice on the same spot Figure 3-12 
shows examples of a polygon and free-fonn in progress. 

Although you do not need to close polygons or free-fonns, you will want 
to if the object is filled with a pattern. 

Resizing and Reshaping a Free-form or Polygon To change the shape of 
a free-form or polygon, select the object, then drag one of the handles that 
appear. The object is reshaped at the point of the handle only. 

To resize a free-form or polygon, frrst choose the Group Picture com
mand from the Format menu, then drag one of the eight handles that appear 
around the boundaries of the object. The object is anchored at the handle 
roughly opposite the one you're pulling, as shown in Figure 3-13. You 
grow or sluink the object from this anchor point. 

If you'd like to reshape a grouped free-form or polygon, you must first 
choose the Ungroup Picture command from the Format menu. 
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Figur~ 3-13 Differences Between Reshaping and Resizing Polygons 

Arc Tool 

The Arc tool creates quarter-circles of any size or angle. To make an arc, 
click the Arc tool and place the pointer where the object is to start. Drag 
the mouse until the arc is the right size and shape. The direction of the 
curve of the arc is determined by the direction you ftrst move the mouse. 

Extending or Retracting the Arc Arcs made with the arc tool comprise a 
quarter of a circle, or 90 degrees. You can e~tend or contract the arc, from 
0 degrees to a full 360 degrees-by selecting the arc, then tugging on one 
of the handles that appear on either end. You can drag either handle to 
extend or contract the arc (see Figure 3-14). Use this feature to make any 
angle of arc you wish, up to a complete circle. 

Resizing the Arc The size and shape of arcs can be altered once they are 
made. To resize an arc, choose the Group Picture command from the 
Format menu, and drag one of the handles that appear. The object is 
anchored at the handle opposite the one you're pulling. You grow or shrink 
the object from this anchor point. 

If you'd like to reshape a grouped arc, first choose the Ungroup Picture 
command from the Format menu. 

Pattern Settings 

The current pattern settings fill the inside and border of objects, and are 
shown with the Fill and Line indicators in the middle of the Tool Palette. 
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Figure 3-14 Extending Arc with Handle 

Patterns indicated for Fill or Line are the ones that will be used for the next 
object you create. The circle-and-slash represents transparent (no) pattern. 

Positioning Pad 

The positioning pad in the Tool Palette helps you precisely place one or 
more selected objects in the drawing window. Each click of one of the 
arrows moves the object one pixel (one screen dot) in the direction indicat
ed. There are 72 pixels to the inch, so by pressing one of the arrows 72 
times, you move the object precisely one inch. (The cursor keys on the key
board have the same effect.) 

Setting Line and Border Widths 

The width settings in the Tool Palette set the thickness of lines and object 
borders. You can select four border and line widths, corresponding to one, 
two, three, and four pixels wide, as well as invisible (no line or border). 
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To change the thickness of a line or border, select the drawing tool to 
use, then choose a new width from the Tool Palette. The dotted line makes 
the line or border invisible. The currently selected line width is marked. 
The preset line width is used for all new objects you create, until you 
change it to a new line width. 

To change the thickness of lines and borders of objects you've already 
made, select the object, then choose a new line width. When done this 
way, the preset line width does not change. 

Line and Arrow Settings 

Draw makes either plain lines or lines with arrowheads. Click the plain 
line at the bottom of the Tool Palette to make just lines; click the arrowhead 
line to make lines with· an arrow on one end. The arrow appears on the 
opposite end of the line where you started drawing; that is, if you draw the 
line from left to right, the arrow is placed on the right end. 

To add arrowheads after a line is made, select the line, then click on the 
arrow line. The arrow is always placed on the right end. H you want the 
arrow on the other end, drag one end of the line around 180 degrees, as 
shown in Figure 3-15. Adjust the line until it is the proper angle and length. 

DRAW MENUS 

The following menus and commands are available when Draw is turned on: 

Format Menu 

The Format menu contains all of the Draw power controls. Within this 
menu are commands for selecting different fonts, font sizes, styles, and col
ors, grouping or ungrouping objects, alignment, controlling the invisible 
Works grid, and more. 

Justification The alignment commands let you control how Draw positions 
the characters within the text block. You have four choices: left, centered, 
right, and justified. 

Font The Font Pop-up menu lets you change the font of text. Previously 
written text can also be changed by frrst selecting it, then choosing the 
commands in the menu. 
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·~ 
Swing line around 
to bring arrow tip 
to other side 
Figure 3-15 Stretching Around Line to Bring A"ow to Other Side 

The number and variety of fonts shown in the menu may vary, depending 
on the fonts you have installed on the Works disk. You can add or delete 
fonts using the Apple Font D/ A Mover utility. 

Size Text can be written in any size from 4 to 72 points. The Mac follows 
standard typesetting convention where 72 points equals one inch. The 
point size takes into consideration the blank area between lines (called 
leading). There, actual character of a font is slightly smaller than the speci
fied point size. See Figure 3-16 for details. 

Style Select one or more items from the Style Pop-up menu to change the 
appearance of any font. Styles can be mixed or you can cancel all styles by 
choosing Plain. Or, to cancel a single style, choose it again. 

Color-White Dots The Color-White Dots command selects the color for 
the white (oft) dots on the screen, as depicted in Figure 3-17. You have 
eight colors, including black and white, to choose from. 

Ascent 11 ne \ ----------
Base 1i ne ""'- ____ F._o~n ...... t __ _ 

J Leading 
Baseline- __ A_n_a--to_m_y_ ] 

/ 
Point size 

Descent line 
Figure 3-16 Font Anatomy 

.__Color-On Dot 

~Color-Off Dot 

Figure 3-17 Explanation of Off/On Pixels and Colors 
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Color-Black Dots The Color-Black Dots command selects the color for the 
black (on) dots on the screen. You have eight colors, including black and 
white, to choose from. 

Group Picture The Group Picture command ties several objects together, 
so that you can handle them as one object. Select the objects to group by 
holding Shift while clicking on object borders, then give the command. 
When grouped, you work with the selection the same way you work with 
individual objects-grouped objects can be moved, resized, deleted, 
copied, and so forth. 

Note: Some operations, like polygon or arc reshaping and text editing, 
can't be done when objects are grouped. You must ungroup them first with 
the Ungroup Picture command (see below). You can also ''nest-group" 
objects by combining two or more grouped selections. 

Ungroup Picture The Ungroup Picture command unties objects grouped 
together with the Arrange-Group command. If you've nest-grouped sever
al grouped selections, ungrouping undoes the fl!St tier of grouped objects 
only. Continue ungrouping to untie all of the tiers. 

Grid Settings The Works grid is used to places all objects along common 
lines of an invisible network of evenly spaced horizontal and vertical lines. 
Draw offers a number of sizing increments for its internal, invisible grid 
To choose a different grid size, choose this command, then click one of the 
size options in the dialog box (see Figure 3-18). 

Grid Setting 

0 112 inch 0 1191nch 0 1 centimeter 

0 113 inch 0 1112 inch 0 1 12 centimeter 

0 114 inch 0 1118 inch 0 1 I 4 centimeter 

0 116 inch 01/24 inch 0 1 17 centimeter 

® 118 inch 0 1136 inch 0 1 I 14 centimeter 

(( OK JJ (Cancel ) 

Figure 3-18 Grid Settings Dialog Box 
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You may prefer using the points and pica system when producing desk
top publishing documents. Use the table that follows as a handy reference 
guide for converting fractional inches to points and picas. 

Grid Setting 
1/2 inch 
l/3 inch 
1/4 inch 
l/6 inch 
1/8 inch 
l/9 inch 
1/12 inch 
l/18 inch 
1/24 inch 
l/36 inch 

Points 
36 
24 
18 
12 
9 
8 
6 
4 
3 
2 

Picas 
5 
3.33 
2.5 
1.67 
1.25 
1.11 
0.83 
0.56 
0.42 
0.28 

The centimeter option offers some useful "in-between" grid sizes. The 
following values are approximate. 

Centimeter 
Setting 

lcm 
1/2cm 
l/4cm 
1ncm 
1/14 em 

Inches 

3/8 
3/16 
3/32 
1/17 
l/35 

Equivalent in 
Points 

27 
14 
7 
4 
2 

Picas 

3.75 
1.88 
0.93 
0.54 
0.27 

Grid On/Oft' When Draw is frrst turned on, the grid is off. It can be turned 
on by choosing the Tum Grid On command. 

Objects you make, move, or resize with the grid off will likely not line 
up with the grid, and they may not be aligned to one another when you tum 
the grid back on. Use the positioning pad in the Tool Palette or cursor keys 
to manually "nudge" objects into alignment. 

Bring to Front The Bring to Front command is used to change the stacking 
order of objects. It brings an object from any place in the stack to the very 
top. To use, select the object you want, then give the command. Grouped 
objects are handled similarly. All the objects in the group are brought to 
the front as a whole. The order of the objects in the group is retained. 

You can also restack two or more ungrouped objects at a time. Shift
click all the objects you want, then give the command. The objects retain 
their respective order. 
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Send To Back The Send To Back command is used to change the stacking 
order of an object It brings an object from any place in the stack to the 
very bottom. To use, select the object you want, then give the command. 
Grouped objects are handled similarly. All the objects in the group are sent 
to the back as a whole. Their order is retained. 

You can also restack two or more ungrouped objects at a time. Shift
click all the objects you want, then give the command. 

Show Column Boxes Column boxes are normally shown around column 
text (see the section "Working with Column Text," below, for more infor
mation on column text). The column boxes are dotted outlines that show 
the boundaries of the text, as illustrated in Figure 3-19. The boxes do not 
print or show up in Print Preview. 

• 
II II ... 
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Figure 3-19 Column Boxes 
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Spread Text The Spread Text command places text along the path of lines 
and arcs. To create spread text: 

1. Write a line of text in the font, size, style, and color you want to use. 

2. Select the text with the mouse and copy it into the Clipboard. 

3. Create a line or arc (if you haven't done so already) in the desired 
size and shape. 

4. Select the line or arc object, and choose the Spread Text command 
from the Format menu. 

The text appears over the object, stretched from one end-point to the 
other, as shown in Figure 3-20. Each character of the pasted text is an indi
vidual text object, and can be moved and formatted independently. 

With all characters selected, dragging by any handle serves to shrink or 
stretch the text along the path, as shown in Figure 3-21 (the size of the 
characters is not affected). You can use this method to compress or expand 
the spacing of characters along the line or arc. 

To delete the underlying arc or line you can do one of two things: 

• With all the characters still selected, group the text (with the Group 
Picture command) and drag it away from the arc or line. Manually 
delete the arc or line. 

• Select the arc or line, then choose the white pattern from the Line 
Pattern menu before choosing the Spread Text command. That makes 
the object invisible, as long as the background is white. 

Fill and Line Pattern Menus 

The patterns in the Fill Pattern menu are used to fill the inside of objects; 
the patterns in the Line Pattern menu are used to change the texture of lines 
and borders. Both pattern menus work with all objects except text. You 
have 39 fill patterns to choose from, including transparent (no pattern, 
marked as a circle-and-slash). 

When Draw is frrst turned on, it automatically selects the transparent fill 
pattern and a black line pattern. These current pattern settings are shown 
in the pattern boxes within the Tool Palette. You can change the fill or line 
pattern of objects before or after you make them. 

Changing Fill or Line Patterns Before an Object Is Made 

To use a new fill or line pattern before an object is made, choose one from 



Figure 3-20 Spread Text on Arc 
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the Fill or Line Pattern menus. Choosing a new pattern without an object 
selected will change the current pattern selection for all subsequent objects. 
New patterns are shown in the pattern boxes in the Tool Palette. 

SFREAD TEXT 

SPREAD TEXT 

SPREAD TEXT 

8 P R E A D T E X T 

8 P R E A D T E X T 

Figure 3-21 Expanding Spread Text 
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Changing Fill or Line Patterns After an Object Is Made 

To pick a new pattern for an existing object only (the current pattern setting 
is not changed), click on it, then make a selection from the Fill Pattern or 
Line Pattern menus. When filling an open free-form or polygon, Draw will 
close the object with the pattern, taking the shortest path between the end
points. Unusual effects can be created this way. 

PASTING OBJECTS 

The Paste command retrieves objects placed into the Clipboard. You can 
control the placing of the pasted selection by: 

• Clicking on the drawing pad. The pasted object will appear there (if 
no spot on the drawing has been clicked, Draw puts the selection in the 
center of the window). 

• Selecting an object. The pasted selection will be placed slightly down 
and to the right of the object. 

If more than one object is pasted, the objects will retain the same stack
ing order they had when they were originally cut or copied. Objects pasted 
from the Clipboard appear over the original object, but under any other 
objects that were on top of the original. Refer to Figure 3-22 for a visual 
representation of this. 

Before 

Objects to paste Objects to paste between 

After 

Figure 3-22 Pasting Under from Clipboard 
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IMPORTANT ASPECTS OF DRAW 

Keeps these points in mind when using Works Draw. 

Borders and Bounds 

Draw objects have two kinds of boundaries: visual and physical. The visu
al boundaries are the borders of the object. The physical boundaries are the 
ones Draw uses to maintain the shape and parameters of an object, and 
these boundaries, or "bounds," are used for many of its operations, such as 
aligning objects to its invisible grid. The handles that appear around a 
selected object show the actual bounds of that object. An object's borders 
and its bounds may not coincide with one another. Some bounds of objects 
extend with wider borders. Two rectangles may be the same size, but if 
they have different border widths, one appears larger than the other, even 
though the bounds of the two shapes are exactly the same (see Figure 3-
23). These shapes will not align as expected when using Draw's internal 
grid. The bounds of an object always go through the border of the object, 
even if the border is invisible. 

Constraining Shapes 

Most of Draw's tools can be constrained, that is, limited to making only 
certain types of shapes. To constrain a tool, hold down the Shift key while 
dragging the mouse. The effects of constraining vary with each tool, as 
noted below. When using the Angle Line, Polygon, or Arc tool, the direc
tion of constraining (horizontally, vertically, or diagonally), is determined 
by the first movement of the pointer. Depress the Shift key only after you 
have pressed the mouse button, and are about to create the object. 

Tool 

angle line 
rectangle 
round-rect 
oval 
arc 
free-fonn 
polygon 

Constrained Effect 

Draws lines at 0, 45, or 90 degrees only. 
Draws squares. 
Draws rounded-comer squares. 
Draws circles. 
Draws quarter circles. 
Draws straight lines at 0, 45, or 90 degrees only. 
Draws lines at 0, 45, or 90 degrees only. 
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Figure 3-23 Bounds with Thin and Thick Borders 

Hidden Keyboard Features 

Works Draw behaves differently when you press certain keys on the key
board while doing an action with the mouse. 

For example: 

• If you hold down the Shift key before you depress the mouse button, 
the pointer turns into a pointing hand. You can use the hand to select 
several objects at once. Drag the hand around a group of objects to 
make a selection rectangle. Be sure to drag COMPLETELY around 
the bounds of the objects (identified by the blank handles). Otherwise, 
one or more objects may not be selected. 

• If you hold down the Shift key after you depress the mouse button, 
Draw constrains the movement of the mouse. Constraining lets you 
move the mouse in a horizontal, vertical, or diagonal plane only. 
Constraining works when creating objects and when moving objects 
(see Figure 3-24). As long as you keep the mouse button down, you 
can release and press the Shift key to tum constraining on and off. 
This can be used effectively when generating unusual polygons, for 
example. When used with the Polygon tool, you must also hold down 
the Option key. Release the Option key when you are done making 
the shape. 
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Figure 3-24 Examples of Constrained Movement 

• Pressing the Shift key while you are resizing a rectangle or oval, and 
the object constrains to a perfect square or circle. 

• Holding down the Command key reselects the last tool used. 

Controlling Size and Placement of Objects 

Draw has an internal and invisible alignment grid, which you can use to 
accurately size and place objects on a drawing. When Draw is first turned 
on, this grid is initially off. The size of the grid is determined with the Grid 
Setting command in the Format menu. 

The standard grid setting is l/8th of an inch. Therefore, the grid is a 
matrix of horizontal and vertical lines spaced l/8th of an inch apart. 
Objects will have sizes in l/8th inch increments, and will be placed in the 
drawing window in l/8th inch increments. 

WORKING WITH COLUMN TEXT 

Works has a hidden text writing feature called column text You'll want to 
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use column text when preparing multiple-column documents such as 
newsletters, reports, and scientific papers. To create a column of text: 

1. Click the Text tool. 

2. Hold down the Option key and drag the mouse inside the document 
window to describe the size and shape of the column. You can 
always resize and reshape the column later on. 

Text columns are normally displayed with a dotted outline. This outline 
appears when working in Draw or the word processing and spreadsheet 
modules, but doesn't appear when the document is printed. The outline 
helps provide a visual border of the boundaries of each column, but you 
may want to turn them off. To do so, choose the Show Column Boxes 
command in the Draw Format menu. 

When Works creates a column of text, it displays a name and link header 
at the top of the column (see Figure 3-25). This header is used to create a 
continuous "chain" of columns. With such a chain, text that won't fit in 
one column is automatically flowed to the next. This is particularly helpful 
when producing multiple-column documents. 

Col 1 Link 

,.N.QN~---------------

I 
I 
I 
I 

I 

I IIIII -------------------------.J .. 
Figure 3-25 Column Box with Header 



Drawing with Works 101 

Initially, Works names each column Col 1, Col 2, and so forth, with no 
columns linked to one another. To create a link, edit the header as desired. 
For example, to link column 1 to a column named NEXT, edit the header of 
column 1 so that it reads Coil Link NEXT. 

You can continue linking in this fashion as long as you want. The last 
column in the chain should not link to any column, such as Col x Link 
NONE. 

Works column numbers aren't very descriptive, but you can change them 
if you'd like. Column names can be any reasonable length (the shorter the 
better to avoid errors), but they should not have spaces, punctuation, or spe
cial characters. For example, Col LeadArticle Link LeadArticle _ cont is 
a proper column header, but Col Lead Article Link LeadArticle (Con't) 
is not. Column headers must also be followed by a Return, to separate 
them from the body of the column text. 

Once a link is established, it stays established until you edit one or more 
column headers, or delete one of the columns in the link. Text that over
flows one column is added to the next. If the second column overflows, that 
text is then added to the third column in the link, and so forth. Text will 
overflow the last column of the link because it will have nowhere to go. 

You are limited to 32K (about approximately 5,000 words) of text in one 
chain of columns, but you can have any number of column chains in a sin
gle word processing document, up to the maximum memory capacity of 
your computer. 

The text does not reflow until you have fmished writing or editing the 
column. To force Works to flow the columns, click the Selection Arrow or 
click anywhere outside the column. 

Columns are also reflowed when they are resized. If the column is 
enlarged, it can accept more characters, and will "siphon" text from the 
next column in the link. If the column is reduced, it will force the excess 
text to flow to the second column. 

Each text column may contain its own unique set of character font for
mats. Text that is flowed from one column to the next takes on the format
ting of the destination column. 

Automatic Linking 

Editing column headers to establish a chain of text columns is tedious, and 
an easier and quicker method is to hold down the Option key and click on 
each column in the link in the desired chaining order. This method works 
with either the default column names (Coil, Col2, etc.), or with your own 
column names. 
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Converting Text Blocks into Columns 

You can convert regular object text (text blocks you make with just the Text 
tool) into column text in two ways: 

• Add a column header, using the header format described earlier. 

• Click the Selection Arrow, hold down the Option button, and click on 
the text object you want to convert. 

To convert column text back to a regular text object, simply delete 
the header. 

ADVANCED DRAW TECHNIQUES 

A few moments spent experimenting with Draw reveal a number of hidden 
capabilities that bare tools and commands don't convey. This section 
details special tips, techniques, and traps of Works Draw. Get to know 
these secrets and you are well on you wait to mastering Works. 

Grouping Objects to Make Graphics Compounds 

As its very basic level, making pictures with Draw is creating and compil
ing objects laid out on a page in a particular fashion and order. You can 
prepare elaborate drawings more quickly and easily if you logically sepa
rate objects that would be moved or resized together into linked clusters. 
Each cluster of objects is a definable graphic compound--a kind of sub
system of the complete picture. Graphic compounds may be landscape fig
ures, nuts, bolts and other hardware, a letterhead logo, or whatever. 
Objects in a self-contained graphic compound can more readily be manipu
lated in your drawing. 

To make a graphic compound, position the various objects that go into a 
drawing. Once the objects are composited, use the Group Picture com
mand from the Format menu to lump them together. Now the graphic com
pound can be moved, resized, copied, pasted, and otherwise manipulated as 
a whole. 

Grouping is especially important if you rearrange the stacking order of 
your objects. If you move a grouped compound from the back to the front 
of the stack, the individual objects in the compound will retain their stack
ing order relative to one another. If the objects are not grouped, and you 
merely select each object to bring to the front, the layering order of the 
objects relative to one another may not remain consistent. 
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Template and Forms Documents 

Works' built-in Stationery feature lets you create template documents 
filled with ready-to-use graphic shapes and images. You can use this fea
ture, for example, to create the basic design of a newsletter. All the graph
ic components (called standing elements) used for each issue are included 
in the template. (Refer to Chapter 1, "General Tips for Using Microsoft 
Works," for more information on the Stationery feature.) 

Saving Common Graphics Compounds 

Graphic compounds can be saved in the Scrapbook file or in a special 
"forms" document, a repository of Draw clip-art. You can reuse the com
pounds whenever you need them. If you access the graphic compounds 
only occasionally, they can be kept in the Scrapbook. If you have many 
graphic compounds to store, you may want to use one of the Scrapbook 
alternative desk accessories, as described in Chapter 9, "Managing Works." 

The Scrapbook, or a scrapbook alternative accessory, is not convenient, 
however, if you access the graphic compounds on a regular basis. Instead, 
store them in a form document and keep the document open while drawing. 
When you need to access a graphic, click on the form document window to 
make it active, and bring it in view (or position the form document to make 
it readily accessible). Then: 

1. Select the graphic compound. 

2. Copy it using the Copy command from the Edit menu. 

3. Reactivate the drawing window. 

4. Paste the compound into the drawing with the Paste command. 

Erasing with Works Draw 

If you've used a bit-mapped graphics program like MacPaint, you learned 
to delete portions of the picture by erasing the dots. Since Draw is object
oriented, its drawings are not composed of small dots. Therefore, to erase a 
part of the drawing in Works Draw, you cover it up with another object 
called a block-out object. The object is made invisible by choosing a fill 
and line pattern that matches the background (usually white). 

For example, to hollow out a section of a black circle that rests on a 
white background, create a small white circle and place it inside the black 



104 Inside MS Works 2 for the Macintosh 

one, as shown in Figure 3-26. Choose a white line pattern to eliminate 
the border. 

For irregularly shaped erasures, use the Free-form or Polygon tools. 
Draw the block-out object over the part you want to delete. Shape the 
object, then tug on the handles to reshape it into the form needed. Select 
the block-out object, and defme the fill and line patterns so that it blends in 
with the background, and obscures the object underneath. Complex era
sures may require you to make several block-out objects, and to selectively 
choose the line and fill patterns to match the immediate surroundings of 
your drawing. 

The block-out erasure technique also works when creating cut-away 
drawings (see Figure 3-27). The cut-away is actually a block-out object (or 
series of objects), over which is placed the various elements that make up 
the interior view. The block-out hides the exterior contours of the drawing, 
providing a white or other even-patterned background. 

Minimizing Screen Redrawing Time 

Each time an object is displayed on the screen, the Macintosh recreates it. 
The drawing time for simple objects is a fraction of a second. Complex 
objects, like ftlled polygons and free-forms, may take considerably longer 
to draw and to appear on the screen. 

White circle with border 

White circle without border 

Figure 3-26 Erasing Sample with Draw 
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finished Cut-Away Assembly of Cut-Away 

Figure 3-27 Block-out for Cutaways 

If your drawing consists of many complex objects, it may take several 
seconds to redraw the screen. This can become annoying when scrolling 
through the document and when examining the drawing in reduced view. 
Nothing can be done to speed up the drawing time. You can, however, 
avoid redrawing objects unnecessarily. 

• Refrain from scrolling the drawing one small section at a time. Don't 
use the arrows to scroll the document. Use the thumb box or click in 
the gray portion of the scroll bar. These methods help you reach the 
part of the document you want much faster. 

• If your drawing is very complex, create it in small chunks and keep the 
chunks in individual documents. Then, when you are done and ready 
to print the drawing, merge the chunks together into one document. 

• If you are printing with an Image Writer, you may convert portions of 
an elaborate drawing into a bit-mapped picture. The Macintosh 
redraws bit-mapped images almost instantaneously. Use the tech
niques covered in Chapter 11, "Using Works with Other Programs," 
for more information. You should not use this method if you are print
ing with a LaserWriter, as bit-mapped graphics are not printed with the 
same high resolution as object-oriented graphics. 

Text Effects 

Since a text block is an object, you can change the background by choosing 
a new pattern from the Fill menu. The text appears on top of the pattern. 
Choose the patterns carefully, since many patterns are too "busy" or dense, 
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making the text characters hard to read. Choose another font style, such as 
bold or outline, for unusual effects. The Outline and Shadow styles usually 
produce pleasing results with any background pattern. 

The Line Pattern menu and line thickness options in the Tool Palette 
don't work with text blocks. You cannot change the pattern of the text 
itself, nor place a border around the text block. If you need a border around 
the block, draw an unfilled rectangle and size it to match the text. 

Use a separate box if you want to add a larger or smaller background 
under the text. 

Mixing Fonts, Sizes, Styles, and Colors 

Draw lets you freely mix fonts, sizes, styles, and colors within any single 
text block or text column. Follow the standard Works procedure for choos
ing a new format while writing text or when reformatting selected text. 

To return all the text in a block or column to a single font, size, style, or 
color, click the block or column with the Selection Arrow, then choose the 
desired commands from the Format menu. 

Works normally retains character formatting of the original text when 
pasting it into a new text block, regardless of the current formatting of the 
text block. If you want the pasted text to take on the character formatting 
of the text you're pasting into, hold down the Option key while pasting. 
This technique works whether you invoke the Paste command from the 
Edit menu, or press Command-V. 

Insuring Proper Text and Graphics Proportions 

The Image Writer prints graphics and text in slightly different resolutions 
(72 dots per inch for graphics; 80 dots per inch for text). This can alter the 
expected size and proportions of text and graphics. 

If your drawing contains only graphics, you can print without much 
worry of altered proportions. But if your drawing also contains text, you 
should make sure the Tall Adjusted option (in the Page Setup dialog box) is 
turned on. With Tall Adjusted switched on, the Image Writer will print text 
and graphics at 72 dot-per-inch resolution. You do not need to tum on Tall 
Adjusted when printing the document sideways (Landscape) or when print
ing with the LaserWriter. 
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Figure 3-28 Drawing Concentric Circles 

Starting Point for Circles and Squares 

With Works Draw, objects grow from the point where you frrst begin drag
ging the mouse. You can use this common point to your advantage when 
creating certain effects and when making concentric circles or squares. 

To make concentric circles, for example, draw the outer most object frrst 
Next, use the Angle Line tool to draw a diagonal line from the upper left 
handle of the object. Depress the Shift key to make sure you get a perfect 
45 degree line. To make the inner circles, line up the pointer along the line, 
as shown in Figure 3-28. When you are done, select the diagonal line and 
delete it. 

Aligning and Centering Shapes 
Works provides rudimentary features for aligning objects to one another, 
centering them, and snapping already made objects to the grid. 

Snapping Objects to the Grid Objects may not coincide with the grid 
when they are made with the grid off. Works Draw lacks an "Align To 
Grid" or "Snap To Grid" feature found on stand-alone graphics programs 
like MacDraw, but it does provide a semi-manual method of accomplishing 
the same thing. 

1. Draw the object, as usual. 

2. Set the grid to the spacing you want (such as 1/8 -or-1/4-inch), but 
make sure the grid is on. 

3. Press and hold the V, H, or B keys, depending on how you wantthe 
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' Snap-to nearest gr1d 1 ntersect1on 

Object 

Figure 3-29 Sample Object-to-Grid Alignment 

object aligned-vertically, horizontally, or both horizontally and ver
tically. 

4. Click on the side or comer of the object you want snapped to the grid 
The object snaps to the nearest grid line or intersection as shown in 
Figure 3-29. 

5. Release the V, H, orB key, then release the mouse. The object is 
snapped to the nearest grid line or intersection. 

Note: The entire object may not be aligned to the grid, just the side you 
indicated in Step 4. 

You can use the same basic procedure when resizing objects to align to 
the grid. Hold down the appropriate key (V, H, or B), and drag one of of 
the handles of the object. The object is aligned to the grid only on the 
side(s) of the object resized. The opposite side(s) are not affected. 

To align an object that you are about to draw to the grid-even when the 
grid is off.-select the tool you want to use, press and hold V, H, or B, and 
draw the object. Release the mouse, then the key. Use this approach to 
"temporarily" turn the grid on for just one or two objects. 

Centering Objects Centering two objects is perhaps the easiest task of all. 

1. Select the object you want centered. 

2. Cut it using the Cut command (from the Edit menu). 

3. Select the object you want to center over. 

4. Choose the Paste command from the Edit menu. The previously cut 
object is pasted from the Clipboard, and is automatically centered 
over the selected object. 

Repeat the process for other objects you want centered. 
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You may need to use the Bring To Front or Send To Back commands to 
properly set the stacking order of the centered objects. 

Aligning Objects to One Another Works automatically centers the pasted 
object both vertically and horizontally within the bounds of the selected 
object. But suppose you want to align the objects along one of the sides, 
such as the top or bottom. 

To center the objects either horizontally or vertically, align the objects by 
one of their sides, follow the steps above for centering, then use the posi
tioning keypad in the Tool Palette menu to nudge the pasted object to the 
desired alignment (see Figure 3-30). 

If precise alignment is not required, you can use the mouse to "eyeball" 
the proper alignment. Use the approach detailed above to center the 
objects, if desired, then use the Shift key to constrain movement either hor
izontally, vertically, or diagonally. Remember to press the Shift key after 
clicking on the object you want to move. 

Alignment on right side 

... 
IIIII ... 

Figure 3-30 Nudging to Align 
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Another approach is to use the V, H, and B snap-to keys, detailed in the 
previous section. Follow the instructions given to align an object to a com
mon grid line. Do the same for the remaining objects in the set. With each 
object, drag it close to the others, then release the mouse button. The 
objects will align themselves as specified. When all objects are properly 
aligned, select them (and group them if desired), and move them to the 
desired location in the drawing. 

Measuring Objects 

Draw lacks a means to precisely measure objects. You could try to com
pare the size of a line or square to the ruler that sits over the window, but 
the results aren't always accurate or easy to obtain. 

Another way is to create your own "rulers" that you can use to measure 
the width or length of any object you create. One of the easiest ways to 
make a ruler is to create small squares with the grid feature turned on. 
These squares represent accurate l/8-inch spacings. Here are step-by-step 
instructions for making a Draw ruler: 

1. Make sure the Grid Setting is at 1/8 inch, and tum the grid on. 

2. Click the Rectangle tool and draw the smallest square you can. 

3. Repeat the process seven times (for a total of eight squares), 
making the sides of each square touch one another. 

4. Click the Ruler Line tool and make a straight line from one end of 
the boxes to the other. This line will be exactly one inch long. 

5. Select the Ruler Line tool again, and make small 1/8th-inch-long 
hash marks at the intersection of each square. Mal,(e the last hash 
mark 1/4-inch at the outside border of the last square. 

6. Select all of the boxes and delete them. 

7. Select all of the lines and group them with the Group Picture 
command. 

8. Extend the length of the ruler by copying the lines and pasting them 
alongside the original. A four- to six-inch ruler should suffice for 
most applications. 

9. When all of the one-inch segments have been copied and positioned, 
select them and group them together. 

10. Click the Text tool, choose a small, easy-to-read font, and add labels 
to the tick marks. 

11. Group all of the ruler elements to keep them together. 
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Figure 3-31 Finished Ruler and Ruler-In-Progress 

The ruler-in-progress, and the final result, is shown in Figure 3-31. Store 
the ruler in the Scrapbook or other safe place so you can use it when you 
need it. 

These instructions are for a horizontal ruler. Use the same basic steps to 
make a vertical ruler, except line the boxes and squares vertically instead of 
horizontally. 

Use a smaller Grid Setting to make smaller boxes should you need a 
more accurate ruler. 

Note: Even though the elements that make up the ruler are grouped 
together, each element is a separate object, and the many objects may cause 
a general slowdown of operation within Works. You can help speed things 
up by converting the object-oriented ruler into a bit-mapped graphic. Refer 
to Chapter 11, "Using works with Other Programs," for an explanation of 
how to do this. 

Spacing Objects 

There are many occasions when you may need to accurately space objects a 
specified distance apart. You can use the ruler described in the previous 
section for spacing objects, or apply one of the methods outlined here. 

• Select a grid size (with the Grid Settings command) that equals the dis
tance you wish to space objects. Tum the grid on, and use the mouse 
to move the objects the designated distance. 
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• Use the positioning cursors (in the Tools Rack) to move objects a set 
distance. Each click of an arrow equals 1{12 of an inch. Count care
fully as you click the arrows. A macro can be used if you need to posi
tion many objects the same distance. Record the macro with the prop
er number of arrow clicks, select the object to move, then play back 
the macro. (Refer to Chapter 8 for information on using the Works 
macro feature.) 

• Create small "measuring sticks" with the aid of the self-made ruler or 
grid. You can then leave the grid off as you use the sticks to place 
objects a certain distance apart. A measuring stick is a vertical or hori
zontal line that is the exact length of the distance you want between 
objects. For 1/2 of an inch between objects, for example, choose the 
1/2 inch option in the Grid Settings dialog box, tum the grid on, and 
make the smallest line you can. Turn the grid off (if necessary), and 
place the stick between the objects, using the stick as a spacing guide. 
Delete the stick when you are done with it. 

Freezing Objects 

You can secure any object so that it can't be moved or resized with a hid
den freeze feature. To freeze an object: 

1. Select the object. 

2. Press and hold the F key. 

3. Click on the object once more. 

With the object frozen, you won't be able to move, resize, or even select 
it. You can freeze a group of objects by selecting all of them and following 
the steps given above. You need to click only one of the objects when 
pressing the F key. To unfreeze an object so that you can edit it, press and 
hold the F key while you select the object. 

Arrowhead Effects 

Any line can be made into an arrow with the line selector options in the 
Tool palette. You can place the arrowhead on either side of the line; to 
make double-ended arrows, you must create two lines with arrowheads on 
each end, then butt the lines together, as shown in Figure 3-32. 

The size of the arrowhead depends on the thickness of the line. If you 
would like a smaller arrowhead with a thick line, create the line, then add a 
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Figure 3-32 Butting Lines Together 

.,...-E-----------~-~ Standard arrow tip 
size for line thickness 

~-----------• Small arrow tips on thick 11 ne 
Figure 3-33 Standard A"ow Thickness and Custom A"ow 

smaller line at the end. Make this small line thinner, and select an arrow
head for it. An example is shown in Figure 3-33. 

An arrowhead may not appear on very short lines. To make one 
appear, you must enlarge the length of the line a small amount. If neces
sary, cover the extra portion of the line with a block-out object, such as a 
line or small box. 

If an arrow crosses over an object, it may blend with the object, and if 
the arrow line is completely over a dark object, choose a lighter pattern 
from the Line Pattern menu. If the line goes partly off the object and onto 
the white background, add a short length of black line to "fill" it in (see 
Figure 3-34). Another technique is to white out the area directly beneath 
the arrow. Here's how to do it: 

1. Draw the arrow at the length and angle you want. 

2. Duplicate the arrow by copying it and pasting it. 

3. Be sure the new pasted arrow line is selected, then choose a heavier 
line width from the Tools Rack. 

4. Select the white pattern from the Lines Pattern menu. 

5. Click on the original black arrow and bring it to the top with the 
Bring To Front command. 

6. Place the original arrow evenly over the white background, as shown 
in Figure 3-35, and group them together. 

7. Drag the arrow into place. 

If you don't like the arrowheads that Works Draw provides, you can 
make your own. Use the polygon and rectangle tools to fashion a wide 
variety of arrow shaped objects. The arrow heads turn out better if you 
constrain the polygon to straight and diagonal lines only. Use the Fill 
Pattern and Line Pattern menus to choose different patterns for the insides 
and borders. 
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Figure 3-34 Adding Line over Arrow 

Figure 3-35 Using White-out Under Arrow 
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Maintaining Proportion when Resizing 

Draw has no simple way of maintaining the proportion of an object or 
group of objects while resizing. If the object is a perfect square or circle, 
you can guarantee the correct proportion by depressing the Shift key while 
resizing (start resizing, then press the Shift key). 

If the object does not have even proportions, you can still maintain those 
proportions during resizing by drawing a square around the object and 
grouping the object with the square. When you resize the square, hold 
down the Shift key. That keeps the correct proportions of the square, and 
hence any object grouped with it. 

Complex Polygons and Free-forms 

The Polygon and Free-form tools provide a great deal of flexibility, but 
they take the longest to master. Here are some tips: 

Tools 

D 
Ao 
"-0 
Jcr 
+~ 

= Cl 

~ 

\ == ====) 
.................................................................................... 

Figure 3-36 Additional Handles Along Polygon Line 
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• You can tum constraining on and off while using the Polygon tool. 
Hold down the Shift key to tum constraining on; release it to tum it off. 

• You can reshape a polygon by dragging at a handle. If there is no han
dle along a portion of polygon, you can't reshape it there. If you think 
you need greater control over the reshaping of polygons, add handles 
when creating the shape (see Figure 3-36). You do this by clicking the 
mouse along the length of a side. Each time you click adds a new han
dle, as long as you don't click twice at the same spot. Move the mouse 
at least one pixel ( 1/72-inch) to make each new handle. 

• Draw lacks a way to smooth free-forms that have been reshaped. You 
may need to use a stand-alone, object-oriented drawing program (such 
as MacDraw) if you need to create and edit elaborate, smooth free
forms. Free-form shapes from another program can be copied into 
Works easily. 

Tracing Graphics 

Complex graphics can be difficult to create from scratch in Draw. For bet
ter results, use a bit-mapped image of the drawing you want to duplicate. 
The bit-map serves as a kind of tracing template. Import the bit-map from 
MacPaint or similar painting program, as described in Chapter 11. Use the 
various tools to trace over the picture. When you are done, select the bit
map picture, unlock it, and delete it. You can now fine-tune the Draw 
image as required. 

If the original bit-map is small, such as a letterhead logo copied into 
MacPaint with the use of a video digitizer, enlarge it in Draw before trac
ing. That will make it easier to work with and you will obtain better 
results. When done, reduce the traced image by grouping it, then shrinking 
it to the desired size. 



CHAPTER 4 

Spreadsheet Strategies 

Before the proliferation of personal computers, the concept of keeping 
track of fmances on an electronic version of an accountant's ledger was 
heresy. In the days of massive micro- and mainframe computers, calculat
ing net worth, budgets, and fmancial projections required special program
ming and a full-time keypunch operator to enter all the data. 

Crunching numbers is second nature to the Macintosh and Microsoft 
Works. Part of Works is an electronic spreadsheet that mimics the func
tionality of a multiple-column ledger pad, but offers more than pencil and 
paper ever could. 

Converted to real terms, the Works spreadsheet pad measures 256 rows 
by 16,382 rows--4,193,792 cells to enter text, values, or calculation formu
las. Assuming 8 1/2- by 11-inch ledger pads with seven columns by 40 
rows per page, one Works spreadsheet can measure 26 by 375 feet. 
Granted, that's assuming your Macintosh has the RAM to accommodate 
that much data, but the possibilities are there. 

This chapter details the fmer points of the Works spreadsheet. In the 
pages that follow, you 'lllearn the ropes for moving easily throughout the 
spreadsheet, formatting cells, when and how to use relative and absolute 
referencing, and a simplified approach to writing formulas. 

117 
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SPREADSHEET BASICS 

Figure 4-1 shows an empty spreadsheet window. The main components of 
the spreadsheet are: 

• The cells, labeled by letter for columns and by number for rows. 

• The edit bar (the Enter and Cancel icons are only present when entering data). 

• The scroll bars, for moving through a spreadsheet larger than one screen. 

• The menu bar, on top of the screen, for issuing various commands. 

Data you enter from the keyboard is placed in the current cell selection. 
The current cell selection-cell AI in the figure-is shown highlighted. 
Furthermore, Works reports the current cell selection in the edit bar above 
the document. 

Moving the Cell Selection 

You can move the current cell selection in three ways. 

• Click on a new cell with the mouse. 
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Figure 4-1 Empty Spreadsheet Window 
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• Press one of the arrow keys on the keyboard (or numeric keypad, if 
your computer is so equipped). The current cell selection will shift in 
the direction indicated on the key. 

• Press the Return, Tab, and Shift keys to move up, down, left, and 
right, as follows: 

Key 
Return 
Shift-Return 
Tab 
Shift-Tab 

Using the Mouse 

Direction 
Down 
Up 
Right 
Left 

The mouse is the most intuitive method of moving the current cell selec
tion. But if you are entering lots of data in many cells, it's not the quickest 
or easiest approach. You'll want to alternate between mouse and keyboard 
control for best efficiency. 

There are few caveats when using the mouse to select cells, but one 
stands out: Be sure you have "pasted down" (entered) data into the cell 
before clicking on another. You can always tell if cell entry is incomplete 
when you see the Enter and Cancel icons in the edit bar. To paste down the 
data, click the Enter icon, or press one of the cell selection keys as outlined 
above (cursor keys, Tab, Return, etc.). You'll see why this is important in 
the section on writing formulas, later in this chapter. 

Role of Enter and Return Keys 

The Return key serves to enter data into the current cell selection, then 
move the cell selection up or down. The Enter key (on the keypad, if your 
computer is so equipped) only enters data into the current cell. It does not 
move the cell selection. The Enter key functions the same as the Enter 
icon in the edit bar. 

SELECTING MULTIPLE CELLS 

Works lets you make only one cell the current cell selection. That's the cell 
that you are currently writing or editing. But you can select any number of 
cells for other tasks, such as formatting, cutting, deleting, and so forth 
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Figure 4-2 Selected Range of Cells 

Selected cells are shown highlighted, as in Figure 4-2; the current cell 
selection is not highlighted, but is identified with a heavy outline. 

With multiple cells selected, you can now choose from among com
mands in the various menus, and the action affects all of the selected cells. 
For example, with cells Al through A5 selected, you can change the cell 
formatting to Bold with the Style options in the Set Cell Attributes dialog 
box. This all-at-once approach relieves you of selecting each cell in the 
range individually, and choosing the desired formatting options. 

You can, however, select only one contiguous (all together) range of 
cells at a time. You can't select cells Al through A5 in one range, then B2 
through B7 in another. The cell selection also must take the shape of a 
square or rectangle, and you can't leave off a cell in one comer of the 
rectangle. This may seem obvious, but it's a point that confuses many 
Works users. 

Follow these procedures for selecting multiple cells: 

To select Do this 
A small range 
A large range 

An entire column 
Two or more columns 
An entire row 
Two or more rows 
All active cells 
Complete spreadsheet 

Drag over the desired cells with the mouse. 
Click in the upper left cell of the range, hold 

the Shift key, then click the lower right 
cell of the range. 

Click in the column heading. 
Drag over the column headings. 
Click in the row heading. 
Drag over the row headings. 
Choose All Cells from the Select menu. 
Choose the Select All command from the 

Edit menu. 
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Figure 4-3 Action of Return and Tab Keys in Selection Range 

Use the Shift-click method to extend or retract a selection. Hold the 
Shift key and click outside the range to extend a selection, and hold the 
Shift key and click inside the range to retract it. 

When the cell range is selected, pressing the Tab, Return, and arrow 
keys moves the current cell selection within the selected range only. You 
can use this to confine the current cell selection to the highlighted range, as 
illustrated in Figure 4-3. By pressing the Command key along with Tab 
and Return, you limit movement of the current cell selection in single rows 
or columns only. 

To deselect a range of cells, click anywhere outside the range. 

SPREADSHEET CONCEPTS 
Keep these concepts in mind when using the Works spreadsheet module. 

Active Area 

The Works spreadsheet contains 256 columns by 16,382 rows, but your 
spreadsheet models will likely be far smaller than this. Realistically, a 
spreadsheet module with all 4,193,792 cells filled would require more 
memory than the Macintosh can currently accept, and would easily take up 
an entire 20 megabyte hard disk! The part of the spreadsheet that is actual
ly filled with data is the active area. 

Works reserves blocks of the Mac's memory depending on the extent of 
the active area. To conserve memory, you should strive to make the active 
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Figure 4-4 Memory Management and Empty Rows and Columns 

area as compact as possible. Even if you leave several rows or columns 
empty, Works still reserves memory space for them, as shown in Figure 4-4. 

Of course, there is a fine balance between memory conservation and 
spreadsheet aesthetics. On one hand, a spreadsheet shouldn't be distributed 
carelessly among dozens of columns and rows, but on the other, the data 
shouldn't be so crammed that the spreadsheet is difficult to view. Use your 
best judgment. 

The intersection of the bottom right-most cell that contains data is the so
called last cell of the spreadsheet. You can readily find this cell with the 
Last Cell command in the Select menu. Works remembers this cell even if 
you erase its contents. If you reduce the size of your spreadsheet by 
moving or erasing cells, you may need to manually reduce the active area 
by clearing the blank columns and rows with the Clear command. That 
way, they no longer consume extra memory. 

To clear unneeded columns and rows, select them by clicking within the 
column and row headers along the top and left side of the spreadsheet (see 
below for more information on selecting columns and rows, as well as 
other parts of the spreadsheet). Then choose the Clear command from the 
Edit menu. 

Spreadsheet "Layers" 

As with many electronic spreadsheet programs for computers, the cells in 
the Works spreadsheet are composed of "layers," superimposed over one 
another. Works has four cell layers. 
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Figure 4-5 Layers 

• The bottom layer, as shown in Figure 4-5, is Layer 1. It contains the 
cell note (if any), and a maximum 511 character "note-pad" used to 
annotate the cell. 

• Layer 2 is the format layer, containing the formatting of the cell. The 
format (or attributes) of a cell determine how it looks on the screen and 
on paper. Among the variations in cell formatting are centered num
bers and text, bold, and italics. 

• Layer 3 is the formula layer, used for computations. 

• Layer 4 is the values layer, which represents the results of formulas, as 
well as numbers and text you enter directly through the keyboard. 

Normally, Works displays the values layer, showing the calculated 
results of formulas, but not the underlying formulas themselves. You can 
view any formula in a cell by selecting the cell; the formula appears in an 
editing area above the spreadsheet window. 

Sometimes, it is necessary to view all formulas at once, to review the 
construction of the spreadsheet or to look for errors. Works provides a 
means to display the formula layer with the Show Formulas command in 
the Options menu. To revert to values display, choose the Show Values 
command from the Options menu. 

Automatic vs. Manual Recalculation 

Formulas in the Works spreadsheet are normally recalculated every time 
you enter new information or change old information. Specifically, Works 
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recalculates when entering or editing formulas or numbers, but not when 
entering text (called labels, as explained later in this chapter). Works also 
automatically recalculates previously saved spreadsheets when you open 
them again. 

If the spreadsheet is small-containing less than a hundred cells of 
numbers and formulas-recalculation time is normally quick and unde
tectable. But recalculation time stretches to sometimes intolerable limits 
when the spreadsheet grows in size, or contains many complex formulas 
and number tables. 

You can prevent recalculation when creating and editing a large spread
sheet by turning calculation off. Choose the Manual Calculation conunand 
from the Options menu; Works recalculates the spreadsheet only when you 
tell it do to so with the Calculate Now command (also from the Options 
menu). Or you can press Command-= (Command and equals key). To 
revert to continuous calculation, choose the Automatic Calculation com
mand from the Options menu. 

Works remembers the setting of calculation when you save a document. 
That is, if you select Manual Calculation, Works records your choice with 
the document Manual Calculation is still selected the next time you open 
the document. Remember that in this case Works won't automatically 
recalculate the spreadsheet when it first appears on the screen; you have to 
do that yourself. 

Circular References 

A circular reference occurs when two or more cells in a spreadsheet refer 
to each other. Suppose, for example, that you enter the formula =Al +A2 in 
cell AI of your spreadsheet, and the number 10 in cell A2. Obviously, 
Works can't calculate a meaningful result because it has no beginning value 
in cell AI. A value is entered into cell AI only after the first calculation; 
that value is 10, provided by cell A2. Subsequent recalculation provides 
different results, because the value of A1 changes each time-frrst 10, then 
20, then 30, and so forth. 

Though there are some times when you need to build a formula that 
relies on itself, circular references are usually made in error, and Works 
prompts you of this fact. 

When Works fmds a circular reference, it displays a dialog box like the 
one shown in Figure 4-6, but the program still attempts to provide a mean
ingful answer. Be wary! The answer will, in all likelihood, be incorrect. 
And if you leave it there, it could cause a rippling effect that will make 
other results in the spreadsheet inaccurate. 
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Figure 4-6 Circular Reference Dialog 

Iteration 

A few of Works' built-in formula functions require repetitive calculations 
to ensure accuracy. These multiple calculations are iterations. Works has a 
limit of 20 iterations; if its formulas are not resolved after 20 recalculations, 
Works presents an error. Iteration is used only with some of Works' built
in financial functions, such as IRR() and Rate(), that require an "educated 
guess" starting point. Unlike other spreadsheet programs, such as 
Microsoft Excel, Works provides no way to alter the number of iterations 
during recalculation. 

And, unlike many other spreadsheet programs, Works does not use auto
matic iteration to resolve circular references (see above). However, you 
can force manual reiterative calculation by pressing Command-= (this 
forces recalculation, whether or not you have selected Manual or 
Automatic recalculation). The circular reference warning dialog box 
appears only after you frrst create or edit the circular reference formula. It 
does not appear when the spreadsheet is recalculated, even if the circular 
reference condition still exists. 

Table 4-1 shows the effects of reiteration of a common circular reference 
between two cells. Each time you press Command-=, Works provides a 
slightly different, more accurate answer. Keep pressing Command-= until 
the changes in the answer are within the range of accuracy you wish. 
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Iteration# 
Formula 

Initial Value 
1 
2 
3 
4 
5 
6 
7 

Content A! 
=A2+A3 

5000 
6562.5 
6640.625 
6660.15625 
6665.0390625 
6666.2597656 
6666.5649414 
6666.6412354 

Table 4-1 Sample Reiteration of Value 

Recalculation Order 

ContentA3 
=A1*.25 

1250 
1640.625 
1660.15625 
1665.0390625 
1666.2597656 
1666.5649414 
1666.6412354 
1666.6603088 

Works uses what's called natural recalculation order when resolving the for
mulas in a spreadsheet The program doesn't simply start recalculation in the 
upper-left cell and work its way to the lower-right. Instead, Works calculates 
the most basic formulas first-those that don't rely on other formulas in the 
spreadsheet-then progressively tackles the more complicated ones. 

Untitled (SS) 

Figure 4-7 Logical Worksheet Arrangement for Calculation 
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Although Works uses natural recalculation to compute formulas that are 
scattered around the spreadsheet, good spreadsheet design suggests you 
write formulas that logically follow one another, such as down columns or 
across rows, as illustrated in Figure 4-7. Not only does this approach make 
the task of calculation easier on Works, but it helps you better visualize the 
construction of your spreadsheet, allowing you to locate errors and spot 
better ways of doing things. 

Limitation of Works Variables 

A variable is a temporary holding tank, or repository, for data that can 
change from one moment to the next. Variables are an integral part of com
puter programming, and are used extensively in many electronic spreadsheet 
programs, including Works. One type of spreadsheet variable is the cell. 
The value of a cell can change if the contents of other cells that are used in 
the computations are also altered. Let's say you are adding two cells togeth
er, Aland A2. In cell A3 is the addition formula Change the contents of 
cell Al, and Works automatically provides the new answer in cell A3. Cell 
A3, then, is a variable. 

Many of the uses of variables are invisible to you, especially when apply
ing one of Works' many built-in formula functions. (A function is a built-in 
formula that performs some complex task, like averaging a group o(num
bers or fmding the present value of an investment) Most of these functions 
rely on variables to pass information from one part of a spreadsheet to 
another, and are limited to working with numbers only, and not text. 

Using the Spreadsheet for Non-Computational Tasks 

The Works spreadsheet is primarily intended to "crunch numbers," but that 
doesn't mean you can't use it for other chores. Though software program
mers hate to admit it, most people use electronic spreadsheet programs not 
to calculate budgets or returns on investment, but as a convenient "struc
tured data processor." (In fact, the much touted "what-if' capability of 
electronic spreadsheets, where you enter a series of numbers and view the 
various results, is only occasionally used by spreadsheet users. 

The division of the spreadsheet into individual cells makes it ideal for 
preparing non-computed lists and charts, and even organization diagrams as 
shown in Figure 4-8. This application is also well suited to the Works 
database module, although the spreadsheet module offers more of an "off
the-cuff' approach to entering data. 
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Figure 4-8 Sample Non-Computational Use of Spreadsheet 

KEYBOARD AND MOUSE SHORTCUTS 

The Works spreadsheet provides many handy keyboard and mouse short
cuts that you can use to save time. In addition to the Command-key short
cuts detailed in Chapter 1, Works offers the following shortcuts you can 
execute with the mouse and keyboard: 

• To select all the cells in a column, click in the column header, as 
shown in Figure 4-9. 

• To select all the cells in a row, click in the row header. 

• To select all the cells in the active part of the spreadsheet, choose the 
All Cells from the Select menu. 

• Double-click on a cell to set its formatting. Double-clicking does lhe 
same thing as choosing the Set Cell Attributes command from the 
Options menu. 

• Press Command and double-click on a cell to open its notes window. 
This does the same thing as choosing the Open Cell Note command 
from the Edit menu. 

• To quickly resize a column, position the pointer inside the column 
header along the right edge of the column you want to resize. Drag the 
column to the desired size with the mouse. Columns must be between 
1 and 40 units wide (or approximately three to 48 characters, assuming 
default Geneva 9 point, plain font). 
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Figure 4-9 Clicking in Row and Column Headers 

• To delete entire columns and rows (even when they are blank), select 
the entire row or column using one of the methods described above, 
and press Command-X (for Cut). This method has the same effect as 
a Delete Column or Delete Row command, which Works lacks. 

• To clear a single cell, select it, press the Delete key, and press Enter. 
Or, select it, and choose the Clear or Cut commands from the Edit 
menu. The Delete key does not erase cell notes, but the Clear and Cut 
commands do. 

• If you know at least a portion of the contents of a cell (formula or 
value), you can quickly shuttle to it with the Find Cell command from 
the Select menu. Choose Find Cell (or press Command-F), enter the 
numbers or text to fmd, and press 0 K. 

• You can immediately view a cell in another part of the spreadsheet 
with the Go To Cell command from the Select menu (or press 
Command-G). After choosing the command, enter the reference of 
the cell you want to go to. Works displays the cell in the top of the 
window, but does not select it. 

• If you scrolled the current cell selection out of view in the document 
window, you can quickly return to it with the Show Active Cell com
mand (from the Select menu). 

TYPES OF CELL ENTRIES 

To use the Works spreadsheet, you must fill its individual cells with infor
mation to be processed. There are several types of cell entries. 
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Values 

Values are numbers, either positive or negative. A value cell can present a 
number as a piece of factual information, or it can be used in computations 
elsewhere in the spreadsheet Because values are entered by you and can't 
be changed by Works, they are often referred to as constant values. 

Values are generally entered as numbers only, without commas, dollar 
signs, or other symbols (of course, a period for a decimal point is accept
able). You may, if desired, enter values with commas, dollar signs, and 
percent signs. However, if these symbols are included as part of a formula, 
Works will treat the entry as text. For example, a value entry of $10,000 is 
treated as a value, but a formula entry of =$10,000*10 is treated as text. 

Values with non-numeric characters (such as dollar signs and commas) can 
be used in formulas as long as the formula is located in another cell, and refers 
to the value by cell reference, as in: =A1 *10. In cell Al is the value $10,000. 
See below for more information on formulas and cell references. 

Cells accept and display numbers with a power-of-ten scaling factor, 
otherwise known as scientific notation. The format is xxxE+nn or :xxxE
nn (theE can be upper- or lowercase). For example: 

Notation 
14e+6 

or 
8E-7 

Decimal Number 
14000000 

0.0000008 

Works accepts exponents up to plus or minus 99. If you enter an expo
nent outside this range, Works displays an *Error* message. Works always 
displays very large and very small numbers in scientific notation when the 
cell is formatted with the default General number attribute. You can force 
Works to display the decimal form of the number by selecting the Fixed 
Number attribute. (Later in this chapter changing cell attributes is discussed 
further.) If the number displayed is too long to fit the current width of the 
column, Works displays a series of #####s in the cell. You must increase 
the width of the cell to see the whole number. 

Formulas 

Formulas are instructions that tell Works how to calculate two or more 
numbers. Formulas always begin with an equal sign ("=") and must follow 
a particular format. If Works doesn't like the way you've written the for
mat, it displays an error box, as shown in Figure 4-10, and allows you to 
change it. You can have up to 238 characters in a formula. 
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Figure 4-10 Formula Error Dialog Box 

Labels 

Labels are text, and are not included in Works' calculation process. Labels 
are generally used to annotate the spreadsheet with explanatory informa
tion, such as months, years, or departments. Labels can contain either let
ters or numbers or both and can be up to 238 characters long, 

Cell References 

A cell reference in one cell refers to the contents of one or more other cells 
in the spreadsheet. A cell reference is entered in a cell either by itself, or in 
a formula. For example, =A2 means "put the contents of cell A2 in this 
cell." Cells may contain a cell reference as part of a formula, as in 
=12+A3, which means, "12 plus the contents of cell A3." A cell reference, 
which can be considered a value, can be entered by typing the cell coordi
nates with the keyboard, or by pointing with the mouse. 

Functions 

Functions are built-in formula-building shortcuts. They may be entered 
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into cells by themselves or with another function, or they may be part of a 
more complex formula. 

Cell Notes 

Cell notes are invisible cell "note pads" where you can write up to 511 
characters of explanatory text for a particular cell. You can open the cell 
notes for a cell in one of two ways: 

• Press the Command key and double-click on the cell. 

• Select the cell and choose the Open Cell Note command from the Edit 
menu. 

The cell notes window is like a miniature word processor, but is only 
capable of rudimentary text editing. Start typing and the text appears at the 
flashing insertion point. Use the mouse and keyboard to edit text. You can 
enlarge the window by clicking within the zoom box in the upper right cor
ner. In fact, the cell notes window behaves just like any other Works win
dow, so you can manipulate it in the same manner. 

When you're done writing, click in the close box in the upper left comer 
of the cell notes window. Alternatively, you can leave the cell notes win
dow open, and return to any other open Works window by choosing among 
the list in the Window menu (or, press Command-, to cycle to the next 
available open window). 

Cells that contain a cell note are identified by a small, black flag in the 
upper right comer, as shown in Figure 4-11. 

You may have occasion to copy a complete cell note from one cell to 
another, and though you can manually copy the text from one cell note and 
paste it into another, an easier approach is to use the Paste With Options 
command, which lets you copy and paste entire cell notes at a time. Follow 
these steps: 

3 
4 

Figure 4-11 CeU with Note Atlllched 
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1. Select the cell to copy. 

2. Press Command-C to copy the cell and cell note into the Clipboard. 

3. Select the destination cell. 

4. Choose the Paste With Options command from the Edit menu. 

5. Click the Both Values and Formulas option, and press the OK button. 

Cell notes are normally not visible when previewing or printing a spread-
sheet document. To see or print the notes, ftrst choose the Page Setup com
mand from the File menu and click the Print Cell Notes option. Cell notes 
are shown on their own page. 

Cell notes are erased only with the Clear or Cut commands in the Edit menu. 

ENTERING VALUES, FORMULAS, AND LABELS 

Works differentiates values (and cell references), formulas, and labels using 
simple defmitions. 

• If the cell entry contains only numbers, it's a value. Numbers started 
· with a minus sign (-) are considered negative. Unlike some electronic 
spreadsheets, you can't indicate negative numbers by enclosing them 
in parenthesis, such as (100) . Values are normally shown flush to the 
right side of the cell. 

• If the entry starts with an equal sign ("="), Works considers it a for
mula or a cell reference. Unless you choose to view the spreadsheet as 
formulas instead of values (using the Show Formulas command in the 
Options menu), the equivalent value of the formulas is shown and not 
the formula itself. Values are normally shown flush right to the side of 
the cell, as shown in Figure 4-12. 
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Figure 4-12 Alignment of Different Types of Cell Entries 
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• In most cases, adding even one non-numerical character into the cell 
forces Works to consider the entry a label. Exceptions are noted 
below. Labels are nonnally shown flush to the left side of the cell. 

Values Using Non-numerical Characters 

Certain non-numerical characters may be used in value entries, shown here: 

Entry 

$10 
10% 
10,000 
10.000 

Result in Cell 
10 
0.10 
10000 
10.000 

Application 

Dollar display 
Percentage 
Thousandssepanttor 
Decimal point 

Works does not generally allow the use of commas in numbers, reserving 
them to separate the arguments of its built-in functions. When Works 
shows the entry as a value without a comma, the number can't be used in a 
formula. 

Sometimes, you may wish to enter a number, formula, or cell reference 
and have Works treat it as label text. You can always force label text by 
starting the entry with a double-quote, as in "A3 or "32 + 43. 

The quote doesn't appear in the edit bar over the spreadsheet window, 
nor does it appear when the spreadsheet is printed. If you'd like the quotes 
to appear around a label, add two double-quotes at the beginning of the 
entry, and one double-quote at the end. For example, '"'10" prints "10" in 
the spreadsheet. 

USING THE EDIT BAR 
The edit bar is empty when no cell is selected. When a cell is selected 
(either by clicking it with the mouse or moving to it with the keyboard), the 
edit bar displays the cell reference and the contents of the cell. 

When creating or editing a cell entry, two additional icons appear in the 
edit bar. 

• The Enter icon is the same as pressing the Enter key: it completes the 
entry and places it in the cell. 

• The Cancel icon cancels any typing or editing you have done. Press 
this icon if you make a mistake and want to start over. 
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EFFECTIVE USE OF MOUSE AND KEYBOARD 

Effective application of the Works spreadsheet calls for a structured use of 
the mouse and keyboard. Some tasks are more suited to the mouse (indeed, 
many operations are only possible with the mouse), while other tasks are 
better handled with the keyboard. Specifically, you '11 want to consider the 
use of the keyboard and mouse when entering cell references and one or 
more of Works' built-in formula functions. 

Entering Cell References by Keyboard or Mouse 

As noted briefly earlier in this chapter, Works offers a variety of ways to 
center cell references: 

• Keyboard entry. Most Works users prefer to enter cell references by 
selecting the desired cell and typing the reference (with formula, when 
necessary) directly from the keyboard. This method is the most 
straightforward, but can be awkward and time consuming when build
ing spreadsheets with many complex formulas. 

• Mouse entry. Cell references can be entered by clicking on other cells 
in the spreadsheet with the mouse. When building formulas, for exam
ple, you have merely to click on another cell to enter its reference into 
the formula. You can add a series of cells together simply by clicking 
each cell in turn; Works automatically adds the"+" sign between cells, 
indicating that it will add the contents of these cells together. If you 
desire another operator, such as "*" for multiply, you must enter it 
yourself via the keyboard. 

WORKSHEET FORMATTING 

Works lets you tailor the appearance of the spreadsheet as you see fit. You 
can change the width of columns, split windows (to see different parts of 
the spreadsheet at once), alter formatting of cells, and prescribe new page 
breaks. 

Changing Width of Columns 

Works normally sets all spreadsheet columns to 12 units (12 units is equal 
to approximately 14 characters, when using Geneva 9 point, plain). Most 
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often, you '11 need columns of varying widths to adequately show the infor
mation in the cells. Colunm widths can be changed in two ways: 

• Select the column to change and choose the Column Width command 
in the Fonnat menu. Enter a new width (from 1 to 40, in even num
bers only), and press OK. 

• Move the mouse pointer into the column header and position it along 
the right edge of the column you want to resize. Drag with the mouse 
to set a new width. 

You can change a number of adjacent columns all at once by selecting 
them all, then choosing the Column Width command (resizing by dragging 
with the mouse doesn't work when multiple columns are selected). 

Splitting Windows 

The Works spreadsheet window may be split once vertically and once hori
zontally. 

• To split the window vertically (across the middle), drag the split bar 
located on the top of the vertical scroll bar. 

• To split the window horizontally (down the middle), 4fag the black 
split bar located at the far left end of the horizontal scroll bar. 

While split, the scroll bars present two sets of arrows and thumb boxes. 
Use them independently to move each side of the split as desired. Splitting 
windows is helpful, for example, when you need to view the names of the 
columns while entering data into cells deep within the spreadsheet, as 
shown in Figure 4..; 13. 

To remove the split, drag the split bars back to their original positions. 
You can lock the split window into place with the Freeze Titles 

Horizontal and Freeze Titles Vertical commands in the Option menu (one 
or both of the commands will be dimmed if the window is not properly 
split). These commands are useful for keeping row and column heads in 
view while you scroll to distant parts of the spreadsheet. 

• With Freeze Titles Vertical selected, the upper part of the split is 
frozen, and you can scroll only the lower part. 

• With Freeze Titles Horizontal selected, the left part of the split is 
frozen. 

When the window is frozen, using the scroll bars moves both portions of 
the split simultaneously. 
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Figure 4-13 Window with One Split 

Cell Formatting 

The cells of a Works spreadsheet may be formatted in different ways. You 
have full control over: 

• Border 

• Font 

• Size 

• Color 

• Cell attributes (including number format, date/time format, alignment, 
style, and number of decimal places) 

All cell formatting is made through the commands available under the 
Format menu. 

Setting Borders Borders are single-width lines that appear all around a 
cell, or along certain sides. You can set borders along the top, bottom, left, 
or right sides of the cell, as shown in Figure 4-14. If you select a range of 
cells and set an outline border, the border line appears completely around 
the range, not around each individual cell. Use this technique to add 
emphasis to certain cells or cell groups, or to separate portions of your 
spreadsheet. 
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Figure 4-14 S(lmple Borders 

You can use borders with multiple cell selections to create all sorts of 
useful formatting effects, as shown in Figure 4-15 (with the exception of 
the Outline option, the border effects can be combined as desired). 

Border option 
Outline 

Left 

Right 

Top 

Bottom 

None 

Creates 

Line around the outermost edges of the 
cell or selection 

Line on the left edge of the cell or every 
cell of the selection 

Line on the right edge of the cell or 
every cell of the selection 

Line along the top edge of the cell or 
every cell of the selection 

Line along the bottom edge of the cell 
or every cell of the selection 

No border 

When the border commands won't do, you can add lines and boxes using 
the Draw feature, available in the spreadsheet module. See Chapter 3 for 
more information on using Works Draw. 

Setting Fonts Spreadsheet data can be displayed in any font currently 
installed in the System file of your hard disk or Works disk. The selected 
font affects all of the cells in the spreadsheet. Different fonts (and font 
sizes) alter the number of cells that are visible in one spreadsheet window. 
The default Geneva 9 point font allows a display of six columns and 18 
rows at a time, for a total of 108 cells at a time. 
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Figure 4-15 Unusual Outline Effects with Borders 

Table 4-2 lists other common fonts and font sizes, and the number of vis
ible cells obtained with them. Some suggestions for the use of different 
fonts and sizes follows. 

• Use smaller fonts as a means to view more of the spreadsheet docu
ment at once (unlike Page Preview, viewing the document in 4 or 5 
point type still allows you to edit the spreadsheet, even though it's a 
little difficult to see the contents of each cell). 

• Use larger fonts if you have vision problems or have trouble seeing 
small type. 

• Use LaserWriter fonts (Times, Helvetica, Courier, etc.) to avoid font 
substitution and to ensure proper printing of the spreadsheet. 

Setting Size Each font can be displayed in sizes ranging from 4 to 72 
points. The selected font size affects all of the cells in the spreadsheet. 

Setting Color You may set a different color for the text in each cell with 
the Color command. The normal setting is Black. 

Setting Cell Attributes Each cell may contain its own unique attributes, or 
formatting. The Set Cell Attributes dialog box provides a number of 



140 Inside MS Works 2 for the Macintosh 

Initial Size 

Font Columns Rows Total Cells 

Geneva9 6 17 102 
Geneva 10 5 17 85 
Geneva 12 4 13 52 
Tunes 9 7 17 119 
Times 10 7 17 119 
Times 12 6 17 102 
Helvetica 9 7 16 112 
Helvetica 10 6 16 96 
Monaco9 6 16 96 
Monaco 12 5 12 60. 

Full Size 

Font Columns Rows Total Cells 

Geneva9 6 18 108 
Geneva 10 5 18 90 
Geneva 12 4 14 56 
Times9 7 18 126 
Times 10 7 18 126 
Times 12 6 18 108 
Helvetica 9 7 18 126 
Helvetica 10 6 18 108 
Monaco9 6 18 108 
Monaco 12 5 14 70 

Table 4-2 Screen Display with Different Fonts and Sizes 

number of options from which to choose (the alignment and style com-
mands are particularly helpful in "dressing up" your spreadsheets). As a 
shortcut to the Set Cell Attributes command, you can access the dialog box 
simply by double-clicking on the cell you want to reformat. Should you 
wish to change the format of many cells at once, select them all and the Set 
Cell Attributes command. 

Samples of cell formats using the options in the Set Cell Attributes dia-
log box are shown in Figure 4-16. 
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Figure 4-16 CeU Fonnat Examples 

Setting New Page Breaks 

Normally, Works tries to fit as much of the active area of the spreadsheet 
on a single page as it can. The natural spreadsheet page breaks may not 
always occur at the most convenient rows and columns, however, so you 
may want to set one or more page breaks yourself. Follow this simple pro
cedure to set a page break: 

• To set a new page break at a column (a vertical page break), select the 
column you want to begin on the next page, and choose the Set Page 
Break command from the Options menu. 

• To set a new page break at a row (a horizontal page break), select the 
row you want to begin on the next page, and choose the Set Page 
Break command. 

Page breaks are shown with a heavy dashed line. 
Follow these steps to remove your own page breaks (natural page breaks 

that Works provides cannot be removed in this fashion): 

• To remove a vertical page break, select the column to the immediate 
right of the break, and choose the Remove Page Break command from 
the Options menu. 

• To remove a horizontal page break, select the row immediately under 
the break, and choose the Remove Page Break command. 
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Figure 4-17 Setting New Page Breaks 

You can also set both a horizontal and vertical page break simultaneously 
by selecting a cell anywhere in the spreadsheet, and choosing the Set Page 
Break command. The new page breaks will appear to the left and above 
the cell selection, as shown in Figure 4-17. 

COPYING AND MOVING CELLS 

You'll often have reason to cut or copy a set of cells from one portion 
of the spreadsheet and transplant them to another. The procedure is 
straightforward. 

To cut or copy one cell: 

1. Select the cell to cut or copy. 
2. Choose the Cut or Copy commands as desired (or better yet, press 

Command-X for Cut or Command-C for Copy). 

3. Select the cell you want to contain the copied or cut data. 

4. Choose the Paste command from the Edit menu (or press Com
mand-V). 

To cut or copy more than once cell: 

1. Select the range of cells to cut or copy. 

2. Choose the Cut or Copy commands as desired (or press Command-X 
for Cut or Command-C for Copy). 



Spreadsheet Strategies 143 

3. Select the same number of cells in the destination range as you did 
when you originally cut or copied the cells, or, select the upper-left cell 
of the destination range you want to contain the copied or cut data. 

4. Choose the Paste command from the Edit menu (or press Com
mand-V. 

You can apply the same multiple-cell cutting and copying techniques to 
entire rows and columns. 

Remember that Works erases any old contents of cells when new data 
is pasted in from the Clipboard, so if you don't want to lose what you've 
already labored on, provide enough room in the spreadsheet for the 
transplanted material. This is particularly important when pasting a 
range of cells. 

Works retains the original formatting of the cut or copied cell, even if the 
destination cell contains other formatting. The program provides no means 
of not pasting cell formatting. 

Using Move 

Moving cells with the Cut and Paste commands is time consuming, but 
Works offers a little-known Move command that performs the procedure 
with one less step. To use Move: 

1. Select the cell(s) you want to move. 

2. Choose Move from the Edit menu. 

3. Enter the destination cell in the edit box, and press the OK button or 
the Return key. If you are moving more than one cell, the 
Destination Cell box indicates the top left cell in the range. 

As a shortcut to the Move command, you can transfer information from 
one cell to another by selecting the original cell, holding down Command· 
Option, and clicking in the destination cell. Works moves the entire cell 
contents, including values, formulas, formatting, and cell notes. 

Note: The Move command works a little differently than standard cut
ting and pasting. First, Move can only be used within a single spreadsheet 
document. If you wish to move cells from one document to another, use 
the standard Cut, Copy, and Paste commands. Second, Move doesn't alter 
relative cell references, as the Cut and Copy commands do. (Relative and 
absolute cell referencing is discussed in the next section.) With Move, rela
tive cell references still refer to the same cell value as before the move. 
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Figure 4-18 Effects ofTranspose Command 

Using Paste With Options 

You can instruct Works to paste cut or copied cells with either values, or 
formulas and values. Cut or copy the original cell, as above, but instead of 
using the standard Paste command, choose the Paste With Options com
mand, in the Edit menu. 

• Click Values Only to paste just the value of the cell. Any underlying 
formula is ignored. 

• Click Both Values and Formulas if you want the entire cell, including 
formatting, cell notes, and formulas. 

The Transpose option in the Paste With Options dialog box lets you con
vert column-oriented cells into row-oriented cells, and vice versa (see 
Figure 4-18). The Transpose option only works when you have previously 
cut or copied a range of cells. 

Using Fill Down and Fill Right 

The Fill Down and Fill Right commands from the Edit menu are similar to 
straight copying, but with an added twist. They are used to . . . (fill in). 
You select one or more cells as "clone masters," along with additional 
blank cells that you want to contain the same data. 

One application of the Fill Right command is shown in Figure 4-19. 
Here, a basic "add-the-numbers-above" formula is placed in cell A5. That 
cell, plus four others to the right, are selected with the mouse. Choose Fill 



Spreadsheet Strategies 145 

Right, and the contents of cell A5 are copied to cells B5, C5, D5, and E5. 
Fill Down can be used to create a number series, as shown in Figure 4-

20. Cell Al contains a "seed" number for starting the series. Cell A2 con
tains a basic formula for continuing the series: =Al+l. By selecting A2 
and a range of cells below it, then using the Fill Down command, the for
mula is repeated, and a number series is produced. 

,.. "" .. File Edit Window Select Format Options Chart 

Figure 4-19 Basic Use of Fill Right 

,.. "" • File Edit Window Select FonT 

Figure 4-20 Using Fill to Create a Number Series 
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Overwriting Cells 

Pasting and filling with any of the methods described so far erases the pre
vious contents of cells. If a cell contains data you want to keep, be sure the 
paste range won't overwrite it. This is particularly important if the over
written cells are used in formulas elsewhere in the spreadsheet. 

Relative vs. Absolute Cell References 

There are two types of cell references: relative and absolute. Relative cell 
references relate to cells a certain distance away-two cells up and two 
three cells over, for instance, as diagrammed in Figure 4-21. When pasting 
or filling, Works updates these references to reflect their positions in the 
spreadsheet. For example, suppose cell A6 contains the formula =A5+2. 
You then copy and paste this formula into cell B6. The formula in cell A6 
is unaffected, but instead of the formula =A5+2 in B6, Works alters it to 
become =B6+2. 

To enter a relative cell reference, simply type the desired coordinates (or 
use the mouse to "point" at the cell you want). 

Usually, this automatic cell adjustment comes in handy, especially when 
using the Fill Right and Fill Down commands. Here, a formula that adds 
the values above it is filled across to adjacent columns. With each fill, 
Works adjusts the formula so that it adds the cells directly above it. 

Sometimes, the adjustment of relative cell references is not de*ed, so 
you must indicate to Works that the cell reference is absolute. Absolute 
cell references relate to cells at a particular column and row intersection, 
such as cell A4 or cell C9, and are indicated with a dollar sign ($) prefix in 

~0 Untitled (SS) . 
A I B I c I D I E II 

1 
2 
3 

4 
5 
6 
7 
8 
9 

10 
11 
12 

==--==~:t=:=--=~::t:::=+-~ 
. .,.~~~nc~d c!).!_~--··---------1·------! -------H 
------~·---+ r .... ocel13 up ---~--- ; ;; . i ! p ·----------··c··--------··-~·-····----------- Referencing cell~ ---------------·rj 

·-----··-----··-····· ..... ·----··------- ---·. - ... -------H 
1 Three cells left 1 i ! ! ·------ .... r .. - - ------r----··-----,. :""1: 
f : I I I .......... - ........................ t ................................. -:·····---··----.. -r--------- H 
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Figure 4-21 Representation of Absolute Cell References 
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Figure 4-22 Cluznging Just One Reference in Formula Entry 

front of both the column letter and row number. Works makes no adjust
ment to absolute cell addresses when copying or moving them to other cell 
locations. 

Cell references that are half relative, half absolute ar~ called mixed. A 
mixed cell reference contains a dollar sign ($) in front of either the row or 
column designator, but not both. To enter a mixed cell reference, type a $ 
before the row or column that is to be absolute. 

Works permits a keyboard shortcut when entering absolute cell refer
ences. To change a cell reference from relative to absolute, enter the refer
ence in the edit bar (by typing or pointing), then, with the insertion point 
immediately after the cell reference, choose the Absolute Cell Ref com
mand in the Edit menu (or press Command-A). Works automatically 
places the required dollar signs in front of both the row and column desig
nators. You can switch back to relative cell referencing by choosing the 
command again. 

Should you want a mixed cell reference, simply remove one of the dollar 
signs. Pressing Command-A with a mixed cell reference reverses each 
part of the reference: A$1 becomes $Al, and vice versa. 

If the cell contains a formula with many cell references, and you want to 
make only one of them absolute, select the desired reference with the 
mouse in the edit bar, as depicted in Figure 4-22, then press Command-A. 

SORTING 

Works provides a convenient method of sorting individual cells or rows of 
cells, helpful when preparing lists, charts, budgets, and many other forms 
of spreadsheets. Works sorts only by row, but you can apply the Transpose 
feature from the Paste With Options dialog box (see above) to invert 
columns of data into rows. Once in rows, you can sort the data, then re
convert it back into columns. 

The important thing to remember about sorting is that Works sorts 
only those cells you have selected. If a row contains cells not selected 



148 Inside MS Works 2 for the Macintosh 

when you give the sort command, the cells not selected will remain unaf
fected! To make matters worse, Works offers no undo for this action, so 
once you sort a spreadsheet, you're stuck with it. As an added precaution, 
get into the habit of saving the spreadsheet prior to sorting. That way, you 
can always revert to the old version if something goes awry. 

How to Sort 

To sort a series of cells, select them, then choose the Sort command from 
the Edit menu. Works allows you to choose sorting keys to avoid ties 
(although you will most often sort on just one key). The sorting keys iden
tify columns of most-to-least importance. 

For example, suppose you want to sort a range of cells first by last name, 
then by first name and ZIP code. This data is stored in cells B, A, and D, in 
that order. That makes the first sort key B, the second A, and the third D, 
as shown in Figure 4-23. The spreadsheet is sorted primarily by column B, 
but columns A and D serve as record-breakers, in case of ties. Note that 
the Works spreadsheet module offers a somewhat more elaborate sorting 
routine than the Works database module. You may wish to use the spread
sheet to sort complex data, then cut and copy the cells to the database. 

Select Sort Keys: 

tst Key ~ 
®Ascending 

Column 0 Descending 

2nd Key ~ 
®Ascending 

Column 0 Descending 

3rd Key [!] ®Ascending 

Column 0 Descending 

[ C8ncel ) ' 
Figure 4-23 Sorting Keys 



Spreadsheet Strategies 149 

Works sorts either in ascending (A to Z, or 1 on up) or descending 
order. Click the appropriate choice beside each sorting key, then press the 
OK button. 

Works places blank cells and rows at the end of the sort. 

Sorting Order 

Numbers are sorted with the smallest negative value to the largest positive 
value (assuming ascending sort order). Text is sorted in alphabetical order. 
There is no difference between accented, upper-, and lowercase letters-A 
is sorted the same as a and a. 

WRITING SPREADSHEET FORMULAS 

One of the most dreaded experiences in life, apart from watching TV 
reruns of Hogan's Heroes and Gilligan's Island, is writing spreadsheet for
mulas. They seem complicated and difficult to decipher, requiring-it 
sometimes seems-a background in mathematics, computer programming, 
or both. 

But with a little patience and practice, you can be writing formulas with 
the best of them. By starting small and simple, you can learn to build upon 
"basic" formulas, and create complex routines for calculating just about 
anything you choose. 

Basic Formula Unit 

Even the most complex formulas are composed of small chunks, pieces 
that calculate just a portion of the spreadsheet at a time. This is the 
basic formula unit-my term, for the lack of a better one. The basic 
formula unit can stand by itself in a cell, or be a part of a more complex 
formula, such as: 

Basic Formula 

=2+2 
=Al+A2 

Within Complex Formula 

=AJ/44.98-(32*2"(2+2)) 
=Sum(Bl:B3)*Pi()/((Al+A2)-1) 

The complex formula contains the basic formula shown, plus a number 
of others. The complex formula is simply a series of basic formulas strung 
along in the correct order to produce the desired result. For example, the 
complex formula =Sum(Bl:B3)*Pi()/((Al+A2)-1) contains basic formula 
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units (the example values show how the formulas might be used to calcu
late actual spreadsheet data). Cells A1 and A2 both contain the value 2, 
and cells B 1, B2, and B3 contain the values 4, 4, and 2, respectively. 

Basic Formula 

A1+A2 
4-1 
Pi divided by 3 
Sum of cells B1, B2, and B3 
10 times 1.047 

Example Result 

4 
3 
1.047 

10 
10.47 

Although it takes up more spreadsheet space, you can just as easily con
struct this complex formula using several cells, as shown in Figure 4-24. 
You can use the technique of building formulas in separate cells until you 
get the formula working the way you want. Then, when you are satisfied 
that the results are accurate, you can combine the basic formula units into 
one complex formula. 

Notice that the complex formula above uses parentheses around some of 
the basic formula units. As explained in more detail below, the parenthe
ses tell Works to calculate those basic formulas fust If the parentheses 
are missing, Works calculates the formula using its own rules of prece
dence, which may have unexpected results if you're not accustomed to the 
way Works operates. See Rules of Precedence, below, for more details on 
this topic. 

Note: Works formulas may contain spaces between the various elements, 
such as =A1 + A2 or =3 + 2 * 7. 

The spaces are ignored when the formula is calculated. Works removes 
the spaces after you complete the formula and press the Return or Enter 
keys. The spaces are removed to save memory. 

=o Untitled (SS) 
A I B I c I D 

1 2i 4i =A1 +A21 I 1---t· .................................... : ..................................... : ................................................... j ............................... : 
2 2 f 4! =C 1-1 i i 1---t ..................................... i ..................................... : ................................................... l ............................... ': 
3 i 21 =P;()/C2j i 

....... -.... -.... -~-t-~.~:.~:~.~~i~.:~g~~~!~ 
Figure 4-24 Using Several Cells for Complex Formula 
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Formula Operators 

An operator is a mathematical symbol that tells Works how to compute 
two or more numbers (these numbers are technically called operands). 
Works uses both arithmetic and comparison operators. 

Mathematical Operators A formula may contain one of more of the fol
lowing mathematical operators: 

Operator 

+ 

* 
I 
() 

Function 

Addition 
Subtraction and negative numbers 
Multiplication 
Division 
Ordering of operations; these calcula

tions are performed first 
Exponentation (raise to the power of) 

The minus sign is used for both subtraction and negation. Formulas with 
negative numbers can be confusing when you need to review the construction 
of your worksheets. For best results, enclose the number and sign in paren
theses; this indicates both to you and Works that you want a negative number 
instead of subtraction. For example: 

Without parentheses 

·10A2 = ·100 

With parentheses 
( -10)A2 : 100 

If you don't type an operator after an operand (whether it be a number or 
cell reference), Works automatically inserts a plus sign ("+") before the 
next cell reference. You can use whatever operator you want by typing it 
from the keyboard. 

Comparison Operators Comparison operators compa,re two operands 
with the aim of figuring out which value, if any, is higher or lower than the 
other one. The result is shown as a 1 for TRUE and a 0 for FALSE. A for
mula may contain one of the following comparison operators: 

Operator Function 

= Equals 
< Less than 
<= 
> 
>= 
<> 

Less than or equal to 
Greater than 
Greater than or equal to 
Not equal 
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Comparison operators are designed to work with just two operands at a 
time, in a single cell. That is, 10=10 produces (or "returns") a result of 1 
(TRUE), but 10=10=10 results in an error. Why? Works first computes 
the frrst two comparisons, 10=10. That results in 1, which Works stores in 
memory. The last part of the formula then tries to compare 1 with 10. 
That returns a 0 (FALSE), even though all three operands are equal to one 
another. 

While you could theoretically build formulas that compare values in this 
way, there's not much benefit from it. This isn't to say that you can't com
pare two or more sets of numbers and arrive at a single result. For exam
ple, let's say you want to compare these values: 

Comparison Result 

10 = 10 1 
20 = 10 0 

Now compare the two fmal results: 1 = 0. In this case, the result is 0 
(FALSE), because the two aren't equal. You can write the formula that 
checks these two comparison sets in any of several ways: 

• Put the frrst set in parentheses, so that Works treats the set as a separate 
entity (Works also calculates the numbers within the parentheses first, 
based on its rules of precedence, discussed below). For example: 
=20=10=(10=10). A quick study of the formula reveals how it works. 

• Put each set in a separate cell, then use a third cell for the final com
parison. For example, in cell Al you place =10=10, and in cell Bl you 
place =20=10. Finally, in cell Cl you place the cell reference formula 
=A1=B1. 

• Use the AND logical function (see later in this chapter for more details 
on functions). The AND function returns a 1 (TRUE) only if all of its 
arguments are TRUE; otherwise it returns a 0 (FALSE). For example, 
=AND(10=10,20=10). 

This may seem like a lot of hassle just to fmd out the obvious: that num
bers are or aren't equal to one another. But the technique of using compari
son operators is an important one to keep in mind when building larger, 
more complex spreadsheets. For instance, you may want to find out easily 
if one group of numbers is higher or lower than a "set price" you have pre
viously provided. Or, you may want to prepare an inventory report that 
constantly monitors minimum inventory levels, and shows you when a par
ticular item should be reordered. 
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Rules of Precedence 

Precedence is the order in which Works tackles formulas that contain multi
ple operators. When the formula contains only one type of operator-like 
addition-Works simply goes from left to right, calculating each number in 
tum. But when the formula contains many different types of operators, 
Works follows a prescribed order of precedence. These rules help you in 
designing formulas that will provide the correct answer. Works performs 
its mathematical and comparison operations in this order: 

Operator Description 
A 

*and/ 
+and-

Exponentation 
Negation (negative numbers, not subtraction) 
Multiplication and division 
Addition and subtraction 

= < <= > >= <> Comparison 

You can readily see how the precedence of calculation affects formulas 
by writing a few compound equations. 

Formula Result 
=10*2-4 16 
=10-4*2 2 

In the frrst example, the equation reads 10 times 2 (20) minus 4 (total: 
16). The formula reads properly left to right because it happens to reflect 
Works' rules of precedence. In the second example, the equation looks like 
it might read 10 minus 4 (6) times two (total: 12), but that's not correct. 
Instead, it's 4 times 2 (8) from 10 (total: 2). 

Its not always possible (or convenient) to remember how Works is going 
to calculate a given formula. The parentheses provide an easy method of 
specifying an exact precedence of calculation. Works deciphers the formu
las inside the parentheses first, then finishes the rest of the formula. 
Parentheses can be used within other parentheses (nesting), in which case 
Works processes the innermost formula first, then moves outward; for 
example: =134A(2*(4+2)). Works frrst calculates 4 plus 2, then multiplies 
the result by 2, then uses that number as an exponent to 134. 

Using the Built-in Functions 

Functions are used as formula-writing shortcuts, and enable Works to cal
culate complex mathematical, fmancial, and statistical problems with a 
minimum of programming by you. 
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Funct;on name Argu~nt(s) "' ./ ---------, 
=lndex(Argument 1, Argument 2, Argument3) 

Equal~/ Closeten 
Open paren 

Figure 4-25 Basic Parts of Function 

The basic parts of a function are shown in Figure 4-25. All functions 
are specified by name, and use parentheses to enclose one or more argu
ments. While most functions require some type of argument, a few-such 
as Pi(), Rand(), True(), and False() do not. However, the parentheses are 
still required. 

The vast majority of functions require just a single value for an argu
ment. That value can be a number, a cell reference, and sometimes another 
function. When more than one argument is required, they are separated 
from one another within the parentheses by commas. 

Some Functions, such as: Sum(), need a range of cells, identified by a 
colon. For example, the range of cells between Al and BS, as shown in 
Figure 4-26 would be indicated as a function argument as: Al:BS. 

,. 

Works provides two ways of entering functions: 

• Type the function explicitly from the keyboard. You may use upper
and lowercase letters for the function name; Works will automatically 
format the function name with an initial cap, then all lowercase. Don't 
forget the parentheses and arguments. 

• 
B7 

File Edit Window Select For• 
--~--: 

:Sum( A 1 :B5 

Figure 4-26 Adding Range of Cells with Sum 
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• Choose the Paste Function command from the Edit menu, and scroll 
through the list that appears. Double-click on a function to enter it into 
the spreadsheet. Unlike the list windows that appear in the Open and 
Save dialog boxes, pressing a letter key on the keyboard does not 
advance you to the first function that starts with that letter. Use the 
scroll bar to quickly shuttle through the list. You may wish to com
pose a small function-entry macro if you find that you frequently use a 
particular function. Once the function has been pasted into a cell, the 
insertion point is automatically placed between the two parentheses of 
the function. Complete the function by entering the required argu
ments (if any). 

Works offers 64 built-in functions. Many are obscure, with special pur
poses that you may not require, especially if you are involved solely in 
fmancial or statistical vocations. You'll find that you use about ten percent 
of the built-in functions 90 percent of the time. 

The commonly used functions are th.ose that sum a range of numbers, dis
play and calculate dates and times, round numbers, and provide basic fman
cial calculations, such as internal rate of returns, and present value of invest
ments. Let's take a closer look at these functions, and how they are used. 

Sum a Range of Numbers By far, the most widely used spreadsheet func
tion is Sum(), which sums two or more cells. The function is designed to 
accept cell references as a range, so you merely indicate the start and stop 
cells of the range you want to sum, and Works does the rest. By adding a 
comma between ranges, you can add together many non-contiguous ranges. 

Here are some examples. Suppose cells A1 through A5 contains the 
numbers, 10, 20, 30, 40, and 50. In cell A6, you want to add them all 
together and show the result. While you could write a formula in cell A6 
that reads =Al+A2+A3+A4+AS, that's the hard way to do it. With Sum(), 
the formula becomes =Sum(Al:AS). 

Now suppose you always want to add the contents in cells B 1 through 
B5. Write the formula as follows: =Sum(Al:BS). 

Cells A1 through B5 comprise a contiguous (all together) range, so you 
can write the range in one step in the Sum() function; that is, 
=Sum(Al:BS). But suppose you want to add yet another set of five cells 
that are not contiguous to cells A1 through B5, such as D1 through D5. 
Use the same structure as above, but add a comma (as an indicator to 
Works that you are providing another argument), and the second range. 
The formula would read =Sum(Al:BS,Dl:DS). 

Finally, suppose you want to add one more cell to the argument list. 
That cell is E10. The formula becomes =Sum(Al:BS,Dl:DS,ElO). 
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A cousin to the SumO function is SSumO, which is designed to give the 
sum of numbers in the list of arguments as they are displayed on the screen. 
This maintains the desired number fonnatting throughout the spreadsheet. 
For example, let's say you have formatted a range of cells as fixed with two 
digits after the decimal point. 

Regardless of the actual numbers you enter into the cells, the values are 
shown in the cells with only a maximum of two digits to the right of the 
decimal point. The SSum() function adds the values actually displayed on 
the screen, not the ones stored in each cell. This can be helpful when you 
want to calculate fractional numbers and don't want to get bogged down 
with multiple digits to the right of the decimal point. 

Using Functions for Dates and Times Works offers ten functions for cal
culating and showing dates and times (and some are rarely used). These 
functions are somewhat difficult to master because they don't produce a rec
ognizable date or time, but a serial number that represents the date or time. 

You can appreciate the use of serial numbers for dates and times when 
you consider that Works is often called on to perform calculations on those 
dates and times. For example, you may wish to subtract 30 days from the 
current date as part of a spreadsheet that calculates aged receivables. To 
accurately subtract 30 days from the current date, Works must take into 
account the starting date, the number of days in the month, whether or not 
it's a leap year, and so forth. Serial numbers make the task easier. 

The date/time serial number is composed of two parts. 

• The numbers to the left of the decimal point represent the number of 
days since January 1, 1904 (the start of the Macintosh's internal clock). 
The maximum number is 49710, which represents February 6, 2040 
(the end of the Mac's internal clock). 

• The numbers to the right of the decimal point represent the number of 
minutes since midnight of the current day. 

Here are some examples: 

Serial Number 

31423 
31423.0145833333333 
31423.5145833333333 
0.71875 

Day 

1/12/1990 
1/12/1990 
l/12/1990 
n/a 

Time 

n/a 
12:21 am 
12:21 pm 
5:15pm 

The basic date/time function is Now(), used without an argument. The 
Now() function returns the current date in serial number fonnat. Use the 
Set Cell Attributes command from the Format menu to convert the serial 
number to a date or time. Click the appropriate radio button in the dialog 
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Figure 4-27 Samples of Date and Time Formats 

box, then click OK. Figure 4-27 shows a series of examples using different 
cell formatting for the date and time. 

Often, you will want to furnish Works with some particular date or time, 
so that you can perform calculations with it. Works has several functions 
that accept English-like date and time nomenclature, and convert it to serial 
format. 

Function 

Date() 
Time() 

WhatltDoes 

Converts specified date into serial number 
Converts specified time into serial number 

The Date() and Time() functions expect you to enter the date and time 
arguments in a specific manner. The result could be in error if you get the 
arguments mixed up . The proper format for the Date() function is 
Date(year, month, day), which is in reverse of the customary date format. 
The proper format for the Time() function is Time(hour, minute, second). 
You can add spaces between each argument, but they aren't needed. Some 
examples: 

Entry 

=Date(1990,1,10) 
=Time(S,l ,lO) 
=Time(S,l,O) 

Equivalent Date 

January 10, 1990 
One minute after 5 AM, and 10 seconds 
One minute after 5 AM, and no seconds 

The Date() and Time() functions are actually redundant; Works doesn' t 
need them to convert a date or time into the proper serial format. As long as 
you enter the date or time in one of the accepted formats, Works accepts it 
and automatically converts the entry into serial form. The exception is when 
working with seconds. Works won' t allow you to enter a time, such as 
12:21:30 for 21 minutes after 12, and 30 seconds. 
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Works excepts any of the following time and date formats as text entries. 
The entry will be converted automatically to serial time/date format. 

Accepted Format 
1/90 
1/1/90 
Jan 1 
Jan, 1988 
Jan 1, 1990 
January 1, 1990 
1 Jan 
1 Jan, 1990 
1 January, 1990 
20:15 
3:30AM 
3:30 
3:30PM 

Format Type 
Short form date; month/year only 
Short form date 
Medium form date; day /month only 
Medium form date; month/year only 
Medium form date 
Long form date 
European medium form date, day/month only 
European medium form date 
European long form date 
24-hour time 
12-hour time, with AM 
12-hour time, AM assumed 
12-hour time, with PM 

Works also accepts these format entries: 

• Date format with a period after the month abbreviation, such as Jan. 1, 
1990. 

• Spaces, dashes, and slashes between the day, month, and year. 

• Use of 12- or 24-hour formats for time, although Works always dis
plays 12-hour format. 

• Either upper- or lowercase for AM and PM, but Works displays in 
upper case. Note that Works assumes AM if you leave off AM or PM 

• p for PM and a for AM when indicating time. 

• Deletion of the "19" in front of the year; Works assumes you are work
ing in the 20th Century and adds the 19 automatically. 

You can't calculate dates before 1904, so an entry such as 1/1/1875 
forces Works to consider the date as text. 

You can manually enter a time and date (using the accepted formats 
shown above), then use the Set Cell Attributes options to convert the serial 
form to a recognizable date and time. 

Sometimes, you may want to enter a date or time and not have Works 
convert it to serial format. As long as you don't want to perform any calcu
lations, you can force Works to treat the date or time as text by adding a 
double-quote at the beginning of the entry. 

Other Works date/time functions perform the opposite of Date() and 
Time(). They convert serial numbers into legible time and dates. These 
offer more flexibility than the options in the Set Cell Attributes dialog box. 



Function 

Day() 

Hour() 

Minute() 

Month() 

Second() 

Weekday() 

Year() 
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WhatltDoes 

Converts serial number into a day of the 
month (1 through 31) 

Converts serial number into an hour of the 
day (1 to 12) 

Converts serial number into a minute of 
the hour (0 to 59) 

Converts serial number into a month of 
the year ( 1 through 12) 

Converts serial number into a second of 
the minute (0 to 59) 

Converts serial number into a day of the 
week ( 1 through 7); the weekday starts 
on Sunday (Sunday= I) 

Converts serial number into a year 

The Now() function can be combined with other date/time functions for 
enhanced utility, as shown in Figure 4-28. Here's how the formulas works: 
The Now() function first calculates the current date and time, and provides 
Works with the equivalent serial number. That serial number is then used 
to display the desired hour, minute, day, and so forth. 

You can also extend the formula to add a certain number of days o:r hours 
to the date or time. For example, to compute the date from 30 days from 
now, use the formula =Now()+30. 

Format the cell so that it displays the date in the desired format. Instead 
of today's date, it will be the date in 30 days. All of the other date and time 
functions can be used in similar formulas. For example, use =Now()-32 to 
fmd those accounts that are more than 31 days past due. 

=:0 Untitled (SS) 
A I B I c I Dl 

1 31119.5625! =Now() l Seria 1 format i i 
t--2----1:::::=:::::::::~:::::::::::::1::::::::::::::::::::::::::::::::::::::::::::1:::::::::::::::::::::::::::::::::::::1=::=::::::] 

3 14l =Day (Now()) I Day I : 
1---t······-"""''''''''''''''''''''"''''''''''''''''''"'"'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''"''''''"'''''' .. ~ 

4 3! =Month(Now()) i Month i I 1-----f ..................................... : ............................................... : ........................................... : .................... . 
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~---6 -~:::::::::::::::::::::::::~::?.:~:?.:r::::::~Y.~~~{~~~~?.?.::::::::c:::::::::::::Y.~~~::::::::::::::::r:::::::::::::::::l 
7 13! =Hour(Now()) I Hour i 1 1-----f ..................................... : ............................................... : ........................................... : .................... ( 
8 30~ =Minute(Now()) i Minute i i t---1 ..................................... : ............................................... : ........................................... : .................... . 
9 0! =Second(Now()) i Second i i 

~--... -.... -.. ~-~.--~.. ~.~~~~~~:.:.~~~~~~~~:.~.:.:.:.:.:.:.:.:.:.:.~.:.:;I.~~~.:.~.~~~~:.:.:.~.~:.:.:.:.:.:.:.:~:.~:.:;.:.:~:.~:;;;.~;I;;;;;;;;;;;;;.:;;;;;;;.:.:;~:.:;.:.~~~~~;;;r:~~;;;.;;;~;;;J 
Figure 4-28 Samples of Now() Function in Spreadsheet 
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· When using the Now() function, the current time and date are not updat
ed until the spreadsheet is recalculated. You can always force recalculation 
by pressing Command-= (or by choosing the Calculate Now command in 
the Options menu). 

The Paste With Options command in the Edit menu offers a useful trick 
for transferring date and time information to other cells in the spreadsheet. 
The Paste With Options command lets you paste either the displayed value 
of a cell (in this case, a formatted date/time, or a serial number), or the 
date/time formula. 

1. Select the cell to copy. 

2. Press Command-C to copy the contents of the cell to the Clipboard. 

3. Select a destination cell. 

4. Choose the Paste With Options command from the Edit menu. 

5. Select the Values Only option if you want to transfer just the serial 
number or formatted date/time, or, select Both Values and Formulas 
if you want to transfer the entire formula and value intact. 

6. Click the OK button. 

Dates and times transferred with the Values Only option lose their con
nection to Mac's internal clock. However, you can convert the time and 
date back to their equivalent serial form by choosing the General format 
option in the Set Cell Attribute dialog box. 

Number Format Functions Works offers a number of useful functions 
for setting numerical formats. These functions are Round(), lnt(), Sign(), 
andAbs(). 

Round(). The Fixed number format (in the Set Cell Attributes dialog 
box) lets you set the number of digits to the right of the decimal point. 
Another method accomplishing the same goal is the Round() mathematical 
function. Round() uses two arguments: the number itself (or a cell refer
ence), and the number of digits you want the number rounded to. Works 
follows standard rounding conventions: digits 0 through 4 are rounded 
down, and digits 5 through 9 are rounded up. For example: 

Original Number 

10.9873 
1384.13 

Rounded Number 

11 
1384 

lnt(). The lnt() (integer) function simply lops off any digits to the right 
of the decimal. The integer function does not round up or down. For 
example: 



Original Number 

10.9873 
1384.13 

Integer 

10 
1384 
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Sign(). The Sign() function reports the sign of a number-either positive 
or negative. If the number is positive, the function returns a 1; if the num
ber is negative, the function returns a -1. 

Abs(). The Abs() (absolute) function translates any negative number to a 
positive number. That is, -123 becomes 123. 

Rand(). Works can provide a 16 digit random fractional number between 
0 and 1 with the Rand() function. You can use this function to set a guess
ing range for the IRR() and Rate() financial functions, or to generate lucky 
numbers for the next Lotto game. The function produces a new random 
number every time the spreadsheet is recalculated. 

Statistical Functions Two statistical functions often come in handy no 
matter what kind of spreadsheet work you do. 

Average(). This averages a list of numbers and displays the result You 
can use either single values, cell references, or cell ranges, such as: 

Formula 

Average(Al,B2,DS) 
Average(Al:AS) 
Average(Al:AS,B6) 

What It Computes 

Average of values in A1, B2, and D5 
Average of values in cells A1 through AS 
Average of values in cells A1 through AS, 

plus cell B6 

Count(). This gives the count of numbers in a list. If you specify a 
range of cells, Works counts only those cells that contain real numbers, not 
blanks, labels, or formulas. 

Financial Calculations Financial calculations are the backbone of the 
Works spreadsheet, although not everyone uses the spreadsheet to calculate 
profit, loss, and other such money matters. The eight fmancial functions 
use similar arguments and are constructed in much the same way, so after 
you get used to one function, the others come more naturally. 

Function Arguments What It Calculates 

FV rate,nper,pmt,type Future value of 
investment 

IRR range,guess Internal rate of 
return 

M1RR range,safe,risk Modified internal 
rate of return 



162 Inside MS Works 2 for the Macintosh 

Function 
Nper 

NPV 
Pmt 

PV 

Rate 

Arguments 
rate,pmt,pv,fv,type 

rate, val-l, val-2, ... 
rate,nper,pv,fv,type 

rate,nper,pmt,fv,type 

nper,pmt,pv,fv,type,guess 

What It Calculates 
Number of payments 

of investment 
Net present value 
Periodic payment of 

investment 
Present value of 

investment 
Rate returned on 

investment 

Following are the defmitions of the arguments used in these functions. 
(Works assumes standard accounting cash flow procedures where cash 
received is represented by a positive number, and cash paid out is repre
sented as a negative number.) 

• fo-Future value of some asset. A positive number. 
• guess-Guess specifies a starting number for calculation, and is used 

to help Works zero in on the target range. If you omit guess, Works 
assumes it is 0.1 or 10%. A starting value of 0 to 1 will yield mean
ingful results. 

• nper-The number of payments (or periods) for payback of the loan. 
If paying by the month, a five-year loan has 60 periods. 

• pmt-Payment amount, each period. 

• pv-Present value of some asset. A negative number. 
• range-The IRR function gives the internal rate of return for a series 

of cash flows; the range represents the cells that contain those cash 
flow numbers. 

• rate-Interest rate for loan, in percent. The rate must reflect the peri
od specified in nper; otherwise, the calculation will be in error. For 
exampl~, don't mix a yearly interest rate of 10 percent with monthly 
payments, and vice versa. 

• risk-Risk is the rate at which the positive cash flows can be reinvested. 
• safe-Safe is the rate returned by an investment that will successfully 

fmance the negative cash flows. 

• type-Indicates whether payments are made at the beginning or ending 
of the period. A type of 0 means payments are assumed to be made at 
the beginning of the period; a type of 1 means payments are at the end. 
When no type is given, Works assumes 0. 

• val-l, val-2, etc.-Each value is a cash flow amount. You can have as 
many values as you wish; separate each with a comma. 
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Shortcuts to Building Formulas 

Works supports a couple of time-saving shortcuts when building formulas. 
These shortcuts apply only when actually writing or editing a formula-the 
formula appears in the edit bar above the spreadsheet window. 

• Click on a cell and the cell reference is added to the formula. 

• Drag around a group of cells and the cell range is added to the formula 
(as in Al:AlO). 

• Use the Fill Down and Fill Right commands to quickly copy formulas 
as desired. Remember the rules of absolute vs. relative cell referencing. 

• Re-use formulas when possible, instead of typing them in agaiQ.. Use 
the Copy and Paste commands to make the duplicates, then edit the 
formula as required. 

Works always places a plus sign ( +) between successive cells that you 
select with the mouse when building formulas. Works assumes you want to 
add the cells together, but you can always choose another operator instead. 
Before selecting the second cell, type an operator, then click on the cell. 
Works understands you have added your own operator, and won't provide 
the plus sign. 

The built-in functions require commas to separate each argument. You 
can use the point and click method of indicating cell references to use as 
arguments, but remember to manually type a comma between cell refer
ences, or Works will add the default plus sign. 

SAVING SPREADSHEETS AS EXPORT FORMAT 

Most of the spreadsheets you create will be saved in Normal format. But 
Works also lets you save ~ in Export or Text-only format. This allows you 
to trade complete spreadsheets with the word processing and database mod
ules of Works, or with a completely different application. 

Before clicking the Save button to record a spreadsheet onto disk, click 
the Export button in the Save or Save As dialog boxes. Works then pre
sents a dialog box where you can choose from three different Text-only for
mats: SYLK, Text With Values Only, and Text With Values and Formulas. 

SYLKFormat 

SYLK stands for SYmbolic LinK, a ftle format pioneered by Microsoft for 
use with electronic spreadsheet and database programs. All of Microsoft 
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spreadsheet programs, including Multiplan and Excel, support the SYLK 
fonnat You save a file in SYLK fonnat only if you are transferring it to 
Multiplan, Excel, or some other application (on the Macintosh or another 
computer) that supports SYLK. Files stored in SYLK format are composed 
of special code words that only SYLK-compatible programs can understand. 

SYLK files store: 

• Values 

• Labels 

• Formulas 

• Cell formatting, such as centering and boldface 

• General worksheet formatting, including column width 

Text With Values Only 

Use the Text With Values Only option for true Text-only export of a Works 
spreadsheet. Files saved in this format are converted to straight text with 
tabs separating columns and returns separating rows. Only the values of 
formulas are saved; the formulas themselves are not. 

Use the Text With Values Only option when transferring whole spread
sheets to some other application where only the data of the spreadsheet 
counts, and not the formatting or formulas. For example, you can open a 
Text With Values Only document with the Works word processor or 
database. In the word processor, columns are separated by tabs and rows 
by returns. In the database, columns become fields and rows become 
records. You can similarly move entire Works spreadsheets to other 
Macintosh applications, such as Microsoft Word. Text With Values Only 
files store: 

• Values 

• Labels 

Text With Values and Formulas 

The Text With Values and Formulas option is the same as the Text With 
Values Only option, explained above, but fonnulas also are stored, instead 
of just their numeric values. A major application of the Text With Values 
and Formulas option is when moving Works spreadsheets to other 
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Macintosh applications that understand spreadsheet formulas, but don't 
support SYLK. 

Text With Values and Formulas files store: 

• Values 
• Labels 
• Formulas 

Both Text With Values Only and Text With Values and Formulas files 
appear as Text-only files on the Macintosh Desktop. To open one of these 
ftles in any of the Works modules, click the Export option frrst in the Open 
ftle dialog box. 



CHAPTER 5 

Charting Your Course 
with Works 

Is there truth in the old adage that "a picture is worth a thousand words"? 
It's easy enough to fmd out. 

The average person can speak about 115 words per minute. In about 8 
1/2 minutes, that person will have spoken 1,000 words. A chart can con
tain most, or all, of the information in the same 8 1/2-minute speech, but be 
completely absorbed in 30 seconds or less. So not only is a picture worth 
at least a thousand words, it's a far more efficient story-teller. 

This chapter examines the charting features built into the Works spread
sheet module. The chart-making commands are simple enough to use, but 
good graphs require more than just entering a few numbers into the spread
sheet and selecting a couple of options. If you want your charts to commu
nicate, you need to carefully select the graph type best suited for your mes
sage and data. You may also wish to import the chart into a word processor 
or spreadsheet document, or edit it with the Works Draw tools. This chap
ter details these topics as well. 

WHEN TO USE CHARTS 

Charts can be used to dramatically increase the effectiveness of your pre
sentations. 

Use charts to: 

• Show and tell facts quickly and efficiently in order to cut down on 
valuable presentation time. 

• Sell a point of view by way of visual reinforcement. 

167 
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• Provoke faster decisions at a company meeting. 

• Increase mental retention of the facts so that your ideas stay with the 
audience as long as possible. 

• Save the reader's or viewer's time by packing dense statistics into one 
or more charts. 

• Show how numbers and other statistics relate to one another. 

• Compare two divergent statistics, and plot a comparison that would 
otherwise be difficult to mentally perceive. 

• Demonstrate non-visual concepts and·ideas visually. 

• Focus the reader's or viewer's attention on certain facts or figures. 

• Provide "visual relief' in an all-word report or oral presentation. 

• Add credence to facts and figures. 

• Attract attention by using the "novelty" of business graphics. 

WHEN NOT TO USE CHARTS 

Charts may not always be the answer you're looking for. Sometimes, it's 
better not to create a chart than to try and use charts to bend the facts, or 
muddle an otherwise adequate presentation. 

H your aim is to impress somebody, but you don't have impressive fig
ures to work with, don't make matters worse by showing off the poor num
bers in a chart. Resorting to graphics trickery-manipulating the perspec
tive, scale, or proportion-rarely pays off. The more sophisticated the 
audience, the more likely they are to catch you trying to fool them. 

Your concept may also be too abstract to be effectively converted into a 
chart. Though you may have lots of numbers, those num~ers may not com
pare to anything. The purpose of a chart is to show some type of numerical 
comparison, so a graph that compares nothing is meaningless. 

Concepts that are too simplistic, specific, or familiar are also not good 
candidates for charting, such as a chart that shows no growth. The chart 
adds nothing to the perception of the data being presented. 

Charts force approximation of numbers, and specific data, particularly if 
it will be used by someone other than yourself, may be best left in tabular 
form. You probably wouldn't want to provide your accountant with a line 
chart that shows your aged accounts receivables, for instance. Your 
accountant needs the actual numbers to work with. ' 

Data that's familiar to your audience also needn't be charted. If it's 
widely held among your group that it's doing 20 percent less business than 
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other departments within the company, a chart pointing up this fact is hard
ly necessary. 

PICKING THE RIGHT CHART TYPE 

On the outside, numbers look much the same. A stack of figures showing a 
rise in interest rates may look the same as a stack showing a fall in grain 
production. But on the inside, the numbers may tell a different story. It is 
this story and how you want to tell it that dictates the type of chart you 
should use. 

Picking the right kind of chart makes a lot of difference if your message 
is to come through to your audience. Even if the charts you make are for 
your own use, you '11 want to choose the right kind so you can more easily 
and accurately analyze the numbers. 

Process of Elimination 

There are five major types of business graphs, with variations of each. 
Picking the right one out of all the possible choices can seem a monumental 
task. Fortunately, the job is made easier by a process of elimination. 

For every chart you want to make, follow these three steps: 

1. Identify the message. 

2. Determine the comparison. 

3. Select the chart. 

Don't forget the ftrst step: identify the message. It's the key to creating 
successful business graphics. You'd be surprised how many charts are 
made each day that don't have a meaningful message. 

Why is it so critical to have a message? Because a message enables you 
to pick a suitable chart for your numbers. More importantly, your audience 
is more likely to perceive the purpose of the chart, and readily accept the 
information contained within it. Without a ftrm message in mind, you run 
the risk of your audience misinterpreting the chart, which can lead to disas
trous results. 

Identify the Message Let's say you want to create a chart showing the per
fonnance of three divisions in a company. There are several ways you 
could reveal the facts, depending on the message you want to convey. 
Table 5-l shows the data that each of the next three charts will use. 
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Company Sales 
A B c Total 

19&3 325 119 &4 52& 

19&4 330 156 &1 567 

19&5 319 171 &7 577 

19&6 32& 1&1 93 602 

Total 1302 627 345 

Table 5-1 Data for Message Chart 

Figures 5-l through 5-3 show the different interpretations of the data: 

• In Figure 5-l, the message says that the total overall performance for 
the company is going up. The chart includes each department, and the 
contribution it makes to the revenue of the company. 

• Figure 5-2, though made from the same data as the previous chart, 
looks completely different. Now, the message has changed from 
showing increasing revenue to comparing the three departments to one 
another, ranking them in order of performance. 

Sales are steadily rising 

Dept 

1963 1964 

Figure 5-1 Total Performance 

1965 1966 

Sales 

300 
inOOO's 

0 
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Revenue from Department A is more than 
Departments B and C combined 

Tow Yearly Revenue ( 1963-1966) 
0 200 400 600 600 1000 1200 1400 

Dept A 

DeptB 

DeptC 

Figure 5-2 Department Ranking 

• Figure 5-3 shows that department B has slowly improved its perfor
mance during the past several months, while the other two have 
remained fairly static. 

The performance of Department B is 
steadily increasing 

350.----------------------------------, 

Departm.elll A 

250 

Revenue 
in OOO's 150 1-

~ Departm.elll B 

0~----------~----------~----------~ 
1983 1984 1985 1986 

Figure S-3 B Improvement 
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Economy TreDdliDe 
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Figure 5-4 100-Year Economy Trendline 

Sometimes you may have a good idea of the message in your chart, but 
your audience may not be so quick to catch on, like the message in Figure 
5-4. 

A couple of possible messages immediately come to mind in this chart, 
none of which may be the message you are trying to get across: 

• The 1929 Depression was the lowest point in the U.S. economic history. 

• Wars stimulate the economy. 

• Minor depressions follow all major wars. 

• The economy is more stable and prosperous now than ever before. 

The best way to help your audience zero in on the particular message 
you're trying to convey is to write the message as the title of the chart. 
Replace non-descriptive titles with ones that state your message, such as 
"Profits and Revenues Take a Dive," or "Our Annual Profit Surge Came 
One Quarter Early." H the message is too long for a title (more than eight 
or ten words), it is acceptable to pare it down into a manageable chunk. 
However, don't reduce the message so much that it is cryptic and impossi
ble to understand. 

Determine the Comparison Your proposed message will lead you to a 
comparison. There are five types of comparisons: parts, item, time, fre
quency, and correlation. 

• Parts-The percentage of components that make up a total. Shows the 
size of individual components (or parts) and how they contribute to the 
total picture. As an example, assume five components make up a fm

. ished product. The cost of manufacturing that product is a known 
value, say five dollars. Each component or part contributes some per-
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centage to the total cost-some more; some less. To find out if your 
proposed chart compares parts as they relate to the total, look for these 
key words in the message: percentage, share, contribution, total, sum, 
ratio, and proportion. 

• Item-The ranking of items. This comparison may show that the 
items in the chart are less than, more than, or equal to one another. 
You'll know you're looking at an item comparison if you encounter 
these key words (or their synonyms) in the message: more than, less 
than, equal to, ranks, higher, and lower. 

• Time-Change over time. Compares how a person gets tall as she 
grows up, for example. This time can be in hours, days, weeks, 
months, years, etc. You can tell you're dealing with a time comparison 
if words such as change, increase, decrease, grow, decline, rise, fall, 
and fluctuate are in your message. 

• Frequency-The number of items that fit into pre-determined 
categories. One good example of a frequency comparison shows how 
many studentS in a class got As, how many got Bs, and so forth. Key 
words to look for: frequency, distribution, range, fall into, how many, 
and how often. 

• Correlation-The relationship between two sets of numbers. The cor
relation comparison pits two sets of numbers together, to see if there is 
a relationship between them. For example, there would likely be a 
comparison between car sales and the selling price of the car. The 
lower the price, the more people are likely to buy it. Key words to 
consider are: related to, changes, increases/decreases with, and varies. 

Don't worry if your message doesn't include one of the key words men
tioned above. Write down the message (so you can study it), and consider 
alternative words for it Consult a thesaurus and dictionary if you need help. 

Select the Chart You've done most of the work already in deciding which 
chart to use. Once you know the message, and what you're comparing, you 
have arrived automatically at the the correct type of chart to use. Although 
there are many varieties of business graphics, 80 percent of charts you will 
use will fall into one of the following three types shown in Figure 5-5: pie, 
column, and line. 

Selecting the appropriate chart is even easier if you refer to the table in 
Figure 5-6, which was adapted from the excellent tutorial on business 
graphics, Say It With Charts (Gene Zelazny, 1985, Dow Jones-Irwin). The 
five types of comparisons are listed on the top; the main chart types along 
the side. Keep in mind that the table represents the recommended choice; it 
is not meant to be an absolute authority. Microsoft Works can't create 



17 4 Inside MS Works 2 for the Macintosh 

Figure 5-5 Chart Types, Plain Examples 
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Figure 5-6 Chart Matrix 

some of the charts, including dot and bar (in this case, "bar" means hori
zontal bar), but they are shown in the table in case you wish to use a stan
dalone graphing program. 
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PIE CHARTS 

Pie charts are popular because they're easy to make and easier still for an 
audience to comprehend. They're used almost exclusively in parts compar
isons. The pie is a fmite circle, and is divided into portions, or slices. Each 
slice represents an individual component, a percentage or share of the total. 
That's perfect for a parts comparison. As you can see in Figure 5-7, the 
larger the part, the bigger the percentage, so the thicker the slice. 

Pie charts suffer from some limitations. By their nature, pie charts can't 
show the parts of more than one total at a time. You can' t, for example, 
show the totals of office expenditures for two separate years in the same 
chart. Pie charts should be limited to fewer than eight slices. With more 
slices, it's difficult to compare how the parts relate. Combine some of the 
smaller parts in a miscellaneous or other grouping. 

Here are some general notes about pie charts. 

• The most important slice should start at the 12 o'clock position. 
Position the remaining slices in descending (largest-to-smallest) or 
ascending (smallest-to-largest) order. 

• If there is no single important slice, order all the slices in descending 
or ascending numerical order. 

Put the most important slice et 
the 12 o'clock position 

slic~ 

Duplicate labels when creating 
multiple pie cherts 

Figure 5-7 Pie Chart 

Pull out the important slice 

Breek out e single slice into a 
stacked ber chert 
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Product A contributes the largest to 
the company's revenue 

Product A 

Figure S-8 Pie Chart 

• Pie charts suffer from three problems: lack of accuracy, difficulty in 
comparing small or closely related items, and difficulty in labeling. If 
these problems can't be overcome, choose a stacked column chart 
instead. 

• When necessary, use arrows or lines to connect labels with pie slices. 

• Important slices can be pulled away from the rest of the slice to add 
emphasis. This is called an exploded pie chart. Exploded pie charts 
must be created with the Works Draw tools (explained later in this 
chapter). 

• Avoid pulling out all the slices. Comparisons are harder to make. 

• Pie slices can be broken down into sub-groups by the use of additional 
(smaller) pies. 

• The labels should repeat for each pie in a chart. Avoid labeling just 
one pie, as that causes the viewer's eye to dart back and forth to get all 
the information. 

COLUMN CHARTS 

Column charts (incorrectly called bar charts in Works) are best used to 
show the change of a single item over time. Each period of time has its 
own column. As you can see in Figure 5-9, the taller the column, the 
greater the value of the item. Because of their design, column charts 
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As expected., sales slumped 45 percent 
during the summer months 

Jn Fell Mu Apr MAy J'II.D. J\ll A'US/ 

Figure S-9 Basic Column Chart-One Series 

emphasize levels of magnitude. Differences from one time period to anoth
er are easy to spot. 

It's possible to compare an item during several ~ets of time in one col
umn chart. Each set is called a series. For example, say you are plotting 
the quarterly sales of a company. The columns for the four quarters in the 
current year are shown in black. The columns for the quarters of last year 
are shown in gray. You can use patterns, stripes, or colors to differentiate 
each series. See Figure 5-10 for an example. 

Overall., sales are up this year 

Ill This year II Last year 

1st QTR 2nd QTR 3Id QTR 4th QTR 

Figure 5-10 Multiple Series Column Chart 
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Ted has consistently outsold Joe 
throughout the year 

1st Qtr 2nd Qtr 3rd Qtr 4th Qtr 

Figure 5-11 Stacked Column Chart 

Ted 

You should limit yourself to stuffmg no more than four series in one col
umn chart. And, avoid plotting no more than six or eight numbers for each 
series. Too many columns make the chart difficult to understand. 

Stacked column charts are an effective alternative to the multi-series col
umn chart. These charts are composed of several columns-one for each 
time period-but the series are shown stacked on one another. Each seg
ment is a different series. The stacked column chart is useful when y,ou 
need to see how the various series are contributing to the whole. For exam
ple, you could show how departments A, B, and C each contributed to last 
year's profits (see Figure 5-11). The length of the segments readily reveals 
a comparison. 

These general notes on column charts will help to produce them more 
successfully. (See Figure 5-12 for samples.) 

• Avoid thin columns. Break up the graph into several smaller charts 
when plotting many data points and series. 

• Column charts should be limited to plotting no more than two series of 
data, although they can accommodate up to four. Cluster or overlap 
the columns to make it easier to read the chart. 

• The front columns in an overlapped grouped chart should be consis
tently shorter than the columns behind. Remember that overlapping 
stresses the difference between the lengths of the columns. 

• The space between the columns should be no wider than the columns 
themselves, preferably smaller. 



Cluster the columns vhen you vent to 
emphasize the difference in height 

Emphasized De-emphasized . . 

Use a drop grid and direct labelling 
for maxi mum emphasis 

Figure 5-12 Column Chart Gallery 
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Whenever possible, limit column charts 
to no more then tvo sets of data 

Place the dominant column on the 
bottom, and make it darkest 

• Column charts designed primarily to point up a comparison don't 
require a grid. A grid should be added when it's important to show the 
actual values represented by the columns. 

• A drop grid can be used to emphasize the data, or to show the absolute 
values of the columns. Absolute values can also be presented by label
ing inside the columns. 

• When creating a stacked (or subdivided) column chart, place the domi
nant or most important element on the bottom. Use different colors or 
patterns to help distinguish each of the segments. 

• Join the tops of segments in a grouped colurrm chart to emphasize the 
trend or relationship between similar items. 

• When plotting a histogram, choose the proper number of ranges to 
adequately reveal the frequency distribution. Too few or too many 
ranges hide the pattern. All the ranges should be of equal size, and all 
ranges should be clearly labeled. 
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LINE CHARTS 

Column and line charts are used for much the same thing, namely, plotting 
the course of an item through time. Because the line of a line chart is 
unbroken, the effect of change-either up or down-is dramatically 
emphasized. Sometimes, this is exactly what you want; other times it isn't. 
The moral: Be extra careful when making a line chart. Be sure the dramat
ic impact of the line won't distract your audience from your idea. See 
Figure 5-13 for an example of a basic line chart. 

Like column charts, line graphs can plot one item over several different 
series of time periods. This is the multiple line chart. One line could be for 
this year's expenditures, for instance; another line could be a projection for 
next year. Different colors, symbols, or textures are used to denote each 
series of data. A legend, usually placed off the side of the chart or within 
it, as in Figure 5-14, explains the meaning of each line. 

Unlike column charts, line charts can also plot more than one item over 
time. One line could be the revenue of store A for one year. Another line 
could be the revenue of store B for a year, and so forth. You should exer
cise caution and avoid plotting more than four or five lines in one chart or 
you may end up with a spaghetti graph, like the one in Figure 5-15. 

The following suggestions, along with Figure 5-16, will help you use 
line charts effectively: 

As expected, sales slumped 15 percent. 
duriDg the SIJmmer months 
--------------------------------~140 

~----------------------~~--P120 

~~--~~----~r-----~------~100 

~----------------~~--~------~80 

~------------------~~--------~60 

~------------------------------~40 

~------------------------------~20 

~--------------------------------~0 .Tan. Fe) !~Jar Apr MAy .Tun .Tul A. 

Figure 5-13 Basic Line Chart 
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Overall, sales are up this year 

--------------------------------140 
120 

100 

80 

60 

40 

20 

------------------~~------------0 1981 1982 1983 1984 

Figure 5-14 Multi-Series Line Chart 

Spaghetti chart 

------------------------------~140 

120 

100 

80 

60 

40 

20 

----------~---------------------0 lstQtt 2nd Qtt 3rd Qtr 4th Qtr 

Figure 5-15 Spaghetti Graph 

• Lines in a multiple line chart should have different weights, patterns, 
colors or symbols. The lines should be keyed directly on the chart or in 
a legend. 

• Grouped lined charts should not have more than four or five trendlines, 
especially if the lines cross each other. If the chart is difficult to deci
pher, break it into multiple charts. 

• A line chart can be combined with another chart for trend analysis. 
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Figure 5-16 Line Chart Gallery 
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• The plotted line should always be thicker than the grid and axis lines, 
but not excessively thick. 

• When plotting a histograph, choose the proper number of ranges to 
adequately reveal the frequency distribution. Too few or too many 
ranges hide the pattern. All the ranges should be of equal size, and all 
ranges should be clearly labeled. 

• Area charts are not line charts with coloring added below the lines. 
Area charts show cumulative effect-Area B is physically stacked on 
top of Area C; Area D is stacked on top of Area C, etc. 

• The bottom band of an area chart should be the most dominant or 
important element. When there is no dominant element, place the 
least fluctuating band on the bottom. Why? The excessive fluctua
tions on the bottom band incorrectly influences the appearance of the 
rest of the bands. 

ANATOMY OF A. CHART 

With the exception of pie graphs, all charts have a horizontal and vertical 
axis. The horizontal axis is often referred to as "X" and the vertical axis is 
referred to as "Y." In most line and column charts, the horizontal, or X, 
axis plots time; the vertical, or Y, axis plots value. 

The parts of the typical chart are shown in Figure 5-17, and are defmed 
in the following list: 

• Title. The, descriptive title of the chart. 

• Subtitle. A secondary title. 

• Legend. Text that identifies the data series (or categories) plotted in the 
chart. 
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Figure S-17 Chart Anatomy, with Callouts 

• Labels. Text that identifies the purpose or meaning of a plotted ele-
ment or value. 

• Key (or annotation). Explanatory text, usually for references. 

• Axis line. Defmes the X or Y axis. 

• Scale. Shows the graduations of the values plotted in the chart. 

• Grid line. Major (and sometimes minor) graduations of the scale. 

• Tick marks. Partial major or minor grid line. 

• Element. Identifies the item of comparison and marks its value. Can 
be a line, bar, column, dot, pie slice, etc. 

• Border. An aesthetic frame that encloses the chart. 

Not all of these elements are created with the Works' chart features, but 
can be added using the Draw tools, available when using the word proces
sor or spreadsheet modules. As you '11 see later in this chapter, you can edit 
any chart by copying it from the chart window, and pasting it into a word 
processor or spreadsheet document. The following table shows which chart 
elements are created in Works, and which must be added using Draw. Note 
that all Works Draw elements can be edited with the Draw tools. 
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Chart Element Created With Chart Notes 

Title Yes Optional 
Subtitle No 
Legend Yes Optional 
Labels Yes Optional 
Key No 
Axis lines Yes 
Scale Yes Adjustable 
Grid line Yes Optional 
Tick marks Yes 
Border Yes Invisible unless 

edited 

CHART DESIGN BASICS 

There are a number of design elements that are basic to every chart you 
create. These elements can be broken down into seven categories: simplic
ity, unity, pattern, text, chart mechanicals, scale, and proportion. 

Simplicity 

Unity 

The best chart is a simple chart. One of the most common flaws in chart 
making is trying to cram too much information in at once. A chart that 
tries to say too much often ends up not saying anything at all. The message 
isn't clear, and the chart is too difficult to read. 

Charts are meant to tell a story in a short amount of time. To help convey 
that story, the chart should have a uniform appearance. Incongruous ele
ments are distracting, hindering the speed at which the message in the chart 
can be digested. 

Pattern 

Empty bars, columns, and pie slices look bare and undramatic. For the 
greatest impact, the most important element in the chart should have the 
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darkest pattern (black or dark gray). Less important elements can be 
lighter, even white. You can use patterns for more emphasis. Patterns can 
also be used to differentiate or identify certain elements. Make sure that 
the patterns you choose don't clash. If you plan on editing the chart with 
Works, an4 your Macintosh supports a color display, you can change the 
colors of patterns, as well as other elements of the chart. 

0 

Even though a chart may be worth a thousand words (or more), almost all 
charts have text of one kind or another for the title, legend, labels, and 
annotations. 

Text Size and Placement The title is almost always centered over the 
chart, and is large and bold, to attract attention. The text style should be 
plain and simple. 

Subtitles should be added only when the chart requires it. The best subti
tles further establish the message of the chart. The subtitle can also indi
cate the unit of measure or the source of the chart. 

Axis label text is smaller and less bold than title text, and is placed as 
close to the two axes as possible. Label text should be written horizontally 
whenever possible. When there's not enough space, it's acceptable to 
rotate the entire label 90 degrees so it reads bottom to top (however, Works 
does not currently do this). Even though Works stacks characters on top of 
each other, it is not very attractive, as shown in Figure 5-18. For best 
results, you '11 want to edit the vertical axis label using the Works Draw 
tools. 

SpeDiliDg has steadily decreased 
silll:e 1979 

SpeDiliDg has steadily decreased 
siDce 1979 

Wrong Right 

Figure 5-18 Wrong and Right Ways for Vertical Axis 
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Labels may not always fit. Writing the years from 1960 to 1980 on a col
umn chart may make all the years run together. The alternatives? Choose 
different major divisions (two or five year periods, for example), or abbrevi
ate the labels. Start with 1960, then go to '61, '62, '63, and so forth. 

Legends and annotations are usually placed to the right or bottom of the 
chart (legends to the right; annotations on the bottom). A legend (also 
called a key) can be placed under the title of the chart, and function as a 
kind of subtitle. Both legends and annotations can be written in small text. 

Text Style Use a plain, undecorative text style (or font) whenever possible. 
Fancy, curly-cue text, like Venice, is hard to read and distracts the audi
ence's attention. If you want to highlight text, use boldface or italics. 

Chart Mechanicals The grid behind a chart acts as a kind of picture frame. 
It draws your eye to the important parts of the chart. The grid also serves 
as a calibrator, to help you better visualize the relationships and values rep
resented in the chart. 

Grid Column, bar, line, and dot charts are often made with a grid back
ground. The spacing of the grid corresponds with the major divisions in 
the X and/or Y scales-1 Os, 50s, I OOs, etc. 

Most line charts use both X and Y (horizontal and vertical) grid lines, so 
the eye can more easily see the relationship between the variables being 
plotted. Column charts are typically graduated with horizontal lines only, 
which mark off the values in the Y axis. 

Linear or Log Grid Most grids are evenly spaced, because the data is plot
ted linearly. The progression from one number to the next is an even unit. 
A logarithmic grid, on the other hand, shows the percentage rate of change 

L;near Log 
Figure 5-19 Linear and Log Chart Scales 
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(or ratios of change). With a logarithmic (or log) grid, an increase from 1 
to 2 is 100 percent. So is an increase from 2 to 4, and 4 to 8. Charts creat
ed on a logarithmic scale show the rate of change, not the actual change in 
absolute values. Refer to Figure 5-19 for examples of both linear (called 
"numeric" in Works) and logarithmic grids. 

Works creates only "semi-log" charts. These employ a logarithmic scale 
in the vertical axis only. 

Since charts are used to compare numbers, a scale is used to indicate the 
value of those numbers. When that scale is distorted, the numbers become 
distorted. With very few exceptions, you should always start the scale of a 
chart at zero. You can occasionally bend this rule, when creating indexed 
or log charts, for example. 

What happens when you don't start the chart at zero? Take a look at 
Figure 5-20. The chart on the left begins at 400 and extends to 700. Notice 
the volatility of the line. The excessive movement is caused by starting the 
Y axis scale at a point other than zero. The Y axis in the chart on the right 
starts at zero and accurately represents the values compared in the chart. 

A similar rule applies for the uppermost limit of the chart. You should 
stop the scale at an even increment just above the largest value in the 
chart. The chart will be improperly compressed if the upper scale limit is 
too high. 

Manipulating the scale of a chart is probably the most co~on tactic peo
ple use to purposefully mislead their audience. This and other ways of false 
charting are described in the satirical study, How to Lie with Statistics, by 
Darrel Huff (W. W. Norton Co., 1954). 

The economy is fluctuating 
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Figure 5-20 Non-zero and Zero Scale 
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Scale Placement Should the scale in a column chart go on the left or right 
side? It all depends. Convention says to put the scale on the left side of the 
chart. But if the values get very large on the right side, or the movement or 
values are more important on that side, put the scale there. 

Scale or Actual Values? The X and Y axes or your charts needn't be 
scaled, especially if you're only interested in showing the comparison 
between values and not the actual values. Most viewers prefer to know the 
quantity expressed in the chart, however. If you don't want scaled axes, 
identify the values by writing them alongside the columns or lines. 

Proportion Akin to scale is proportion. Line and column charts are often 
drawn so that they are semi-rectangular in shape. The exact aspect ratio 
isn't important, but the horizontal axis is usually about 1.25 times longer 
than theY axis. Obviously, pie charts don't follow this convention. 

WHAT TO DO WITH INCOMPATIBLE DATA 

Has this happened to you yet? You enter a set of numbers into the comput
er, and the graph comes out looking lopsided, as in Figure 5-21. The 
cause? Incompatible data. The computer scales the chart according to the 
largest value. If the other values are considerably less, you '11 end up with 
one tall bar, and several miniature ones. There are several solutions, dis
cussed below. 

The company•s munitions revenue 
vas the highest in the 1940. s 

600 
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In 400 'E 
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0~!!1!!!1!!!!14-.111!11!!~-

Figure 5-21 Chart with Incompatible Data 



Charting Your Course with Works 189 

The company•s mUDitioDS revenue 
vas the highest in the 191o·s 

60 

50 

140 
a 3o 
~ 20 

10 

0 
1920 

Figure 5-22 Direct Labeling over Column 

Reduce Data Value 

The best, and often easiest, way to avoid a lopsided chart is to replot the 
chart with a lower value for the tall column. Regraph the numbers and the 
other columns will be a normal height. 

The tall column no longer represents the original value, so you '11 have to 
tell your audience that the column has been chopped down to size. Use the 
Works Draw tools to write the actual value directly over the column, as 
illustrated in Figure 5-22. 

Out of Scale 

Here's another technique: As shown in Figure 5-23, you can extend the bar 
beyond the top of the chart, as if it's popping through the top. Or cut the 
bar in the middle, showing a break in the scale. In both cases, you should 
write the actual value immediately above the chart. 

Convert to Percentages 

Another approach to presenting incompatible data is to not plot the actual 
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The company·s munitions revenue 
vas the highest in the 191o·s 
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Figure 5-23 Bar Popping Through Top 

1950 1960 1970 

values of the numbers. Instead, plot the numbers as percentages. Your 
graphics program should be able to automatically convert the numbers to 
percentages for you. 

If the program can't do the arithmetic for you, it's easy enough to do 
yourself. First, add all the numbers together. The sum will represent 100 
percent. Then, divide each value in the chart into the sum. Here is an 
example: 

Numbers to chart: 950, 126, 164, 201. 
Sum of numbers: 1441. 
950 is 66 percent of total ( 1441 ). 
126 is 8.7 percent of total. 
164 is 11.3 percent of total. 
201 is 13.9 percent of total. 
Add up all the percents, and you get 100 (actually 99.9, because of 

rounding error). 
But plotting these numbers on the column chart used earlier still doesn't 

provide a very striking chart, and in fact, it shouldn't Since you've con
verted the numbers to percentages, use a pie chart. See Figure 5-24 for a 
before and after look. 

Bear in mind that using a new scale, or plotting the numbers as percent
ages, may drastically alter the look of the chart. This may not be what you 
want. Analyze the chart in its new form before you commit to it. And 
remember that your audience may not understand the chart as readily. 
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When plotted. as a pie graph, the 
vanous percentages are easy to see 

Figure 5-24 Column/Pie Chart of Given Numbers 

Additional Methods 

You can also use an indexed or logarithmic scale to deal with incompatible 
numbers. Depending on the original values, this may produce a usable 
chart. 

Except for 1977, the cost of living bas 
increased at a steady pace 
1975=100 
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Figure 5-25 Cost of Living Index Chart 
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An index scale is very much like the old and reliable linear scale, but with 
a twist: the scale is based not on zero, but some number that represents 100. 

The cost of living chart is a good example of a graph based on an index 
scale. In such a chart, the price of housing, food, rent, etc. is compared 
against the cost in years past. Because of inflation, and other monetary fluc
tuations, it's necessary to fix the value of the dollar at some arbitrary level. 

For instance, the value of the dollar in 1975 may be considered 100, as it 
is in Figure 5-25. If the cost of living goes down (fat chance) in subsequent 
years, the line in the index chart goes below the 100 mark. If it goes up, 
the line goes above the 100 mark. 

Index charts are helpful because they enable you to compare similar 
statistics. But they can also lead you into trouble. You must carefully pick 
an appropriate base, or the effectiveness of the chart may be diminished. 

You could, for instance, pick a year when the value of the dollar was 
unreasonably high. Your chart would then show that the cost of living has 
actually gone down, compared to the inflated year. If your aim was just the 
reverse-to prove that the cost of living is ridiculously high-choose a 
base year when the dollar value was low, as shown in Figure 5-26. No mat
ter what base you choose, you must identify it somewhere on the chart. 

Although some stand-alone charting programs will index a set of num
bers around a common base, Works will not. You'll have to do the math 
yourself, which fortunately, is easy. 

The cost of 1i vin.g has increased 
dramatically since 197 0 
1971 = 100 
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Figure 5-26 Too High/Low Base Year 
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Index chart based on numbers from text 
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Figure 5-27 Index of Sample Numbers 

1. Locate a value in your chart that you want to be 100. 

2. Divide that number into 100. The result will be a "constant" that 
you '11 use for the other numbers. 

3. Take each number in the chart and multiply it by the constant. 

Suppose your chart consists of the values 10, 12, 14, 16, and 18. You 
choose 14 to be the base index of 100. Dividing by 14 gives you the con
stant of 7.14. Therefore: 

• 10 is equal to 71.4. 

• 12 is equal to 85.7. 

• 16 is equal to 114.2. 

• 18 is equal to 128.5. 

When charting these numbers, as shown in Figure 5-27, it is necessary to 
override Works' auto-scaling feature. You'll want to choose a bottom scale 
limit just below the smallest index value, and the top scale limit just above 
the largest index value. If you can, make the 100 mark a heavy line, to 
highlight it for your audience. 
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WHAT TO DO WITH MISSING DATA 

It's easy to spot missing data when you're looking at a table. There's a 
blank where there should be a number. But missing data can be harder to 
spot when the numbers are in chart form. You can easily jump from April 
to June, and few people will notice. You may have simply forgotten May, 
or the data may not have been available. Or the numbers for May were so 
disappointing that you decided to leave them out! 

If the information you have for that month is an estimate or approxima
tion, fill that column with a distinctive pattern, to set it off from the rest. 
Note on the chart that the data is approximate. You can use the same tech
nique when projecting into the future. 

Column charts are most often used to plot numbers against equal inter
vals of time. Notice the word equal. If you start the chart at 1980 and pro
ceed to 1986, a year at a time, there should be a column for every year in 
between. When the data for a particular time period is missing, enter the 
value as zero, as depicted in Figure 5-28. 

Dot and sliding bar charts suffer most from incomplete data. Both charts 
rely on examining the correlation between two sets of numbers. If a value 
from one set of numbers is missing, the corresponding value in the other set 
is useless. If several numbers from both sets are missing, you should steer 
away from making a chart. It will have little meaning. 

Last year. company revenue remains 
in the S275-S110 thousand range• 

Jaa rc\ MarAprHayJua Jul Aus Scp O~t J:1'ovJ>cc: 

Figure S-28 Chart with Missing Month 
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MAKING A CHART WITH WORKS 

The Works spreadsheet module has its own chart making tools, where you 
can produce five different types of charts: pie, line, column (called "bar" in 
Works), stack, and combo. The stack chart type produces stacked columns; 
the combo chart type overlays one or more line charts over a column chart. 
All of the commands for making presentation graphics are in the Chart 
menu. 

Data for charts is entered directly into the spreadsheet. You instruct 
Works how each chart is to use this data by entering column and row defi
nitions. Once you defme a chart, it is permanently linked to the data in the 
spreadsheet. Changes in the spreadsheet data are automatically transferred 
to the chart. 

Works can support up to eight chart defmitions for each spreadsheet. 
Because the charts are a part of the spreadsheet, they are saved along with 
it. To access a chart, you must first open its spreadsheet, then fmd the chart 
defmition with the Select Chart Defmition command in the Chart menu. 

Producing a Chart 

The process of making a chart is simple and straightforward, but it does 
require that you enter the chart information into the spreadsheet in a partic
ular manner. Works expects you to enter data following the formats shown 
in Figures 5-29 and 5-30. Works considers line, column (bar), stack, and 
combo charts as Series charts, and treats pie charts separately. Data for 
series and pie charts are organized differently, as the figures show. 

Valut 
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/ / 
Untitled (SS) P1E 

I 

Figure 5-29 Data Entry Format for Pie Charts 
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Figure S-30 Data Entry Fonnatfor Series Charts 

Once the data is entered, choose the New Series Chart or New Pie Chart 
command in the Chart menu. Enter the rows and columns that contain the 
data you want to plot (move the defmition dialog box out of the way to see 
the spreadsheet data underneath, if necessary), and press the Plot It! button 
(the other entry boxes, for Scale, Chart Title, Vertical Scale Title, and so 
forth, need not be filled in right now). 

Assuming Works finds all the data it needs to successfully build the 
chart, a plot of the numbers from your spreadsheet is shown in a new chart 
window. Works does not allow you to manipulate the chart from within 
this window, but you can edit it with the Draw tools from within either the 
word processor or spreadsheet modules. 

When you are viewing the chart, click the Close button in the upper left 
comer of the chart window. This closes the chart from view, but doesn't 
erase it. You can redisplay the chart by choosing the Draw Chart command 
from the Chart menu, and selecting from the list presented. Alternatively, 
you can remove the chart from view simply by choosing another open 
Works document in the Wmdow menu. You can then reactivate the chart 
window by selecting it from the Window menu, or with the Draw Chart 
command. 

Changing Chart Definition 

Charts can be redefmed at any time. The spreadsheet data is permanently 
locked to the chart defmition, so changes made to value and label cells are 
updated in the chart defmition window. 

Some changes used to define the values and labels of the chart may lie 
outside the spreadsheet cells. Follow these steps to redefme elements such 
as number of series, chart title, or scale: 
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1. If the chart is not in view, choose the Select Chart Definition com
mand in the Chart menu. If the chart is currently in view, double
click anywhere on the chart window. 

2. Make the desired changes in the chart definition dialog box. 

3. Click Plot It! to replot the chart and view the changes. 

Copying Chart Definition 

You may wish to make several versions of one chart, using the same basic 
information in the spreadsheet. If each chart is fundamentally different, 
you're better off creating each one fresh with the New Series Chart and 
New Pie Chart commands. But if the charts share many of the same char
acteristics, such as chart type, vertical and horizontal scale titles, and cells 
used for data and labels, you can save much time with the Copy Chart 
Defmition command. 

To copy a chart definition, choose the Duplicate Chart command in the 
Chart menu, then select the definition you want to clone. Works generates 
a carbon copy of the original, presenting the chart definition dialog box 
where you can make the desired changes. 

Erasing a Chart Definition 

Once made, charts are pennanently attached to the spreadsheet. But chart 
definitions consume memory space, and many are not needed after printing 
or copying to a word processor or spreadsheet document. To delete a chart 
definition that's no longer needed, choose the Erase Chart command from 
the Chart menu. Select the chart to be deleted. 

Resizing a Chart 

Charts may be readily resized by resizing the chart window. The chart win
dow initially fills the screen, but you can make the chart smaller by reduc
ing the size of the window. Drag the window by the size box, located in 
the bottom right comer, but be aware that Works resizes the bars, lines, pie 
slices, and other graphic elements of the chart only. The font (Geneva 9 
point) used for chart title, legends, and labels is not resized. 

When possible, be sure to resize the window so that the chart maintains 
the same proportions as the original. You can easily stretch or squash a 
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Figure 5-31 Nonnal and Stretched Charts with Window 

chart into severe distortion by making the chart window extremely tall or 
wide, as shown in Figure 5-31. 

Revert to the full size of the window by double-clicking on the chart 
window title bar. 

Printing a Chart 

Works provides a rudimentary method of printing charts. With the 
desired chart on the screen, simply choose the Print Window from the 
File menu. The chart is printed in the size and proportion as displayed on 
the screen. 
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Copying and Pasting a Chart 

Most often, you '11 want to paste a chart into a word processor or spread
sheet document, and use the chart to illustrate a point or summarize a set of 
numbers. Works lets you copy the entire chart only, but once you paste the 
chart into the destination word processor or spreadsheet document, you can 
only edit it with the Draw tools. 

To copy a chart, view it, then choose the Copy command from the Edit 
menu (or press Command-C). Open a new word processor or spreadsheet 
document, or activate an already open window, then choose the Paste com
mand from the Edit menu (or press Command-V). 

Works pastes the entire chart as a single, grouped object. Draw is turned 
on automatically if it is not already on. Use the Selection Arrow to move 
the chart into position on the page. Add at least a half-page worth of blank 
lines when pasting a chart into an empty word processing document. The 
blank lines let you see more of the document than just the current window. 

Later in this chapter using the Draw tools to edit Works charts is discussed. 

ORGANIZING DATA ON THE SPREADSHEET 

Although you can prepare charts from information located anywhere with
in Works, the program initially assumes that data is placed in specific 
cells. You can use this feature to more quickly format and prepare data 
and charts. 

Initial Pie Chart Data Location 

When you create a new graph, Works assumes that data for pie charts is 
located in the rows and cells indicated below: 

Data 
Plot values 
Value titles 

Initial Location 
Column B, rows 3 to 7 
Column A, rows 3 to 7 

Figure 5-32 shows one way to organize data in a spreadsheet prior to gen
erating a pie chart. Cells Al and A2 contain a chart title and annotation; 
cells A3 to A 7 contain value titles, and cells B3 to B7 contain plot values. 
Works automatically assumes you will always be creating pie charts with 
five segments. If you have more or less, you need only to change the nota
tion in the Through Row edit box in the chart defmition dialog. 
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Figure 5-32 Full Formatting of Data for Pie Chart 

Initial Series Chart Data Location 

When you create a new graph, Works assumes that data for series charts is 
located in the rows and cells indicated below: 

Data 
Plot values 

Data legends 
Horizontal titles 

Initial Location 

1st Row: 3, from columns B toM 
2nd Row: 4, from columns B to M 
Column A, rows 3 and 4 
Row 1, from columns B toM 

Works automatically assumes you will always be creating series charts 
with two sets of data with 12 data points each. Change the numbers in the 
2nd, 3rd, and 4th row edit boxes, depending on whether you are plotting 
one, two, three, or four series or sets of data If you have more or less than 
12 data points, change the notation in the To Column edit box in the chart 
definition dialog. 

Transposing Data Between Rows and Columns 

If you know you'll be creating a chart with the data you're entering into the 
spreadsheet, supply that information in the proper format. 

• Pie charts expect plot values and value titles in columns. 

• Series charts expect plot values and titles in rows, and data legends in 
columns. 

If the data you want to plot is not in these formats for the chart type you 
want to use, you can easily convert it with the Transpose option. Transpose 
takes a range of numbers and inverts them so that columns become rows, 
and rows become columns. 
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To transpose a range of cells: 

1. Select the cells with the mouse. 

2. Press Command-X to cut them from the spreadsheet and enter them 
into the Clipboard. 

3. Click on a cell to establish the upper-left comer of the new, trans-
posed range. 

4. Choose the Paste With Options command from the Edit menu. 

5. Click the Both Values and Formulas option. 

6. Click the Transpose option, and press the OK button. 

Works fills the cells with the transposed range, starting from the cell you 
previously selected. 

Be aware that cells pasted with Transpose will overwrite other cells that 
still have data in them. Be sure the paste range is large enough to accom
modate all of the cells, or you could lose valuable data. 

EDITING CHARTS WITH DRAW 

The Works Draw tools provide a convenient method of editing spreadsheet 
charts. All of the elements of charts are individual graphic or text objects 
that can be manipulated with the Draw tools. 

To edit charts with Draw, you must frrst copy and paste the desired chart 
into a word processor or spreadsheet document, as detailed earlier in this 
chapter. When pasting a chart, Works automatically turns Draw on. The 
chart is pasted as one grouped picture, to make it easier to position within 
the document. Be sure that you don't ungroup the chart before you place 
the chart in the desired location on the page. 

Some points to remember: 

• You should avoid straddling the chart over two pages, since that will 
cut the graphic in two when the document is printed. 

• H the graphic is too large or too small, resize it by one of the handles 
that appear on the right or bottom edges. Remember that only the 
graphic elements of the chart are resized, not the text. Resizing a chart 
may disrupt its appearance, causing misalignment of the text and 
graphic portions. H you need a larger or smaller chart, resize the chart 
window before copying the chart. 

Once the chart is sized and positioned the way you want it, you can 
ungroup it. Ungrouping allows you to edit the individual graphic and text 
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Figure 5-33 Ungrouped Chart 

elements. To ungroup the chart, select it, then choose the Ungroup Picture 
command in the Format menu. 

A typical ungrouped chart is shown in Figure 5-33. Notice that the chart 
includes an invisible "background" box that corresponds to the border of 
the chart window. The size and shape of this box is the same as the chart 
window when you originally copied the chart. You can do a number of 
things with the background box: 

• Fill the box with a distinctive pattern. Choose a pattern carefully or 
the rest of the chart may be hard to see. 

• Fill the box with white. This blocks any text in the word processor or 
spreadsheet document that appears under the chart. This is most help
ful in blocking the grid lines in the spreadsheet. 

• Change the border of the box to solid black or a pattern. This puts a 
visible box around the chart. 

• Erase the box altogether. 

Use the Draw tools as detailed in Chapter 3 to delete or edit the graphic 
and text objects of the chart. You can change the font and size of text, for 
example, by selecting each text object and choosing a new font/size from 
the Format menu. Changing axis labels may alter their alignment to the 
chart, so you may wish to first select and group the labels together, then 
alter the font and size. Reposition the entire group to realign the text to 
the chart. 
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Tick marks and background grid marks are made from small segments of 
lines (in fact, the background grid marks are short, one-pixel lines that 
appear as dots). These are almost impossible to edit, so you may want to 
leave them alone, or simply create new ones from scratch. 

Use the cursor arrows on the keyboard or in the Tool Palette to nudge 
chart objects by small amounts. This technique is particularly helpful when 
working with small pieces, like tick marks. 

Once the chart is edited as desired, select all of the graphic and text 
objects, then group them together with the Group Picture command. 
Recheck the position of the chart in the document, and move it into a better 
position if required. 

ENHANCING CHARTS 

Some charts beg for exotic treatment. You can use the Draw tools to make 
3-D column and pie charts, add illustrations to nearly any kind of chart, 
substitute the columns in a column chart with symbols, and lots more. 

Making a 3·D Pie Chart 

By duplicating a two dimensional pie chart and placing the copy over, but 
to one side of the original, you can achieve a striking 3-D effect. You 
should add the 3-D before you place the text and legends on the graph. To 
start, position the chart where you want it, then ungroup it. Then: 

1. Group just the slices of the pie chart (no text), then copy and paste the 
chart. Slide the duplicate to an open area of the drawing. 

2. Make sure the duplicate is selected, then choose the Send to Back 
command from the Format menu. This pie is now the underside-the 
bottom crust-of the chart. 

3. Slide the bottom crust under the original. Align the top and bottom 
crusts for the perspective you desire. Figure 5-34 shows you how the 
orientation of the two crusts affects the perspective of the graph. 

4. Add connecting lines between the crusts to connect the slices. 
Depending on the pattern you used to fill the slices, you will achieve 
good results by using a thin line width. When heavy line widths are 
used on angled lines, they tend to become thicker than straight lines 
and borders made with the same line width. 

5. When fmished, group the entire pie and add the text. Figure 5-35 
shows an example of a completed 3-D pie chart. 
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Figure 5-35 Completed 3-D Pie 

Exploding a Pie Slice 

You can readily pull one or more slices from the pie to make an exploded 
pie chart. Attention is drawn to the exploded piece (or pieces). To start, 
position the chart where you want it, and ungroup it. Then: 

1. Remove the outer circle that surrounds the pie slices. Make sure you 
select and delete just the circle, and not any of the slices themselves. 

2. Pull out the slice you want to explode. Don't drag the slice too far 
from the rest of the pie. 

3. If desired, you can add borders around the unexploded slices in the 
pie by selecting each one, then choosing the solid black pattern from 
the Line Pattern menu. 
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Figure 5-36 Finished Exploded Pie Chart 

4. You can also add a border around the exploded slice by selecting it, 
then choosing the solid black pattern. Only the outside arc of the 
slice is bordered; to add a border to the inside wedge, select the 
polygon tool and carefully draw two lines around the outside edge of 
the wedge. 

5. Group all of the segments of the pie chart together. 

A finished exploded pie chart is shown in Figure 5-36. 

Adding Illustrations to Line or Column Charts 

An illustration added to a line or bar chart can help tell your story. Imagine 
a sketch of a newspaper behind a chart of increasing newspaper sales. Your 
message is more quickly grasped and your chart looks more interesting. 

You can use just about any kind of illustration for your chart. The best 
illustrations are simple and undecorated; you don't want the picture to 
overshadow the graph. The illustration is placed behind the graph-an 
underlay. With creative use of Draw you can place the illustration any
where-even make the chart part of the illustration. 

Illustrations used for underlays should be the same size or smaller than 
the graph. If the chart is to be laser printed, the illustration should be 
object-oriented. Bit-mapped pictures are not adequately smoothed by the 
Laser Writer, and the picture will look jagged in comparison to the smooth 
contours of your Draw chart. Also, the LaserWriter tends to stretch bit-
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Figure 5-37 Dimming in MacPaint 

mapped pictures when printed with Works, so the image on the screen may 
not be exactly what you see on paper. With some experimenting, however, 
you can adjust the size and position of the graph and picture until you get 
the right effect. 

The underlay picture should also be lighter than the chart. If the picture 
has heavy black areas, the chart will be harder to read. When working 
with a bit-mapped picture, you must first "dim" it to a lighter gray. Do 
this in the paint program, such as MacPaint or SuperPaint. One effective 
way to dim images in MacPaint is to lasso portions of the picture and fill 
(using the Fill command from the Edit menu) using a gray pattern (see 
Figure 5-37). 

Dimming is easier with an object-oriented graphic. In Works Draw, 
select the picture, then choose gray patterns in the Fill Pattern and Line 
Pattern menus. If the fill pattern is too light, some lines and borders may 
disappear. Figure 5-38 shows a Draw graphic before and after dimming. 
The 50 percent gray fill and pen patterns were used for dimming. 

With the underlay picture prepared and properly "dimmed," copy it and 
paste it with the chart document. Choose the Send To Back command from 
the Format menu. That will place it behind your chart. 

Slide the picture so that it rests under the chart, as shown in Figure 5-39. 
Drag the picture or chart until the two line up the way you want. If the pic
ture is object-oriented, you can resize it to better fit the chart. If the picture 
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Figure 5-39 Chart with Underlay 

is bit-mapped, you should not resize it or it may be grossly distorted. 
Adjust the size of the chart to match the picture. After resizing the chart, 
rearrange the text to match. 

Designing a Pictograph 

A pictograph uses symbols to represent the columns of a column chart. 
The symbols used instead of the column help to convey the message of the 
chart. For example, population charts, as shown below, often use people 
symbols. The type and variety of symbols you use are completely up to 
you, and the symbol can change for each column. 

For the maximum effect, however, the symbols should be simple and 
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immediately recognizable. The symbols can be made with Works Draw or 
with a bit-mapped painting program, such as MacPaint. If the chart is laser 
printed, the best results are achieved when using Draw-created objects. To 
develop a pictograph: 

1. Create the column chart as usual. 

2. Copy and paste the chart into a blank word processing or spreadsheet 
document. 

3. Elsewhere in the document, create the symbol you want to use. The 
size of the symbol should allow you to place at least one character on 
the shortest column. If the symbol is not made in Works, quit the 
program temporarily, start the paint program, and create the symbol. 
Copy the symbol into the Clipboard and return to Works. 

4. Duplicate the symbol and place it at the bottom of the first column, 
as in Figure 5-40. Duplicate the symbol again and place the copy on 
top of the frrst one. Repeat until the entire column is covered with 
symbols. 

5. If the end of the column isn't long enough for one more symbol, add 
the symbol anyway. Cover the end of the symbol that hangs over the 
column with an erasing mask (a rectangle filled with white and white 
line pattern). Delete the column rectangle underneath. Do the same 
for the remaining columns. The finished pictograph is shown in 
Figure 5-41. 
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Figure 5-40 Pasting Symbol 
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Figure 5-41 Finished Pictograph 

Creating a Chart "Blank" 

Sometimes, you may wish to create a chart entirely from scratch in Works. 
You can produce a chart blank-just the background and no text or chart 
elements-then use this blank to generate your own chart, such as an area 
chart, a dot chart, or a bar chart. To create a blank, open a new spreadsheet 
document, and choose the New Series Chart command from the Chart 
menu. Select the desired chart type (line, column, etc.), and click the Plot 
It! button. Copy the blank and paste it into a word processing or spread
sheet document. 



CHAPTER 6 

Keeping Tabs on Data 

The American Heritage Dictionary defines the word data asy "infonnationy 
especially information organized for analysis or used as the basis for a deci
sion." Computers are ideally suited for both organizing and analyzing data, 
in ways far faster and more efficient than any one human could ever hope 
to achieve. 

The Works database module lets you enter those tidbits of information 
that are so important in your life or work, organize them so you can find 
facts and figures more quickly, and even analyze your data to show trends, 
directions, and strategies. There are limits to what the Works database can 
do, of course, but you '11 find it ideally suited for such applications as pay
roll, inventory tracking, and client listings. 

In this chapter, you'11learn how to harness the power of the database 
module and make it work for you. And you '11 discover that a number of 
the most useful shortcuts and capabilities of the database module are 
ignored in the Works manual. 

DATABASE BASICS 

Figure 6-1 shows an empty database window (with the one, obligatory field 
column). The main components of the database are: 

• The rows that denote records. 

• The columns that denote fields. 

• The edit bar (the Enter and Cancel icons are only present when enter
ing data). 

211 
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Figure 6-1 Empty Database Window, with Callouts 

• The scroll bars, for moving through a database larger than one screen 
(unlike the Works spreadsheet, the scroll bars do not appear when the 
database is confined to one screen only). 

• The menu bar, on the top of the screen, to let you issue various com
mands. 

USING THE DATABASE 

Entering and editing information in the list view of the database is identical 
to the way it's done in the spreadsheet. Therefore, the techniques for mov
ing the current cell selection, entering data, and editing data won't be 
repeated here. (Chapter 4, "Spreadsheet Strategies," has more information 
on the topics of moving the cell selection, using the mouse, the role of the 
Enter and Return keys, and selecting multiple cells.) 

Navigating in Form View 

The form view of the database employs a slightly different approach to 
moving between fields and records. The Return, Tab, and Down arrow keys 
all will move you down the fields of the same record. When you reach the 
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bottom field, Works moves to next record. Conversely, pressing Shift
Return, Shift-Tab, or the Up arrow moves you up through the fields. The 
currently selected record number is shown in the left edge of the edit bar. 

H you want to move to a new record quickly, one way is to click the up 
and down arrows in the vertical scroll box. You may also move to different 
records by pressing the following keys: 

Press This To 
Command-Return 
Command-Enter 
Command-Shift-Enter 
Escape 

Move to next record select, top field 
Move to next record, select same field 
Move to previous record, select same field 
Deselect all fields 

To select the frrst record, click any field in the Form window, then drag 
the vertical scroll bar all the way up. The record number will show 1, indi
cating you are viewing the frrst record of the database. 

Conversely, to select the last record, click any field in the Form window 
and drag the vertical scroll bar all the way down. 

There may be many times you wish to select a certain record in Form 
view and switch to List view, keeping the same record selected. This is 
possible if you select the record by clicking once in the selection box at the 
far left of the record, then double-clicking in the same spot. 

The Form view is easiest to use when entering new records in the 
database. After filling all the fields in one record, pressing the Return or 
Tab key automatically starts a new record, and the frrst field in the record 
is selected for you. 

Navigation in List View 

If you are using the List view to enter new records, press the Tab key to 
move from one field to the next in a record, as well as to start a new record. 
Pressing the Return key moves you down through the field columns, but 
only within the existing records of the database. 

KEYBOARD AND MOUSE SHORTCUTS 

The Works database provides a number of helpful keyboard and mouse 
shortcuts that can save you time. In addition to the Command-Key short
cuts detailed for the database module in Chapter 1, Works offers the follow
ing shortcuts you can execute with the mouse and keyboard. Note: Some 
shortcuts depend on the current view of the database, either List or Form. 
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Shortcut Database As List Database as Form 
Select all fields in a Click in column None 
column header 
Select all fields in a Click in row None 
record header 
Select all fields in active Choose All Cells None 
part of database from Edit menu 
Set field formatting Double-click in Double-click in 

cell cell 
Resize a field Drag left edge of Drag left edge of 

column in field field box 
header 

Move afield Drag middle of Drag middle of 
column in field field box 
header 

Delete field contents Press Delete key; Press Delete key; 
then Return then Return 

Delete field column Select field in Select field, 
field header, choose Delete Field 
choose Delete Field command in Edit 
command in Edit menu menu 

Change field name Double-click in Double-click on 
field header; field name; enter 
enter new name new name 

Delete record Click once in row None 
header; choose Cut 
from Edit menu 

Delete just contents of Click once in row None 
record (leave blank cells) header; choose 

Clear from Edit 
menu 

To duplicate entry from Press Command-' and Press Command·' 
previous record Enter (when in and Enter (when in 

destination field) destination field) 
Enter current date Press Command-D Press Command-O 
Enter current time Press Command-T Press Command-T 

In addition, you can quickly switch from List view to Form view with 
the following double-click shortcuts: 

• From List to Form view: Double-click anywhere in the row header. 
This is the same as choosing the View Form command from the 
Format window, or pressing Command-L. 



Keeping Tabs on Data 215 

• From Form to List view: Double-click anywhere in a blank portion of 
the form. This is the same as choosing the View List command from 
the Format window, or pressing Command-L. 

DATABASE CONCEPTS 

The Works database is actually a specialized form of the spreadsheet. It 
consists of a number of cells laid out in row and column format. As with 
many spreadsheet-oriented databases, the individual cells are fields for 
recording data. One field contains one piece of information. 

The rows of the database comprise records. Each record is a complete 
set of data on a particular person, product, or thing. Each person recorded 
in your database, for example, will occupy a row of his or her own. The 
columns represent specific fields. One column may be the Last Name 
field, another the Telephone field, and so forth. See Figure 6-2 for a graph
ic illustration of the field/record concept. 
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Figure 6-2 Concept of Fields and Records 
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Figure 6-3 Concept of Different Databases 



216 Inside MS Works 2 for the Macintosh 

All the fields and records of a particular Works file comprise one 
database. You can have as many different databases as you like, each orga
nized in ways that best suits your needs, data, and application. For 
instance, one database may be a list of clients, another may be a list of ven
dors, and a third may be a list of employees, as shown in Figure 6-3. In 
each case, the data contained in the three databases will be different. 

Field and Record Limits 

Works supports up to 60 fields (or columns) per record (or row). That 
should be enough for most applications. There is no limit to the number of 
records in a single database, other than the maximum amount of RAM in 
your computer. Realistically, a Mac with one megabyte of RAM can sup
port a database roughly 12 fields by 150 records. More memory means 
more records per database. Remember that each field can contain up to 
250 characters; the more characters per field, the faster the database is 
filled up, no matter how many fields or records you've added. 

One Database, Two Views 

The Works database can be viewed in one of two ways: as a spreadsheet 
list, such as the format described above, or as a form. You choose which 
one you want from the Format menu. When viewed as a form (see Figure 
6-4), the fields of the database are displayed in a single window on the Mac 
screen. You see all the fields in one record. 

The form view is helpful when adding new information to the database. 
It's particularly well-suited to those familiar with Works, as it presents a 
rather simple view of the entire database. You'll want to view the database 
as a list, however, when you are sorting the records or copying data. 

The form view can contain just one screen. If you have lots of fields, 
you may not be able to fit them all on the screen at once. As you '11 see 
later in this chapter, you can alter the size and placement of the fields in the 
form at will. 

Although there are two views of the database, the data is interlinked. 
Changes you make to data or field names in one view are immediately 
reflected in the other. However, the organization of the fields in the form 
window have no relation to the organization of fields in the list window. 
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Figure 6-4 Form View of Database 

STARTING A NEW DATABASE 

A database must have at least one field column, so when you start a new 
database by double-clicking the Database icon in the Open File dialog box, 
Works displays a Field Name prompt on the screen. Simply provide a name 
to the field (or leave as Untitled for now), and do one of the following: 

• Click the Done button if you are finished adding field columns to the 
new database. You can add field columns at any time, so there's no 
need to provide extra in case you need more later. 

• Click the Add Field if you want to add another field column. Name 
that field as before, then click either Done or Add Field, as desired. 

Works ordinarily displays the database as a list. To view the database as 
a form, choose the View Form command from the Format menu. To switch 
back to the list window, choose the View List command. 

DATABASE FORMATTING IN LIST VIEW 

Works lets you tailor the appearance of the database while viewing it as a 
list. You can change the width of field columns, rearrange fields, add hori-
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zontal and vertical splits (to see different parts of the database at once), and 
alter formatting of fields. You can also vary the formatting of the database 
while viewing it as a form. See the next section for details. 

Changing the Width of Field Columns 

The standard width for field columns is 19 characters (assuming Geneva 9 
point, plain font). You may wish to vary the width of the field columns to 
better match the form of data you are entering. 

To change the width of a field column, move the mouse pointer into the 
column header and position it along the right edge of the column you want 
to resize. Drag the mouse to set a new width. You must place the mouse 
pointer along the edge of the field column, not within it, or you '11 move the 
column to a new position in the window. 

Rearranging Fields 

You can easily rearrange the field columns in a Works database, as shown 
in Figure 6-5. Move the mouse pointer into the column header and position 
it along the middle of the column you want to resize. Drag the mouse until 
the outline of the column is located where you want it. 

Figure 6-5 Rea"anging Field Columns 
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Renaming Fields 

Even if you named your fields when you first set up the database, you can 
rename them at any time. Simply double-click in the field column header, 
enter a new name, and press Return. 

Splitting Windows 

The Works database window may be split once vertically and once 
horizontally. 

• To split the window vertically (across the middle), drag the split bar 
located in the far left of the vertical scroll bar. 

• To split the window horizontally (down the middle), drag the split bar 
located at the top of the horizontal split bar. 

While split, the scroll bars present two sets of arrows and thumb boxes. 
Use them independently to move each side of the split as desired. Splitting 
windows is helpful when you need to view the left edge of the database 
(listing customer name, for example), while entering cells far to the right, 
as shown in Figure 6-6. 

To remove the split, drag the split bars back to their original positions. 
The split bars won't appear if the database is smaller than one window. 

Moule List (DB) 
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Figure 6·6 Use of Split Windows 
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Field Formatting 

The fields of a database may be formatted in a number of different ways. 
You have full control over: 

• Field type 

• Computed/non-computed field 

• Numeric display 

• Alignment 

• Style 

• Number of decimal places 

• Font 

• Size 

• Color 

All cell formatting is made through the commands available under the 
Format menu. 

Setting Fonts Database data can be displayed in any font currently 
installed in the System flle of your hard disk or Works disk. The selected 
font affects all of the fields in the database. Setting a smaller or larger font 
changes the amount of information that is shown in one screen. 

Setting Size Each font can be displayed in sizes ranging from 4 to 72 
points. The selected font size affects all of the fields in the database. 

Setting Color You may set a different color for the text in each field with 
the Color command. The normal setting is Black. 

Setting Field Attributes Each field column (but not each field) may con
tain its own unique attributes, or formatting. The Set Field Attributes dia
log box, shown in Figure 6-7, provides a number of options from which to 
choose. As a shortcut to the Set Field Attributes command, you can access 
the dialog box simply by double-clicking on any field in the field column 
you want to reformat. 

Should you wish to change the format of many field columns at once, 
select them all and use the Set Field Attributes command. Even though 
you may double-click on a single field, changes you make affect the entire 
column. 
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Set Field Attributes For Color or BW 
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Figure 6-7 Set Field Attributes Box 

DATABASE FORMATTING IN FORM VIEW 

The Form view offers many of the same formatting capabilities as detailed 
above, but the procedure for modifying the look of the database form is dif
ferent. You have the same formatting options as in List view except for set
ting split screens. 

Changing the Width of Field Boxes 

Field boxes in Form view are normally nine characters wide (assuming 
Geneva 9 point, plain). To increase or decrease the width of a field box, 
position the mouse pointer over the right edge of the box, as shown in 
Figure 6-8, and drag it. 

Rearranging Fields 

To move a field box anywhere in the Form window, position .. the mouse 
pointer over the box (the pointer turns into a hand), and drag to a new posi
tion. Both the field name and entry box are moved together. 

As described earlier in this chapter, pressing the Return key or Down 
arrow key steps you from one field box to another. The order in which 
Works selects the next field box as you press the Return or Down arrow 
keys is determined not by the order in which you created the fields, or their 
order in the List window, but a simple top-to-bottom, left-to-right sequence. 

At least 50 percent of the field box must be in line with the field immedi-
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Figure 6-9 Alignment of Boxes in Form Window 

ately above it, as shown in Figure 6-9, or Works will skip it and proceed to 
the next field box below. The skipped field box gets its tum as the program 
works its way left to right across the form window. 

Renaming Fields 

Fields are renamed in Form view in much the same fashion as List view. 
Double-click on the name in the field box, and provide a new one. 
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luntitled1 I Bold Field Name I 
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Figure 6-10 Example of Formatting Commands 

Field Formatting 

Formatting for the text in fields, as well as the field name, is controlled 
with options in the Format menu. You have the same field formatting 
options as detailed in the previous section, plus: 

• Bold Field Name. This command in the Format menu lets you tum 
bold on and off for the field name. 

• Bold Field Data. This command in the Format menu lets you turn bold 
on and off for data you enter into the field. 

• Border Field Name. This command adds or removes the border 
around the field name. 

• Border Field Data. This command adds or removes the border around 
the field data. 

Examples of using these field formatting commands are shown in Figure 6-10. 

REPETITIVE ENTRY 

Some database information repeats from record to record; for example, zip 
codes for people who live in the same town. There are a number of ways 
that you can quickly duplicate field information: 
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Figure 6-11 Selecting FieldforCopying 

To copy a field from the previous record: 

1. Select the field in the record immediately following the field you 
want to copy, as shown in Figure 6-11. 

2. Press Command-'. Note that the contents of the previous record 
field are shown in the edit bar, where you can modify it, if necessary. 

3. Press the Enter key. 

To copy one or more fields from the previous record: 

1. Select the fields of the record you want to copy. 

2. Press Command-C to copy the field contents into the Clipboard. 

3. Select the first field of the destination record. 

4. Press Command-V to paste in the copied fields. 

You can also use this technique to copy one or more fields from multi
ple records. 

Remember that Works erases any old contents of fields when new data 
is pasted in from the Clipboard. To avoid losing work you've spent time 
on, remember to add blank records in the database to accommodate the 
pasted material. 

USING SPREADSHEET FUNCTIONS FOR THE DATABASE 

The Works database lacks a fill down command where you can quickly 
enter a number of formulas, and have them copied into succeeding fields in 
the column. Such a command could be used to create a number series-the 
digits l through 10 in one of the field columns, for example-and would 
enable you to easily and automatically number the records of your database, 
helpful in keeping track of record numbers, invoices, and entry orders. 

You can, however, use the Works spreadsheet to provide the same result 
as a fill down command in a database. Open a new spreadsheet document, 
enter a value or formula into one cell, !hen select it, along with a series of 
cells below it (see Figure 6-12). Choose Fill Down from the Edit menu, and 
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Figure 6-12 Using Fill Down in Spreadsheet 

Works copies the contents of the flrst cell into the other selected cells. With 
the cells still selected, press Command-C to copy the cells to the Clipboard, 
switch to the database, and paste the values in at the desired spot. 

If you'd like to create a number series, follow these simple steps: 

1. Switch to a new spreadsheet document. 

2. Select cell Al, and enter the number 1. 

3. Select cell A2, and enter the formula: =Al+l. 

4. With cell A2 still selected, select two or more empty cells in the same 
column. These cells will contain the filled data. For example, to pro
duce a number series of 1 to 10, select cells A2 to AlO. 

5. Choose the Fill Down command from the Edit menu. 

6. Select all the cells in the column, and press Command-C. 

7. Switch to the database document, and set an insertion point for the 
start of the number series, as shown in Figure 6-13. 

8. Press Command-V to paste in the numbers. 

Other spreadsheet functions can be put to good use as well. For exam
ple, you may wish to use the more advanced formula features of the spread
sheet (the database repeats the same formula for each row). 

You may fmd it necessary to create the basic data in the database flrst, 
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Figure 6-13 Pasting Number Series in Database 

transfer it to the spreadsheet, manipulate it there, then copy it back to the 
database. Be aware that when you copy database fields, the titles for field 
columns are included, UNLESS you hold down the Option key while past
ing. You should use the Option key method when transferring data 
between database and spreadsheet, and back again, to avoid copying and 
pasting the field column titles. 

The Option key method works when using the Paste command from the 
Edit menu, or with the paste command keyboard shortcut, Command-V. 

SORTING 

Works provides a convenient method of sorting records. Works sorts only 
by record, so if you want to rearrange the field columns, you must do so 
manually using the technique described earlier in this chapter. 

Unlike the Works spreadsheet, Works sorts all the fields of a record, not 
just the fields you have selected. That prevents you from jumbling a 
database you have spent hours creating. 
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How to Sort 

To sort a set of records, first identify which field column you want to use as 
the "sorting key." The sorting key determines which field column Works 
will use to sort either alphabetically or numerically. For example, if you 
use the field column that contains the last names of your clients, Works will 
sort the database alphabetically by last name. 

Click the column you want as the sort key; there is no need to select spe
cific rows to sort (Works will sort ALL records regardless). Then: 

1. Choose the Sort command from the Organize menu. 

2. Click the sort order you desire, in either ascending or descending 
order. Works senses the type of data contained in the field column, 
and offers you the choice of selecting alphabetical, numerical, or 
chronological (for dates and time). 

3. Click OK to initiate the sort. 

Numbers are sorted with the smallest negative number to the largest pos
itive number (assuming ascending order). There is no difference between 
accented, upper-, and lowercase letters. 

Setting Multiple Sort Keys 

The database module does not offer sort on more than one field column at a 
time. But you can duplicate multiple-key sorting with this simple routine: 

1. Identify the field columns you want as sorting keys. 

2. Decide which columns take precedence over the others; that is, the 
field column for last names is more important than the field column 
for ZIP codes. 

3. Select the column of least precedence frrst, and sort by it. 

4. Select the next column of least precedence, sort by it. 

5. Repeat the process until all field columns are sorted. 

USING COMPUTED FIELDS 

A computed field is a field that holds a spreadsheet-like formula. Database 
fields are normally set up to accept just text or numbers. If you want your 
database to be semi-intelligent, you can assign the calculated field attribute 
to a column (you must assign the entire column as computed fields; you 
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Figure 6-14 Sample Calculated Field 

can't set just one field as computed). 

To set computed fields for a column: 

1. Select the column. 

2. Choose the Set Field Attributes command from the Format menu. 

3. Click on the Numeric option (alternatively, you can also click the Date and 
Tune options if you plan on using dates and times in your calculations). 

4. Click the Computed option to place a check in the box, then click the 
OK button. 

Calculated fields accept either numbers or formulas. Formulas take the 
same form as in spreadsheets, but lack cell references. To build a formula 
in a database, you refer to the name of the field column (such as 
=Population+lncome, shown in Figure 6-14). The formula is placed in 
its own column. "Population" and "Income" are headings for field 
columns, and contain numbers. The formula adds the contents of the 
Population fields with the contents of the Income fields. 

You enter the formula only once for an entire column of fields, and 
Works automatically copies the formula to all the fields in the column. The 
database works only with relative references. Each field in a calculated 
column refers to the contents in its own row. 

You can use most of Works' built-in spreadsheet functions with the 
database, except: 

• IRR 

• MIRR 
• HLookup 

• VLookup 

• Index 

• Match 
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Furthermore, those functions that require a range of cells in the spread
sheet work only with single references in the database. These are: 

• Statistical functions: Average, Count, Max, Min, SSum, StDev, Sum, 
and Var. 

• Financial functions: FV, NPV, Pmt, PV, and Rate. 

• Logical functions: And, Choose, If, IsBlank, and Or. 

As with spreadsheet formulas, Works updates the numerical values in 
calculated fields whenever you change the numbers in the rest of the 
database. You can "lock down" values in computed fields by converting 
them back to standard fields. 

1. Click the column. 

2. Choose the Set Field Attributes command from the Format menu. 

3. Click on the Computed option to remove the check mark, and click 
the OK button. 

You can't clear or cut (using the Clear and Cut commands from the Edit 
menu) the contents of calculated fields (exception: when the fields have 
been formatted as Time or Date, instead of Numeric). If you need to delete 
the fields, turn the Calculated Field option off frrst. 

SEARCHING AND MATCHING DATA 

Part of the work of any database is sifting through the data and finding infor
mation for you. The Works database offers three ways to search for data: 

• Finding Single Records-Finds a single record with a field that match
es a string of characters. 

• Matching Records-Finds all records with fields that match a string of 
characters. 

• Matching Records with Selection Criteria-Finds all records with 
fields that meet specific criteria. 

Finding Single Records 

The Find Field command in the Organize menu searches the entire database 
for any field that contains a certain set of characters. You enter the charac
ters to search in the dialog box that appears when you choose the Find 
Field command, as shown in Figure 6-15. The Search Text Fields Only 
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option siUps Numeric fields; it makes searching through a database with 
many Numeric fields quicker. 

Works will repeat the search, using the same character string you previ
ously entered, by choosing the Find Field command again. You can search 
through a database to find all matching fields by using the Command-F 
and Return keys. Press Command-F (for the Find Field command), then 
Return to accept the character string you previously entered. Works 
prompts you when it can't fmd any more occUITences of the string. 

Matching Records 

If you know the database contains many instances of the character string 
you are looking for, and you want to find them all at once, use the Match 
Records command (also in the Organize menu) instead. 

Enter the character string you are looking for in the dialog box, as 
described above for the Find Field command. Works then finds only those 
records that contain fields with the character string you specify, and dis
plays only them instead of the entire database. Of course, the original 
database is still there; to return to the database, select the Match Records 
command again. 

The Match Records command is particularly helpful when using the 
database with the merge printing features of the word processor. You can 
use Match Records to find only those records that conform to a certain cri
teria, like ages, ZIP codes, or cities. If you want to keep a permanent 
record of the matches, save them in a separate file, and use that file for 
merge printing. More specifically: 
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1. Select the Match Records command. 

2. Choose the Save As command. 

3. Enter a new name for the file, but before clicking Save ... 

4. . .. Click the Save Selected Records Only option. 

5. Click Save. 

Both the Find Field and Match Records commands find fields (anywhere 
in the database) that contain the character string you are looking for, even if 
the string is part of a larger number or word. For instance, if you are look
ing for the number 92, Works will match 92, 922, 192, 1922 and other vari
ations. Use the selection criteria method if this is not acceptable. 

In addition, the Find Field and Match Records commands are not case 
sensitive, so they will fmd all occurrences of the, even if the word appears 
as THE, The, or another form. 

Matching Records with Selection Criteria 

Matching records with selection criteria makes use of the record selection 
feature of the Works database. With selection criteria (discussed in more 
detail in the next section), you have much more control over the record 
matching. For example, you can find all records that DON'T match the 
selection criteria, or only records that match exactly-92 and NOT 922, 
192, or 1922. 

USING DATABASE RECORD SELECTION CRITERIA 

The Record Selection command in the Organize menu presents the "think
ing" portion of the Works database. With Record Selection, you can ask 
Works to fmd specific entries for you, excluding some and including others. 

Record Selection makes use of selection "rules," which are rules you 
impose on Works to locate and display only the information you want. 
Though most selections will contain only one rule, you can assign up to 
five rules at a time. 

The rules are used with field names, which appear on the left side of the 
Record Selection dialog box; the rules appear on the right. To impose a 
rule, select a field name and the appropriate rule, such as Name for the 
field and Does Not Begin With for the rule. 

Finally, enter in the Record Comparison Information box the specific 
text or numeric value that you want the rule to apply to, such as 
"Smith." The rule just established says, "Name Does Not Begin With 
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Figure 6-16 Sample of Before/After Database with Records 

Smith." When you press the Select button, Works will fmd all records 
where Smith does not begin the entry in the Name field. An example is 
shown in Figure 6-16. 

Works offers 14 rules, all of which can be used to compare against num
bers, but only eight to compare against text, as shown here. 



Rule 

Equals 
Contains 
Begins With 

Works With Numbers 

X 

Is Greater Than 
Is Greater Than or 

Equal To 
Is Less Than 
Is Less Than or 

Equal To 
Is Not Equal To 
Ends With 
Does Not Contain 
Does Not Begin With 
Does Not End With 

X 
X 
X 
X 

X 
X 

X 
X 
X 
X 
X 
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Works With Text 

X 
X 
X 

X 
X 
X 
X 
X 

In addition, two special purpose rules check to see if a particular field is 
empty or not. The Is Blank and Is Not Blank rules can be used with either 
numeric or text fields. 

Once a selection has been made, Works presents the records it has found 
in the database window. This window looks identical to the main database, 
but only lists those records that meet the criteria you have set up. To return 
to the original database, choose the Show All Records command from the 
Organize menu. 

You may wish to record the record selections you make for future refer
ence. You can do so by making a report of the record selection. Reports 
are record selections that you can save along with the database ftle. You 
can "attach" up to eight reports to any one database ftle, and access them 
through the Report menu, where you can duplicate them or delete them. 
The Works manual provides sufficient information on using the Works 
database report feature, so it won't be repeated here. 

Using AND and OR 
AND and OR are concepts used in logic, including the inner workings of 
the Macintosh computer. Works uses AND and OR (which are technically 
called "Boolean Expressions") as connectors, ways to add two or more 
rules to one selection. 

• The AND connector used between two rules forces Works to find only 
those records that conform to BOTH rules. If the record fails either 
rule, it does not pass the test. Of course, if more than two rules are 
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Record Selection: 

Last Name 
State 
ZIP 

contains 
begins with 
Is greater than 
Is greater than or equal to 

Record Comparison Information: 
~----------------------~ 

Selection Rules: Last Name equals SMITH 

® Rnd 0 Or ZIP equals 01100 

0 Rnd ® Or Last Name equals JONES 

® Rnd 0 Or ZIP equals 01100 

ORnd ®Dr 

OAnd OOr 

cancel Delete Rule ( Install Rule ) Gselect D 

Figure 6·17 Record Selection Box with Smith/Jones Rules 

used, and each one is separated by an AND connector, then ALL rules 
must be met, or the record fails. 

• The OR connector used between two rules enables Works to match 
records that meet EITHER of the rules (or both). When more than two 
rules are used, with each one separated by an OR connector, the record 
passes if it meets even one rule. 

You can, if you wish, use a combination of AND and OR connectors to 
develop a set of rules to fmd very specific information in your database. 
For example: 

Field 

Name 
Name 
ZIP Code 

Rule 

Equals 
Equals 
Equals 

Information 

Smith 
Jones 
01100 

Connector 

Or 
And 

This combination of rules finds r~cords with Smith OR Jones in the 
Name field, but only if the ZIP code field equals 01100. The Record 
Selection dialog box for this rules set is shown in Figure 6-17. 

Saving Record Selections 

Works keeps track of only one record selection at a time, unless you 
develop the selection as a report (choose New Report from the Report 
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menu, then choose the Record Selection command from the Organize 
menu). As a report, you can create up to eight record selections, and 
choose among them at will. Remember that Works attaches records with 
the database file, so when you save the database, you also save any records 
you may have created. 

Reports Feature and Relational Database 

A relational database is one that uses a "core" of records, and many ancil
lary database documents that access those records. When you add or 
change records in one database document, the core is changed so the infor
mation is simultaneously updated for all other databaSe· docinnents that use 
those records. 

Works is not a relational database, but its reports feature closely mimics 
one. The basic database file is the core of records you keep on your clients, 
friends, projects, or other information you are tracking. Each report is a 
different selection of that same data. One report may show clients that live 
on the East Coast, another those who live on the West Coast. 

Works doesn't allow you to edit or sort records when viewing them in 
reports, but you can print reports for future reference. You can also reposi
tion field columns in each report, and adjust printing margins to include 
only those fields you want in the printout. 

SAVING DATABASES AS EXPORT FORMAT 

Most of the database documents you create you '11 save in Nonnal format. 
But Works also lets you save in Export or Text-only format. This allows 
you to trade complete databases with the word processing and spreadsheet 
modules of Works, or with a completely different application. 

Before clicking the Save button to rC(Cord a database onto disk, click the 
Export button in the Save or Save As dialog boxes. You can additionally 
choose to save only those fields and records currently selected. Use this 
feature to save records for merge printing, for example. 

OPENING TEXT-ONLY FILES 

The Works database doesn't take much for granted when opening files 
saved in Text-only format (such as those created when you click the Export 
option). To open a Text-only document: 
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1. Click the database icon in the Open Files dialog box. 

2. Click the Export option at the bottom of the dialog box. 

3. Choose the file you want to open and double-click on it. 

4. In the dialog box that appears (as shown in Figure 6-18), select how 
the text is to be converted into database record/field format. 

5. Click OK; Works converts the file to database format. 

The Separate Database Fields dialog box provides three options for for
matting the file for the database module. 

• Tabs: Each tab starts a new field. A new record starts when Works 
encounters a return (new paragraph) character. 

• Spaces: Two or more spaces start a new field. A new record starts 
when Works encounters a return (new paragraph) character. 

• Return: A return (new paragraph) character starts a new field, and a 
new record. You can specify the number of fields contained in each 
record. 

SYLK files should not be opened by the database module. All you get is 
gibberish. If you accidentally open a SYLK file, just close it without sav
ing and open another. 

Separate Database Fields By: 

®Tabs (Each Record Ended By A Return) 

0 Two Or More Spaces (Treated Rs R Tab) 

0 Returns D Fleld(s) Per Record 

( cancel ) ( OK ) 

Figure 6-18 Import Text Conversion Dialog 
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Communicating with 
Works 

Name three important inventions over the past 150 years, and you're apt to 
say the television, the automobile, and the telephone. It's the last innova
tion, the telephone, that has particular importance to personal computer 
owners. 

With a modem attached between your computer and the household or 
office telephone lines, you can contact computers worldwide, and tap into 
their vast resources and capabilities. Among the possibilities: 

• Chat with friends and associates electronically. 

• Obtain up-to-the-minute Dow Jones stock reports. 

• Make plane reservations to anywhere in the world. 

• Receive free or nearly free public domain and Shareware software. 
• Contact your office computer while you're at home or away on a long

distance trip. 

This chapter covers telecommunications from start to finish, including 
the basics of modems and communications standards, setup and operation 
of the Works communications module, and manual operation of your 
modem to make it do what Works alone can't. 

ABOUT COMPUTER COMMUNICATIONS 

For years, audiences gathered at the local cinema to watch their favorite 
stars on the silver screen. But when television came along, the idea of hav
ing a cinema at home was even more appealing. Despite the lack of many 
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television stations to beam programs into homes, television sales rose 
sharply after World War IT. 

Like the television, the Macintosh was designed to be more personal. 
Computing brings number crunching close to those sitting behind the 
keyboard. Rather than one large computer serving the needs of 
many-the neighborhood cinema-why not an army of small computers, 
one on each desk. 

There are times, however, when the Macintosh (and all personal com
puters, for that matter) suffers from provincialism. It needs input from 
other computers to complete a task, or to perform a calculation, or to 
make a decision. 

Fortunately, the design of the Mac is such that connecting two of them 
together-for the purpose of sharing data-is not an extremely difficult 
task. It doesn't matter if the other computer is one mile or one thousand 
miles away; the techniques and the results are the same. 

Modem Basics 

Modems are used to connect two distant computers, for the purpose of 
sharing data, programs, or both. This connection is most often made 
through standard two-wire telephone lines. 

Most modems attach to the computer via an RS-232C serial port. They 
are powered by one of three possible sources: the electricity flowing 
through the telephone line (about minus 6 volts when the phone is off the 
hook), a separate AC power cord, or an internal battery. 

Modems connect to the telephone in one of two ways: directly or acous
tically. Direct-connect units run in-line between the telephone wall jack 
and the telephone instrument. Most direct-connect modems available 
today can be programmed to place and answer calls, and are aptly desig
nated "smart" modems. Most smart modems are Hayes "AT" compatible, 
using the same "AT" command set as the popular Hayes models. This 
compatibility assures that the modem will work with a variety of software, 
including Works. 

Acoustic-connect modems, which are no longer made in any quantity but 
sometimes available as close-out merchandise, cannot dial or answer the 
phone. Direct-connect modems have a pair of rubber cups that accept the 
handset of a standard desktop telephone. Acoustic-connect modems are 
generally used when you can't tap directly into the phone line-with a pub
lic phone, or a telephone in a motel room. 

Connecting a modem to your computer and phone isn't enough to estab
lish a communications link. Your computer must be told it's having a con-
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versation with another computer, for which a communications program is 
needed. At one end of the spectrum are simple software packages that 
instruct the computer to send and receive data, and nothing more. At the 
other end are sophisticated terminal programs that let you save the data 
received by your modem, or command a smart modem to dial the phone or 
answer a call. The Works communications module belongs to the second 
group, though it is not as refmed as some stand-alone terminal programs. 

Modems transmit and receive data at a variety of standard speeds, all 
expressed in baud (the term baud is often used interchangeably with 
bits per second, or bps, but the two are actually different; for our applica
tion, however, we'll assume they mean the same thing). The slowest stan
dard speed is 300 baud, which roughly equals 30 characters per second. 
Most modems in use today operate at 1200 or 2400 baud (120 to 240 char
acters per second). To work properly, the modem on the other end of the 
phone line must be capable of sending and receiving data at the same 
speed. 

Most modems have one of two operating modes: full-duplex or half
duplex. In full-duplex mode, the modem can receive and transmit data at 
the same time. In half-duplex mode, the modem receives or transmits, but 
not simultaneously. The Macintosh, and Microsoft Works, are designed for 
use with modems capable of full-duplex operation. 

The two modems in a link send and receive data in two discrete sets of 
tones. These two tone sets are referred to as answer and originate. All 
modems sold today are capable of both answer and originate operations, 
but some older models operate in originate mode only. H you use such a 
modem, you must connect to a distant modem capable of answer opera
tion, or the link cannot be established. With most smart modems, you can 
force them to operate in answer or originate mode, whether or not you ini
tiate the call. 

Using the Proper Cables 

No matter what brand or type modem you use, it must connect to your 
Macintosh via a cable. This cable serves to route the signals between modem 
and computer, and the cable must be constructed so that it matches both the 
Mac and the modem you are using. The cable connectors on most modems 
follow a standard format. You are fairly assured of successful results with a 
standard Mac-to-modem cable, available at most computer dealers. 

Note that different Macintosh models use two different connectors for 
the printer and modem jacks, and many modems use a third type of connec
tor. The three connector types, as shown in Figure 7-1 are: 
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(·.·.·.·.·) 
DB-9 

e e e 
e e e 

DIN-8 

eeeeeeeeeeeee 

-------·----DB-25 
Figure 7-1 Three Connector Types 

• Mini-DIN plug-matches the modem/printer jacks on the Mac Plus, 
Mac SE, and Mac ll. 

• 9-pin "D" plug-matches the modem/printer jack on the original 
Macs, including the 512K, as well as the IBM PC/AT. 

• 25 -pin 11D" plug-used with many modems, and also the the IBM PC 
and most other personal computers. 

Macintosh modems may use any of the three connector types detailed 
above. The cable you use must properly bridge the modem and Macintosh. 
Use suitable adapters, as necessary, to mate a mismatched cable to the 
Macintosh or modem. 

Besides using the proper connector ends, the wiring of the interconnec
tion between computer and modem must match. Why? Many modems 

. require specific signals for proper operating. These signals are detailed in 
Table 7-1. The Macintosh does not provide some of the signals normally 
needed for modem communications, requiring instead that the interconnect
ing cable be specially wired to force proper operation. If you can't fmd the 
right cable for your needs, you'll need to make it yourself or have one 
made for you. 

For example, some modems (particularly those designed to be connected 
to an IBM PC or other computer) require a DTR, or Data Tenninal Ready, 
signal on pin 20 (assuming the modem is equipped with a 25-pin "D" con
nector). The Macintosh does not support this signal line; rather, the DTR line 
from the modem is permanently grounded when used with the Macintosh. 
Using a modem that requires the DTR signal with a cable that doesn't ground 
the line can cause the modem to hang up before calls are completed. 



Pin 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 

Table 7-1 Modem Signal Lines 
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Function 

Frame ground 
Transmitted data 
Received data 
Request to send 
Clear to send 
Data set ready 
Signal ground 
Data carrier detect 
Reserved 
Reserved 
Unassigned 
Secondary data carrier detect 
Secondary clear to send 
Secondary transmitted data 
Transmit clock 
Secondary received data 
Receiver clock 
Unassigned 
Secondary request to send 
Data terminal ready 
Signal quality detect 
Ring detector 
Data rate select 
External transmit clock 
Unassigned 

'JYpical connection diagrams for Hayes and Hayes-compatible modems 
appear in Figure 7-2. The ImageWriter cable-which has either a 9-pin 
"D" or Mini-DIN connector on one end, and a 25-pin "D" connector on the 
either-is not designed for modem use. However, this cable can often be 
used as a "null-modem," for the purpose of directly connecting a 
Macintosh and ffiM PC or XT together. There's more information on null
modems and direct connections to other computers later in the chapter. 

Communications Protocols 

Works can send and receive data at six different speeds: 300, 1200, 2400, 
4800, 9600, and 19200 baud. These speeds assume that the modems con
nected to the computers on both ends of the phone link can keep up with 
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Mac to Hayes Modem Moe to PC (Null Modem) 
Dtn-8 DB-9 DB-25 Din-8 DB-9 DB-25 

4 3 7 4 3 7 
3 5 2 3 5 3 
2 7 5 5 9 2 
5 9 3 1 N/C 6 

Shell 1 1 

Mac to Mac 
Moe 1 Mac 2 

Din-8 DB-9 DB-25 Din-8 
4 3 4 3 
6 4----8 8 
3 5 5 9 
8 8 6 4 
5 9 3 5 
1 N/C 2 N/C 
2 N/C 1 N/C 

Figure 7-2 Typical Modem Connections 

the data transfer rate. Most modems have top speeds of 1200 and 2400 
baud. Of course, the speed limitation of the modem is not a consideration 
when transferring data directly from computer to computer, with no modem 
connected (see "Hard-Wrred Transfers," later in this chapter). However, 
both computers must be capable of transferring data at the same speed. 

Works is nonnally set up to operate at 1200 baud, but you can readily 
change the speed in the Settings window (either when Works communica
tions module frrst starts, or by choosing the Settings command from the 
Communications menu). The choice of baud rate is dictated by the speed 
limitations of your modem, the speed limitations of the modem on the other 
end of the phone line, and the quality of the phone connection. Normally, 
you should select the fastest baud rate possible. 

Syncing Up 

Most modems for personal computers operate asynchronously. With asyn
chronous communications, the signals that tell the receiving computer 
when a new character begins are embedded within the data as start and 
stop bits, as shown in Figure 7-3. The transmitting and receiving comput
ers are not synchronized to one another. This is the simplest form of 
modem communications, but it isn't always reliable. 
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Start 0 0 0 0 0 0 Stop 

Figure 7-3 Basic Serial Data Frame, with Start and Stop Bits 

Modems for larger computers, those most often used by corporations or 
professional database services, operate synchronously. With synchronous 
communication, which is less prone to error but can be slower overall, the 
transmitting and receiving computers are synchronized by the use of spe
cial timing signals. 

A good number of 2400 baud and faster modems operate in synchronous 
or asynchronous mode, assuring you of being able to communicate with 
most computers. This is an added feature not found in most of the previous 
300 or 1200 baud modems, even the expensive ones. If you're going to be 
contacting a variety of computers, synchronous operation is a good feature 
to have. 

Modem Protocols 

Modems transmit and receive data following standards developed by con
sultation groups from around the world. Two competing groups are Bell 
(part of AT&T), and CCITT, or Consultative Committee on International 
Telephone and Telegraph. The data transmission standards from these two 
groups are not generally compatible with one another. One standard is 
selected over another because of technical restrictions, capabilities, or cost 

Transmission standards for computer communications can be compared 
to standards for radio transmissions. An AM radio is designed to receive 
amplitude modulated (AM) stations; an FM radio is designed to receive fre
quency modulated (FM) stations. Only a radio capable of both amplitude 
and frequency modulation reception can receive both AM and FM stations. 
Table 7-2 lists the data transmission standards for the most often used baud 
rates. Italicized entries indicate the data transmission standard used most 
often in Macintosh communications, whether in the United States or 
throughout the world. 

For any one baud rate, there are other standards used elsewhere in the 
world, so even though you may have a modem capable of 2400 baud trans
mission, it may not properly communicate with all 2400 baud modems 
everywhere. Nearly all commercially available modems for use in the 
United States conform to the CCITI V.22bis data transmission standard. 
This standard is also used by most 2400 baud modems, regardless of where 
they are used in the world. 
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The same isn't true of 300 and 1200 baud modems. Almost all 300 baud 
modems used in North America follow the Bell 103 standard. Likewise, 
almost all 1200 baud modems used in North America follow the Bell 212 
standard. These two standards are used mostly in the United States, but see 
little application in other parts of the world. 

Protocol Data Rate Synchronization Line Type* Usage 

Bell103 300 Async Reg N.America 
CCI'ITV.21 300 Async Reg Europeflapan 
Bell 202 1200 Async Reg N.America 
Bell212 1200 Async/Sync Reg N.America 
CCITTV.22 1200 Async/Sync Reg Europeflapan 
Be11201 2400 Sync Reg/Leased N.America 
ccrrr V.22bis 2400 Async/Sync Reg All 
ccrrr V.26ter 2400 Async/Sync Reg All 
Bell208 4800 Sync Reg/Leased N.America 
CCITI'V.32 9600 Async/Sync Reg All 
Bell209 9600 Sync Leased N. America 
CCI'ITV.29 9600 Sync Reg/Leased All 

Table 7-2 Transmission Standards 

* Line JYpe refers to Regular or Leased lines. Regular lines suffer from greater 
noise than Leased lines. This noise can prevent high-speed data transfer. 

Data Transfer Protocols 
Beyond data transmission standards are data transfer protocols. These pro
tocols dictate how information is "packaged" before it is sent through a 
modem. By organizing the data in a specific way, communications pro
grams can check for accuracy of the transmitted information. 

Unlike data transmission protocols, which are determined by the elec
tronics in the modem, data transfer protocols are determined by the com
munications program running on the computer. Microsoft Works accom
modates three data transfer protocols: ASCII, XMODEM, and MacBinary. 

The most basic form of data transfer is ASCII, a system where both com
puters send and receive each character one at a time. ASCll (pronounced 
"ask ee") transmissions are best suited for word processing documents, 
where you only want to send the words of a file, and not its various fonnat
ting instructions. In fact, Works only allows ASCII transfers to send regu-
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lar word processing documents. With version 2.0 of Works, you cannot use 
ASCII data transfers for sending Text-only (Export) files, spreadsheet doc
uments, or database documents. 

Works, however, does let you receive ASCII Text-only documents from 
another computer. These files are then opened as export documents (within 
the word processor, database, or spreadsheet, as desired). 

Another application of ASCII data transfers is chatting with other com
puters "on-line," or accessing dial-up communications services such as The 
Source and CompuServe. What you type on the keyboard is instantaneous
ly transmitted over the phone lines to the destination computer. 

The XMODEM data transfer protocol dates back to the years before the 
Macintosh, when computers used the CP/M operating system and came 
with a whopping 64K of memory. Despite its age, XMODEM is one of the 
most versatile data transfer protocols around, and just about every commu
nications program for any computer supports it. 

XMODEM uses a system of sending data in discrete chunks, called 
blocks. Once transmitted through the phone lines, the XMODEM protocol 
then tests the electronic fmgerprint of the blocks to ensure the data was 
received properly. If XMODEM detects an error, the block is sent again 
(Works allows 10 retries of the same block; if the transfer is still faulty after 
10 tries, Works gives up and displays an error message). With Works-and 
other Macintosh communications programs-each XMODEM block con
tains 128 bytes of data. 

The most common use of XMODEM is to send and receive data that 
must remain accurate and intact. These include spreadsheet and database 
files, where even one small error can totally corrupt the entire document. 

XMODEM is a "universal" data transfer protocol, and can be effectively 
used to communicate with most any other brand of computer, including the 
ffiMPC. 

XMODEM sends the contents of the file, not the complete file as it resides 
on your hard disk or Works disk (here, the contents refer to the part of the 
file you actually see in Works, including text and formatting instructions). 

Conversely, the MacBinary data transfer protocol provides a means to 
send and receive entire Macintosh flies, complete with file name and icon. 
Because MacBinary allows you to send the complete file, and not just its 
contents, you can use it to send and receive whole Works files, including 
Macintosh applications (you can even send the Works program flle through 
the phone, but even at 2400 baud, it would take more than 50 minutes to 
complete the transfer). 

MacBinary is unique to the Macintosh, so it cannot be used to communi
cate with other brands of computers. 
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WORKS COMMUNICATIONS MODES 

The Works communication module has three general modes of operation: 
terminal, data receive, and data transmit. The mode dictates the data trans
fer protocol. 

• You are automatically placed in Terminal mode when starting the 
Works communication module. You are able to send or receive char
acters to and from a distant modem, as if your keyboard is connected 
to that computer (hence the word "terminal"). Terminal mode supports 
only the ASCII data protocol. 

• Data Receive mode allows you to capture (or download) information 
sent to you by a distant computer. Once captured, that data can be 
used by one of the other Works modules (or even another Macintosh 
application). Data Receive mode supports ASCII, XMODEM, and 
MacBinary protocols. 

• Data Transmit mode allows you to send (or upload) information to a 
distant computer. Depending on the data transfer protocol used 
(ASCTI, XMODEM, or MacBinary), you can send documents created 
in Works as well as other Macintosh documents and applications. Data 
Transmit mode supports ASCII, XMODEM, and MacBinary proto
cols, but you cannot send Text-only (Export) documents. 

Data Format 

Data is passed between modem and computer following a specific format. 
You can alter some of the variables in this format, as long as both you and 
the remote computer are set up the same way. The data format encompass
es three variables, which you can change in the Communications window: 

• Data Bits. Each character sent through a modem can comprise either 
seven or eight bits. Seven-bit communication allows you to send and 
receive normal alphanumeric characters, but not special formatting or 
font characters. If your document contains special font characters, use 
an eight-bit transfer. 

• Start and Stop Bits. These are clock bits that surround the data bits. 
The start bit is always included, and you can select either one or two 
stop bits. Generally, use one stop bit when transferring eight-bit data; 
two stop bits when transferring seven-bit data. 

• Parity Bit. The parity bit helps ensure accuracy in the transmission. 
The computer uses the parity bit in a mathematical formula to detect 
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when data bits have been received properly. If the parity bit doesn't 
match up to the sum of the data bits, an error has occurred. Most 
often, you can turn the parity check off (select None). Parity is gener
ally only used with seven-bit transfers. 

For general communication, whether between two Macs or between a 
Mac and another computer (including a dial-up service like CompuServe), 
use the following default data format settings: 

Data Bits Parity 
8 None 

Stop Bits 
1 

With the necessary start bit added, this data format contains 10 bits per 
character. The 10 bits per character format is standard among 300, 1200, 
and 2400 asynchronous communications. 

Data formats are often indicated in shorthand notation, as 8Nl, for eight 
data bits, no parity, and one stop bit. Other formats of the shorthand are 
easy to decipher. 

Problems of Call Waiting 

Progress can sometimes get in the way of itself. One example of a good 
thing taken too far-at least where modems and computer communications 
are concerned-is call waiting. With call waiting, you can be on the phone 
to one person, but still keep your phone free for other calls. It's a great 
convenience but it wreaks havoc on telecommunications: receiving a call 
during telecommunications can cause the modem to hang up! 

Most (but not all) phone companies that offer call waiting also provide a 
means to temporarily defeat it. Use this feature to turn off call waiting for 
the next call you make. Some phone companies use the following conven
tion for suspending call waiting: 

• On Touch Tone phones, dial *70, then wait for the dial tone. Without 
hanging up the phone, dial the phone number you want. 

• On rotary phones, dial1170, then wait for the dial tone. Without hang
ing up the phone, dial the number you want. 

If you're using Works to dial the number for you, you can add the sup
press-call waiting code to the number to dial. Add *70, or 1170, to the 
beginning of the phone number. The comma instructs Works to wait two 
seconds before sending the rest of the number. If you need more of a pause 
between the suppress-call waiting prefiX and the phone number, add more 
commas. For example: 
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Entry Number 

*70,555-1212 

1170,555-1212 

*70,555-1212 

Effect 

Touch Tone dialing: Suppress call waiting, 
pause two seconds, then dial number. 

Rotary dialing: Suppress call waiting, 
pause two seconds, then dial number. 

Touch Tone dialing: Suppress call waiting, 
pause four seconds, then dial number. 

Unfortunately, there is no sure way of turning call waiting off when you 
have instructed Works to listen for an incoming telecommunications call. 
If you use your computer to receive calls from other computers often, and 
are plagued by call waiting interruptions, consider removing the call wait
ing or adding a second, dedicated modem line. 

Noise on the Phone Line 

Some phone connections, even local ones, are better than others. And you 
never know when the connection will be good or bad. You may have called 
across country and talked to someone who sounded like they were in the 
next room. That's a good connection. Then the next call, to the same per
son on the same phone, sounded like it was beamed half-way out of the 
solar system before returning to earth. 

Noise on the telephone line is annoying in conversations, but trouble
some in telecommunications. H the noise is above a certain threshold, it 
impairs the normal communications between computers. This threshold, 
called signal-to-noise ratio, decreases as the data transfer speed increases. 
That is, if the noise only marginally affects data transfer at 1200 baud, the 
noise may make communications impossible at 2400 baud. 

Noise is characterized by a garbled transmission of lost, misplaced, and 
incorrect characters. If you are simply conversing with someone behind 
another computer, an occasional glitch is merely an annoyance. But if you 
are transferring entire Works documents from one computer to the next, 
any lost characters may spell doom to the entire procedure. 

Fortunately, the Works communications module provides two popular 
error-correction protocols to ensure that data is received intact. These two 
protocols, MacBinary and XMODEM, are discussed earlier in this chapter. 

What can you do if you're plagued by noisy phone lines? First, inspect 
the phone wiring in your home or office, including the jacks where your 
phone is plugged into the wall. A loose or dirty wire may be causing the 
problem. You'll also get the best lines during off-peak calling hours, from 
about 6 pm to 7 am weekdays, and all hours on the weekends. 
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Economy long distance phone lines are typically noisier than their full
priced cousins, so you may want to talk to your phone company about what 
measures you can take to obtain better results. Or, switch long distance 
carriers. 

Many companies that use telecommunications extensively lease special 
conditioned lines, at extra cost. These lines are engineered for cleaner, less 
noisy operation, and are generally used with super-fast modems-4800 
baud and higher. Conditioned lines are effective only for local dialing, 
though some phone companies offer conditioned long distance lines at a 
substantial surcharge. 

As an added safeguard against marginal phone lines, most 2400 baud 
and faster modems automatically fall back to a slower speed if they 
encounter an especially noisy phone line. Modem manufacturers bill this 
as adaptive call sequencing-the ability to automatically adapt to the limi
tations of the phone line. The fallback process usually occurs before actu
al data transmission begins, so valuable data is not lost. 

USING THE WORKS COMMUNICATIONS MODULE 

The Works communications module provides all the necessary commands 
for operation in one main menu, so talking with other computers is a rela
tively painless operation. 

When you open a new communications document, Works automatically 
presents the Settings dialog box. This dialog box is also available by 
choosing the Settings command from the Communications menu. With 
few exceptions, you can change the settings at any time, even during trans
mission. However, doing so is not recommended as changes while on-line 
can cause data loss. 

This dialog box, shown in Figure 7-4, allows you to: 

• Select the type of terminal emulation, if any. The Works communica
tion module can force the Macintosh to behave like a standard teletype, 
or ITY, machine (the standard setting), a DEC VT-100 tenninal, or a 
DEC VT-52 terminal. The VT-100 or VT-52 terminal modes, which 
offer special display capabilities, should be set only when you know 
the computer on the other end can accommodate the emulation. These 
modes are used most often when connecting to a larger computer, such 
as the corporate mainframe or CompuServe. 

• Set automatic line feed and auto-wrap. These options are active only 
under VT-100 and VT-52 emulation. They force Works to automati
cally wrap words that won't fit on the next line, and to begin each suc
cessive line under the previous one. 
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Communications Settings: 

Type: ®TTY 0 UT-1 00 0 UT-52 D lluto-u-r<JJI D N•~uJline 
Baud Rate: 0 300 0 2400 0 9600 

® 1200 0 4800 0 19200 
Delete Key Means: 

0 Delete 
Data Size: ® 8 Bits 0 7 Bits ® Backspace 

Stop Bits: ® 1 Bit 0 2 Bits Number of screens: U 
Parity: ® None 0 Odd 0 Euen 

Handshake: 0 None ® Hon/Hoff 0 Hardware 0 Both 

Phone Type: ®Touch-Tone® 0 Rotary Dial 

Line Delay: lnMI Character Delay: ~ 
[gl Capture TeHt When Document Opens 

Connect To: ® ~~~ 0 ~~~ _ca_n_ce_l_) ([ OK J 
Figure 7-4 Communications Dialog Box 

• Choose the baud rate. Select a baud rate according to the capabilities 
of your modem, the capabilities of the distant modem, and the quality 
of the phone connection. 

• Select the number of data bits per character. Works permits characters 
with either seven or eight bits; eight is the standard and should be used 
unless you are instructed otherwise. 

• Set the number of stop bits per character. Determines the number of 
clocking bits that follow each data byte. Available choices are one or 
two; one is standard. 

• Set the parity, for rudimentary error correction. Determines the type of 
error-catching parity bits that follow each character. Available choices 
are None, Odd, or Even. None is standard. 

• Determine the action of the Delete key (marked Backspace on Mac 
Plus and earlier models). When Backspace is selected (default), press
ing the Delete key moves the cursor one character to the left, but 
doesn't erase any character there. When Delete is selected, pressing 
the Delete key moves the cursor one character to the left, and erases 
any character there. Note that the action of the Delete key, regardless 
of the setting in the dialog box, may have a different effect on the dis
tant computer. The action of the Delete key will differ in other com
puters depending on how the communications program running on 
them is set up. 



Communicating with Works 251 

• Number of screens. Sets the amount of memory reserved in the 
Macintosh for remembering data you sent or received. Each screen 
contains approximately 2,000 characters, or about 315 words. The 
default screen setting is four pages (8,000 characters), but you can 
increase or decrease it as desired. Works accommodates up to 100 
screens of data, depending on available memory. 

• Select type of handshaking. Handshaking, or flow control, determines 
how the two computers in the link control the flow of data between 
them. The idea of handshaking is to keep one computer from sending 
data faster than the other can accept and store it. Available choices are 
None (normal); XON/XOFF (called software handshaking, where 
codes sent with the data stream are used for flow control); Hardware 
(otherwise known as ETX/ACK, where special lines in the intercon
nect cable carry flow control information); and Both. 

• Determine the dialing system when using the communications module 
to place calls. Select either Touch Tone (normal), or pulsed, depending 
on the capability of your phone system. Works doesn't allow you to 
mix dialing types when calling a number unless you control the 
modem manually (more on this topic later in this chapter). 

• Set a delay between successive transmitted lines. Permits a crude form 
of flow control where extra time is allowed between each line of trans
mitted data. Normally set to 0, or no wait. 

• Set a delay between successive transmitted characters. Permits a crude 
form of flow control where extra time is allowed between each charac
ter of transmitted data. Normally set to 0, or no wait. Using a delay 
between lines and characters greatly impedes data transmission, how
ever, and it does not guarantee error-free transmission. Delays should 
be used only if there is no other means of getting two computers in the 
link synchronized to one another (be sure to try the handshaking 
options frrst). 

• Indicate if text received and transmitted should be automatically stored 
in a WP document. When checked, Works asks for the name of the 
document after you press OK in the Settings dialog box. 

• Select a serial connection for the modem. Select either Printer or 
Modem, depending on which port connects to the modem. The stan
dard setting is Modem. 

Once you have established the communications parameters, click OK to 
place Works into terminal mode (if the default settings are to your liking, 
simply click OK or Cancel to start). If the Capture Text When Document 
Opens option is checked, Works first asks for a name for the captured data 
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before starting tenninal mode. If you decide you don't want to capture any 
data, click the Cancel button. 

Once in terminal mode, you can dial the number of another modem, wait 
to receive calls, or immediately begin conversing with a distant computer. 

Dialing the Phone 

To make a connection with another computer through a modem, you '11 
need to either dial the number to establish the link, or wait for the other 
computer to call you. Works provides a convenient way to dial numbers; it 
even remembers eight numbers for future reference (the numbers are saved 
when the communications document is stored on disk). 

To dial a number: 

1. Choose the Dial command in the Communications menu. An 
eight-number telephone directory dialog box appears, as shown in 
Figure 7-5. 

2. Enter a number in the Phone Number entry box. 

3. Click the Dial button opposite the number. 

If the telephone directory already contains the number you want to dial, 
you don't need to enter it again. Just click the Dial button opposite the 
number you want to call. Assuming the modem is properly connected to 
the Macintosh and your phone, Works places the call and waits for the call 
to be answered. 

cmiD 
Olli!!5 
I Olnll 

I Dloll 

I OllliJ 

I Oioll 

(Oiol) 

(Oiol) 

Name: 

555-121~ 

Figure 7-5 Phone Dial Box 

Phone Number: 

Uncle doe's Modem 

( Cancel ) ([ OK ) 
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During dialing, Hayes and Hayes-compatible modems provide a visual 
indication of the progress of the call (this is named, appropriately enough, 
call progress monitoring). Depending on how the modem is configured, 
the progress of the call is printed on the screen, either in full-English words 
or as codes. The most common call progress prompts are: 

• OK -General acknowledgment of a command, such as a number to dial. 

• DIALTONE-Dial tone detected. 

• DIALING-Phone being dialed now. 

• CONNECf-Phone answered (usually slow 300 baud speed). 

• CONNECT 1200/2400-Phone answered at 1200 or 2400 baud. 

• ERROR-A command could not be executed. 

• RING-Your telephone is ringing. Only appears when you command 
Works to answer the phone. 

• BUSY-The telephone dialed is busy. 

• NO CARRIER-Phone link terminated. 

Under software or hardware control, you can force the modem to provide 
these prompts as a single digit code. Most Hayes and Hayes-compatible 
modems use the following codes for call progress prompts: 

Code 

0 
1 
2 
3 
4 
5 

Waiting for a Call 

Prompt 
OK 
Connect 
Ring 
Busy or No Carrier 
Error 
Connect Hi-Speed (1200 or 2400 baud) 

To wait for an incoming call, choose the Answer Phone command from the 
Communications menu. Works will answer the next incoming phone call 
on the frrst ring. 

Works has no menu command to alter the number of rings until the 
phone is answered. Should you wish to wait more rings until Works picks 
up the phone, you '11 have to control the modem manually, as detailed later 
in this chapter. 
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Capturing {Receiving) Text and Files 

You'll spend many communications sessions capturing data sent to you 
through the phone lines. Here are some tips: 

• To save just the text of files transmitted in ASCIT (text only) made, 
choose the Capture Text command from the Communications menu. 
Provide a name for the captured text. The data is saved in Text-only 
(Export) document format. To end text capture, choose the End Text 
Capture command from the Communications menu. 

• To save the text (and not formatting instructions) of files transmitted 
with an error-checking protocol, choose the Receive File command . 
from the Communications menu, and click the XMODEM Text option. 
Provide a name for the captured text. The data is saved in Text-only 
(Export) document format. 

• To save the text and formatting of files transmitted with an error
checking protocol, choose the Receive File command from the 
Communications menu, and click the XMODEM Data option. Provide 
a name for the captured text. 

• To save the entire file, complete with icon and other Macintosh file 
resource information, choose the Receive File command from the 
Communications menu, and click the MacBinary option. Provide a 
name for the captured file. The file is saved in the same format as it 
was sent. 

You do not have to use the Receive File command when receiving a 
MacBinary file. Works will automatically receive a file sent in the 
MacBinary format, saving the file on the current disk drive and directory, 
using the same name as the original, transmitted file. If a file already exists 
on your disk with the same name, Works adds a digit to the received file, in 
order to differentiate it from the one you already have. Works never erases 
a file and replaces it with another. 

Sending Text and Files 

Works allows you to send text and ftles in the same manner as it receives 
them. Therefore: 

• To send the text (with formatting) of a Normal word processing docu
ment, choose the Send Text command from the Communications 
menu. Select the ftle to send and double-click on it. Works only sends 
text files of documents saved in the Normal word processing format 
(not Export). 
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• To send the text (minus formatting) of word processing, spreadsheet, 
and database files with error-correction, choose the Send File com
mand from the Communications menu, and click the XMODEM Text 
option. Select the file to send and double-click on it. Works sends 
XMODEM text of files saved in any format (including Export). 

• To send the text and formatting of word processing, spreadsheet, and 
database files with error-correction, choose the Send File command 
from the Communications menu, and click the XMODEM Data 
option. Select the file to send and double-click on it. Works sends 
XMODEM data of files saved in any format. 

• To send an entire Macintosh file, choose the Send File command from 
the Communications menu, and click the MacBinary option. Choose 
the file to send and double-click on it. 

Hanging up the Phone 

When the current communications session is over, you should instruct the 
modem to terminate the call; otherwise, the connection may not be broken. 
H the call is long distance, you may be charged extra for the connect time 
you didn't use. 

To hang up the phone, choose the Hang Up command from the 
Communications menu. It takes a few seconds for the modem to respond 
and terminate the call. 

Saving and Opening Communications Documents 

Changes you make in the Settings dialog box can be saved in a communi
cations document. You can use this document to quickly start a new com
munications session with the parameters you previously specified. 

Save the document in the usual manner. You can then open the docu
ment from within Works by double-clicking it in the Open Document dia
log box window. You can have only one conununications document open 
at a time. 

Both the Normal and Stationery file formats save similar communica
tions documents. Normal documents are opened with their name in the title 
bar. Works prompts you to resave the document after you have fmished the 
session. Stationery documents open as Untitled, even though Works 
changes the Setting parameters as you specified. Works prompts you to 
save the document after you have finished the communications session. 
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Other Communications Settings and Features 

Works includes a couple of other settings and features you may want to 
know about. 

Echo Off/Echo On The Echo Off and Echo On commands in the 
Communications menu determine whether Works repeats characters you 
type from the keyboard. In most cases, the distant computer will repeat (or 
echo) the characters you send to it. These echoed characters appear on 
your screen. Sometimes, the remote computer will not echo the characters 
you type, so as you write you won't be able to see what you are sending. 

Note: 

• If you type and nothing appears, tum Echo On. 

• If you type and two characters appear for every one you write, tum 
Echo Off. 

Most Hayes and Hayes-compatible modems also include an echo capa
bility, which is separate from the Echo Off and Echo On commands. You 
can turn modem echo off and on via manual control, as detailed later. 

Keypad The Macintosh keyboard lacks the keys normally found on DEC 
VT-100 and VT-52 computer terminals. When using Works under VT-100 or 
VT-52 emulation, you can access the special keys with the Keypad menu, 
shown in Figure 7-6. Apart from the number keys, which you can enter 
using the numerical keypad on your computer (if so equipped), the Keypad 
menu provides four programmed function keys (PFl through PF4) as well as 
special functions assigned to the number and character keys of the keypad. 

Non-Modem Calls 

What happens when you use Works to dial a number, only to fmd a real 
person answers and says "Hello." Depending on the features of your 
modem, it will: 

• Turn itself off and indicate a voice has answered the phone and not a 
modem. 

• Make squealing and squawking sounds and the person on the other end 
gets an earful of electronic gibberish. 

In either case, it pays to make sure that the number you are dialing is 
attended by a modem, not a human being. Prior to calling any number with 
your Macintosh, make it a habit to audition it frrst yourself, and do so only 
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Macro 

Figure 7-6 Keypad Menu 

at regular business hours (remember to take into account time zones). If 
you hear the telltale sounds of a modem carrier, you know you've got the 
right number. If a bewildered human answers the phone, and you're sure 
you dialed correctly, you know the number was given to you in error. 

If you have a single phone line for both voice and modem use, be sure to 
disable the modem to prevent it from prematurely answering the phone on 
non-computer calls. You can disable the modem in any of three ways: 

• Thm it off. 

• Disconnect it from the phone line. 

• Thm the Answer Phone command off, or manually instruct the modem 
to ignore incoming calls (see below for more details on manual modem 
control). 

Control Code Commands 
Many commercial communications systems, like CompuServe, The 
Source, and Dow Jones News/Retrieval, can be commanded with the use of 
control codes. Control codes are special characters created by pressing 
Command-Option, and a letter, number, or symbol key (extended and 
enhanced keyboards have a Control key that you can use instead of the 
Command-Option pair). Control codes generally occupy the beginning of 
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the ASCIT character table. Note that the letter A doesn't begin until ASCll 
character 65. 

Specific control code sequences vary from system to system, and you 
should obtain the instruction manual for your system for complete details. 
Here is a list of the most commonly used control code sequences, and their 
usual effect on communications systems and other terminals (even other 
Macintoshes running Works). 

Command 

Command-Option-3 
Command-Option-Del 
Command-Option-[ 
Command-Option-G 
Command-Option-H 
Command-Option-1 

Command-Option-J 
Command-Option-M 

Effect 

Break 
Delete 
Escape 
Sound tone 
Backspaces cursor one space 
Tabs cursor five to 20 spaces (depend

ing on communications program) 
Moves cursor down one line 
Moves cursor to beginning of line 

Works allows you to record control code sequences in a macro 
only when you use the Control key, not the Command-Option key pair. 
For example, you can record Control-G in a macro to sound a tone, but not 
Command-Option-G. If your keyboard lacks the Control key, you won't 
be able to record control code sequences in macros. 

Action of Delete Key 

The Delete key (or Backspace key on the Mac Plus and earlier models) can 
serve double-duty. Ordinarily, pressing Delete moves the cursor one space 
to the left, but doesn't erase any character there. With the Delete key 
option in the Settings dialog box, you can change the action of the key so 
that pressing Delete moves the cursor and erases the character. 

The action of the Delete key affects text only on your computer; text on 
the other computer may not be affected the same way. With the Backspace 
option selected in the Settings dialog box, Works sends a 08 code 
(Control-H) through the communications line to the other computer. Most 
terminal programs, including Works, accept the code, and obeys by 
backspacing the cursor. But with the Delete option selected, Works sends a 
127 code, which many communications programs ignore. Pressing Delete 
may have an effect on your computer, but not on the on~ at the opposite 
end of the phone line. To summarize: 
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Delete Key Setting 

Backspace 
Delete 

Local Action 

Backspace 
Delete 

Remote Action 

Backspace 
None 

The Works manual states that the Delete key setting applies only in VT-
100 or VT-52 modes, but also appears to work in TTY mode. 

Special Escape Key and ANSI Commands 

The Escape key on an enhanced and extended keyboard is fully functional 
in the Works communications module. Pressing Escape sends the ASCll 
character 27, and is equivalent to Command-Option-[ (or Control-[). The 
Escape key is often used to send special code sequences (called escape 
sequences) for controlling the display of the terminals connected in the 
communications link. 

As with most other communications programs, Works responds to many 
of the special American National Standards Institute (ANSI) escape 
sequences developed for manipulating the screen. ANSI codes are most 
often provided by commercial communication services, like CompuServe, 
as a way to provide a less cluttered and more presentable video display. 
Among the capabilities of ANSI escape sequences are: 

• Clearing the whole screen at once. 

• Moving the cursor a specific number of spaces, in any direction. 

• Setting unique display attributes, including high intensity (alas, dis
play attributes are not visible in Macintosh Works, but seen on other 
computers). 

• Selectively erasing lines, characters, and parts of the page. 

The ANSI escape sequences require that Works be in VT-100 or VT-52 
emulation mode (VT-100 offers more escape sequences, so use that when 
possible). The opposite computer in the link must also emulate an ANSI 
terminal. 

An appendix in the Works manual lists the ANSI escape sequences that 
Works responds to (there are many others in the ANSI code set). You can 
send nearly any sequence to another computer by pressing the Escape key 
(or Command-Option-[), then following it with the appropriate codes. 
For example, pressing the Escape key, and following with [2J erases the 
screen on both computers (assuming both are emulating ANSI terminals, 
such as a VT-100). 
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While you probably won't have much cause to work directly with ANSI 
escape sequences, some may come in handy even during routine chit-chat 
with another computer. The escape sequences are best implemented with 
macros, discussed in more detail in Chapter 8. There, you '11 fmd specific 
details for recording the following ANSI escape sequences for later playback. 

In the escape sequences that follow, the {Esc} entry indicates the Escape 
key; do not type the characters " {Esc}." Entries within angle brackets 
show variable information, such as number of rows or columns. Be sure to 
type letter characters in upper-or lowercase, specifically as indicated. For 
example, type {Esc}[2J to clear the screen, not {Esc}[2j. 

Sequence 

Cursor Movement 
{Esc}[ <rows> A 

{Esc}[ <rows>B 

{Esc}[ <chars>C 

{Esc}[ <chars> 

{Esc}[ <cols>Z 

{Esc}[ <Cols>l 

Line Editing 
{Esc}[ <lines>M 

Function 

Moves cursor up indicated number of 
rows; Example: {Esc}[SA moves cur
sor up five rows. 

Moves cursor down indicated number 
of rows; Example: {Esc}[SB moves 
cursor down five rows. 

Moves cursor right indicated number of 
character spaces; Example: {Esc}[SC 
moves cursor right five spaces. 

Moves cursor left indicated number of 
character spaces; Example: {Esc}[SD 
moves cursor left five spaces. 

Moves cursor left indicated number of 
tab columns; Example: {Esc}[2Z 
moves cursor left two columns. 

Moves cursor right indicated number of 
tab columns; Example: {Esc}[21 
moves cursor right two columns. 

Deletes one or more lines starting from 
the current position of the cursor; 
Example: {Esc}[3M deletes next 
three lines. 



Line Editing cont. 

{Esc}[ <lines>L 

{Esc}E 
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Inserts one or more lines starting from 
the current position of the cursor; 
Example: {Esc}[3L adds three new 
lines. 

Adds new line (carriage return and line 
feed). 

Cursor Position Save and Restore 

{Esc}[s Stores current position of cursor, for 
later recall. 

{Esc}[u Recalls previously stored cursor posi-

Screen and Line Erase 

{Esc}(OJ 
{Ese}[lJ 
{Esc}[2J 
{Esc}[OK 
{Esc}[lK 

{Esc}[2K 

Character Display Attributes 

{Esc}[Om 
{Esc}[lm 

{Esc}[4m 

{Esc}[7m 

tion; places cursor at that spot. 

Erases to end of page. 
Erases entire screen from cursor. 
Erases entire screen. 
Erases from cursor to end of line. 
Erases from start of line, including 

character at the cursor. 
Erases entire line. 

Thms off all character display attributes. 
Thms on high intensity character attribute 

(not shown on Macintosh display). 
Turns on underline character attribute 

(not shown on Macintosh display). 
Turns on reverse character attribute (not 

shown on Macintosh display). 
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Mode Selection 

{Esc}[?201 
{Esc}[?20h 
{Esc}[20h 
{Esc}[201 
{Esc}[?71 
{Esc}[?7h 
{Esc}[>7h 
{Esc}[>9h 
{Esc}[>8h 
{Esc}[>Sh 
{Esc}[>lh 
{Esc}[>71 
{Esc}[>91 
{Esc}[>81 
{Esc}[>ll 
{Esc}[?2Sh 
{Esc}[?251 
{Esc}= 
{Esc}> 

Disables auto line feed on carriage return. 
Enables auto line feed on carriage return. 
Sets carriage return on line feed. 
Resets carriage return on line feed. 
Disables auto-wrap mode (or use Settings dialog box). 
Enables auto-wrap mode (or use Settings dialog box). 
Sets modes, alternate keypad mode. 
Sets modes, auto carriage return on line feed. 
Sets modes, auto line feed on carriage return. 
Sets modes, cursor off. 
Sets modes, enables 25th line. 
Resets modes, no alternate keypad. 
Resets modes, no auto carriage return on line feed. 
Resets modes, no auto line feed on carriage return. 
Resets modes, disables 25th line. 
Disables cursor. 
Enables cursor. 
Enables alternate keypad mode. 
Disables keypad alternate mode. 

Note: The final character codes in the preceding examples end with 
either lowercase H or lowercase L (not a numeral 1 or an uppercase i). 

CONTROLLING A MODEM MANUALLY 

Many of the commands you give Works during a communications session 
are actually carried out by the modem. Works assumes you are using a 
Hayes or Hayes-compatible modem, and communicates with this modem 
using special command codes. Among the command codes Works sends 
out to the modem include: 

• Instructions for dialing a number, including dialing type (Touch Tone 
or pulse), and pauses between numbers. 

• Instructions for answering the phone. 

• Instructions for hanging up the phone. 

Why would you want to control a modem manually? One reason is to 
use Works with a non-Hayes-compatible modem, especially one of the 
older "direct-con.n.ect" types. Another reason is to access a modem com
mand not supported by Works, such as wait xxx rings before the modem 
answers. 
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Hayes AT Command Set 

Hayes modem commands are prefiXed by the letters AT (for ATtention), so 
they are often called AT-commands. With most Hayes and Hayes-compatible 
modems, the modem determines the speed of data transmission with the letter 
A, and the parity with the letter T. With this system, you needn't set baud 
rate on the modem itself, just within the Word communications module. 

To enter a command, you type AT, followed by the command you want. 
Some commands-most notably the commands for dialing the phone-are 
comprised of several parts. For example, to dial the phone, you enter 
ATDT999-0000 and press Return. Broken down: 

• The AT calls the modem "to attention." 

• The D commands the modem to dial the phone. 

• The T instructs the modem to use tone dialing. 

• The 999-0000 is the number to call. 

The standard Hayes AT command set is shown in Table 7-3. You can 
use either upper- or lowercase to enter modem commands. 

Operational Commands 

Command 

+++ 
0 
AT? 
A 
co 
Cl 
EO 
El 
FO 
FI 
HO 
HI 
10 
11 
QO 
QI 
Sx? 
vo 
VI 
z 
Dx 
p 

Function 

Escape On-Line 
Return on-line 
Menu (some modems only) 
Answer phone w/o waiting for ring 
Modem carrier off 
Modem carrier on 
Inhibit echo of commands 
Permit echo of commands 
Select half-duplex operation 
Select full-duplex operation 
Telephone on-hook 
Telephone off-hook 
Interrogate modem/product code 
Interrogate modem/self-test 
Send result codes to DTE 
Do not send codes to DTE 
Ask register contents (x is 0 thru 5) 
Send result codes as digits 
Send result codes as works 
Software reset 
Dial number (x is number to dial) 
Selects pulse dial type 

Default 

co 

El 

FI 
HO 

GO 

VI 
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Command Function Default 

T Selects tone dial type 
Wait two seconds 
Return to command mode after dialing 

Set Registers 

Register Function Default 

so Sets number of rings before answer 001 
Sl Number counter, increments as phone 000 

rings 
S2 Holds ASCII number for Escape code 043 

character 
S3 Holds ASCII number for Return code 010 

character 
S4 Holds ASCII number for Line Feed code 010 

character 
ss Holds ASCII number for Backspace code 008 

character 

Table 7-3 Standard Hayes Command Set 

Testing with AT Command 

When directly communicating with the modem, you can test that it is con
nected to your computer properly by typing AT directly into the tenninal, 
and pressing Return (you should not be connected to another computer 
through the phone lines during this). The modem responds with an OK. 

Using Direct Commands 

You may use a direct modem command any time you are not actively send
ing or receiving text or files. 

The modem automatically falls into a command mode when frrst turned 
on, and with no computer on the other end of the phone line. You may 
enter any AT command when in the command mode. However, after the 
modem establishes connection with the other computer, it places itself in 
on-line mode, sending what you type through the phone line instead of 
intercepting it as a command. The modem therefore now ignores AT com
mands. To issue a modem command, you must first enter an interrupt 
sequence consisting of three plus signs in a row-+++ (you don't need to 
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type AT first). When interrupted, the modem goes back into command 
mode. After a second or two delay, you may enter an AT command. To 
exit command mode, type ATO (the letter 0, not the numeral zero). Here's 
a summary: 

Mode 

Command 

On-line 
Command 

On-line 

Condition 

Connection to another computer not estab
lished (phone on hook). 

Connection to another computer established. 
Type +++, wait one or two seconds before 

entering AT command. 
'JYpe ATO (must be connected to another com

puter or modem returns an ERROR message). 

More Useful Manual Modem Commands 

Here are some manual modem commands you may fmd useful when com
municating with Works: 

• Mixed dialing: Mix the T and P dialing commands with the number to 
dial if you must use both Touch Tone and pulse (a PBX system, for 
example). For instance: ATDP9,T555-1212 starts pulse dialing with a 
digit 9, pauses four seconds for the PBX system to grab an outside dial 
tone, then fmishes the call with tone dialing. 

• Return to command mode after dialing: Sometimes, you may wish to 
force the modem into command mode after dialing a number (the 
default automatically changes to on-line mode). Place a semicolon(;) 
after the number to dial, which causes the modem to return to com
mand mode after dialing without disconnection. 

• Set number of rings: To force your modem to answer the phone after a 
certain number of rings, add SO=# (# is the number of rings from 0 to 
255) before waiting for the call (by the way, don't use the Answer 
Phone command in Works, as it will override your number of rings set
ting). To answer the phone on the fifth ring, for instance, enter 
ATS0=5, then press Return. When the number of rings is set to 0, 
auto-answer is disabled and the modem won't answer the phone. You 
can test the number of rings setting by typing ATSO? and pressing 
Return. The standard default of most modems, and used by Works, is 
one ring. 
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• Immediately answer the phone: You can force the modem to pick up 
the phone without waiting for a certain number of rings by typing 
ATA, then pressing Return. 

• Telephone on-hook: You can force the modem to hang up the phone 
with the HO command. If you are conversing with another computer, 
remember to frrst return to command mode (type +++, then pause for 
a second or two), before typing ATHO and pressing Return. 

• Telephone off-hook: Normally, your modem seizes the phone line 
immediately before dialing a number or going on-line. For special 
applications, you can force the modem to pick up· the phone with the 
Hl command. Type ATHl, then press Return. 

• Return to default settings: Most modems have initial or default set
tings, either set at the factory, set by a series of switches, or encoded in 
a battery backup RAM chip. You can return to these default settings 
by typing ATZ, and pressing Return. This command is helpful if you 
have changed the parameters of the modem during a session, and want 
to start all over again from scratch. 

• Redial the last number or repeat a command: Typing A/, and follow
ing with a Return causes the modem to repeat the last command you 
gave it. This is most helpful in redialing the last number. 

• Turn off/ on modem speaker while dialing: Thrn off the speaker in the 
modem (if so equipped) during dialing with MO and Ml commands. 
MO turns the speaker off; Ml turns it back on. An additional com
mand, M2, turns the speaker on during the entire use of the modem, 
even during data transfer. 

Command Name 

Speaker off during dial 
Speaker on during dial 
Speaker on continuously 

Command Code Example 

MO ATMODTSSS-1212 
Ml ATMlDTSSS-1212 
M2 ATM2DT555-1212 

USING A NON-HAYES COMPATIBLE MODEM 

Modems that use an operating command structure other than Hayes may 
require you to enter different operating commands. While Works will oper
ate with any modem, even an acoustic-connect modem that lacks any intel
ligence, the Dial, Hang Up, and Answer commands in the Communications 
menu will not work. Consult the instruction manual that came with your 
modem for special command sequences. 
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HIGH IQ MODEM-EXTRA COMMUNICATIONS POWER 

Computer-to-computer communication can be complex business, particu
larly if you want the process automated. Most of today's modems (whether 
they operate at 1200 baud, 2400 baud, or some other speed) have a good 
deal of built-in intelligence, making it a lot easier for you to converse with 
distant computers. This intelligence goes beyond being able to automati
cally dial and pick up the phone. 

Some of these smarts are transparent to you-they operate without any 
assistance from you or Works. Other operations require help from you. 
Works itself doesn't provide a means to control these higher levels of oper
ation, but you are always free to interact with the modem manually, as 
detailed above. Consider these extra features to make your job with the 
Works communications module simpler and more enjoyable. 

Adaptive Dialing 

Most so-called smart modems can dial the phone for you. The majority can 
be used with either Touch Tone or rotary pulse phone lines. The better 
modems can automatically select which type of dialing mode is required. 
This is called adaptive dialing and is useful when both types of dialing are 
required in one call (which is often the case with certain PBX systems). 

The average smart modem has limited dialing capabilities. Give it a 
number to dial and it does it, with no questions asked. Phone systems 
aren't foolproof, however, and there are plenty of circumstances that pre
vent even routine calls from going through. It's often handy to have a 
modem that can quickly realize when something has gone wrong, and ter
minate the call and try again. 

This is where a power modem (like the venerable Hayes Smartmodem 
2400) comes in. Let's say, for example, that you are dialing out from your 
place of business. You have a centralized PBX phone system, one where 
you must dial a certain digit to get an outside line. With the Smartmodem 
2400, you can instruct it to listen for the second dial tone before completing 
the call. This way, no matter how long it takes for the outside line dial tone 
to come, the modem will patiently wait for it. 

Many of the latest modems can listen for several successive dial tones while 
calling. This can be particularly handy when using one of the economy long 
distance services like Sprint and MCI. Just make sure that the modem you 
pick can dial from a non-standard dial tone (called blind dialing), which 
Sprint and MCI use. 
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Increasing the Dialing Directory Power 

A good number of smart modems have their own built-in phone directories. 
Rather than store the numbers in Works, the modem itself carries the num
bers in its memory banks. While this may seem like an unnecessary fea
ture-given Works' ability to record frequently used phone 
numbers-smart modems have a variety of ways to extend the usefulness 
of their internal directories. 

For example, some smart modems let you type in a name instead of a 
code when selecting a number to dial. To call your work computer, for 
example, you can simply type "W-0-R-K." Such modems also store log
on sequences (user I.D. and password) and automatically provide all the 
necessary information after the connection has been made. Works offers a 
similar approach to log-on sequences with macros, but macros currently 
cannot be made to wait for user input or provide the proper character and 
code sequences in response to prompts. 

Most power modems can also link stored numbers. If you get a busy sig
nal on one number, the modem will automatically dial an alternate number 
(or, you can program the modem to repeatedly redial one number until it 
rings through). 

Who's Calling, Please? 

Once the call has been made, a good smart modem can distinguish which 
type of answer it gets: type of dial tone, a busy signal, no answer, and even 
voice. The modem displays the dialing progress on the screen for you. 

An intelligent modem, such as the Hayes Smartmodem 2400, goes one 
step further, and is able to detect a "quiet answer," a short period of silence 
which follows a connection to many PBX phone systems in use today. The 
modem can then dial an access code needed to get a dial tone for connect
ing to a specific extension. 

"Multi-tasking" with Modems 

Modems are used in tandem with a computer, the latter of which often has 
its own memory. Putting memory inside a modem for use other than to 
store phone numbers may seem like a daft idea at ftrSt, but there are plenty 
of good reasons for doing it. With extra memory, the modem can act as an 
electronic mail center, sending and receiving messages without involving 
the computer. 
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This can be handy when the host computer is disconnected, busy, or 
turned off and messages come in (the Works communications module can 
work in the "background" while you're busy crunching numbers or pro
cessing words, but communications halt when the mouse button is 
depressed or when the Macintosh accesses its disk drives). 

Another use for internal memory is keeping track of your modem calls. At 
any time, you can display the calls you made, along with the duration in 
hours, minutes, and seconds. This is useful for audit or time billing purposes. 

DATA TRANSFER SPEED 

When sending and receiving files it is often handy to know how long the 
process will take. You can estimate roughly how long it takes to send a 
certain file through the phones by dividing the number of characters in the 
file by the characters per second speed of the modem transmission. For 
example, if the file you're sending contains 5,000 characters and you are 
using a 2400 baud modem, approximate transfer time is 21 seconds-5,000 
divided by 240 (240 is the number of characters sent per second with a 
2400 baud modem). 

Modem Speed 
300 

1200 
2400 
4800 

Divide Character Number by 
30 

120 
240 
480 

You can also use the table that follows to estimate transfer times when 
working with files from 5K to 50K. 

File Size 300 baud 
5K 2. 7 minutes 

10K 5.6 minutes 
15K 8.3 minutes 
20K 11.2 minutes 
25K 13.9 minutes 
30K 16.6 minutes 
35K 19.4 minutes 
40K 22.4 minutes 
45K 25.0 minutes 
50K 27.8 minutes 

1200 baud 
42 seconds 
1.4 minutes 
2.0minutes 
2.8 minutes 
3.5 minutes 
4.0 minutes 
4.9 minutes 
5.6 minutes 
6.3 minutes 
7.0minutes 

2400 baud 
21 seconds 
42 seconds 
l.Ominute 
1.4minutes 
1.7 minutes 
3.0minutes 
2.4minutes 
2.8 minutes 
3.1 minutes 
3.4minutes 

Data transmission using XMODEM or MacBinary takes about 10-15 
percent longer than plain ASCII transfers. This extra time is caused by the 



270 Inside MS Works 2 for the Macintosh 

data overhead needed to properly transfer error-corrected files, but it does 
not take into account blocks of data that must be re-sent because of errors 
caused by noisy phone lines or other denizens. 

When sending and receiving XMODEM and MacBinary files, use the 
table above to compute the duration of transmission, and add 10 to 100 per
cent, depending on the quality of the phone connection. 

Connection Quality 

Excellent (no errors) 
Good (infrequent errors) 
Fair (occasional errors) 
Poor (constant errors) 

Base Time Plus 

10 percent 
25 percent 
50 percent 

100 percent 

DEALING WITH TRANSMISSION ERRORS 

Transmission errors during normal terminal use of the Works communica
tions module, or during plain ASCII transfers, appear as occasional garbled 
characters, as shown in Figure 7-7. This is in contrast to a completely gar
bled screen, which typically indicates incorrect terminal settings, such as 
baud rate or number of data bits. 

If at least some of the transmission is legible, the Works communications 
module is set up properly to receive the other computer's transmissions, but 
the phone link may be excessively noisy. Try making a new connection, or 
decrease the speed of transmission. 

I Subsc~lba~ Asslstan-~~ 
2 Find a Topic 
3 Communications/Bulletin Bds. 
4 News/~eatha~/Spo~ts 
5 T~avel 
6 The Elecxr-nlc MALL/Shopping 
7 Money Matte~s/Ma~kets 
8 Enta~talnmant/Gamas 
9 Home/Health/Edu8djdon 

10 Reference 

<Baj dll 
II Computers/Technology 
12 Business/Othe~ Interests 
Ente~ choice nu~be~ 

Untitled (CM) 

Figure 7-7 E"ors Caused by Noise 
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Transmission errors during XMODEM and MacBinary transfers aren't 
shown as garbled characters, but Works provides a dialog box that shows 
you the progress of the transfer. If you notice Works must resend the same 
blocks over and over agaip., and the transfer is not progressing as quickly as 
you'd like, cancel the transfer and make a new connection, at a slower baud 
rate if necessary. 

HARD-WIRED TRANSFERS 

Hard-wired transfers dispense with the modem and connect two nearby 
computers by wire only. You can use this technique to transfer data 
between two computers in your office that don't share the same disk for
mats-a Macintosh and an mM PC, for example. 

Although there are a number of special-purpose terminal programs for 
connecting the Mac to an alien computer and transferring data, you can 
readily accomplish the same task with the proper cable and Works. The 
connected computer on the other end of the cable must likewise be outfitted 
with a communications program, so that it can send and receive data. Most 
communications programs will work. 

The cable connected between the two computers must be wired appropri
ately for the transmission of data. Such a cable is often termed a "null 
modem" cable, meaning that the cable is meant for use in serial communi
cations between computers, but without a modem. Generally, a null 
modem cable is the same as a regular modem cable, except that the data 
transmit and data receive lines are reversed on one end. 

As it turns out, the Image Writer I cable is constructed as a suitable null 
modem cable, so you can use it to connect a Mac to an mM PC or other 
computer that is equipped with a DB-25 25-pin "D" connector. 

Once the cable is in place, you can set up Works and the terminal pro
gram on the other computer so that they share the same communications 
settings. Since a hard-wired connection is not susceptible to noise in a 
phone line, or the speed limitations of a modem, you can choose the fastest 
baud rate you wish. However, if the cable stretching between the comput
ers is more than about 50 feet along, you may fmd it necessary to reduce 
the transmission speed to 4800 baud or slower. Longer cables exhibit high
er capacitances, which act to distort the data signals. The distortion is 
decreased when transmitting at a slower speed. 
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COMMUNICATIONS GLOSSARY 

Consult this glossary if you encounter a mystifying word or two on the sub
ject of modems and telecommunications. 
Adaptive Call Sequencing-A feature of some modems to automatically 

switch to a slower data transmission speed when using noisy phone lines. 
Adaptive Dialing-The ability of a modem to sense the type of dialing 

method to use for a particular phone line or service-either pulse or 
Touch Tone. 

Answerback-A short message sent by a modem upon answering a call. 
Asynchronous Communications-Data transfer from one modem to another 

with start and stop framing each character. The start and stop bits tell the 
receiving modem when one character ends and another begins. 

AT Command-An operating command used by the Hayes family of 
modems; also used by Hayes-compatible modems. A typical AT 
command might be to dial a number or hang up the phone. 

Autobaud-The ability to automatically detect and match the data 
transmission speed being used by the other modem on the line. 

Baud-Data transmission speed; same as bits per second. 
BPS-stands for bits per second, often used to indicate data transmission 

speed of a modem. 
Bell Compatible-A modem that follows the standards set by Bell Labs 

with their original 300 and 1200 baud modems. The North American 
standard for 300 baud modems is Bell103; the North American standard 
for 1200 baud modems is Bell212A. 

Blind Dialing-The ability to detect a non-standard dial tone and dial from it. 
Buffer-A memory holding tank inside a modem. 
Call Progress Monitoring-A feature found in some modems where the 

progress of a call (dial tone, dialing, ringing, etc.) is relayed to the 
computer electronically or played through a built-in speaker. 

Callback Security-A security system where, after the caller presents a 
valid password, the modem automatically hangs up and redials the 
caller using a predetennined phone number. 

CCIIT Compatible-A modem that follows the standards set by the 
Consultative Committee on International Telephone and Telegraph. The 

CCITT standard for 300 baud modems is V.21; 1200 baud is V.22; 2400 
baud is V.22bis. The CCITT also has standards for auto dialing and 
other modem operations, but few U.S. manufacturers follow these. 

Chaining-A feature of some modems to automatically dial a standby 
number in case the primary number is busy. 

Fall back-The ability of a modem to automatically switch to a lower 
operating speed to compensate for excessive noise in the phone line or to 
match the speed of the modem on the other end of the line. 
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Number Storage-A small portion of memory built into the modem for 
telephone number storage, used for fast dialing. 

Secure Modem-A type of modem with its own built-in password security 
system, which can be used to deny unauthorized users access to the host 
computer. See also "Callback Security." 

Smart-A modem that, at the very least, can dial or answer the phone 
following computer command. 

Synchronous Communications-Data transfer from one modem to the other 
using special synchronizing pulses. These pulses put both transmitting 
and receiving computers "in sync" so characters can be properly 
recognized. 

Transparent-The ability of a smart modem to turn off its intelligence, for 
manual call processing and data transfer. 



CHAPTER 8 

Saving Time with Macros 

To paraphrase Thomas Edison, word processing is composed of one per
cent inspiration and 99 percent perspiration. With judicious use of Works 
macros, you can reduce the perspiration to a much more comfortable level. 
Macros record the keys you press and mouse actions you make when using 
Works. Played back, macros replicate your actions automatically, and in 
the wink of an eye. 

This chapter details the fmer points of creating and using macros. You'll 
learn how to store macros in easily usable "sets," how to record pauses with 
macros, and how to keep a running log of the macros you've created. The 
chapter also provides several useful applications of macros. 

MACRO BASICS 

Though macros provide a great deal of versatility, many Works users 
neglect to learn how to use them. Here's a quick rundown on how to apply 
the macro feature. 

Recording Macros 

Follow these steps to record a new macro: 

1. In any Works module, turn the macros feature on by choosing the 
Macros On command from the Macro menu. This is akin to turning 
on the power switch to a tape recorder. 

275 
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2. To record a new macro, choose the Start Recording command from 
the Macro menu. The dialog box in Figure 8-1 appears. Enter a 
number or letter key to identify the macro. When used with the 
Option key, this key will be used to quickly start macro playback 
directly from the keyboard. The following list shows the keys you 
can't use to identify a macro: 

Key Types Examples 
E, I, N, U,,.... Accent 

Modifier 
Reserved 

Shift, Caps Lock, Option, Command 
Delete (or Backspace), ', =, -, +, _ 

3. Enter a short description of the macro in the Description editing box. 
If you want to record pauses click the Record Pauses option (if you 
need to see the execution of the macro; for example, when creating a 
recorded presentation). Press Record to continue. 

4. From this point on, keys you press and menu commands you choose 
are recorded in the macro. Be careful! There is currently no way to 
edit a macro, so any mistakes you make will also be recorded, and 
will be a part of the macro. If you make a big mistake, you'll have to 
start over. 

5. When recording is done, choose the Stop Recording command from 
the Macro menu. Works double-checks that you want to stop macro 
recording with the dialog box shown in Figure 8-2. To stop macro 
recording, press the Stop button. 

If you choose to assign a single digit number to a macro (such as 1, 2, 3, 
and so forth), you must enter the number in the Key box using the keys 
along the top of the keyboard, not the ones in the numeric keypad. 

Be aware that you cannot start a macro when in the New or Open files 
dialog box. In addition, you cannot use a macro to record a free-hand 
Draw object. Macros can only record the points on the screen where you 

Start Recording: 
Key Description of new macro 

...._I _ ... IlL... ______ ____.I n Record B 

D Record pauses ( Cancel ) 

Figure 8·1 Start Recording Dialog Box 



*** Currently recording *** 

D Record preuious delay 
D Record future delays 

Figure 8-2 Stop Recording Dialog Box 
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~ Stop ll 
( Continue J 

( Cancel J 

click the mouse, not the space between the points of a free-hand object 
where you drag the mouse. 

Playing Macros 

Previously recorded macros can be played back in either of two ways: 

• Press Option and the key used to identify the macro. For example, if 
you identified the macro with the letter F, then press Option-F. 

• Choose the Playback And command from the Macro menu, select the 
macro you want to play, and click the Play button. 

SPECIAL IDENTIFICATION KEYS 

You can assign macros to the Tab key, as well as the 10 function keys (Fl 
through Fl 0) on an enhanced Macintosh keyboard. 

• To assign a macro to the Tab key, type the word "Tab" in the Start 
Recording dialog box. To play the Tab key macro, press Option-Tab. 

• To assign a macro to a function key, press Fl through FlO while the 
Start Recording dialog box is open. To play a function key macro, 
press Option-F#, where# is one of the function keys. 

SAVING MACROS 

Macros are really document files. You can use any recorded macro for as 
long as you're in Works, but if you want it for your next Works session, you 
must remember to save it frrst. Macros are stored in special macro files. 
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Each file can contain only one macro per available key (one for each letter 
and number), but you can create as many macro files as you want, each 
with a different definition for the available keys. For example, in one 
macro file, Option-N may type your name and address, and in another 
macro file, Option-N may open a new word processing document. 
To save the macros you have created so far: 

1. Choose the Save Macro File command from the Macro menu. 

2. Enter a name for the macro flle, and press OK when fmished. You 
can also select a drive and directory for storing the macro file. 
Alternatively, just press OK to use the default macro file named 
"Microsoft Works(keys)." 

OPENING SAVED MACRO FILES 

If you have already recorded one or more macros in a macro file, access 
those macros by opening the file using these steps: 

1. Turn macros on (if they aren't already) with the Macros On command 
from the Macro menu. 

2. Choose the Open Macro File command from the Macro menu. 

Open Macro File 

G::J Number SiH 

( l: j(~( t ) 
( OritH~ ) 

···-··-······· ... --·················--
( Open ~1 
( New ) 
( Cancel ) 

Figure 8-3 Selecting Macro File in Open Macro File Box 
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3. From the list directory that appears, choose the macro file you want, 
as shown in Figure 8-3, and click the Open button (or press Return). 

Note: You can have only one macro file open at any time. If you try to 
open another macro file before saving any macros recently created, you are 
asked if you wish to save them frrst. 

ADDING MACROS TO A MACRO FILE 

Often, you'll want to add a macro to one of your existing macro files. Be 
sure to open the desired macro file frrst, then record the macro. After 
recording is fmished, save the macro file again. 

MERGING MACROS 

Works provides no easy way to combine two or more macros from one 
macro file into another file. However, you may wish to merge macros-to 
consolidate files, for instance. The best approach is to open the macro file 
you wish to keep and re-record those macros you want to add to it. 

USING THE PLAYBACK AND COMMAND 

The Playback And command provides most of the functions found in the 
Macro menu. You can delete macros, save macro files, open macro files, 
start recording, and more with the dialog box that appears in Figure 8-4: 

• The New button lets you clear the slate of all macros and start over. If 
you have created any new macros, or erased old ones, you are prompt
ed to save the file. 

• The Open button lets you open a new macro file. It is the same as the 
Open Macro File command. 

• The Save button saves the existing macros in a macro file. If the file 
has not been previously saved, you are asked to provide a name for 
your macro file. The Save button is the same as the Save Macro File 
command. 

• The Save As button saves the macros under a new macro file name. It 
is the same as the Save Macro File As command. 

• The Play button plays the currently selected macro (from the macro 
list on the left). 
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Playback Macro File: (no name yet) 

Macro Description Keys 

~ fi Play II 
(Record ... ) 

( Delete ) 

!() Cancel 
~------------------------------~ 

New ) ( Open... ) ( Saue ] (Saue Rs ... ] 

Figure 8-4 Playback and Dialog Box 

• The Record button records a new macro. It is the same as the Start 
Recording command. 

• The Delete button erases the currently selected macro (from the macro 
list on the left). Works does not let you undo the deletion, so be care
ful with this button. However, if you accidentally delete a macro that 
has been previously saved in a macro flle, open the flle again. Works 
will ask if you want to save the changes to the macro ftle; click the No 
button. Beware! All other changes you have made, including new 
macros you created, will not be saved, either. 

• The Cancel button cancels the Playback And command and returns 
you to Works. 

PAUSES 

Normally, macros play back at only a fraction of the speed it took you to 
record them. A macro with pause on (as indicated with the Record Pauses 
option in the Start Recording dialog box) plays back in roughly the same 
speed it took to record. Pauses in a macro are most useful as a presentation 
tool. You can use the feature to prepare a guided tour of a document, for 
example, highlighting a series of facts and figures for a client or associate. 

You can also use pauses as a means to "debug" a Works macro. 
Debugging means to locate a fault in programming-in this case, the pro
gramming of a Works macro. If a macro doesn't seem to be operating prop
erly, re-record it, this time with pauses on. Play it back and watch its 
progress carefully. You should easily fmd the cause of the problem. Once 
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the error has been corrected, record the macro once more, this time with the 
pauses off. 

LIMITATIONS OF MACROS 

Macros are great productivity tools, but Works macros are more limited 
than the macro function found in some other Mac applications, such as 
Microsoft Excel or WingZ. 

Macros merely repeat your actions with the keyboard and mouse. Works 
macros are not intelligent, and they can't determine the type of document 
currently open. For obvious reasons, using a macro designed to draw a 
series of boxes in any Works module other than Draw will result in an 
error. Be sure to double-check that you are using the proper macro, and 
that the correct Works module is active. If the macro requires a specific 
document be opened, check that the document is on the screen and active. 

Macros work best when the document window you used to create the 
macro is the same size as the document window during playback. 
Otherwise, the macro may not work properly. Get into the habit of expand
ing windows to their full size before recording and playing back macros. If 
only one window is open at a time, you can include expanding the window 
as the frrst step of a macro. 

Macros operate in an "absolute" world where mouse actions are replayed 
in the exact same place as they were recorded. For best results, use the 
mouse only for choosing commands from a menu or options from a dialog 
box; avoid using the mouse for controlling windows (opening them, closing 
them, and so forth), scrolling through documents, and editing. Why? The 
macro replays the recorded mouse action in the same place as the original; 
if the window during playback is in a different place than it was during 
recording, you could end up with a terrible mess. 

You must access the Macro menu to stop recording a macro; there is no 
command key shortcut to do it from the keyboard. This presents a serious 
limitation: Works macros can't be stopped at dialog boxes. 

PRINTING THE MACRO LIST 

Unless you use the same macros several times each day, you will invariably 
forget which macro does what, and which keys you must press to invoke a 
particular macro. Unfortunately, Works doesn't provide a way to print 
macro defmitions. If your macro files each contain eight or more macros, 
write them down by hand and make a paper copy for your own reference. 
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Figure 8-5 Sample Works Macro Database File 

If you regularly update or add new macros, keep a running tally in a Works 
database file. Update the file as needed, and print a new one. Figure 8-5 
shows how you might construct a macro-tracking database file. 

If you have fewer than eight macros, you can make a quick printout of 
the Playback And dialog box that lists the available macros. To make a 
direct print of the dialog box to an Image Writer, press Command-Option-
4. You can also make a MacPaint document of the dialog box and screen 
by pressing Command-Option-3. Documents created in this fashion have 
the name ScreenO through Screen9 (you can only make 10 screens at a 
time). Use MacPaint, or any other application that can open MacPaint doc
uments, to edit and print each file. 

MACRO EXAMPLES 

No doubt you'll have little trouble dreaming up practical uses for Works 
macros, but here are some applications you may want to try. Feel free to 
modify these macros as you see fit. 

Spreadsheet Number Series Macro 

With a number series, you indicate the start of a number range, the intervals 
(by l s, 2s, 5s, lOs, and so forth), and the end of the number range. Anum
ber series macro approximates a real number series spreadsheet function. 
Here's one approach, using cell Al as the start of the range, and counting 
by ls to 10. 

1. Select cell Al. 

2. Start a new macro, providing it with a key and description. 

3. Enter a numerall in cell Al. 

4. Make cell A2 current. 
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5. Write the formula =Al+l. 

6. Press Return. 

7. Select cells A2 to AlO. 

8. Choose the Fill Down command from the Edit menu. 

9. Stop the macro. 

If you need to make the number series longer (up to 25, for example), 
play back the macro, then manually select the last cell in the series. 
Extend the selection to the end of the desired range, and choose Fill 
Down. If the number series is too long, simply select the numbers you 
don't need and Clear. 

You can make similar macros for other number series intervals, such as 
by 2s, 5s, and lOs. To count by 5s, for example, enter a 5 in cell Al, and 
write the formula as =Al+S. 

Place Marker Macro 

A place marker is a special code you insert in a word processing document 
to help you at some later date return to a specific location in the text. The 
marker should be a character or series of characters you don't often use, 
for example, 

Code Example 

Tilde 

Double ampersand 
Backs lash 

&& 
\ 

Follow these steps to prepare the macro that will fmd the place marker: 

1. Start a new macro, providing it with a key and description. 

2. Choose the Find command from the Search menu. 

3. Enter the code in the Find What: box. 

4. Press the Return key. 

5. Click the cancel button in the Find dialog box. 

6. Stop the macro. 

To use this macro, open the document (if it isn't open already), and make 
sure the insertion point is at the very beginning. Start the macro. It will fmd 
the code (assuming it is in the document), and highlight it. If you always 
plan on fmding the code and erasing it, include an additional step after Step 
5, above. Press the Delete (or Backspace) key to erase the highlighted code. 
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Get into the habit of running this macro before you print your docu
ments, or else you run the risk of printing the place marker code with the 
rest of the text. 

Spreadsheet Month Column Headers 

The spreadsheet module is often used to track monthly income and expens
es throughout the year, and spreadsheets commonly have headings for the 
individual months of the year. Instead of manually writing each month 
over and over again for each spreadsheet you make, create a macro that 
will do it for you. 

1. Select cell Al (on playback, you can start the month entry at any cell). 

2. Start a new macro, providing it with a key and description. 

3. 'JYpe the word January, and press the Tab key. 

4. Type the word February, and press the Tab key. Repeat for the rest 
of the months in the year. Mter entering December, press Enter 
instead of Tab. 

5. Press Shift-Tab 12 times to return to January. 

6. Stop the macro. 

CompuServe Communications Scripts 

CompuServe (and other computer on-line services like it) can be greatly 
automated with the use of macros. Although Works macros cannot be 
made to wait for a specific CompuServe prompt, you can create a set of 
scripts designed for manual activation at the appropriate times. Here are 
some examples. 

• Log-on script. Provide your ID and password at the "User ID" prompt. 
Although CompuServe nonnally asks for the ID and password sepa
rately, you can provide them both on the same line. Record a macro 
that includes your ID number, a backslash (\),your password, and a 
Return, such as 12345,0987\password*here. <Return>. Activate the 
log-on script after connecting with CompuServe and pressing Controi
C, or Command-Option-C. 

• GO SIG script. A primary application of the CompuServe network is 
its many special interest groups, or SIGs. These SIGs go by such 
names as MACPRO (for Macintosh productivity forum), CEFORUM 
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(for consumer electronics forum), and MSAPP (for Microsoft applica
tions forum). You access these forums by entering a GO command at 
any ! prompt, such as GO CEFORUM. Construct a series of scripts 
for each forum you regularly visit. If desired, also include instructions 
for playing back new messages posted at the forum. 

• Message tag script. Many users of the various SIGs, as well as the 
public CB "gab" section of CompuServe, develop special signatures 
and sign-offs for their messages. It may be as simple as your name, or 
it may be a crude "electronic" version of your handwritten signature 
(composed of letters and numbers carefully placed across the page). 
Obviously, manually typing your sign-offs for each message can be 
time-consuming and prone to error, but a macro converts the task to 
child's play. The technique works whether you enter your messages 
on-line, or compose messages in Works and upload them to 
CompuServe. 

Other Ideas for Macros 

Here is a list of additional uses for Works macros: 

• Start spelling check. 

• Select specific options in the Spell Options dialog box. 

• Open new document (one macro each for word processor, database, 
spreadsheet, and communications). 

• Set new justification or spacing (for instance, one macro for single 
space, and another for double space). 

• Go to the beginning or end of the database records. 

• Sort database. 

• Change attributes of spreadsheet cells or database fields. 

• Create a spreadsheet chart. 



CHAPTER 9 

Managing Works 

Works requires no special setup or installation before you can use it, but 
effective results with Works demand that you think about how you have the 
Works files organized on floppy or hard disks, how much memory you 
have available for Works operation, and the variety of Macintosh system 
resources you are using concurrent with running Works. 

This chapter details the effective supervision of Works, including hard
ware you need to use Works, minimum required memory and system 
resources, and disk management. You'll also learn about the minimum 
flies you need to use Works, how to set up unique working disks for using 
Works, and how to start Works automatically when you turn on the 
Macintosh each day. 

Works requires a minimum of one megabyte of system memory, most of 
which it uses for its own gluttonous program resources. This limits the 
variety of Mac models that can use Works to: 

• Mac Plus 

• Mac SE 

• Macll 

You can also use Works with a Mac 512KE that has been outfttted with 
at least one megabyte of memory. Memory upgrades for the older 512KE 
machines are performed by third-party companies not generally recognized 
by Apple or Microsoft, so compatibility problems may occasionally arise. 
The computer may not operate properly with future versions of the 
Macintosh System, Finder, or with Works. 

Works operates more smoothly and efficiently with additional memory, 

287 
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especially if you use MultiFinder. Memory upgrades in the Mac Plus 
require hard-wiring, and like the modified Mac 512KE, the implementation 
of extra memory may not be compatible with future releases of Macintosh 
System and application software. The Mac SE and Mac IT models incorpo
rate sockets for simple and straightforward memory upgrades. 

If you are contemplating a memory upgrade for your Macintosh, consid
er the type and variety of software you wish to run on it. Assuming Works 
is your main application, you can consider the following memory capacities 
adequate for typical applications: 

Memory Application 
Amount 

Document Size 

1MB 
2MB 

2.5MB 

4MB 

8MB 

Works with Finder. 
Works with Finder or 

MultiFinder. 

Small to moderate 
Moderate 

Works with MultiFinder, Moderate 
and one or two other 
moderate-size applications 
loaded into memory at 
once (such as MacDraw or 
Super Paint). 

Works with MultiFinder, Moderate to large 
and up to four other 
applications loaded into 
memory at once. 

Works with MultiFinder, Large 
and up to 10 other 
applications loaded into 
memory at once. 

As noted in the table above, document size pertains to the amount of 
characters in documents, though Works keeps in memory all documents 
currently open. For the sake of estimating memory requirements, assume 
that only one or two documents are open at any one time. 

Document WP SS DB 
Size 

Small 
Moderate 
Large 

15 pages 
40 pages 

100 pages 

300 cells 
2,000 cells 
8,000 cells 

10 fields/30 records 
10 fields/1 ,000 records 
10 fields/4,000 records 
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SOFTWARE CONFIGURATIONS 

Works takes up to a maximum of 768K of memory when loaded in the 
Mac, even though the application size is only 587K. The extra memory 
is reserved for internal use by Works and includes working space for 
documents. 

When used with the Finder and a one megabyte Mac, Works leaves just 
enough space for the required system resources. You may not be able to 
use some applications and utilities that consume extra memory, such as 
RAM cache and RAM disk (both of which are detailed later in this chap
ter). Use the following table as a guide for setting up Works with various 
system and software configurations. Here's what the entries under the 
headings mean: 

• R means the recommended configuration. 

• NR means not recommended. 

• 0 means optional. 

Note: Recommendations consider available memory, software flexibility, 
and efficiency. Of course, you are free to formulate your own custom soft
ware configuration to best suit your needs. The use of MultiFinder, RAM 
cache, and RAM disk is really a personal decision, depending on your 
working habits, level of general Macintosh knowledge, and the tasks you 
need to perform. 

Available Finder MultiFinder RAM Cache RAM disk 
Memory 

1MB R NR NR NR 
2MB R 0 0 NR 
2.5MB 0 R 0 0 
4MB 0 R R R 
8MB 0 R R R 

The Macintosh lets you vary the size of RAM cache and RAM disk. 
With less than 2.5 MB of memory, RAM cache should be 128K or smaller, 
and RAM disk should be 400K or smaller. You can assign RAM cache and 
RAM disk sizes up to the maximum allowable limit if your computer is 
equipped with 4 MB or more of memory. 

MAXIMIZING YOUR PERFORMANCE WITH SYSTEM 
RESOURCES 

System resources help the Macintosh function. Among the vital System 



290 Inside MS Works 2 for the Macintosh 

resources are fonts, desk accessories, printer drivers (for the Image Writer 
and LaserWriter), and basic operating instructions for keeping the 
Macintosh on an even keel. All System resources consume memory, 
whether you are actively using them or not. 

Some System resources are not absolutely necessary for the Macintosh 
to function, and you may prefer to trim certain resources in order to gain 
extra operating space for Works. This is particularly important if you use 
Works with MultiFinder and a marginal one megabyte of RAM (such a 
setup is not strictly recommended, but you can do it). 

All System resources are contained in the System Folder of your hard 
disk or Works disk (in fact, all startup disks for the Macintosh contain such 
a System Folder). System resources come in a variety of fonns. Among 
the most common are: 

• Resources fonning the System file 

• Independent INITs (Resources loaded into memory on startup) 

• Independent CDEV s (Special utilities for the Control Panel) 

System File Resources 

The System file contains many "packets" of infonnation. Macintosh pro
grammers and software developers call packets resources. These resources 
can often be individually edited (as detailed in Chapter 10, "Customizing 
Works"), and perform a variety of useful functions. Most System flle 
resources cannot be removed; doing so would cause the Macintosh to fail. 
But some resources are not absolutely critical to the operation of the Mac, 
and consume valuable disk space. 

The two main System file resources that you can eliminate are installed 
fonts and desk accessories (DAs). "Installed" means the resources for the 
fonts and DAs have been converted to packets that reside in the System 
fJ.le; they are not individual font or DA files residing on the disk. 

The Macintosh requires the following fonts for operation, and these can-
not be removed: 

• Chicago 12 point 

• Geneva 9 and 12 point 

• Monaco 9 point 

Ordinarily, the Macintosh loads into memory only fonts (and sizes) it 
requires to display the text on the screen (this includes text for icon names, 
windows, menus, commands, and so forth). Since Works keeps all its open 
documents in RAM-rather than shuttling parts of documents to the disk to 
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make extra working space-the more fonts you use in a document, the 
more memory is consumed. You can combat this by using fewer fonts in 
the document. H disk space is your problem, removing unneeded fonts 
reduces the size of the System file. 

Desk accessories consume RAM only when you open them, but also take 
up valuable disk space. Remove those desk accessories you don't need. 

Both fonts and desk accessories are installed and removed using Apple's 
Font/DA Mover. If you decide to remove fonts and DAs from your Works 
disk System fJ.le, make it a point to save them frrst in separate files, just in 
case you need them at some later date. 

Independent INITs 

An INIT is an initialization resource that loads into the Mac's memory 
when you frrst turn it on. INITs are disk dependent; every startup disk can 
contain different INITs. 

The System file has its own INIT resources, but INITs can also be inde
pendent files stored in the System Folder. On power-up, the Macintosh 
loads these INITs in the same manner as the ones in the System file. A 
number of specialized utility software, such as print spoolers, are distribut
ed as INITs. Because INITs are loaded into memory when the Macintosh 
starts, they consume memory that might otherwise be used to hold Works 
documents. Check the INITs in the System Folder and determine their use
fulness to you. To deactivate an INIT, remove it from the System Folder 
(you can store it in another folder for safe keeping). Restart the Macintosh 
and the extra memory will be available. 

If and when you want to use one of the removed INITs, simply re-place 
it in the System Folder and restart the Macintosh. 

The Macintosh System/Finder software comes with only a few INITs. 
The most notable is Easy Access, which modifies the operation of the key
board. If you're not sure which files in the System Folder are INITs, while 
at the Desktop select the unknown file and choose the Get Info command 
from the File menu. The Get Info window usually describes an INIT file as 
a "Startup document." 

The icons for many, but certainly not all, INITs appear in the lower left 
corner of the Welcome screen ("Welcome to Macintosh," or a custom 
screen) after the Macintosh has started. 
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Independent CDEVs 

CDEV stands for Control DEVice, a type of INIT that handles Control 
Panel chores. CDEV s are set once in the Mac's Parameter Random Access 
Memory {PRAM), and don't depend on each system disk you own. 

In the most recent releases of the Macintosh System/Finder software, the 
Control Panel is composed of individual elements, such as General (for 
things like date and time, Desktop pattern, and speaker volume), Mouse, 
Keyboard, and Sound. Each of these elements corresponds to a separate 
CDEV file located in the System Folder. As with INITs, by removing 
unneeded CDEV files you can reclaim lost memory. 

Once you make the desired changes to the Control Panel, you can close 
the Control Panel window, then remove its CDEV s, and restart the Mac 
(keep the CDEV files in another folder for safe keeping, in case you need 
them again). 

Should you decide to change one or more of the Control Panel set
tings, you can return the desired CDEV s to the System Folder and restart 
the Mac. 

Apple provides the bulk of the CDEV files used with the Macintosh, 
though others are available from third-party sources (including Shareware 
and public domain). The standard CDEV files, shown in Figure 9-1, are: 

CDEUs 
7 ;tems 27, 1 45K ;n d;sk 14,251 K ava;lable 

···~ , ............. ) 
~=·=·~·=·: tj 

Keyboard Mouse Startup Dev;ce Genera 1 

<]>~ ~ 
Sound Color 

(g 
Mon;tors 

~I 
Figure 9-1 CDEV Files in Folder 
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• General 

• Mouse 

• Keyboard 

• Sound 

• Color 

• Monitors 

• Startup Device 

Most, but not all, CDEV s appear in the Control Panel window. 
If you're not sure which files in the System Folder are CDEVs, while at 

the Desktop select the unknown file and choose the Get Info command 
from the File menu. The Get Info window usually describes a CDEV file 
as a "Control Panel document." 

SYSTEM VERSION AND UPDATES 

Works is designed to operate with System version 6.0.2 or later. If you are 
using an earlier version of the System, you should upgrade before trying 
Works, or you could experience unexpected "bombs." If you're not sure of 
the System version, select the System file from the Desktop, and choose the 
Get Info command from the File menu. The dialog box should include a 
version number. 

If no version number can be found, choose the About Finder (or 
MultiFinder) command in the Apple menu. As shown in Figure 9-2, the 
box includes the version numbers for both System and Finder. 

flbout the Macintosh 'M Finder 

Finder: 6.1 
System: 6.0.2 

Tot a 1 Memory : 

!J Finder 

~System 

1 ,024K 

Larry .. John .. SteYe .. and Bruce 
C) Apple Computer .. Inc. 1983-88 

868K - :::::::::::::::::::::::::::::::::::::::::::::::::1 

156K-

Figure 9-2 About Finder Box 
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MINIMUM FILE CONFIGURATION FOR WORKS 

At a minimum, you need only the Works program file to use Works. As 
long as you don't use the spelling checker, on-line help, or homonym fmd
er, the extra files are not required and you can remove them to make more 
space on your disks. The following files are required only when you 
specifically access them. 

• Ms WorksHelp-Only needed when you call for on-line help. 

• Ms WorksDict-Only needed when you start a spell check. 

• MsWorksHymn-Only needed when you check Homonym option for 
spell checking (in addition, Works manufactures a compressed version 
of the Ms WorksHymn file the first time you use the homonym feature; 
this file is also not needed). 

In addition, Works come with tutorial example documents and a 
Hypercard guided tour stack, all of which are not necessary for day-to-day 
operation. The Works-Works Transporter application is used for converting 
Works documents to other file formats, and vice versa. It, too, is not need
ed for routine use of Works. 

The Ms WorksPref preference file (kept in the System Folder of the start
up disk) is not absolutely required to run Works, but the program will auto
matically create a new preference file if it can't find it. You can delete the 
file, but a new one will take its place after you use Works. 

DISK MANAGEMENT 

Works and its various support files come on three 800K diskettes. The fol
lowing is a list of the files on the Works distribution disks as of this writ
ing; future releases of the software may have somewhat different contents. 

Disk and Files 

Startup Disk 
System Folder 

Works Dictionary Folder 

Readme 

Program Disk 
Microsoft Works 

Contents 

System, Finder, Image Writer files, 
Control Panel CDEVs; MsWorksPref 
preference ftle. 

MsWorksDict and Ms 
WorksHymn ftles. 

Last-minute information (WP format 
document). 

Works application ftle. 



MsWorksHelp 
Tutorial 

Works Tools 

Works Tour Disk 
A Works Tour 
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Works on-line help file. 
Various Works documents for 

guided tutorial. 
Works-Works Transporter application. 

Works Tour Hypercard stack. 

Works comes on three diskettes, but you only need two-the Startup 
and Program disks-for everyday operation. You can use the two 
diskettes with either one 800K floppy drive, or two 800K floppy drives. 
Keep in mind that using one floppy drive means that you '11 have to swap 
the two Works disks in and out of the drive, which can be frustrating and 
time consuming. 

FLOPPY DISK MANAGEMENT 

Though Works runs best with a hard disk drive, your Macintosh may be 
outfitted only with one or two floppy disk drives. Using floppy disk drives 
is more than acceptable of course, but you '11 be constantly fighting the 
problem of overflowing disks and disk swapping. 

Whether your computer has one or two 800K floppy disk drives (two is 
recommended), you should strive to keep only the required files on your 
Works disks. Remove unnecessary fonts and desk accessories, as well as 
independent INITs and CDEV s, as described earlier in this chapter. The 
Works on-line help file, MsWorksHelp, consumes 130K of disk space, so if 
you don't need to access help, remove the file. 

As a starting point, construct two working disks with the following files 
in each disk (feel free to modify the disk contents as you see fit, but keep 
an eye on remaining disk space). 

Disk Files on Disk 
Startup Disk System Folder with Finder (or MultiFinder) 

and system files, Ms WorksPref, Image
Writer or LaserWriter driver; optional: 
Works Dictionary folder with 
Ms WorksDict and MsWorksHymn files. 

Program Disk Microsoft Works; optional: MsWorksHelp. 

With the Startup disk specified (including optional files and average 
number of fonts and desk accessories), there is approximately 140K bytes 
of free space (262K without the dictionary and homonym files). 

The Program disk has 192K bytes of free space without the help flle; 
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62K with the help file (I recommend you leave the Ms WorksHelp file off 
the disk and use the Works manual instead). You can use either disk for 
storing Works documents, but you may fmd it more convenient to restrict 
document storage either to the Program disk, or to a separate documents 
disk (the latter approach is recommended if you create lots of documents). 

Mac with One SOOK Drive 

Works is only marginally useful with one disk drive. To use Works with a 
single BOOK drive: 

1. Start the Mac with the Startup disk. 

2. Once the Desktop appears, eject the Startup disk. 

3. Insert the Works Program disk. 

4. Start Works by double-clicking on its icon. 

The Macintosh may eject the Program disk and ask you to temporarily 
insert the Startup disk, only to return to the Program disk again (this pro
cess may continue for several complete disk swaps). And when using 
Works, the Macintosh may periodically stop and ask you to insert another 
disk. It's a good idea to keep all the required disks at hand so that you can 
feed the Mac as instructed. To minimize disk swapping while using Works: 

• Avoid choosing new fonts and sizes. 

• Avoid opening desk accessories. 

• Avoid switching between Works modules. 

• Avoid using the Works speller. 

• Save documents on the Program disk. 

Mac with Two SOOK Drives 

Having two BOOK drives makes life considerably easier, not to mention 
making you a more content Macintosh user. As long as you store your 
Works documents on either the Startup or Program disks, you avoid disk 
swapping and the attendant inefficiency associated with it. Start with the 
Mac with the Works Startup disk in the internal drive (or the lower drive if 
you have an SE). The Works disk is placed in the external (or upper) drive. 

Should you wish to store documents on a separate disk, be sure to start 
Works first, then open the desired document from within Works. You will 
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find the Mac requests you to swap disks fewer times if you eject the 
System disk, rather than the Works Program disk, and replace it with the 
document disk. 

Once the Mac needs some information from the System disk, it will 
eject the document disk and ask for the System disk. Replace the System 
disk as requested and continue working. When it comes time to re-save 
the document, eject the System disk once again and replace it with the 
documents disk. 

Using Folders 

Folders allow you to keep like documents and files together in one, easily 
managed package. Works comes with several of its files tucked neatly 
within folders. You should retain this folder system to maintain efficient 
file management of your Works disks. (In any case, the System Folder on 
the Startup disk is required, and should never be removed.) 

Folders are created at the Desktop using the New Folder command from 
the File menu. New folders are initially named Empty Folder, but you can 
rename them as you can any Desktop icon. If you plan on generating lots 
of documents in a single Works session, consider the types of files you will 
be creating, and make folders for them. You can always change the names 
of folders later. 

Feel free to place folders within other folders, if your documenting fil
ing system requires it. For example, suppose you have created the basic 
document folders shown in Figure 9-3. While not suggesting this is the 

=D Works Program t!l-
7 items 27, 1 60K in disk 14 ,236K available 

CJ CJ CJ luCK~ 
~ 

Letters Budgets On-Line Services MsWorksHelp 

~~ CJ ~ lillil~ 
Microsoft Works Misc. Works Desktop 

10 
~I 10 ~ 
Figure 9-3 Sample Folder System 
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best method of storing Works documents, it is one approach you can use. 
Each folder contains one type of Works document-word processor, 
database, spreadsheet, or communications. Within each folder are addi
tional folders that specify your individual tasks, such as Letters, Budgets, 
and On-Line Services. 

Once the folders are created, you may save documents within them while 
using Works. Open the desired folder as usual and click the Save button. 
If you decide you would like a particular document in one folder instead of 
another, you can move it from the Desktop, or within Works, as detailed in 
Chapter 1. 

USING CUSTOM DISKS 

A custom disk is one engineered for a core task, such as creating and edit
ing newsletters with Works. Figure 9-4 shows the basic idea of custom 
disks. Though Works is already an integrated program, you can enhance its 
effectiveness and versatility by combining it with other applications, unique 
desk accessories, and special fonts. You may use these additional resources 
only for specific tasks, so it makes no sense to build one main Works disk 
and mix it with ingredients for all your chores. A far better way is to build 
individual working disks, each customized for a specific assignment. 

With a custom disk, you also avoid much of the disk swapping necessary 
when alternating from one application disk to another, and because all of 
the tools you need for the task are within easy grasp, your Mac efficiency 
will skyrocket. 

Some Guidelines 

Although there aren't many rules for developing custom work disks, there 
are a few tips you '11 want to consider. 

As much as possible, try to keep your applications on a single disk, 
regardless of the number of drives you have. The size of Works prohibits 
you from stuffmg the System and Finder files on one disk with the Works 
program. 

Most tasks will require that you combine two or more applications on a 
disk. Your biggest enemy will be limited disk space-fitting all the appli
cations you want on a SOOK disk. Still, there are several ways around this 
limitation. 
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Figure 9-4 ConceptofCustom Disks 

As mentioned earlier in this chapter, you can free up some disk space by 
removing extraneous fonts and desk accessories from the System file. Use 
Apple's Font/DA Mover for this. 

As a final measure, you can remove some of the more critical disk files, 
like the Image Writer or Finder files. There are several desk accessories 
available that duplicate the function of the Finder. Bear in mind that you 
give up the desktop metaphor when removing the Finder. 

If you've removed the ImageWriter (or LaserWriter) file from the disk, 
you won't be able to print documents with that disk. You can, however, use 
the original program disk-with its Image Writer file intact-for printing 
documents. 

Works isn't copy protected, but some other Mac applications are, so you 
can't easily make extra work copies. Backup utilities overcome most copy 
protection schemes so you can make additional work disks. Because of the 
way copy protection plans work, however, you may not be able to fit two or 
more protected applications on a single disk. 
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When constructing your own disks, be on the lookout for "program 
interaction." The Mac is unstable when you combine certain applications 
or accessories on one disk. If the Mac bombs, or doesn't behave as it 
should, experiment with different program combinations until you fmd the 
right mix. 

Sample Custom Disk 

Let's say you put together flyers, brochures, or newsletters. You could 
invest in a page make-up program, but you can also create one of your own 
with cheaper applications. 

Works already makes a good basic page make-up program, but it lacks 
the ability to work with bit-mapped graphics. But combined with the origi
nal MacPaint and the Artisto or Art Grabber desk accessories, Works 
becomes a versatile desktop publishing tool. (Sources for supplementary 
Macintosh utilities and applications can be found in Appendix A.) You can 
create and edit any type of graphic, and easily insert it anywhere on the 
Works word processing page. 

You may also wish to combine with this mix an application for operating 
an image scanner or digitizer, such as ThunderScan. The scanner applica
tion is used to capture the picture, MacPaint is used to edit and clean it up, 
and Artisto or Art Grabber is used to copy the picture to Works. 

HARD DISK MANAGEMENT 

You can load the entire contents of all three Works distribution disks onto 
your hard disk if you want, but there's certainly no need for it. Though you 
may have empty megabytes on your hard disk, treat each free byte of space 
as a valuable commodity. Place only those Works files you need on the hard 
disk. Your hard disk should contain only one System Folder, so don't copy 
the System Folder for the Works Startup disk, or its contents, to the hard disk. 

Hard disk drives can contain several thousand files, so you need to 
develop a file keeping system. As with floppy disks, store similar files in 
separate folders. One approach that works particularly well for most users 
is a separate folder for each Macintosh application, such as Works, 
MacDraw, SuperPaint, or Illustrator. Within these folders you place the 
files associated with each application. Again, make use of folders to keep 
like items together. One folder may contain Works dictionaries, another 
Works documents, and a third, Works utilities (including the Works-Works 
Transporter application). 
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HOW WORKS FINDS FILES 

Works must be able to find certain files when you request on-line help, acti
vate spelling, or choose the homonym option during a spell check. Works 
follows a certain path as it attempts to find these special files. By knowing 
this path, and how the program uses it, you can devise better ways of stor
ing Works files. The path has three checkpoints: 

1. The folder containing Works. 

2. The root, or topmost folder of the disk containing Works. 

3. The System Folder. 

STARTING WORKS 

There are numerous ways of starting Works. You can begin a Works ses
sion by opening the flle manually, by setting the Works program file as the 
Startup application, or by using a Desktop macro. 

Starting Works Manually 

You can start Works manually from the Desktop in either of two ways: 

• Select the Microsoft Works icon, then choose the Open command from 
the File menu. 

• Double-click on the Microsoft Works icon. 

Using the Set Startup Option 

The Set Startup command in the Special menu (at the Desktop) allows you 
to select the application the Macintosh automatically runs when it is first 
started. Normally, the Mac runs the Finder or MultiFinder (both of which 
are considered applications). But by choosing Works as the startup applica
tion, the Mac automatically begins a new Works session when you tum the 
Mac on. The startup application can vary from one disk to the next, so if 
your Mac is equipped with floppy disk drives, each startup disk you use 
can begin a different application. 

To set Works as the startup application: 

1. At the Desktop, select the Microsoft Works icon. 

2. Choose the Set Startup command from the Special menu. 
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3. Select the Finder or MultiFinder option (depending on whether you 
want to use the Finder or MultiFinder), along with Microsoft Works, 
as shown in Figure 9-5. 

4. ClickOK. 

The next time you start the Mac with your Works startup disk or hard 
disk, either the Finder or MultiFinder will load, followed automatically by 
Works. 

To cancel automatic startup of Works, make sure no icons are selected, 
and choose the Set Startup command once more. Click on either the Finder 
or MultiFinder options, and click the OK button. 

Desktop Macros 

Versions of the Macintosh System/Finder software from 6.0 and on come 
with a convenient macro recording feature. Finder macros are similar to 
the macro function built into Works: you can record keystrokes and mouse 
movements for later instant replay. As of this writing, Finder macros are 
incompatible with Works 2.0, but you can use Finder macros to start 
Works. Alternatively, you can use one of the many third-part macro 
recording utilities, including Tempo II and Quikeys. 
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USING MULTIFINDER 

MultiFinder is a diverse application that not only allows you to run two or 
more applications at one time, but to switch between those applications 
with a click of the mouse. Perhaps most important, applications running 
under MultiFinder are totally independent of one another, and share pro
cessing time. With MultiFinder, you can calculate a large Works spread
sheet, then click off to a stand-alone graphics program. While drawing pic
tures, Works completes its calculations. 

Of course, the modularity of Works diminishes the importance of 
MultiFinder for many users, but you may still employ Works with other 
Macintosh applications. You may also like using MultiFinder because of 
the speed it offers in switching between Works and the Desktop. You no 
longer have to quit Works just to throw files away, rename files, or move 
files between folders. 

The Finder and MultiFinder use separate application files. You can keep 
both in the System Folder of your Works startup disk or hard disk, but you 
can use only one at a time. Save space by removing the one you don't use. 
You specify your choice of Finder or MultiFinder with the Set Startup com
mand, in the same manner as you set Works as the startup application (see 
the previous section for more information). 

When using the Finder, you can switch to MultiFinder (assuming it is 
also present in the System Folder) by pressing Command-Option, and 
double-clicking on the MultiFinder icon. Once MultiFinder starts loading, 
release the Command and Option keys. This technique does not work 
when switching from MultiFinder to the Finder. 

If you have selected MultiFinder in the Set Startup dialog box, you can 
start the Macintosh with the Finder by depressing the Command key while 
the Macintosh starts. Keep the key depressed until the Desktop appears. 

Even if you only use Works, you can still use MultiFinder as a conve
nient way to switch between Works and the Desktop. Start Works from 
MultiFinder, and the Desktop appears "underneath" the Works windows. 
To switch between Works and MultiFinder, and back again, click on the 
icon in the upper right comer of the screen, or choose the desired applica
tion from the bottom of the Apple menu. 

Many users new to MultiFinder fmd it difficult to use at frrst, but through 
continued practice working with MultiFinder will become second-nature. 
For best results, keep these points in mind: 

• Keep track of which application is currently active by looking at the 
icon in the upper right comer, or observing which application is 
checked in the Apple menu (see Figure 9-6). 

• Clicking on a window makes it-and its application-active. If you 
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are in Works, and click inside a Desktop window, you instantly return 
to the Desktop. 

• You can't switch between Works, MultiFinder, or another application 
when most dialog boxes are displayed. 

• If Works "crashes" for some reason while running under MultiFinder, 
you are returned to the Desktop and a dialog box informs you of the 
trouble. Bear in mind that some portion of data in the Mac's memory 
may have been corrupted during the crash. You should always reset 
the memory by restarting the Mac after a crash. 

USING RAM DISKS 

RAM disk software partitions a portion of the Mac's RAM as an electronic 
disk drive. Data is temporarily stored in memory rather than on a disk. 
The benefit of a RAM disk is its speed. You can store and retrieve data on 
a RAM disk several hundred times faster than with mechanical disk drives. 
If you want to save the data in the RAM disk, you must copy it to a floppy 
disk before you turn the Macintosh off. Once the power is turned off, 
information in the RAM disk is forever lost. RAM disk software is avail
able through most public domain and Shareware sources, as detailed in 
Appendix A. 
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USING RAM CACHES 

A RAM cache is a small portion of memory (usually between 32K and 
384K) reserved to hold bits and pieces of programming codes. The idea of 
the cache is that repetitive tasks are stored in RAM, where they can be 
retrieved by the Macintosh much faster than data retrieved from a disk. 
The performance of Works is sped up, although only marginally, since 
Works tries to use as much RAM in your Macintosh as it can find. 

The latest version of the Macintosh System and Finder includes a RAM 
cache as part of the Control Panel. You can tum the cache on or off, as 
well as assign a specific amount of memory (up to 384K). You can 
increase your work efficiency with the Macintosh by five to 10 percent by 
turning the cache function on. For best results with Works, you need a 
Macintosh with at least two megabytes of memory, preferably more. You 
should not use RAM cache is you have only one megabyte of RAM. 

As with RAM disk software, RAM cache programs are also available 
separately. These let you assign most amounts of memory for caching. 

HELPFUL DESK ACCESSORIES 

A number of desk accessory utilities offer enhancement to any Works sys
tem. However, RAM-hungry DAs could interfere with Works' operation. 
We therefore cannot guarantee that a 1 megabyte system will support Works 
and the following DAs. Generally, the more memory, the better. H you 
have sufficient memory, consider adding the following accessories to your 
System file (refer to Appendix A for a list of sources for these utilities). 

Note: The programs listed as "public domain/Shareware" are offered by 
most public domain clearinghouses, such as Public Domain Exchange and 
Educomp. True public domain programs are free, except for a small distri
bution charge (usually $6 to $8). Shareware programs are not free, but are 
available on a "trial basis." Contact the clearinghouses mentioned in 
Appendix A for more information. 

• Art Grabber. Lets you snatch a MacPaint picture from within 
Works. You can select as much of the 8 by 10 MacPaint document as 
you want. 

• Acta. Has the same general function as Art Grabber. 

• Multi-Scrap (public domain/Shareware). Lets you access any number 
of individual Scrapbook files. The files can be stored on the Works 
disk or any other disk. 

• Smart Scrap. Has the same general function as Multi-Scrap. 
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• Extras (public domain/Shareware). Allows you to perform some 
Finder-like tasks from within Works. You can use Extras to delete 
files, display the amount of disk space available, and more. 

• CheapPaint. A MacPaint-like desk accessory used to edit existing 
MacPaint documents, or to create new ones. The bit-mapped graphics 
can be pasted into Works. 
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Customizing Works 

Before you get too involved using Works, you should frrst consider how to 
customize the program for your individual needs. Doing so can make you 
a better and more efficient Works user. 

You can customize Works in these five ways: 

• Make changes in the Macintosh Control Panel (these changes affect 
Works and all other applications you run on the Mac). 

• Record your preferences in the MS Works Pref file (actually titled 
MSWorksPref). 

• Create Works Stationery for the word processor, database, spreadsheet, 
and communications modules. 

• Modify Works with a utility program such as Apple's Resource Editor. 

• Create Works macros. 

This chapter discusses three of these methods; customizing with 
Stationery is discussed in Chapter 1, and using macros is detailed in 
Chapter 8. Included are step-by-step instructions for typical Works setup 
configurations. 

CUSTOMIZING WITH THE CONTROL PANEL 

The Control Panel desk accessory, shown in Figure 10-1, controls several 
characteristics of the Macintosh keyboard, mouse, display, and general 
interface. You can alter these characteristics with the Works Startup Disk, 
or with any other disk that contains System and Finder resources. 

307 
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Figure 10-1 Control Panel Box 

The changes to the Control Panel are stored in the Mac's Parameter 
RAM (PRAM) and are kept alive by the clock battery installed in the 
Macintosh. The changes remain in effect until you alter them again or 
when the battery dies or is removed. Because the Control Panel is part of 
the Macintosh operating system, any alterations you make to the Control 
Panel affect not only Works but also any other Mac application. 

Before using the Control Panel, make sure you have the latest release of 
the Macintosh System and Finder. Works 2.0 is engineered to operate with 
System version 6.0.2 or later and Finder version 6.1 or later. If you are 
using earlier System and Finder versions, contact your dealer for an 
upgrade. The appearance and contents of the Control Panel may differ 
from version to version. The figures and examples in this chapter were 
made with System 6.0.2 and Finder 6.1. 

The icons you see to the left of the Control Panel desk accessory are 
individual resources that aren't really an attached part of the Control Panel 
desk accessory. These files are known as CDEV resources (as discussed in 
Chapter 9), and appear in the Control Panel dialog box only when they are 
present in the System Folder. If any of the icons are missing when you 
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open the Control Panel, check the contents of the System Folder to be sure 
the desired CDEV resources are there. The most common resources are: 

• General 

• Keyboard 

• Mouse 

• Sound 

• Startup Device 

Only a couple of the Control Panel options are of primary interest to us 
in the process of customizing Works. 

Key Repeat Rate 

The key repeat rate (displayed when you click the Keyboard icon within the 
Control Panel dialog box) varies the speed at which the character keys repeat 
when they are held down (see Figure 10-2). Touch typists may want to set the 
key repeat fast or moderately fast Others should keep it slow or moderate. 
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Delay Until Repeat 

The delay until repeat option (also displayed when you click the Keyboard 
icon) varies the interval between the time when a character key is pressed 
and when repeating begins. Touch typists should choose a short delay; oth
erwise, keep the delay moderate or slow. 

Double-Click Speed 

The double-click speed (displayed when you click the Mouse icon in the 
Control Panel dialog box) varies the interval between successive clicks of 
the mouse button. If the clicks occur within a preselected period of time, 
the Macintosh treats the action as a double-click; otherwise, the action is 
considered single-clicks. If you're new to the Macintosh, keep the double
click speed slow, as depicted in Figure 10-3. Those comfortable with the 
mouse may choose a faster setting. 
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' 
Keyboard 

... , 
I -

Control Panel 
Mouse Track;ng 

+ + + 
•o +® •<p 

Figure 10-3 Double-Click Speed 



Customizing Works 311 

Mouse Tracking 

Mouse tracking (displayed when you click the Mouse icon) alters the track
ing ratio of the mouse and pointer. When you select one of the mouse 
options, the pointer moves in a variable ratio depending on the speed and 
acceleration of the mouse. The faster the mouse moves in a particular peri
od of time, the faster the pointer skims across the screen. 

Choosing the Tablet option moves the pointer at a constant 1: 1 ratio with 
the mouse, regardless of speed. Choose this setting if you are using a 
graphics tablet, having trouble positioning the pointer accurately, or creat
ing detailed graphics (with mouse or tablet). 

Insertion Point Blinking 

As shown in Figure 10-4, the rate of insertion point blinking (displayed 
when you click the General icon in the Control Panel dialog box) changes 
the rate at which the insertion point flashes on and off. A slow blink makes 
the insertion point hard to see, especially in a full screen of text. Choose 
the medium or fast speed to enhance the visibility of the insertion point. 
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Menu Blinking 

The menu blinking control (displayed when you click the General icon) 
changes the number of times a chosen menu item blinks before the com
mand is carried out. The blinks provide a form of visual feedback that a 
command has been selected. Most people set this at one blink to save 
some time. 

Speaker Volume 

The speaker volume (displayed when you click the General icon) controls 
the volume of the Mac's internal speaker. Works uses the speaker to sound 
a warning tone if there is danger of accidentally closing an unsaved docu
ment. An alert tone is also sounded in other non-warning situations: when 
Works can't find a specified word with the Find or Replace command, for 
example, or when you attempt to edit the contents of a protected spread
sheet cell. 

Drag the speaker volume control up or down to adjust the volume of the 
alert tone. The tone increases from 1 to 7; a setting of 0 is no tone. When 
the volume control is at 0, the Mac flashes the menu bar at the top of the 
screen as a visual warning cue. 

In addition to the volume control, you may wish to change the alert cue 
issued by the Mac. Refer to the Sound Cues section below on how to 
change the tone to a monkey screech, a "boing," or other sound. 

RAM Cache 

Many computer operations are redundant, requiring the Mac to retrieve the 
same data from a disk drive and insert it into memory. RAM cache is a 
way to cordon off a small segment of the Mac's available random access 
memory as a temporary holding tank for data. The RAM cache control 
(displayed when you click General icon in the Control Panel) lets you tum 
cache on and off, and adjust the amount of RAM you want removed for 
cache service. Click the On/Off buttons to activate or deactivate the cache; 
click the arrows to allot the desired amount of memory to cache use. 

Sound Cues 

Sound cues (displayed when you click the Sound icon in the Control Panel 
desk accessory) let you control the type of warning tone emitted through 
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Figure 10-5 Sound Cues 

the Mac's speaker. Apple provides four basic cues, as shown in Figure 10-
5: a clank, a boing, a monkey screech, and the standard tone. Additional 
cues are available from third party sources and are installed in the Control 
Panel desk accessory as a normal CDEV resource. To select a new sound 
cue, click it and the Mac produces the sound through the speaker. Not all 
cues are at the same sound level, so you may need to adjust the speaker 
volume. 

WORKS PREFERENCE FILE 

Works remembers some of your working habits by recording certain prefer
ences in a file called MSWorksPref. This file is normally kept in the 
System Folder. If the file is missing, Works starts over with the default 
(standard) preference options and places a new copy of Ms WorksPref in the 
System Folder. 

The Works preference file records: 

• Selections in the Options command found under the Spelling menu. 
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• The location of the main Works spelling dictionary, MsWorksDict, and 
the location of the Works homonym file, MSWorksHymn (the location 
includes the disk and folder). 

Works doesn't update the preferences file until you quit the program, so 
if you fmd that Works isn't yet tracking the options that you've chosen, quit 
the program, then restart it. If the MSWorksPref file is lost or damaged, 
Works creates a new one with standard defaults. The standard defaults are: 

• All spelling options checked except "Homonyms." 

• Dictionary and homonym file location in the same drive and folder as 
the Works program. 

MODIFYING WORKS WITH RESOURCE EDITOR 

With a program called Resource Editor (otherwise known as ResEdit or 
ResEd), you can change the names of Works commands, redraw icons, add 
new command keys to menus, rewrite the messages that appear in dialog 
and alert boxes, edit and create fonts, and much more. 

In short, ResEdit is a do-all Mac handyman, allowing you to customize 
your Works (or most other applications) the way you want. You can't 
change everything with ResEdit, but it gives you far greater control over 
your Mac and Works than you've had before. 

The instructions provided here are for Resource Editor version 1.0. You 
may have an earlier or later version. The general procedure for using 
Resource Editor may be the same, but the exact steps and menu command 
names may differ from version to version. 

Most importantly, bear in mind that Resource Editor is a technical pro
gram, and is not designed for general consumer use. By following the 
instructions given below to the letter, you should have no trouble customiz
ing Works as described in the text, but you may not understand what you 
are doing. If you want to know more about how programs like Works and 
Resource Editor operate, consult a good book on Macintosh programming. 

Natural Resources 

Most of the Mac's applications, including Works-as well as the System 
and Finder files-are made up of discrete building blocks called resources. 
One resource might contain all the fonts you've installed on your disk; 
another might hold the icons that appear on the desktop. Yet another may 
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Figure 10-6 Application Resources 

be a listing of menu commands. Resource Editor is used to open the doors 
to these resources, and make changes. 

Here's an example (but don't try it yet, before you read the do's and 
don'ts on using Resource Editor). Using ResEdit, open the System file on 
one of your application disks, and you '11 see a listing of resources like that 
in Figure 10-6. The resources are in code: BNDL, CURS, DITL, DRVR, 
and so forth. 

Open the resource labeled CURS, for instance, and you access the hold
ing tank that stores the various pointer shapes of the mouse. Double-click 
on the wristwatch pointer, and you can edit it. You can even redraw it com
pletely. How does a turtle strike you? Draw one. Now, whenever the Mac 
has you waiting, the mouse pointer will tum into a turtle. 

To keep track of the multitude of resources within each application, the 
Mac attaches identification numbers to each one. You can often use the ID 
numbers to your advantage. Instead of editing the wristwatch, make the 
turtle from scratch. Then, give the turtle the same ID as the wristwatch 
(renumber the wristwatch first so you don't overly confuse the Mac-give 
it a big six or seven digit number). IDs are changed by selecting a 
resource, then choosing the Get Info command from the File menu. A box 
appears allowing you to type in a new number. 

When the Mac changes from an arrow to a wristwatch, it simply grabs 
the pointer shape with the ID number of 4-it doesn't care what the pointer 
actually looks like. Once again, the turtle appears. To revert back to the 
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wristwatch, just reverse the renumbering process. (Specific instructions on 
changing the appearance of Works' pointers are given later in this chapter.) 

You should note that only programs and certain Mac files (including 
System, Finder, Scrapbook, and lmageWriter) have editable resources. 
Documents created by Works and most other programs don't have editable 
resources, and can't be manipulated by Resource Editor. 

That doesn't mean that Resource Editor can't tap into all documents. It 
can easily open and manipulate Font/DA Mover documents, for example. 
You can even use Resource Editor to install fonts into the System file, 
although Apple's Font/DA Mover utility is much easier and safer to use. In 
addition, Resource Editor creates documents of its own, in which you can 
store resources that you've cut or copied. 

Using the Resource Editor 

Using Resource Editor is a simple process. But ifs not foolproof. It can 
crash unexpectedly, and the hard work you've done will be lost forever. 
That's the goodnews. The bad news is that if the program bombs while it's 
saving your work onto disk, it will most likely ruin beyond salvage the file 
you've been editing. 

You can save yourself a lot of agony if you work only with copies of 
your applications, and by editing applications only on floppy disks. With 
practice, you '11 learn the limitations of Resource Editor-what it can and 
can't do. Another reason for working only with copies of your applications 
is that you may try to edit a resource that the Mac needs intact and 
unchanged. Altering even one seemingly innocent character can totally 
destroy an entire application. 

To use Resource Editor, make a copy of it and the files you want to edit 
(in this case Works), and put everything on a separate floppy disk. Start 
Resource Editor, and a small window appears, displaying the editable files 
on the disk. To open a file, double-click on it. To get to some resources, 
you may have to open several windows. Quite often, resources are tucked 
within one another, the same way you can put folders within other folders 
when working on the Mac's desktop. 

H the file you want to edit is on another disk, and you have a two-drive 
Mac, insert the disk in the other drive. The second disk's directory window 
will appear. To eject a disk, locate its disk window and click its close box. 
If you have a one-drive Mac, you can still work with two disks, but you '11 
have to swap them in and out of the drive. 

Some of the resources you open may reveal a windowful of strange num
bers. These numbers are the hexadecimal code the Mac uses to perform its 
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sundry tasks. While you can edit these numbers, it does you no good 
because without training there's no way of knowing what you're doing. 

Data contained in an editable resource appear in templates, usually com
prised of boxes to fill and buttons to push. If the data is a picture or icon, 
you '11 see its image in the window. Pictures cannot be directly edited with 
Resource Editor, but icons can. Double-click on an icon and a handy edit
ing template appears. 

You can pass resources from one file to another (and from one disk to 
another) by using the Cut and Copy commands from the Edit menu. You 
can make a backup copy of a resource by selecting it, then choosing the 
Duplicate command. To delete a resource without affecting the contents of 
the Clipboard, choose the Clear command. 

When you are done editing a resource, click the Close box in each of the 
resource windows that are open. As you close the window to the Works 
program (or other application), Resource Editor asks if you want to save 
the changes you've made. Click Yes, No, or Cancel, as desired. 

Make it a habit of saving your changes often, especially if you are making 
several alterations at once. Then, try out Works to make sure it operates 
properly and that your changes have the desired effect. As an added precau
tion make a backup copy of Works each time you use Resource Editor. That 
way, if a problem occurs, you can go back to the most recently edited ver
sion instead of starting all over with a factory-fresh copy of Works. 

Adding and Modifying Command-Key Equivalents 
One of the most outstanding uses for Resource Editor is adding or editing 
command key shortcuts to menu items. Works already has command-key 
equivalents for some of its commands but you can readily add your own, or 
change the ones Works offers. See Table 1-1 in Chapter 1 for a list of letter 
keys that are already assigned to command-key equivalents within the 
modules of Works. 

You'll see that only the letter His not already assigned as a command
key equivalent in at least one module of Works. Of course, not all letters 
are used in each module. For example, Command· T is used only in the 
database module to enter time; you are free to use T in your own com
mand-key equivalents in any of the other modules. Of course, you are 
also free to remove any command-key equivalent already provided by 
Works. You can make Command-T equivalent to any command in the 
database module. 

Suppose you use a command often, like the Select All command in the 
word processing module, but Works doesn't offer a con;unand-key shortcut 
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for it. With Resource Editor, you can apply just about any key on the 
Mac's key board as a command-key equivalent (assuming, of course, that 
the key isn't already in use by Works). Keys you can use include: 

• All alphabet keys-A through Z (Works treats upper- and lowercase 
alphabet keys the same). 

• Number keys-from the top row of the keyboard or the numeric keypad. 

• Unshifted punctuation and symbol keys-those you get without press
ing the Shift key. 

• Shifted punctuation and symbol keys-those you get when pressing the 
Shift keys (in other words, Works differentiates between : and ;). 

• Option keys-either shifted or unshifted. 

Examples of command-key equivalents are shown in Figure 10-7. 
To create or edit command key shortcuts in Works: 

1. Double-click on Microsoft Works in the Resource Editor disk 
window. 

New .•• 
Open ••• 

Close 
Close All ••• 
Saue 
Saue As ••• 
Delete ••• 

3CO 

xw 
X1 
XS 
X' 
XD 

Make Works Desktop ••• 

Page Setup... X[ 
Print... XP 
Print Window X] 
Eject Page 
f>rin t Mt~njt~...... :•:; 

Quit XQ 

Figure 10-7 Sample of Command-Key Equivalents 
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2. Double-click on the Menu resource. (A full list of the Works menus 
appears in the table below.) 

3. Double-click on the desired menu. 

4. Scroll the menu window until you find the command you want. 
Under it will be a box labeled "key equiv," as shown in Figure 10-8. 

5. Click inside this box and type a letter. Though there is space for sev
eral characters, type only one. You can use upper- or lowercase let
ters, but the Mac will treat them the same. If you run out of letters in 
the alphabet, use a symbol or one of the Option characters. 

6. Close each window in tum and answer Yes to the dialog box that asks 
if you want to save the changes. 

An example of a Works menu with additional keyboard command equiv
alents is shown in Figure 10-9. 

While you've got the Menu resource open, you can also change the 
names of menus and commands. Find the menu/command name in the data 
boxes, and edit it. Don't worry about the length of the name; the menu will 
automatically expand. However, if the menu name is.too long for your lik
ing (or it goes off the edges of the screen), you can compress the text by 
clicking the "1" button opposite "condense." 

-o MENU I D - 258 from Microsoft Works 

prociD 0 

filler 0 

enableflgs $00000001 

title File 

***** 
menu Item !New ... 

icon# lo I 
key equiu D 
mark Char D 
ignored @0 01 

Figure 10-8 Menu ResEdit Dialog Box 
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~0 MENU I D = 258 from Microsoft Works 

menu Item 

icon# 

key equiu 

mark Char 

ignored 

eHtend 

I Print Window 

D 
[] 
D 
@0 01 

®0 01 

Figure 10-9 Example of Menu with New Commands 

Works contains the following menus, each identified by a number, and 
indicating the menu ID, the menu name, the module that uses the menu, 
and the menu type. Menu type Main indicates a menu listed along the top 
of the Mac screen, and one you pull down with the mouse. A Menu Sub is 
a pop-up menu that appears when you select an entry in a main menu. 

MenuiD Name Module Type 

257 Apple Menu General Main 
258 File General Main 
259 Edit General Main 
260 Window General Main 
261 Macro General Main 

66 Size Draw Sub 
67 Style Draw Sub 
68 Color-Foreground Draw Sub 
69 Color-Background Draw Sub 
70 * Line Pattern Draw Main 
71 ** Fill Pattern Draw Main 
72 Justified Draw Sub 

142 Format Draw Main 
150 Fonts WP Sub 
151 Style WP Sub 
152 Size WP Sub 
153 Color WP Sub 
154 Justify WP Sub 
155 Spacing WP Sub 
517 Search WP Main 
518 Format WP Main 
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MenuiD Name Module Type 

519 Spell WP Main 
775 Report DB Main 
774 Format DB-List Main 
776 Fonnat DB-Form Main 
773 Organize DB Main 

1285 Organize DB-Report Main 
1286 Format DB-Report Main 
1287 TotalsPage DB-Report Main 

128 Align ss Sub 
129 t Styles ss Sub 
130 Borders ss Sub 
131 Font ss Sub 
132 Size ss Sub 
133 Color ss Sub 

1029 Select ss Main 
1030 Format ss Main 
1031 Options ss Main 
1032 Chart ss Main 
1789 tt Keypad COM Main 
1797 Communications COM Main 

*, ** Line Pattern and Fill Pattern menus include the name of the menu 
only, and entries of the Blank/fransparent menu choices. The actual 
patterns are fetched from the pattern resource in the System file (on the 
Works Startup disk or your hard disk). 

t The Styles sub-menu for the spreadsheet is not shown in the 
Format menu, but does specify keyboard shortcuts for the Normal, Bold, 
and Italics styles. 

tt The Keypad menu includes the name of the menu only. The keys 
for the keypad are derived from special codes elsewhere within Works 
(this code can't be edited directly with Resource Editor). 

Changing Patterns 

Another practical application of Resource Editor is altering patterns that are 
used to create the Mac's desktop, along with the Fill and Line Pattern 
menus in Works (which are not changeable except with Resource Editor). 

Changing patterns requires that you edit the System file used to run 
Works (this System file will be either on your Works Startup disk or on 
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your hard disk). Works itself does not include resources for the Fill and 
Line patterns. 

WARNING: Never edit the System file the Mac is currently using. 
Make a copy of the System file on a separate disk, and use the copy to 
make the changes. Try out the edited System file with Works to make sure 
everything still works. Keep a safety copy of the original System file in 
case something goes wrong in the future with the edited version. 

To edit the patterns in the System file: 

1. Double-click on System in the Resource Editor disk window. 

2. Double-click on the PAT# resource. 

3. The System patterns appear in a window, as shown in Figure 10-10. 
Double-click anywhere in the block of patterns to "open" them. 

4. To select a pattern to edit, click in the left or right side of the small 
boxes in the bottom of the window. Drag off the window to the left 
or right and you '11 "fast forward" or "rewind" through the patterns. 

5. To edit a pattern, click inside the window in the upper-left comer, as 
in Figure 10-11. The results of your edits are shown immediately as 
you add and take out dots. 

6. Close each window in tum and answer Yes to the dialog box that asks 
if you want to save the changes. 

=D: Pattern Lists from System ------
. . . . :. :. :. -:·:·:·:·:·:·:· . . .. . . . .· .·· .·· .·· ..... -. .·.·.·. ::::::::::::::::::::::::::::: 11111111"' .. ·· .. ·· .. ··.1111~·····--1 

::::::: ~:~:~:~ }}}~:~ ~~~~~~~ :::·:::-:::-::: ~~~~~-~ 

Figure 10-10 Basic Pattern Box 
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•••••••• 
···~~~~... ••• 't 

•••••••• 
.......... .......... .......... .......... .......... .......... .......... .......... .......... 

Figure 10·11 Editing Patterns 
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Use the new Works patterns just as you did the old. To keep the old pat
terns intact for future use, enable Resource Editor to duplicate the pattern 
list (use the Edit-Duplicate command) before you edit the patterns. Leave 
the duplicated set alone. 

To revert back to the old patterns, reverse the ID numbers of the two 
sets (Works uses the set with the ID number of 0). You can use this tech
nique to create a bevy of pattern sets, and uactivate" each one by changing 
its ID to 0. 

Editing Fonts 

If you want to add a special character to one of the Mac's fonts, Resource 
Editor will get the job done. All of the Mac's writing fonts are stored in the 
FONT resource, which is located in the System ftle. To edit a font: 

1. Double-click on System in the Resource Editor disk window. 

2. Double-click on the FONT resource. A full listing of all the available 
fonts appears, in all sizes (see Figure 10-12). 

3. Double-click on a font, and you're greeted with a font editing tem
plate. 

4. Click inside the large window to lay down or pick up dots, as illus-
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trated in Figure 10-13. To edit another character, either type it from 
the keyboard, or use the mouse to shuttle up and down the list charac
ters in the box in the lower right comer. Click on either side of the 
box to step up or down the alphabet, or drag off the box to quickly 
fast forward or rewind. 

5. Close each window in tum and answer Yes to the dialog box that asks 
if you want to save the changes. 

-o Fonts from System 
Avant Garde 10 ID = 4234 ;Q 
Avant Garde 12 ID = 4236 
Chicago 12 I D = 12 
Geneva 9 I D = 393 
Geneva 1 o ID = 394 
Geneva 12 ID = 396 
Geneva 14 ID = 398 
Helvetica 10 ID = 2698 
Helvetica 12 ID = 2700 
Monaco 9 ID = 521 

Figure 10-12 Font Window wiJh AU Sizes 

iiD - ------
- -- =----=-=--------=---==-- - - Geneua9 

• •• • •• • •• ·-·· I II . . "' 

Figure 10-13 Editing Fonts 

Tht quick brown fox 
jumps ov.r tht lull 
dog . 

G 
ADLOW I 0-2-162-o-6 
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•• •• • • --·-··· • • ... -. • •• •• • • •• • • • •••••••••• •• ·-•• •• •• •• .. ~·· 

Figure 10-14 Creating a New Font Character 
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L---2 19 -----1 

ADLO'W 1 2-2-8 1 6-0-9 

Resource Editor allows some creative freedom when working with fonts. 
H you want to change the horizontal spacing of the characters, drag either 
of the black triangles located along the bottom edge of the font window. 
You might use this feature to transform New York, for example, which is a 
proportionally spaced font (i's take up less space on the line than w's), intd 
a mono-spaced font. H you want to add more vertical spacing, drag the 
black triangles that appear on the left edge of the font window. 

To create an entirely new character, as in Figure 10-14, use the Key Caps 
desk accessory to find an unused Option or Shift-Option key (such as 
Option-K in Geneva or New York). Type it on the keyboard; the large win
dow in the center of the template will go blank. Make the new character. 

Modifying the Mouse Pointers 

You can change any of the pointers (or cursors) used to indicate the posi
tion of the mouse. You might, for example, change the standard 1-beam 
pointer to a heavy rectangle. 

1. Double-click on Works in the Resource Editor disk window. 

2. Double-click the CURS resource. 

3. The Works cursors appear in a window (refer to Figure 10-15). 
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Double-click on the 1-beam pointer and an editing box appears. (You 
can edit any other cursor if you wish; the meaning and use of each 
cursor is provided in the table below.) 

4. Edit the cursor in the left window of the editing box. Simply click to 
remove or add dots. You can see how the cursor will look by choos
ing the Try Cursor command in the Cursor menu. Revert back to the 
arrow by choosing Restore Arrow. You can see how the cursor will 
look on black, white, and gray backgrounds by examining the sam
ples at the bottom of the three editing windows (see Figure 10-16). 

5. Some cursors, including the original 1-beam, may not have a back
ground mask, so the middle window is blank. Other cursors, includ
ing the arrow, have a background mask that can be individually edit
ed. When designing your own cursors, you can quickly transfer an 
image of the cursor to the background mask window by choosing the 
Data-> Mask command from the Cursor menu. 

=o= Cursors from Microsoft Works 

8 ~ ~ s ~ I l X Q 

Q b ~ ? ~ + -*- ~~ . ... 

0 
Figure 10-15 Cursor CoUection 

Figure 10-16 Editing Cursor 
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6. The left editing window lets you set the "hot spot" for the cursor, the 
exact point Works uses to defme the location of the cursor. The hot 
spot is normally in the center of the 1-beam; click any of the gray pix
els to choose another hot spot. 

7. Close each window in turn and answer Yes to the dialog box that asks 
if you want to save the changes. 

Cursor Looks Like 
<beach balls> 
<hand> 

<1-beam> 
<1-beam with dot> 

<magnifying glass> 
<line, single arrow> 
<hollow pointer> 

Application 

Works busy, please wait. 
Scroll in Print Preview; move field in 

DB form. 
Set text insertion point in WP. 
Set text insertion point in WP while 

Works is repaginating or reformatting. 
Zoom in Print Preview. 
Resize field in database form. 
Set new cell or field selection in SS or DB 

while Works is calculating. 
<question mark> Select on-line help topic. 
<pointer> General purpose mouse pointer. 
<line, double arrow> Resize columns/fields in SS and DB. 
<horizontally split window > Split SS and DB window horizontally. 
<vertically split window > Split SS and DB window vertically. 

Both the System and Finder have additional cursors that you can edit in the 
same marmer. One of the cursors Works regularly uses from the System file is 
the cross, used to create objects with Draw. To change this cursor, you must 
open the System file you use with Works. Be sure to follow the caution provid
ed earlier about editing the System file without first making protective copies. 

Modifying Dialog Boxes 

You may not always like how some of the Works dialog boxes are orga
nized. Resource Editor lets you change the positions of the options so they 
are more logically situated for you. 

Dialog boxes are kept in DITL resources. You can freely change the 
organization of any dialog, but are limited to retaining the same size and 
shape for the box. To edit a dialog box, open Works with Resource Editor 
and find the DITL resource listing. Double-click on DITL and scroll 
through the ID numbers until you find one you want. Not all of the dialog 
boxes lend themselves to modification. Here is a list of some of the most 
suitable to customizing with Resource Editor. 
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DITLNumber Function Module 
142 Close all General 
212 New pie chart ss 
213 New series chart ss 
269 Open file General 
310 Sort field DB 
318 Set field attributes DB 
420 Paste with options ss 
422 Select sort keys ss 
431 Set cell attributes ss 
801 Find WP 
802 Replace WP 
940 Communications setting COM 
941 Dial number COM 
943 Send file COM 
947 Receive text COM 
948 Send text COM 
949 Capture text COM 

1000 Spell check WP 
7484 Grid settings in Draw Draw 

13052 Record macro Macro 
13070 Stop macro Macro 
13080 Playback macro Macro 
13081 Save macro file Macro 
13085 Open macro file Macro 
15767 Options ss 
Here's an example of how to change the organization of the Find dialog 

box in the word processor module. 

1. Double-click on Works in the Resource Editor disk window. 

2. Double-click on the DITL resource. 

3. Double-click on the DITL ID=801 resource. The Align Objects dia
log box appears (if 10=801 does not contain the Align Objects box, 
open each ID=# in tum to fmd it). The box is shown in Figure 10-17. 

4. Tum on the alignment grid by choosing the DITL-Grid command. 

5. Use the mouse to drag the options around the window. You may 
resize the window, if you wish, by dragging the resize box on the 
lower right comer. Figure 10-18 shows one way of organizing the 
options. 

6. When fmished, close each window in tum and answer Yes to the dia
log box that asks you if you want to save the changes. 
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~o~ Dialog item list • Find" I 0 801 from Microsoft Worlcs 

!Find What: Jl J 
~~ 0 Match Whole Words Only 0 Checlc Upper/Lowercase 

( Cancel ) l Find NeHtJbj 

Figure 10-17 Original Find Dialog 

50= Dialog item list "Find" 10- 801 from Microsoft Worlcs 

!rfiiifuffi"D"E'i' J 
'····-···---·--··-··.i_L--:---:-:-:-:-:-:--:-:-:-:---:---:--:---===---r===='" 

0 Match Whole Words Only '11 J ( Cancel ) 

0 Checlc Upper/Lowercase ] l_!"lifd NeHt -b 
Figure 10-18 Updated Find Dialog 

Changing Time/Date Separator 

The Alarm Clock desk accessory lets you easily copy the current time and 
date, then insert it in a document. The Works spreadsheet contains its own 
time and date function, but the word processor doesn't. You can use the 
Alarm Clock desk accessory to readily insert the current time and date any
where in a word processor document. 

The Alarm Clock uses specific characters to separate the day, month, and 
year for the date; and the hour and minute for the time. You may, if you 
wish, change these separator characters to better suit your tastes. 

Changing the time/date separators requires you to open the itlO resource 
in the System ftle, then open the itlO=O resource. Scroll through the window 
until you get to the boxes labeled timeSep and dateSep. TYPe a new symbol. 

Resource Editor also lets you change the order and the format of the date. 
To change the date order, enter a new digit in the dateOrder box, follow

ing these conventions: 

Order Number 

0 
1 
2 
3 

Date Order 

M!D!Y 
DIMlY 
Y/M/D 
M/Y/D 

To change the date format, enter a new code in the shrtDateFmt box, fol
lowing these conventions: 
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Format Code 
$00 
$AO 
$CO 

Date Format 

1/1/90 
1/1/1990 
01/01/1990 

To copy the time and date text into a word processing document: 

1. Open the Alarm Clock desk accessory. 

2. Choose the Copy command from the Edit menu (or press Command
C). 

3. Close the desk accessory and set an insertion point in the word pro
cessing document. 

4. Choose the Paste command from the Edit menu (or press Command
V) to paste the time and date. 

The Macintosh automatically includes both the time and date; if you 
want only one, simply remove the other. 

The Alarm Clock display is designed to work best with the standard time 
and date separators, and standard date format. Using different separators 
and formats may corrupt the display, but the actual time and date text is still 
properly copied and pasted. 

PersonaiiD 

Works insists that you "personalize" your copy when you first use it. This 
personalization includes your name and organization, and appears when 
you first start Works. The personal ID can't be edited except with a utility 
such as Resource Editor. 

But why would you want to edit the personal ID? Several reasons come 
to mind; the most obvious is if you get a "hand-me-down" copy of Works 
in your office, and it has someone else's name on it. You may also wish to 
sell your copy of Works, and not be responsible if the buyer gives away 
unregistered copies of a program you used to own, and which still has your 
name on it. 

Of course, you can avoid editing or removing the personal ID by using 
only a copy of the Works program, leaving the original unused. But sup
pose you inadvertently personalized your original copy of Works? Here's 
how to delete or edit the personal ID. 

1. Find the PSIP resource in the Resource Editor disk window, and dou
ble-click on it 

2. Double-click on the PSIP ID=257 resource. 
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3. Use the mouse to carefully select the name text that's located between 
the two boxes. Don't delete these boxes; if you do, close the win
dows without saving and try again. 

4. To delete the name text, press the Delete key. To write in a new 
name, simply type from the keyboard (no more than about 18 charac
ters). 

5. Close the ID-257 window, and double-click on the PSIP 10=258 
window. 

6. Use the mouse to select the organization text that follows the box. 
Don't delete the box. 

7. Follow the same procedures as in step 5 to delete or replace the orga
nization text. 

8. When fmished, close each window in turn and answer Yes to the dia
log box that asks you if you want to save the changes. 

OTHER WAYS TO CUSTOMIZE WORKS 

There are a number of other methods to customize Works to best suit your 
working habits. 

New Command Keys with Menu Master 

Using Resource Editor is but one method of changing command-key equiv
alents for Works menus. A number of stand-alone utility programs are 
available that make the process of adding or editing command-key equiva
lents easy. One such utility is Menu Master, available as Shareware. (See 
Appendix A for a list of sources that offer Menu Master and other helpful 
utilities.) 

Menu Master is a desk accessory you use along with Works (or any other 
Macintosh application, including the Finder and MultiFinder. To add a 
command-key shortcut to a command, open Menu Master, choose the menu 
and command you want, then indicate a command-key letter. 

Menu Master lets you assign any alphabetic key to a command, such as 
A, B, C, and so forth, as well as numerals. Unlike Resource Editor, Menu 
Master does not allow you to use punctuation marks or special characters, 
such as<;. 
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Embedded Fonts and Desk Accessories 

Fonts and desk accessories are nonnally placed as individual resources in 
the System file, but they can also be inserted in any applications program, 
including Works. Embedded fonts and desk accessories offer a number of 
benefits: 

• Desired fonts and desk accessories are always available, even if your 
copy of Works is used with a different Startup disk. 

• Fonts and desk accessories that you use only with Works don't get in 
the way of other applications. 

• Specially modified versions of fonts can be implanted within Works, 
overriding the fonts in the System file. 

Apple's Font/DA Mover offers an easy method of embedding fonts and 
desk accessories in applications. Here's how to do it: 

1. Start Font. 
2. Choose Font or Desk Accessory, depending on which type of 

resource you want to add to Works. 
3. Close all open files (the buttons underneath the list windows should 

read Open). 

4. Depress and hold the Option key, and click the Open button under 
one of the list windows. 

5. Find the Microsoft Works file (use the Drive and Eject buttons as 
necessary, or change the levels of folders, to bring the Works file into 
view). 

6. Double-click on Microsoft Works. 
7. Click the Open button under the other list window and fmd the font 

or desk accessory you want. It may be in its own fJ.le, or it may be 
installed in the System fue. 

8. When the font or desk accessory is found, select it in the list window. 
9. Click the Copy button. 

Repeat steps 7, 8, and 9 for each additional font or desk accessory you 
want to add. Once the font is installed in Works, use Resource Editor to 
edit it, if desired. 

Note: These instructions assume you already know how to use the 
Font/DA Mover. If you are unfamiliar with the utility program, consult the 
manuals provided with the Macintosh. 
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Using Works with 
Other Programs 

In this chapter, you 'II learn how to use Works with other programs, how to 
format and convert Works documents for use with other programs, how to 
cut and paste data between applications, and how to use the various Works 
tools for maximum efficiency. (For information about sharing data 
between Works modules instead of outside Works, review Chapter 1.) 

REVIEW OF WORKS DATA TYPES 

We covered this topic in Chapter 1, but it's worth reiterating here. There 
are four types of information used in Works: text, tab-delimited data, bit
map pictures, and object-oriented (or QuickDraw) pictures. The Mac 
works with each kind of information in a different way, and with some pro
grams you're limited to sharing only certain types of data. 

• Text documents are letters and memos. The characters form whole 
lines or paragraphs, and the Works word processor creates text docu
ments. Text is also generated by the communications module, and can 
be saved directly to disk or by cutting and pasting. 

• Tab-delimited data is composed of many discrete cells or fields, sepa
rated by rows or records. The Works spreadsheet and database create 
tab-delimited documents. 

• Bit-mapped pictures are composed of dots, like a MacPaint image. 
You can erase or add dots to alter the picture. No works module cre
ates bit-mapped images, but the word processor and spreadsheet can 
accept bit-mapped pictures created and pasted from other applications. 

333 
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• Object-oriented pictures are composed of discrete shapes-like circles 
and rectangles-each of which can be separately manipulated. The 
Works Draw and spreadsheet charting features create object-oriented 
pictures, which can be exported to other Macintosh applications or 
pasted into a word processor or spreadsheet document. 

Module 

Word processor 
Spreadsheet 
Spreadsheet charts 
Database 
Draw (in WP and SS) 

Data Type 

Text 
Tab-delimited 
Object-oriented graphics 
Tab-delimited 
Object-oriented graphics 

Keep these differences and their applications in mind as you read 
through this chapter. 

EXPORTING WP TEXT 

There are two methods of exporting text written in the Works word proces
sor to another Macintosh word processor or application that accepts text 
data: through the Clipboard and with the Export (Text-only) Save option. 

Exporting Through the Clipboard 

The Clipboard is shared among most Macintosh applications. It holds all 
types of Works information, including text, tab-delimited spreadsheet data, 
bit-mapped graphics, and object-oriented graphics. Only one clipping can 
be stored at a time in the Clipboard. If you cut or copy one clipping, then 
another, the frrst one will be lost. 

To export text through the Clipboard: 

1. Select the text or data you want. 

2. Choose the Cut or Copy command from the Edit menu, as desired. 
This places the selection, or a copy of it, into the Clipboard. 

3. Exit Works. 

4. Start the application you want to put the data into. 

5. Once you're in that application, select an insertion point for the text 
and choose the Paste command from the Edit menu. 

All this assumes, of course, that the applications you're pasting into have 
a Paste command; most Mac programs do, but not all. If one of your appli-
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cations lacks these commands, then it probably doesn't make use of the 
standard Macintosh Clipboard, so you won't be able to use it for routine 
cutting and pasting. 

When cutting and pasting a large clipping, the Mac temporarily stores 
the data in a special Clipboard file on disk. This file is placed onto the 
same disk that holds the application you're using, regardless of whether or 
not the application is on the Works startup disk or hard disk. 

This means that if you change disks to load the application to paste to, 
the Mac may ask you to swap disks as it copies the Clipboard file to the 
new disk. If you have a two-drive Mac, you can avoid this hassle by insert
ing the application you've cut from in one drive, and the application you're 
pasting to in the other. 

Be careful never to tum off the Macintosh before cutting and pasting is 
completed, or the contents of the Clipboard will be erased. 

Clipboard vs. Scrapbook 

Since the Clipboard holds only one clipping at a time, you should use the 
Scrapbook if you're cutting and pasting several clippings. It can hold up to 
256 clippings and you can add and remove clippings individually. 

The Mac uses the Scrapbook file (the file that holds all the Scrapbook 
clippings) on your current Works startup disk or hard disk. If the applica
tion you're pasting to is on another startup disk, copy the current 
Scrapbook file to it. But frrst check if that disk already has a Scrapbook 
file, or you'll erase it unless you change its name before you copy. You can 
have as many Scrapbook files on the disk as you want, but all of them must 

0 ScrapBooks E!l= 
1 ;tern 612K in d;sk ·168K available 

~ ~ ~ ~ ~ 
Q 

. . 

Hardware Mise. p;ctures 
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Electron;cs Graphs Draw Elements 

0 
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Figure 11-1 Many Scrapbook FUes, with Different Names 
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have different names, as shown in Figure 11-1. The Mac always accesses 
the Scrapbook file named "Scrapbook file." If it can't fmd a file with that 
name on the current startup disk, a new, empty one is created. 

Using the Export Option 

The Export option is available when saving word processor flies, database 
and spreadsheet files. Clicking the Export option before saving a file (new 
saves or when using the Save As command), stores the ftle on disk with 
just text characters, and no information for fonts, paragraph margins, or 
other formatting. Once converted to Text-only (or ASCll) format, the file 
can be opened by any word processor on any computer. 

You can also save Works word processing files under the Export option 
as RTF-or Rich Text Format. The Rich Text Format, discussed more fully 
in Chapter 2, allows you to share Works documents with non-Macintosh 
word processing programs. 

Some Macintosh word processors, most notably Microsoft Word, can 
open Works 2.0 ftles directly; you don't need to convert it frrst to Text-only 
fonnat. Check frrst to avoid the extra step of text conversion. 

IMPORTING WP TEXT 

Importing text to the word processor follows the reverse procedure as 
outlined above. You can paste previously captured text from the Clipboard 
into an open Works word processing document, or open an entire Text-only 
document. 

To paste previously cut or copied text: 

1. Open a Works WP document or create a new one. 
2. Set an insertion point for the text. 
3. Choose the Paste command from the Edit menu. 

The imported text will take on the character and paragraph fonnatting of 
the surrounding text. If you have many snippets of text to transfer to 
Works, save them in the Scrapbook. See the section titled "Clipboard vs. 
Scrapbook," earlier in this chapter, for more details. 

To open a Text-only document: 

1. Choose the Open command from the Works File menu. 
2. Click the word processor icon. 
3. Click the Export option. 
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4. Choose the file from among the list in the file list window, then dou
ble-click on it to open it. 

No formatting information is saved with Text-only documents, so Works 
opens the file in an Untitled window, using standard character and para
graph formats. An exception to this rule is when importing Text-only doc
uments that have been saved in RTF, or Rich Text Format. The RTF format 
records format settings as English commands. Works converts as many of 
these commands as possible into their corresponding formats, then leaves 
the rest as plain text. 

Most Text-only files do not contain unusual codes and characters, but 
you may encounter one, especially if you are working with documents cre
ated on another computer. Works automatically strips most special codes 
or characters. Prior to formatting and printing the converting document, 
check for stray characters and remove them. You may need to refer to a 
printout of the original document in case you need to manually retype any 
characters that were lost during the conversion. 

You are not limited to importing text to the word processor. The Works 
word processor also accepts tab-delimited text pasted from the Clipboard, 
or complete files that have been saved in Export format. Imported tab
delimited text is treated in a word processor document just like data copied 
from the Works spreadsheet or database. Cells (or fields) are separated by 
tabs, and rows (or records) are separated by paragraph returns. 

The Works word processor (as well as the spreadsheet) also accepts both 
bit-mapped and object-oriented graphics. See the section below on 
"Importing Graphics" for more information. 

EXPORTING SPREADSHEET AND DATABASE DATA 

Works spreadsheets can't be directly read by most other electronic spread
sheet programs. If you need to export a spreadsheet for use with another 
program, you must convert it frrst using the Export option. 

Before saving the file, Works asks if you want to save it as a SYLK or 
Text-only document. The SYLK format allows conversion of spreadsheet 
data, including formulas, and most formatting. You must use a SYLK
compatible electronic spreadsheet program, such as Excel. (Note: Many 
electronic spreadsheet programs for the Macintosh and IBM PC are SYLK
compatible.) The Text-only format converts the spreadsheet to plain ASCIT 
text, without recording the formatting of the document. 

The database module offers only Text-only conversion; the SYLK for
mat is not available. 
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More specific details on using the Export option with spreadsheet and 
database documents can be found in Chapter 4, "Spreadsheet Strategies," 
and Chapter 6, "Keeping Tabs on Data." 

IMPORTING SPREADSHEET AND DATABASE DATA 

Both the Works spreadsheet and database use tabular data, which consists 
of a series of lines, with each item in a line separated by tabs. A number of 
programs, including Microsoft File, Excel, and Multiplan, also accept tabu
lar data into their specialized file formats. 

For electronic spreadsheets like Excel that support the SYLK document 
fonnat, transferring files is a rather simple process: just save the file in 
SYLK format and open it within Works. (Note: The database module can't 
open SYLK documents, so try this technique only with the Works spread
sheet.) If the program doesn't support SYLK, or you need to transfer a file 
to the database, save the original document in Text-only format. Then: 

1. In the Open Files dialog box of Works, click the module you want to 
hold the document (spreadsheet or database). 

2. Choose the Export option. 

3. Find the file you want to open and double-click on it. 

EXPORTING GRAPHICS 

Works isn't a graphics program and you wouldn't use it to draw pictures. 
Sometimes, however, you must transfer a block of formatted text to another 
program. The special fonnatting features of Works (like boxes and lines) 
are probably not shared by the other program, so the only way to transfer 
the text intact is to frrst convert it to an object-oriented picture. Consider 
the possibilities of this feature. 

Works is fine for most routine desktop publishing endeavors, but it is not 
a full-fledged page makeup program. But page makeup programs aren't 
generally as easy to use as Works, and they aren't word processors. Works 
lets you have the best of both worlds. You can create your text and page 
formats on Works, then transfer them over, practically intact, to a page 
makeup program, such as PageMaker or Ready-Set-Go. 

You must use the Clipboard (or Scrapbook) to transfer text and special 
graphics. However, Works won't let you simultaneously select and copy 
both text in the word processor or spreadsheet, as well as graphics from the 
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Draw layer. If you want to transfer both text and graphics of a word pro
cessing document, for example, you need to do it in two passes--once for 
the text, and once for the graphics. 

IMPORTING GRAPHICS 

Works accepts both bit-mapped and object-oriented graphics. From an 
operational standpoint, it doesn't matter which kind of graphic it is. You 
copy and paste both in the same fashion. Once in Works, however, the two 
kinds of graphics behave differently. You'll want to use object-oriented 
graphics if you plan to edit them with the Draw tools, or if the document is 
to be printed with the LaserWriter. The LaserWriter, as well as other 
PostScript-language output devices, "smooth" the contours of object-ori
ented graphics much better than the contours of bit-mapped graphics. The 
result is a sharper image. 

You will also want to use bit-mapped graphics if you plan on resizing the 
graphic once in Works. Figures 11-2 and 11-3 show the effects of resizing 
an object-oriented graphic, and a bit-mapped graphic. Notice how the 
object-oriented graphic retains its smoothness and correct pattern, while the 
bit-mapped does not. 

Original Resized 
Figure 11-2 Object-oriented Graphic, Resized 

Original Resized 

Figure 11-3 Bit-mapped Graphic, Resized 
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When copying graphics into Works via the Clipboard, Draw is automati
cally turned on. Object-oriented graphics are automatically grouped 
together, even if they weren't grouped in the original graphics program. 
You can position the graphic and box anywhere along the width of the doc
ument simply by dragging it in place. 

OTHER THINGS TO CUT AND PASTE 

The Mac offers a great deal of cut and paste flexibility. Don't forget these 
shortcuts: 

• Plug in the current time and date by calling up the Alarm Clock desk 
accessory, choosing the Cut or Copy command, then pasting any
where in the document. If you don~ like the form of the time and 
date as pasted, use Resource Editor, as detailed in Chapter 10, 
"Customizing Works." 

• Use the Scrapbook to keep simple form letters. Write the basic letter, 
select all of it, then save it in the Scrapbook. When you want to use a 
letter, call up the Scrapbook, select the form you want, then cut and 
paste it into the current document. You can also use this system to 
insert long passages of text that you regularly use in your line of busi
ness. If you're a lawyer, for instance, you can save boilerplate portions 
of contracts in the Scrapbook and cut and paste them into your word 
processing documents as you need them. 

• Program the Calculator desk accessory to replay a long equation. Type 
the equation on the keyboard into the Note Pad, then copy it into the 
Clipboard. You can put the Note Pad away or keep it handy. When 
you're ready, paste the equation into the Calculator. When the equa
tion is pasted, the Calculator performs the math, as you instructed. 
You can keep several equations on each page of the Note Pad. 

Of course, these hints are just the beginning of the many ways you can 
use the Mac's cut and paste feature to make your work with the Mac easier 
and more productive. Don't be afraid to experiment. 
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Printing with Works 

Only a few short years ago, computer industry pundits were forecasting a 
paperless office for the 1980s. The completely electronic office would con
duct business through computers. Important mail, reports, and memos 
would be not in the fonn of printed papers, but as thousands of tiny bits of 
data sent through complex webs of computer links. 

So far, the electronic office hasn't happened, nor anything closely resem
bling it. True, businesses today are using computers, but they are using 
them to produce more printed material than ever. U.S. business computers 
generate an estimated 600 million pages of output every day. 

And that's not counting the 235 million photocopies and 76 million let
ters produced daily. Many of these pages are saved for future reference. 
File cabinets around the country hold an estimated 21 trillion sheets of 
printed paper, much of it generated from computers. Until the vision of the 
electronic office becomes a reality, we will continue to make printed copies 
of computer data. 

The printing process is the culmination of all the labor you've put into 
your Works documents, the denouement that shows everyone the result of 
all those hours pounding on the keys and scooting the mouse around the 
desk. In this chapter, you '11 learn all about printing with Works: how to 
prepare the document for printing, how to audition the printed output 
before committing a single letter to paper, and how to print multiple copies 
of your documents, or print just sections and pages. 

341 



342 Inside MS Works 2 for the Macintosh 

WHAT YOU CAN PRINT 

Works allows you to print any of the following documents: 

• Word processor 

• Database report 

• Spreadsheet 

Text files captured with the communications terminal cannot be printed 
directly from the communications module. You must save the captured text 
and open it with the word processor. You also cannot print records directly 
from the database. You must frrst create a report of the database records. 

Works will allow you to print the current window, using the Print 
Window command in the File menu, regardless of the module you are 
using. This applies to the communications and database modules, as well 
as the charts made within the spreadsheet. An additional command in the 
File menu, Eject Page, starts a new page in the printer. Use this command 
to start work on a fresh, blank page after printing the contents of one or 
more windows. 

Using the Page Setup Dialog Box 

Choosing the Page Setup command in the File menu allows you to control 
the layout of the entire document, including the paper size, page orientation 
(either portrait or landscape), margins, and header/footer text. Keep these 
notes in mind when using the Page Setup dialog box. 

• The Laser Writer and Image Writer use different Page Setup dialog 
boxes, as shown in Figures 12-1 and 12-2. The currently selected print
er (as defined by the Chooser desk accessory) determines the dialog 
box that is displayed when you choose Page Setup from the File menu. 

• The Page Setup dialog box may appear in a different form, depending 
on the version of Finder and System you are using. The boxes in the 
two figures are from System 6.0.2 (Finder 6.1). 

• The Page Setup dialog box also differs-slightly-depending on the 
Works module you are using. 
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The Paper, Orientation, and Paper Width/Height options tell Works how 
large a canvas it has to work with. The four paper options have preset 
width and height dimensions. Clicking one of the options automatically 
places the following dimensions into the width and height boxes: 
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Paper 
U.S. Letter 
u.s. Legal 
A4Letter 
International FanFold 
Computer Paper 

Width 

8.5 in. 
8.5 in. 
8.25 in. 
8.25 in. 

14in. 

Height 
11 in. 
14 in. 
11.67 in. 
12 in. 
11 in. 

With the Image Writer, you can generate documents wider than the print 
carriage by printing them sideways. You choose this option by clicking the 
Landscape (or Wide) option. Works now prints each page on the wide 
(lengthwise) dimension. 

With the LaserWriter, you can indicate a percentage of reduction or 
enlargement, from 25 percent to 400 percent. The reduction and enlarge
ment percentage relates to the size of the finished print in relation to the 
original. That is, a reduction of 7 5 means "7 5 percent of original size." 
You can use reduction to fit a large document on a small piece of paper. 
The original document may be 22 by 22 inches, but reduced to 25 percent 
the fmal printout takes up only 5.5 by 5.5 inches. 

The paper width dimension affects the left and right margins of the page. 
You can see the different effects of margins depending on the module you 
are using. 

Module 

WP 

DB 

ss 

Effects 

Right paragraph indent marker turns hollow 
when moved outside the right margins. 

Right indent marker will not move beyond 
right margin. 

Dotted lines appear at each page break. 

The paper height dimension affects the length of each page, and there
fore the number of papers your document takes up. You further control the 
amount of text that can be placed on a page with the bottom and top mar
gins (see below). You can increase or decrease the page length by chang
ing the paper height, margins, or both. 

Each document you create with Works stores its own unique Page Setup 
settings. If you want to prepare a number of documents using the same 
Page Setup selections, create a master of the document using the Works 
Stationery feature. See Chapter 1 for more information on using 
Stationery. 
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The Truth About Margins 

Margin settings defme the printable area for the body of a document (page 
numbers and headers/footers are printed outside these areas, one half-inch 
from the top or bottom of the page). To change a margin, choose the Print 
Setup command from the File menu, click in the corresponding entry box 
and enter a number, in inches. Enter only numbers; Works ignores symbols 
or text such as " or in., and resets the value in the margin box to zero. 

Tall Adjusted The Tall Adjusted option corrects the discrepancy between 
the horizontal resolution of the Mac's screen (72 dots per inch) versus the 
horizontal resolution of the Imagewriter (80 dots per inch). Without Tall 
Adjusted, graphics that appear on the screen as round may print as ovals. 
With Tall Adjusted, the circle comes out as a circle. Be sure this option is 
on whenever you have inserted a graphic into the document. 

Your graphics suffer slightly when you must compensate for different 
resolutions. With Tall Adjusted, text is slightly squeezed, although the 
effect is hardly noticeable. What you will perceive, however, is that Works 
can fit more text on a line, and the line breaks may not always be what they 
were with Tall Adjusted turned off. This has a domino effect, including 
throwing off paragraph breaks and page breaks. You have two options: 

• Compensate for the change by adjusting the margins to return the line 
breaks to their previous state. 

• Plan on the Tall Adjusted discrepancy from the beginning, and format 
the document with it turned on. 

Fifty Percent Reduction When you choose Fifty Percent Reduction, doc
uments are printed at half their normal size on the Image Writer. (As 
detailed earlier in this chapter, the LaserWriter lets you set variable reduc
tions and enlargements.) 

No Gaps Between Pages The No Gaps Between Pages prints text so that 
you can overlap succeeding pages to make one large document sheet. The 
option is most often used to print large spreadsheet files. 

Headers and Footers Works lets you assign headers and/or footers to word 
processing, spreadsheet, and database report printouts. See Chapter 2, 
"Writing and Works," for a complete rundown on using headers and footers. 
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REPAGINATION AND PAGE BREAKS 

Works automatically breaks your document into pages while you write. 
The process is known as dynamic pagination. Page breaks appear on the 
screen as a light dotted line. You can force your own page break by press
ing Shift-Enter. Page breaks you set yourself, called required page breaks, 
are shown on the screen as a heavy dotted line. You can select and delete 
your page breaks, but you can't get rid of the ones Works creates. 

PRINT PREVIEW 
Get into the habit of checking your documents before you print them. Use 
the Print Preview option in the Print dialog box. 

1. Choose Print from the File menu. 

2. Click the Print Preview option. 

3. Click the OK button. 

A miniature version of your document appears on the screen. To use 
Print Preview, click within the displayed page or one of the buttons beside 
the page. 

• To move forward one page, click the Next button. 

• To move backward one page, click the Previous button. 

• To examine the page enlarged, move the mouse pointer over the spot 
you want to view and click. 

• To see another part of the document while zoomed in, drag with the 
mouse. 

• To return to normal magnification, double-click anywhere on the page. 

• To print the document, click the Print button. 

• To exit Page Preview click the Cancel button. 

You can't edit the document while in Print Preview, and all commands are 
inaccessible. The Print Preview options, in the Print dialog box, stay select
ed for all documents you create or edit, until you tum it off or quit Works. 

PRINTING 

Now that you've set up the document the way you want it, and made sure 
the page breaks appear at their proper places, it's time to print. 

During printing, you have the option of canceling at any time, even 
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before the Image Writer actually prints a character. To cancel printing, 
press Command-. (period). 

The changes you make in the Print dialog box are not stored with the 
document when you save it, but many are remembered during a single 
Works session. 

Option 

Quality 
Pages 
Paper Feed 
Copies 

Printing Options 

Stays Until Reset 

X 

Returns to Default 

X 
X 
X 

The Print dialog box lets you set options to accommodate special printing 
situations. 

Pages The Pages options set the range of text you want scribed on paper. 
Normally, the All option is selected, which prints all of the document. To 
print a range of pages or sections: 

1. Note the pages and/or sections you want to print (page numbers are 
displayed in the box in the vertical scroll bar). 

2. Choose the Print command. 

3. Click inside the From box. 

4. Enter the starting page in the From box. 

5. Press Tab, and enter an ending page in the To box. 

6. Click the OK button to start printing. 

Some printing shortcuts: 

• To print from the beginning to a specific page, enter a page number in 
the To box but leave the From box blank. 

• To print from some point within the document to the end, enter a page 
number in the From box but leave the To box blank. 

• If you just want to print one page out of many, enter the number for 
that page in both boxes. 

Copies The Copies option sets the number of copies of the document you 
want printed. If you know you want three original copies of your docu-
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ment, it's faster to print them all at once than separately. Enter a number up 
to 99 into the Copies box. 

Paper Feed You can instruct Works to print non-stop from beginning to 
end, or one page at a time. For non-stop printing, load the printer with con
tinuous fan-fold·paper and keep the selection on Automatic. For page-at-a
time, you use single sheets and click Manual. 

Quality You can select the quality of print with the Best, Faster, and Draft 
options. 

• With Best, each character is printed twice, and the look of the docu
ment turns out darker and neater (unless you use a fresh ribbon; then 
the print looks smeared). 

• Faster is the standard setting; it prints text and graphics as they appear 
on the screen, but only with one pass. Faster printer is about twice as 
fast as Best printing. 

• Draft uses the text fonts built into the Image Writer to print your docu
ment, and does not display fonts or graphics. 

When using Draft, different fonts, styles, and sizes affect the look of the 
print. You get more reliable results when using a monospaced font, such as 
Seattle, Monaco, or Courier when printing in Draft. 

PRINTING WITH A LASERWRITER 

The benefits of using a LaserWriter includes higher resolution text and 
graphics, and faster text output. Works behaves slightly differently when 
using a LaserWriter, and there are some tricks, tips, and caveats you should 
know about. 

Setting up for the LaserWriter 

If you haven't done so already, you must set up your Mac to use a 
LaserWriter. Be sure the LaserWriter printer driver (called LaserWriter) 
and the preparation program (called Laser Prep) are in the System Folder 
on the Works Startup disk or your hard disk. 

With the printer connected to the Mac and turned on, select the 
Chooser desk accessory and click the AppleTalk Active option. Choose 
the Laser printer icon. If there is more than one laser printer in your 
AppleTalk network, you must choose the one you want. The names of 
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the printers are shown in the list box. Close the Chooser dialog box and 
you're ready to print. 

LaserWrlter Dialog Boxes 

When printing with the LaserWriter, the dialog box for the Print command 
is different from the one when using an Image Writer (see Figures 12-3 and 
12-4). Additional options are: 

• Print Back to Front. Printing starts from the back of the document 
and goes forward. The printed output is collated for you in the prop
er sequence. Printing is slower when going backwards. This option 
is helpful when using one of the older LaserWriter models (newer 
models eject printed pages so that the first page printed is on the top 
of the stack). 

• Cover Page. Prints a page identifying your document. For use when a 
lot of Macs share one Laser Writer. 

• Smoothing. Smooths the edges of graphics and non-laser fonts, and 
produces a better overall result. Printing is somewhat slower with 
Smoothing turned on. 
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• Font Substitution. Allows the LaserWriter to automatically substitute 
one of its internal fonts when it encounters a matching Image Writer 
(bit-mapped) font in your document. Printing is faster with Font 
Substitution on. The following Image Writer fonts are substituted for 
built-in LaserWriter fonts: 

Image Writer Font 
New York 
Geneva 
Monaco 

Substituted Font 
Times 
Helvetica 
Courier 

• Reduce/Enlarge. Lets you specify the amount of reduction or enlarge
ment for printed output. You can specify a number from 25 percent 
(one-quarter the size of the original you see on the screen) to 400 per
cent (four times the size of the original). 

Print Size and Orientation 

The LaserWriter does not have the same printing area as the Imagewriter. 
The print area of the standard carriage Imagewriter is 8 1/2 inches wide by 
10 inches high (one-half an inch is cropped off the top and bottom). The 
print area of the Laser Writer, however, is only 7 by 10 inches. That leaves 
a strip of 3/4 inches on either side of the page. Keep this in mind when for
matting documents. 

If your documents are wider than seven inches, or go beyond the print 
boundary, some of the text may be cropped off. If you don't want missing 
text, choose a reduction percentage where the lines can be printed within the 
printing area, or relocate the margins so they are within the printing area. 

Downloadable Fonts 

Though the LaserWriter has many fonts permanently encoded in its memo
ry (including Times, Helvetica, Bookman, and Avant-Garde), any number 
of specialty fonts can be downloaded to it from the Macintosh. The down
loaded fonts are kept in the memory inside the LaserWriter until the printer 
is turned off or more fonts are loaded into it. Sources of downloadable 
fonts can be found in Appendix A. 

Fonts for downloading come in two major parts: screen font and laser 
(or outline) font. The screen font is installed in the System file on your 
Works disk or hard disk, and is what you see when you are working with 
text The laser font is the font data actually sent to the LaserWriter. Most 
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downloadable fonts have sundry other support files for printing on the 
LaserWriter. You keep the support files on the system disk with the 
LaserWriter driver ftles. 

SCREEN PRINTING 

Beyond printing text and graphics for a single page, you can make a paper 
copy of anything you see on the Mac's screen. You can use this feature, for 
example, to make a visual record of the settings in one or more dialog 
boxes. 

• To make a copy of the entire screen, frrst press the Shift Lock key into 
Shift position. Then press Command-Shift-4. Be sure the printer is 
turned on, selected, and has paper, or the screen print will not tum out. 

• To make a paper copy of just the currently active window, leave the 
Shift Lock key up, and press Command-Shift-4. 

• To record a copy of the entire screen onto disk instead of sending it to 
the printer, press Command-Shift-3 (the Shift Lock key is not used). 
The screen shots are MacPaint pictures, tided Screen 0 through Screen 
9 (the icons may not always look like MacPaint documents until you 
edit or print them with MacPaint). The documents are placed on the 
same disk as the application. The Mac beeps at you when you have 
ftlled the disk with all 10 screen shots, or if the disk runs out of room. 

PRINTING AND REPRODUCTION TIPS 

If you're like most Works fans, you'll use the Image Writer for the majority 
of your printing chores. Image Writer printouts are sharp and clear, and the 
results are nearly identical to what you see on the Mac's screen. There are 
certain tricks of the trade, however, for getting the best possible results 
from the Image Writer. Follow the easy steps outlined in this chapter, and 
you can make your printouts sharper and clearer than ever before. 

The Image Writer is the ideal choice for most printing situations, but it 
isn't capable of typeset-quality words and graphics. Fortunately, the Mac 
can be used with a variety of high-end graphics devices, including laser 
printers, phototypesetters, and video ftlm cameras. 
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Using the lmageWrlter 

You can improve the quality of Image Writer printouts by carefully select
ing the best print setting, ribbon, and paper. 

ImageWriter Print Settings Works has three print settings, "Best," 
"Faster," and "Draft," as detailed earlier in this chapter. The Best and 
Faster print settings let you choose between standard and high quality print
outs. Select one or the other as the situation demands. Because the 
Image Writer prints most of the document twice in Best mode (which takes 
twice as long), you '11 probably want to reserve Best print quality for special 
occasions only. 

Ribbon Freshness The age of the ribbon used in your Image Writer has a 
significant impact on the quality of your printed graphics. Contrary to pop
ular belief, a new ribbon isn't always the best choice. 

• When printing in Faster mode, it's a good idea to use a fresh, well
inked ribbon. The printouts will tum out dark and easy to read. You'll 
know when to replace the ribbon when the print looks gray and washed 
out 

• When printing in Best mode, use an older, partially worn ribbon. 
Since the Image Writer goes over most of the document twice in Best 
mode, some characters may fill in when printed with an inky ribbon. 
This is particularly important if you will be reproducing the printouts 
on an office copier and when making overhead transparencies. 

New ribbons can cause undo ink smearing. If smearing is a continual 
problem, you may want to make a slight adjustment to the printhead-to
platen gap on the lmagewriter. To widen the gap (so the face of the print
head doesn't scrape across the page), locate the gap adjustment lever on the 
right side of the Imagewriter. Pull the lever toward you a notch or two. To 
narrow the gap, push the lever away from you. 

Image Writer ribbons are usually made of nylon, which lasts a long time. 
You can rejuvenate old ribbons by using a re-inker. Cost is about $50. 
Most ribbons can be re-inked from three to five times before they become 
overly worn. Use caution when reusing ribbons. The threads of a frayed 
ribbon can become tangled with the Image Writer's printhead, causing con
siderable damage. Get into the habit of regularly inspecting reused ribbons. 

Another method of rejuvenating used ribbons involves spraying with 
WD-40, a popular oil-free lubricant spray (available at most hardware and 
automotive stores). While the technique works, the design of Imagewriter 
ribbons makes it hard to spray inside the cartridge. Re-inking is easier and 
less expensive. 
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Another way to save money is to buy repacked ribbons-new ribbon 
cloth in old cartridges. Repacked ribbons are just as good as new ribbons, 
yet cost considerably less. Tum in your used ribbons for an even greater 
discount. 

The Image Writer I uses the same ribbons found in the C. Itoh Pro writer 
and NBC 8023A, two common printer types. If you don't see Apple 
Imagewriter ribbons listed in a ribbon catalog, check the availability of rib
bons for the C. Itoh and NEC printers. 

Print Density When printing words and pictures for reproduction on a 
plain paper copier, it's a good idea to go a little on the light side. The same 
isn't true, however, with most types of offset printing. The darker and rich
er the original, the better the copy. 

If the blacks in the original printout aren't black but gray, most printers 
can darken the graphic by frrst making a PMT (photo-mechanical transfer). 
The PMT process make a high contrast copy of the original where white 
and black are the only shades. There are no in-between grays. 

Paper Quality The quality and texture of paper also plays an important 
role in print clarity. Cheap computer paper yields inferior results because 
the ink tends to smear and the paper doesn't hold up well to handling. 

Paper that has a cotton rag content or is textured may also yield inferior 
results, because the surface of the paper is uneven. Whenever possible, use 
a high grade, smooth bond paper. It's available in both single and continu
ous sheet form and doesn't cost much more than regular computer paper. 
Shop around for a good price. 

Better paper also resists excessive curling, which can cause paper jams. 
Paper that sits in the Image Writer curls around the platen, so when it is 
advanced, it can be deflected back inside the printer. If this is a problem, 
lift up the clear plastic paper cover while the first page advances. You may 
need to help the paper along. You can also prevent paper deflection by 
placing a Post-It note over the paper slot. 

If you are reproducing your printouts on an office copier, and need high 
quality, you may want to use specialty clay coated paper, available at many 
printing shops and art supply stores. The smooth clay coating provides a 
better, more stable surface for the ink. 

When using a variety of paper stocks, remember to adjust the printhead
to-platen gap as necessary. Pull the lever toward the front of the 
Image Writer when using thicker papers. Paper stock that is excessively 
thick or slick may not feed through the lmagewriter properly, so experi
ment with a sample piece before you buy a whole box. 
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The quick brown fox jumped over the lazy dog. 0123456 
The quick brown fox jumped over the lozy dog. 
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Figure 12-5 Test Pattern for Printing 

Judging Ribbon and Paper Quality To make it easier to judge ribbon, 
paper, and printhead-to-platen gap, create a simple test pattern, like the one 
in Figure 12-5. Use Works Draw to create a series of patterns and shapes. 
(The symbols were created with the Cairo picture font.) 

Keep the pattern handy whenever you try a new type of ribbon or paper 
stock. Pay particular attention to the 50 percent gray pattern. With some 
ribbons and paper, the pattern may come out overly streaked. 

Image Size Discrepancies 

The picture you see on the Mac's screen doesn't always represent the exact 
size you '11 get when the image is printed. For example, a one-inch circle 
on the screen may actually be 7 /Bths of an inch when printed. Leave the 
Tall Adjusted option on for best results when printing graphics. 

Using the LaserWriter 

Laser printers are capable of extremely fme resolution-300 dots per inch 
versus about 80 dots per inch with the Imagewriter. Graphics reproduced 
on a laser printer look clean, sharp, and professional. More importantly, 



Printing with Works 355 

the dots that make up laser print are much fmer than the ImageWriter's. 
Text and graphics from a laser printer look almost typeset. You can hardly 
see the individual dots at all unless you inspect the print closely with a 
magnifying glass. 

Improving Laser Quality 

Although the quality from the LaserWriter is good, it can be improved by 
following some simple guidelines. The LaserWriter uses a replaceable car
tridge that contains the toner and photoreceptor drum. This cartridge is 
replaced as a unit every 2,500 to 5,000 pages. As the toner wears out, the 
printouts may become light. If your prints are excessively light, check the 
cartridge indicator located on the right side of the Laser Writer. Replace the 
cartridge if the toner level is low. 

If the cartridge is still good, and shows a reserve of toner, try taking it 
out of the LaserWriter and lightly tapping it a few times to redistribute the 
toner. Rock the cartridge back and forth (not end to end). Reinstall the car
tridge and try a few more test prints. The frrst few prints may be smudgy; 
this is normal. Keep in mind that the frrst 100 to 200 prints from a new 
cartridge may be light and uneven. The toner has not had a chance to be 
evenly distributed along the length of the photoreceptor drum. 

Voids in the printout may indicate poor toner distribution (see the para
graph above), or it may mean a dirty photoreceptor drum, transfer wire, or 
corona wire. Clean the LaserWriter as directed later in this chapter in the 
section titled "Special LaserWriter Cleaning Tips," and in the operator's 
manual. In most cases, a dirty transfer or corona wire will cause the page 
to be excessively light or completely blank. 

A number of paper companies, including Hammermill and James River, 
offer a specialty paper designed expressly for laser printers. If you have a 
choice, use it. Laser paper has a smooth, even fmish that readily accepts 
the toner. The coating and paper content also prevent excessive curl, 
caused by the heat and pressure of the LaserWriter's fuser (the fuser bonds 
the toner to the paper). Lacking laser paper, you can use standard 20 lb. 
bright-white copier paper in your LaserWriter and achieve better than aver
age results. 

Toner cartridges for the LaserWriter may be refilled and reused (up to 
about three times). A number of local and mail order fmns specialize in 
"recharging" spent LaserWriter cartridges; see Appendix A for a partial list. 
The recharged cartridges are about half the cost of new ones and are said to 
offer the same quality. 
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Color Output 

The LaserWriter is not capable of color printing, but a unique transfer sys
tem allows you to add color to any of your printouts. The KroyKolor sys
tem (see Appendix A for the address) consists of colored dry transfer sheets 
and a transfer machine. After the page is printed, you place a color transfer 
sheet on the original. The sheet and printout are fed through the transfer 
machine. Color is transferred to the parts of the page that contain printing. 
The Kroy Kolor transfer sheets are available in a variety of colors, including 
brown, green, blue, red, yellow, pink, and orange. 

PHOTOGRAPHING THE MAC'S SCREEN 

There may be times when you want a photograph of the screen instead of 
an Image Writer or Laser Writer printout. Just about any 35mm camera can 
be used to take the pictures. A close focus zoom lens allows you to aim, 
frame, and shoot with the greatest flexibility and without having to be too 
far away from the Mac's screen. Zoom lenses with 35mm to 70mm focal 
lengths yield the best results without undo distortion. You can also get by 
with a standard 50mm lens equipped with a 1 + or 2+ diopter close-up lens. 

Mount the camera on a sturdy tripod and set the shutter speed at no faster 
than l/8th of a second. A noticeable bar will appear across the screen with 
faster shutter speeds (higher numbers). Dim or extinguish the room lights 
and adjust the Mac's brightness control so that it's comfortable to your 
eyes. Use the camera's built-in exposure meter to set the f/stop, or use the 
recommended indoor light setting for the film you're using (see the instruc
tion sheet packed with the film). If your camera has an automatic flash, 
tum it off or cover it up completely. 

For slides, use either Kodachrome 40 or Ektachrome 100 (or another 
manufacturer's comparable slide film). Ektachrome film has a blue cast to 
it-especially noticeable when shooting the Mac's black and white 
screen-but you can have it processed anywhere. Kodachrome film needs 
to be processed by Kodak or some other large photographic lab, and the 
tum-around time can be as long as a week. If time is of the essence, use 
Polaroid instant-slide film. Developing time is one minute. You need the 
auto-processor kit to develop the slides. 

Until you get to know the proper settings for the films you're using, 
shoot several pictures of the same screen using different f/stops. Shoot one 
picture normally, then two others at one half f/stop below and above the 
meter reading. 

Perhaps the best way to shoot the Mac's screen is with a video film 
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camera. These have their own built-in high resolution monitors, color 
wheels (for adding color to the slides) and film cameras. Several models 
are available for the Macintosh. Some connect to the Mac via an external 
monitors adapter that you (or a qualified dealer) must add, while others, 
such as the Presentations Technologies Image Maker, connect to the Mac 
via a serial port. 

PHOTOTYPESETTING 

Phototypesetting is similar to laser printing, but the resolution is much 
higher. Some phototypesetting equipment, including the Linotronic 
L-300P, is PostScript compatible, and therefore can be used directly with 
Works and the Macintosh. The resolution of the Linotronic L-300P is 
2,540 dots per inch, or roughly 8 l/2 times that of the LaserWriter. If you 
can't afford your own typesetter (a minimum $30,000 investment), mail 
your MacDraw disks to a phototypesetting house (see Appendix A). Cost 
is between $5 and $10 per page. 

PRINTER MAINTENANCE 

Your computer is nearly all electronic, and it doesn't need rigorous periodic 
cleaning and maintenance to keep it in tip-top shape. But that doesn't 
apply to everything in your computer system. Your printer-whether it be 
dot matrix, daisywheel, ink jet, or laser-is mostly mechanical, and you 
must treat it with the same care and diligence as the family car. A clean 
printer is a happy printer; besides, your printer lasts longer and works better 
when it's clean. 

There are several cleaning and maintenance steps you can take to keep 
your Image Writer or Laser Writer in good working order. They're simple, 
don't require special tools or know-how, and the cleaning supplies are com
monly available. 

General Cleaning 

When not in use, it's a good idea to place a dust cover over your printer. 
This makes sense because most printers are used a relatively short period of 
time each day. If you don't want to keep removing and replacing the cover 
every time the printer is used, at least keep it on overnight. As always, 
avoid smoking around your computer gear. The smoke and nicotine can 
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settle on mechanical and electrical parts, making cleaning that much more 
difficult. If you must smoke, install a filtered air cleaner near your work 
station or use a "smokeless" ashtry. 

Even with a cover, dust can never be avoided; some always sneaks 
through the best protective measures. A soft painter's brush, about 1/2- to 
3/4-inch wide, can be used to wipe away the loose dust that accumulates on 
the exterior of the printer. Be sure to get all the nooks and crannies around 
the switches, ventilation holes, and levers. 

Hard to reach areas can be cleaned with a can of compressed air, such as 
that offered by Falcon and Bib (available at most photographic and com
puter stores). When using compressed air, blow the dust away from the 
printer; avoid pushing dirt further inside the machine. In place of the com
pressed air you can use a vacuum cleaner to scoop up the dust. A house
hold vacuum with a soft brush attachment works well, or you can use one 
of the miniature battery-operated vacuums. 

If dirt or grime piles up on the exterior of the printer, use a household 
spray cleaner, like 409 or Fantastik, to wipe up the gunk. Don't spray the 
cleaner directly on the printer; spray the cleaner on a sponge, then apply the 
sponge to the printer. 

Follow the same general steps when cleaning inside the printer. Remove 
the various covers and hatches as needed to access the printing and platen 
area. Most printers have two or three covers that can be readily removed 
when you require access to the inside. Under most circumstances, you do 
not need to disassemble the printer to clean it. In fact, this may void the 
warranty and may cause more problems than it is worth. 

After a period of use, small flecks of paper dust can gather inside the 
Image Writer. For best results, this dust should be removed every week or 
two. Use a vacuum to suck the dust out or a can of compressed air to blow 
it away. However, be particularly wary of blowing the paper dust further 
into the printer. Aim the can so the dust is shot outside, not inside. 

If you use pin-fed paper with your Image Writer, the round "holes" from 
the tractor-feed edges may accumulate around the feeding mechanism. 
Open the mechanism and inspect carefully for bits of paper. Use a tooth
pick or wood manicuring pick to remove stubborn bits of paper. Do not use 
a sharp metal or plastic object. 

Scraps of paper may also pile up around the paper-out switch, which is 
located to the rear left side of the paper feed area on the Image Writer. This 
switch detects the presence or absence of paper. When the printer runs out 
of paper, the switch signals the printer, which in tum stops the flow of data 
from the computer. 

The paper-out switch is mechanical, and can be bent out of shape if you 
are careless. Gently squirt the compressed air around the switch to dislodge 
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any foreign matter. Avoid using a pick or stick to remove the paper bits, as 
you may bend the lever of the switch, and throw it out of adjustment. 

Avoid the use of cleaning solutions inside the printer. They act to 
remove necessary lubrication. Additionally, if the solution leaves a residue, 
it could cause problems in operation. 

Cleaning the Platen 

The platen is the large rubber roller that feeds the paper through the 
Image Writer. The platen receives a lot of abuse dwing printing, but you 
can easily rejuvenate it and restore it to almost-new condition. 

The platen is rubber and needs a special cleaner. You can buy a can of 
rubber cleaner/rejuvenator at most typewriter repair shops (avoid using 
alcohol; it dries out the rubber). The bottle will last several years if you 
keep the cap on tight. To use it, soak the cleaner onto a comer of a piece of 
cotton or other white cloth, then wipe the platen from side to side. Roll the 
platen around to get all of it. The cleaner will dry within seconds. 

Cleaning the Printhead 

Depending on the volume of printing you do, you '11 want to clean the print
er's printhead every six months to a year. Cleaning will remove caked-on 
paper dust, ink, and other foreign material. 

The printhead in the Image Writer is very prone to the effects of accumu
lated paper dust and dried ink. In the Image Writer (or any dot matrix print
er), the printhead is composed of small needles that selectively strike 
against the ribbon, making an inked impression on the paper. Through use, 
ink and paper dust can clog up the workings of the printhead, reducing 
print quality. 

To clean the printhead, first remove the ribbon and blow excess particles 
away with a can of compressed air. Move the head-to-platen adjustment 
lever so that the printhead is as far from the platen as possible. 

Soak a cotton or sponge swab in alcohol and gently scrub the printhead 
clean (make sure the printhead is cool before you touch and clean it). If 
you can't reach the front of the printhead, use an alcohol spray cleaner, the 
kind designed for cleaning audio and video tape heads. Repeat the process 
until the printhead is completely clean. 



360 Inside MS Works 2 for the Macintosh 

Special LaserWriter Cleaning Tips 

The LaserWriter is really a plain paper copier with a laser light imaging 
source. You clean the LaserWriter just as you would the office plain paper 
copier. 

Follow the manufacturer's recommended service interval for changing 
the drum cartridge. The cartridge lasts 2,000 to 3,000 pages. An indicator 
on the cartridge shows you if it needs replacing. Or, replace the cartridge if 
you notice consistently poor print quality. While changing the cartridge, 
wipe or vacuum spilled toner. This keeps the machine clean and easier to 
use, and helps promote better looking printouts. 

Regularly inspect the insides of the LaserWriter. Use a small vacuum to 
get rid of paper dust and other foreign objects. Be careful with the internal 
parts of the printer, especially the small transfer and corona wires (these are 
mostly hidden, but you should be aware of them anyway). Follow the 
maintenance procedures provided by the manufacturer on cleaning the 
internal parts, including rollers, fuser, and drum. 

Printer Lubrication 

After cleaning, especially if you use cleaning solutions, or even after pro
longed use, parts of the printer may need lubrication. Points of critical 
lubrication will usually be indicated in the printer's user manual. Consult 
the book for more information. Generally, you will lubricate the printhead 
running bar, which supports the printhead as it travels back and forth across 
the platen, and any associated gears. Do not lubricate pulleys, cables, or 
other components that rely on friction for proper movement or activation. 

Most manufacturers suggest you use a common machine oil for lubrica
tion. The oil should not have anti-rust chemicals in it, as they can cause the 
mechanisms to bind in unusually high or low temperatures. A graphite
based oil also should be avoided because the dark color can smudge the 
printouts. Suitable lubrication oils are available at Radio Shack stores, 
industrial outlets, and most electronic stores. Do not use an oil-free lubri
cant such as WD-40. The spray is non-conductive and may impair the 
operation of the printer. 
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Sources for Products 
and Information 

Acta 
A desk accessory that lets you grab MacPaint images from any disk and include 
them in the current application (such as MacDraw). 

Symmetry Corp. 761 E. University Dr. 

Allotype Fonts 

Mesa, AZ 85203 
(800) 624-2485 
(602) 844-2199 (in AZ) 

A collection of downloadable laser fonts; serif and sans-serif, in a variety of styles. 

Allotype l}tpographics 

Bullets & Boxes 

1600 Packard Rd. #5 
Ann Arbor, MI 48104 
(313) 663-1989 

Unique laser font that consists of different sizes of boxes and bullets (filled and 
unfilled). Included with the package is a selection of bullets that snap to the grid 
within MacDraw. The fonts are downloadable into the LaserWriter. 

Caseys' Page Mill 

Cheap Paint 

6528 S. Oneida Ct. 
Englewood, CO 80111 
(303) 220-1463 

A desk accessory version of MacPaint. Use it with MacDraw to edit bit-map 
graphics. Spinnaker also sells ArtGrabber, a program that lets you snatch a bit
map image recorded on disk (any disk) and plant it into the current application. 

361 
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Spinnaker Software Corp. 

ClickArt:Letters 

1 Kendall Sq. 
Cambridge, MA 02139 
(617) 494-1200 

Mostly large, display fonts-24, 36, and 48 point. Lots of them and well done. 

T/Maker Graphics 

Cricket Draw 
Cricket Graph 

1973 Landings Drive 
Mountain View, CA 94043 
(415) 962-0195 

Cricket Draw is a MacDraw-like program that boasts some additional features, 
including incremental rotation of certain object types and "pattern fountains." 
Cricket Graph is a business graphics program for changing numbers into charts. 

Cricket Software 

Desktop Art 

40 Valley Stream Parkway 
Great Valley Corporate Center 
Malvern, PA 19355 
(800) 345-8112 
(215) 251-9890 (in PA) 

Excellent object-oriented clip art collection (bit-mapped clip art also available). 

Dynamic Graphics 6000 N. Forest Park Drive 
Peoria, IL 61656 
(309) 688-8800 

Digit -Art Laser Graphics 
Object-oriented (MacDraw) clip art collection especially designed for advertising 
and business. Disks come in sets. 

Digit-Art Laser Graphics 

Fluent Fonts 

2828-19th Street N.E. 
Calgary, Alberta, Canada T2E 6Y9 
( 403) 250-1969 

Font collection of mostly decorative and occasional fonts, including computer, out
line, and art deco. Most are available in a variety of sizes. 

Casady Company 

Fontographer 

PO Box 223779 
Carmel, CA 93922 
( 408) 646-4660 

Font creation tool for creating LaserWriter fonts. Allows you to create fonts and 
add embellishments, such as drop shadows, slants, and rotations. 
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Fontastic Plus 
Fontastic is a font editing program that you can use to create or customize 
Image Writer fonts. Works with all fonts in all sizes. Includes some advanced fea
tures, including horizontal and/or vertical rescaling. 

Altsys Corp. 

LaserFonts 

720 Avenue F, Ste. 109 
Plano, TX 75074 
(214) 424-4888 

Collection of laser fonts. Includes more than 32 font families. 

Century Software, Inc. 

LaserPaint 

2483 Hearst Ave. #175 
Berkeley, CA 94709 
(415) 549-1901 

Drawing program that relies on the LaserWriter or other suitably equipped 
PostScript compatible laser printer. Intended as a high-end product and requires 
some technical skill to use effectively. 

LaserWare, Inc. 

Laser Writer 

POBox668 
San Rafael, CA 94915 
(800) 367-6898 
(415) 453-9500 (inCA) 

Apple's own xerographic printer especially designed for the Macintosh. Has sever
al.fonts built in, but can also accept downloaded fonts. Built in is a smoothing 
algorithm that can take rough artwork and turn it into clean, drafting room copy. 

Apple Computer, Inc. 20525 Mariani Ave. 

MacDraft 

Cupertino, CA 95014 
(800) 538-9696 
(408) 996-1010 (inCA) 

MacDraw-like drafting set program with a few advanced features like incremental 
rotation, zoom in and zoom out, and auto-dimensioning. 

Innovative Data Design, Inc. 

MacDraw 

2280 Bates Ave. 
Concord, CA 94520 
(415) 680-6818 

Object-oriented drawing tool, in both original and updated (MacDraw m versions. 
Claris also sells MacPaint; similar programs are available from other sources. 
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Claris Corp. 

Mac Tools 

440 Clyde Ave. 
Mountain View, CA 94040 
(800) 334-3535 
(415) 960-1500 

MacTools isn't a graphics program, but it's useful for reclaiming MacPaint or MacDraw 
documents you've accidentally thrown away, disks that have been damaged, and for 
generally fiddling around with Macintosh files. Comes with Copy n Mac, a diskette 
backup utility you can use to make duplicates of your copy protected disks. 

Central Point Software, Inc. 

Microsoft Chart 

9700 W. Capital Highway, #1 00 
Portland, OR 97219 
(503) 244-5782 

A highly useful business graphics program. Use it to create pie, bar, line, scatter, 
and area charts. Features include drop shadowing, built-in data sorting, and 
Multiplan compatibility. 

Microsoft Corp. 

PageMaker 

16011 N.E. 36th Way 
Box 97017 
Redmond, WA 98073-9717 
(800) 426-9400 
(206) 882-8080 

Sophisticated, professional electronic paste-up program that lets you combine 
MacPaint and MacWrite documents and produce camera-ready mechanicals. 
Interfaces with the Image Writer or LaserWriter. 

Aldus Corp. 

Pages (and Hot TYpe) 

411 First Ave. South 
Seattle, WA 98104 
(206) 622-5500 

A series of fonts, downloadable PostScript files, and MacDraw images. Available 
in sets. Unusual and attractive laser font designs. 

Image Club 

Professional TYpe Fonts 

#206, 2915-19th St. N.E. 
Calgary, Alberta, Canada T2E 7 A2 
(403) 250-1969 

Disk of well-known Mergenthaler and lTC typefaces, including Times Roman, 
Helvetica, and Optima. Sizes range from 12 to 24 point. H you need larger ver
sions of these fonts, the company offers them in a separate disk, Headlines. 



Sources for Products and Information 365 

Kensington Microware, Ltd 

SuperPaint 

251 Park Ave. South 
New York, NY 10010 
(212) 475-5200 

A combination MacPaint and MacDraw, all in one program (you can combine bit
map and object-oriented graphics in one document, and switch between editing 
modes). SuperPaint offers all of MacPaint's versatility but is lacking many of 
MacDraw's finer points. The program can both read and write MacPaint and 
MacDraw ftles. 

Silicon Beach Software 

Tempo 

PO Box 261430 
San Diego, CA 92126 
(619) 695-6956 

A keyboard/mouse recorder that lets you program the Mac and have it play back 
your exact movements. Allows non-stop or interactive control. 

Affinity Microsystems 

Public Domain Programs and Utilities 

10560 Walnut St, #425 
Boulder, CO 80302 
(800) 367-6771 
(303) 442-4840 (in CO) 

These clearinghouses provide public domain and "user-supported" programs for the 
Macintosh. Among the programs and utilities available from these sources are 
Resource Editor, DrawPaint (a MacDraw-to-MacPaint picture converter), Multi
Scrap, hundreds of fonts, and more. 

CompuServe 

Educorp 

Translatum International 

The Mac Group 

POBox20212 
Columbus, OH 43220 
(800) 848-8199 
(614) 457-8600 

531 Stevens Ave. 
Suite B. 
Solana Beach, CA 92075 
(800) 843-9497 
(619) 259-0255 

1730 E. Oltorf St, #127 
Austin, TX 78741 
(512) 442-0266 

POBox85125 
San Diego, CA 92138 
(619) 747-7940 
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MCUS 

ResEdit 

POBox6963 
San Jose, CA 95150 
(408) 723-3388 

An advanced version of Resource Editor, with documentation. 

APDA 

SmartS crap 

290 S. W. 43rd St 
Renton, WA 98055 
(206) 251-6548 

A replacement desk accessory for the Apple Scrapbook. The Clipper, a Clipboard 
enhancer, is also available. 

Solutions International, Inc. 29MainSt 
Montpelier, VT 05602 
(802) 229-0368 
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Table of Character Sets 

This appendix presents a table of complete printable character sets for four com
mon Macintosh fonts: Geneva, New York, Times, and Zapf Dingbats. The first 
two fonts are Image Writer fonts, and the remaining two are Laser Writer fonts. 
Note that each font displays slightly different characters. 

The first column in the following table represents an ASCll code number from 
32 to 255. These code numbers are used by the Macintosh to keep track of the 
characters you type. Because the Mac tracks the ASCII code numbers, and not the 
actual characters, the characters can change when switching from one font to 
another. 

The Keys column indicates the keys to press to produce that character. When 
necessary, additional information about the character is provided in the Comments 
column. 

With the exception of the Zapf Dingbats font, characters represented by a box 
are undefmed, meaning there is no character for that ASCll code number. You can 
use these "empty slots" to include your own special characters, which can be added 
with the help of a font editing utility, such as Resource Editor or Fontographer. 

367 
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ASCII Times Dingbat Geneva New York Keys Comments 

33 ~ Shift-1 
34 " ~ 

II " Shift-' 
35 # ~ # # Shift-3 
36 $ ~ $ $ Shift-4 
37 % v o/o % Shift-S 
38 & ([) & & Shift-7 

39 @ 

40 ( + ( ( Shift-9 
41 ) 1:!51 ) ) Shift-a 
42 * ... * * Shift-8 
43 + my' + + Shift-== 
44 lS (comma) 

45 fhJ (hyphen) 
46 ' (period) 
47 I § I I I 
48 0 ~ 0 0 0 (zero) 
49 1 C$ 1 1 1 
50 2 .. 2 2 2 

51 3 ./ 3 3 3 
52 4 1/ 4 4 4 
53 5 X 5 5 5 
54 6 • 6 6 6 
55 7 X 7 7 7 
56 8 K 8 8 8 

57 9 + 9 9 9 
58 + Shift-; (semicolon) 
59 + 
60 < -Q- < < Shift-, (comma) 
61 = t = = = 
62 > '& > > Shift-. (period) 

63 ? t ? ? Shift-/ (slash) 
64 @ t:a @ @ Shift-2 
65 A * A A Shift-a 
66 B + B B Shift-b 
67 c + c c Shift-c 
68 D + D D Shift-d 
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ASCII Times Dingbat Geneva New York Keys Comments 

69 E + E E Shift-e 
70 F • F F Shift-f 
71 G -¢- G G Shift-g 
72 H * H H Shift-h 
73 I '(:( I I Shift-i 
74 J 0 J J Shift-j 

75 K * K K Shift-k 
76 L * L L Shift-1 
77 M * M M Shift-m 
78 N * N N Shift-n 
79 0 * 0 0 Shift-o 
80 p * p p Shift-p 

81 Q * a Q Shift-q 
82 R * R R Shift-r 
83 s * s s Shift-s 
84 T * T T Shift-t 
85 u * u u Shift-u 
86 v * v v Shift-v 

87 w * w w Shift-w 
88 X • X X Shift-x 
89 y • y y Shift-y 
90 z • z z Shift-z 
91 [ * ' [ [ [ 
92 \ * \ \ \ (backslash) 

93 * ] 
94 1\ • 1\ 1\ Shift-6 
95 0 - Shift-- (hyphen for underscore) 
96 f1 

... 
(grave accent) 

97 a • a a a 
98 b 0 b b b 

99 c * c c c 
100 d * d d d 
101 e • e e e 
102 f * f f f 
103 g * g g g 
104 h * ,.. h h h 
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ASCII nmes Dlngbat Geneva New York Keys Comments 

105 * 106 j * j j j 
107 k * k k k 
108 • I I 
109 m 0 m m m 
110 n • n n n 

111 0 0 0 0 0 

112 p 0 p p p 
113 q 0 q q q 
114 r 0 r r r 
115 s A s s s 
116 t ~ t t t 

117 u • u u u 
118 v + v v v 
119 w t w w w 
120 X I X X X 

121 y y y y 
122 z I z z z 

123 ' { ( Shift-[ 
124 I ' I I Shift-\ (backslash) 
125 } " } } Shift-] 
126 " Shift-' (grave accent) 
127 
128 A ( A A Option-u Shift-a 

129 A ) A A Shift-Option-a 
130 ~ ( c ~ Shift-Option-c 
131 E ) E E Option-e Shift-e 
132 N ( N N Option-n Shift-n 
133 () 0 0 Option-u Shift-o 
134 (J < 0 u Option-u Shift-u 

135 a > a a Option-e a 
136 a I a a Option-' a 
137 a J a a Option-i a 
138 a ( a a Option-u a 
139 a ) a a Option-n a 
140 4 ( A 4 Option-a 
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ASCII Times Dingbat Geneva New York Keys Comments 

141 ~ c; ~ Option-c 
142 e e e Option-a e 
143 e e e Option-' e 
144 e e e Option-i e 
145 e e e Option-u e 
146 f f Option-a i 

147 l l Option-' i 
148 i i i Option-i i 
149 i "j 1 Option-u i 
150 ii n ii Option-n n 
151 6 6 6 Option-a o 
152 0 0 0 Option-' o 

153 0 0 0 Option-i o 
154 ij 0 ij Option-u o 
155 0 0 0 Option-n o 
156 11 u 11 Option-a u 
157 u u u Option-' u 
15S (i a (i Option-i u 

159 ii a ii Option-u u 
160 t t t Option-t dagger 
161 0 !}" 0 0 Shift-Option-S degrees 
162 ¢ ' ¢ ¢ Option-4 cents 
163 £ ' £ £ Option-3 pound sterling 
164 § • § § Option-6 section symbol 

165 • • • • Option-S bullet 
166 ~ 'i 11 ~ Option-7 paragraph symbol 
167 B ~ B B Option-s 
16S ® • ® ® Option-r registered trademark 
169 © • © © Option-g copyright symbol 
170 TM • TM TM Option-2 trademark symbol 

171 • Option-e Option-e acute accent 
172 (i) Option-u Option-u umlaut 
173 * ® * * Option-= 
174 }E @ ~ }E Shift-Option-' (single quote) 
175 0 @ 0 0 Shift-Option-a 
176 00 ® 00 00 Option-S 
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ASCII Times Dlngbat Geneva New York Keys Comments 

177 ± ® ± ± Shift-Option-= 
178 s ® s s Option-, (comma) 
179 ~ ® ~ ~ Option-. (period) 
180 ¥ ® ¥ ¥ Option-y Japanese yen symbol 
181 J.1 @ JJ JJ Option-m 
182 d 0 d a Option-d 

183 :I: • :I: :I: Option-w 
184 n • n n Shift-Option-p 
185 1t 0 1t 1t Option-p 
186 I e J I Option-b 
187 I CD D 8 Option-9 

.188 Q 8 g 9 Option-0 (zero) 

189 n • n n Option-z 
190 ce CD m ~ Option-' (single quote) 
191 f{j CID g f{j Option-a 
192 l (j) l l Shift-Option-/ 
193 ® I Option-1 
194 --, @ .., --, Option-1 (lower case L) 

195 v @ v v Option-v 
196 f @ f f Option-f 
197 ::::= ® ::::= ::::= Option-x 
198 ll (/) ll ll Option-j 
199 « ® cc « Option-\ (backslash) 
200 » ® )) » Shift-Option-\ (backslash) 

201 ® Option-; (semicolon) 
202 0 not accessible 
203 A. • A A Option-' Shift-a 
204 A • A A Option-n Shift-a 
205 0 8 0 0 Option-n Shift-o 
206 <E 0 CE <E Shift-Option-q 

207 re 0 ce re Option-q 
208 • Option-- en dash 
209 • Shift-Option-- em dash 
210 CD " Option-[ open dbl. quote 
211 '' 4It> Shift-Option-[ close dbl. quote 
212 -+ Option-] open sng. quote 
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ASCII Times Dlngbat Geneva New York Keys Comments 

213 ~ Shift-Option-] Ccose sng. quote 
214 + ++ + Option-/ 
215 0 t 0 0 Shift-Option-v 
216 y ' y y Option-u y 
217 y ... 'Y 'Y Shift-Option-' (grave accent) 
218 I .;t I I Shift-Option-1 

219 c ~ a a Shift-Option-2 
220 ~ Shift-Option-3 
221 -+ Shift -Option-4 
222 fi .... fi fi Shift-Option-S 
223 ft ... fl fl Shift-Option-6 
224 :f: • * * Shift-Option-7 

225 .. Shift-Option-9 
226 > Shift-Option-0 (zero) 
227 > 

" " 
Shift-Option-w 

228 %o ,... roo %o Shift-Option-a 
229 A. ... A A Shift-Option-r 
230 :E ... E E Shift-Option-t 

231 A. • A A Shift-Option-y 
232 :E ... E E Shift-Option-u 
233 E c) E E Shift-Option-i 
234 f ¢ i i Shift-Option-s 
235 t ~ i i Shift-Option-d 
236 i ~ "i "i Shift -Option-f 

237 l 0 1 1 Shift -Option-g 
238 6 0 6 6 Shift-Option-h 
239 6 Q 6 6 Shift-Option-j 
240 Shift-Option-k 
241 0 0 0 0 Shift-Option-1 (lower case L) 
242 (J :> 0 0 Shift-Option-; {semicolon) 

243 0 Jt+ 0 0 Shift-Option-z 
244 u .. 0 0 Shift-Option-x 
245 .. Shift-Option-b 
246 .;' Shift -Option-n 
247 ~ Shift-Option-m 
248 .... Shift-Option-, {comma) 
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ASCII Times Dlngbat Geneva New York Keys Comments 

249 ~ Shift-Option-. (period) 
250 .. Option-h 
251 ... Option-k 
252 .. not accessible 

~ ~ 

253 .. " " not accessible 
254 not accessible 

255 not accessible 
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Editable Works 
Resources 

The following Works resources can be edited with Resource Editor, version 1.0 or 
later. The number of items may change depending on the version of Works. 

Name Description Number of items 

ALRT Alert boxes 105 items 
CURS Cursors 16 items 
DITL Dialog item list 189 items 
DLOG Dialog boxes 79 items 
ICN# System icons 5 items 
ICON Program icons 23 items 
:MENU Menus 44items 
PSIP Personalization 5 items 
STR Strings 100 items 
STR# Strings 122 items 
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Index 

A 

Abs, number format functions, 161 
Absolute cell references, 146-147 
Acoustic-connect modems, 238 
Acta, 305 
Active, area, spreadsheet, 121-122 
Adaptive dialing, modems, 267 
Alignment, 50,53-54 
justified margins, 54 
of shape, in Draw, 107-108, 109-110 
types of, 53-54 

All options, spell checker, 62 
)Unpe~d,printing,58 

Anchor, 33 
AND and OR, use of, database, 233-234 
Annotations, charts, 186 
ANSI escape sequences, Works communi
cation 

module, 259-262 
ApFont, 13 
Arc, Draw, 87 
Arguments, formulas, 154 
~wheads,Draw,89, 112-113 
Art Grabber, 305 
ASCll, data transfer protocols, 244-245 
Asynchronous communication, modems, 
242 
AT command set, Hayes modem, 263-264 
Average, statistical functions, 161 
Axis label, charts, 185-186 
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B 

Baud rates, modems, 239,241-242 
Best, print quality option, 348 
Bit-mapped graphics, 333, 339 
importing to Draw,ll6 
MacPaint, 23, 76 

Blank Works documents, templates, 29 
Block-out method, erasing, Draw, 103-104 
Boilerplate text, 68-71 
boilerplate characters, inserting, 68 
database, 71 
spreadsheet, 70-71 
usefulness of, 68 
word processor, 69-70 

Bold, printing, 58 
Boolean expressions, 233 
Borders 
Draw, 88-89 
and boundaries, 97 
sp~dsheet, 137-138 
options,138 

Box width, database, 221 
Bring to Front, Draw, 92 

c 
Cables, connector types, modems, 239-240 
Calculated fields, database, use of, 227-229 
Call waiting problems 

telecommunications, 24 7-248 
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Works communication module, 247-248 
Capitalization, spell checker and, 60 
CDEV (Control DEVice), Microsoft 
Works, 292-

293 
Cells 
absolute cell references, 146-14 7 
mixed cell references, 147 
relative cell references, 146 
sorting, 147-149 
spreadsheet 
cell attributes, 139-140 
cell notes, 132-133 
cell reference, 131 
copying cells, 142-143 
Fill Down, 144, 145 
moving cells, 143 
overwritingcells,146 
paste with options, 144 

Centered tab, 52, 53 
Centering shapes, Draw, 108 
Character formats, 46-49 
choosing format, 46-4 7 
fonts and, 47-49 

Characters, special characters, 39-45 
dashes, 43-44 
diacritical characters, 40-41 
font characters, 40 
hidden graphics, 41-43 
hyphens,43 
ligature characters, 41 
microspaces, 44-45 
most commonly used characters, 45 

Charts 
chart blank, creating, 209 
choosing type of, 169-174 
comparisons, determining, 172-173 
message identification, 169-172 
selecting chart, 173-174 

column charts, 176-179 
copying charts, 199 
data entry for, 195-196 
organization of data, 199-200 

design elements, 184-185 

editing with Draw, 201-203 
erasing chart definition, 197 
grids 
linear grid, 186 
logarithmic grid, 186-187 

illustration, adding, 205-207 
incompatible data solutions 
conversion to percentages, 189-190 
cutting or extending bar, 189 
index scale, 192-193 
reducing dat value, 189 

line charts, 180-182 
missing data problem, 194 
parts of, 182-184 
pasting charts, 199 
pictograph, creating, 207-208 
pie charts, 175-176 
data formatting for, 199-200 
exploded pie chart, 204-205 
3-D pie chart, 203 

printing, 198 
redefinition of, 196-197 
resizing, 197-198 
scale, 187-188 
placement, 188 
proportion, 188 
zero and non-zero, 187 
series charts, data location, 200 
several versions of, making, 197 
text, 185-186 
annotations, 186 
axis label, 185-186 
legends, 186 
style of text, 186 
subtitle, 185 
title, 185 

transposing data, between rows and 
columns, 200-201 

uses of, 167-168 
CheapPaint, 306 
Circles, Draw, 107 
Circular reference, spreadsheet, 124 
Clipboard, 15 
exporting graphics, 338-339 



exporting text, 334-335 
importing graphics. 339-340 
pasted objects from Draw, 96 

Closing documents, 25 
Color 
choices for, 46 
database,220 
Draw, 106 
printing, 356 
spreadsheet, 139 

Color-Black dots, Draw, 91 
Color-White dots. Draw, 90 
Column boxes. Draw, 93 
Column charts, 176-179 
illustration, adding. 205-207 

Column text, 99-102 
creating column text, 100 
header for. 100, 101 
linking,101 
outline for, 100 
text blocks converted to, 102 

Column width 
database, 218 
spreadsheet, 135-136 

Command-keys 
equivalents, keyboard shortcuts, 8 
modifying 
Menu Master, 331 
Resource Editor, 317-319 

Commands, keyboard shortcuts, 6-8 
Command-specific help, 15 
Communications document, icon, 2 
Communications Stationery document, 
icon, 3 
Comparison operators, formulas, 151-152 
CompuServe communications scripts, 
macros, 

284-285 
Conditioned lines, telecommunications, 
249 
Constant values, 130 
Constraining shapes. Draw, 97 
Control code commands, Works communi
cation 
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module. 257-258 
Copies, printing, 347-348 
Count, statistical functions, 161 
Custom disks 
example of, 300 
guidelines, 298-300 
Microsoft Works, 298-300 

Customization of Works 
Control Panel, 307-313 
CDEV resources, 292-293. 309 
delay until repeat, 310 
double-click speed, 310 
insertion point blinking, 311 
key repeat rate, 309 
menu blinking, 312 
mouse tracking, 311 
RAM cache, 312 
sound cues. 312-313 
speaker volume, 312 
and Works• versions, 308 

desk accessories, embedding, 332 
fonts, embedding, 332 
Menu Master, command-keys, modifying, 

331 
Resource Editor, 314-331 
action of, 314-316 
command-keys, modifying, 317-319 
dialog boxes, modifying, 327-328 
fonts, editing, 323-325 
menus, changing name of, 319-321 
mouse pointers, modifying, 325-327 
patterns, changing, 321-323 
personal ID, editing, 330-331 
time/date separator, changing, 329-330 
use of, 316-317 

Works preference file, 313-314 

D 

Dashes 
en and em dashes, 43-44 
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use of, 43-44 
Data 
non-delimited text, 16 
object-oriented graphics, 16 
tab-delimite(t'text, 16, 17 

Database 
boilerplate, 71 
calculated fields, use of, 227-229 
components of, 211-212 
copying fields, 224 
data enuy, 212 
data sharing, spreadsheet information, 21 
exporting text, 337-338 
fields, 215-216 
fonn view, 212-213,216 
box width, 221 
field formatting, 223 
rearranging fields, 221-222 
renaming fields, 222 

importing text, 338 
keyboard shortcuts, 213-215 
limits for fields/records, 216 
list view, 213 
list view formatting 
column width, 218 
field formatting, 220 
rearranging fields, 218 
renaming fields, 219 
splitting windows, 219 

mouse shortcuts, 213-215 
new database start-up, 217 
Print merging 

missing database files/records and, 73 
record selection, 74 
setting up for, 72-73 

records, 215-216 
record selection criteria 

AND and OR, use of, 233-234 
reports feature, 235 
rules, 231-233 
saving record selections, 234-235 

repetitive entty, techniques for, 223-224 
rows, 215 
saving, fonnats for, 235 

search for data 
fmding single records, 229-230 
matching records, 230-231 
matching with selection criteria, 231 

sorting, 226-227 
multiple-key sorting, 227 
process in, 227 

spreadsheet functions, use of, 224-226, 
228-229 

Text-only files, opening, 235-236 
views of, 216 

Database document, icon, 2 
Database Stationery document, icon, 3 
Data bits, 246 
Data format, telecommunications, 246-247 
data bits, 246 
parity bit, 246-247 
start and stop bits, 242, 246 

Data sharing 
within document, 15-16 
between like documents, 16 
between unlike documents, 16-23 
from graphics to word processOr, 20-21 
pictures, 20-21,23 
between spreadsheet and database, 21 
from spreadsheet to word processor, 18 
from word processor to spreadsheet, 18-

20 
Data Terminal Ready, 240 
Data transfer protocols 
telecommunications, 244-245 
ASCII, 244-245 
MacBinary, 245, 269-270 
XMODEM, 245, 269-270 

Data transfer speed, telecommunications, 
269-270 

Data types 
bit-mapped data, 333 
object-oriented pictures, 334 
tab-delimited data, 333 
text documents, 333 

Date, printing, 58 
Date/time functions 
formulas, 156-160 



spreadsheet 
accepted fonnat, 158 
calculations with, 157-158 
conversion to date/time format, 158-159 
conversion to serial format, 157-158 
Now function as utility, 159-160 
serial number, parts of, 156 

Decimal-aligned tab, 52, 53 
Delete key, 24 
action of, Works communication module, 

258-259 
Deleting files, caution about, 27 
Desk accessories 
Acta, 305 
Art Grabber, 305 
CheapPaint, 306 
embedding, 332 
Extras, 306 
Multi-Scrap, 305 
Smart Scrap, 305 

Desktop files 
creating file, 28 
opening, 28 

Diacritical characters, use of, 40-41 
Dialog boxes, modifying, Resource Editor, 

327-328 
Direct-connect modems, 238 
Document formats, 56-58 
headers and footers, 56, 58 
margins, 56, 57 
paper size, 56, 57 
print orientation, 56, 57 

Documents 
closing, 25 
opening documents, 4-5 
saving, 24-25 
scroll bars, vertical and horizontal, 12 
windows, 11-12 

Document size, Microsoft Works, 288 
Draft, print quality option, 348 
Draw 
activating Draw, 77 
alignment of shapes, 107-108, 109-110 
arc, 87 
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extending/retrncting arc, 87 
resizing, 87 

arrowhead objects, 112-113 
bit-map, importing, 116 
borders, thickness, 88-89 
boundaries and borders, 97 
centering shapes, 108 
charts 
editing charts, 201-203 
illustrations, 205-207 
pictograph, 207-208 

circles and squares, starting point, 107 
colors, 106 
column text, 99-102 
creating column text, 100 
header for, 100, 101 
linking, 101 
outline for, 100 
text blocks converted to, 102 

constraining shapes, 97 
editing graphics, 23 
erasing, block-out method, 103-104 
Fill and Line Pattern menu, 94-96 
changing after object drawn, 96 
changing before object drawn, 94-95 

Format menus 
Bring to Front, 92 
Color-Black dots, 91 
Color-White dots, 90 
Column boxes, 93 
fonts, 89-90 
grid on/off, 92 
grid settings, 91-92 
Group Picture, 91 
justification, 89 
Send to Back, 93 
size, 90 
Spread text, 94 
style, 90 
Ungroup Picture, 91 

free-form and polygon, 85 
resizing, 86 
tips for, 115-116 

freezing objects, 112 
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graphics compounds 
creating, 102 
saving, 103 
template, 103 

handles around objects, 78-79, 97 
hidden keyboard features, 98-99 
lines, 83-84 
resizing, 83 
settings, 89 

lines and arrows, 84_ 89 
measuring objects, 110-111 
object-oriented graphics, 23, 76 
and other modules, 76, 77 
palette with callouts, 78 
Pasting objects from Clipboard, 96 
patterns, 87-88 
placement of objects, control of, 99 
positioning pad, 88 
proportions 
and resizing, 115 
text/graphics proportions, 106 

rectangles and ovals, 84-85 
resizing, 84-85 

redrawing time, minimizing, 104-105 
resizing objects, 108, 115 
scope of use, 75 
selection arrow, 79-80 
deleting objects, 80 
moving objects, 79 
reshaping objects, 80 
selecting several objects, 79 

size of objects, control of, 99 
spacing objects, 111-112 
stacking, 76-77 
text, 81-83 
background pattern, changing, 82 
editing text, 82 
text box, changing width, 82 
writing, 81 

text effects, 105-106 
fonts, mixing, 106 

tracing graphics, 116 
Dynamic pagination, 346 

E 

Echo Off/Echo On, Worlcs communication 
module, 256 

Ecological Linguistics, 41 
Edit bar, spreadsheet, 134-135 
Elements, pictures, 23 
En and em dashes, 43-44 
Erasing, Draw, block-out method, 103-104 
Escape key, action of, Works communica
tion 

module, 259 
Excel, 164 
Exploded pie chart, 204-205 
Exponents, 130 
Exporting text 

Export option, 336 
spreadsheet, 337-338 
word processor 
Clipboard, 334-335 
Export option, 336 
Scrapbook,335-336 

Export Text-only, saving, 35 
Extras,306 

F 

Faster, print quality option, 348 
Fields, database, 215-216 
attributes, setting, 220 
fonnatting, 220, 223 

Fifty Percent Reduction, printing, 345 
File configuration, Microsoft Works, 294 
File management 
copying documents, 26 
deleting files, 27 
renaming documents, 26 
saving in folders, 26 

Fill and Line Pattern menu, Draw, 94-96 
Financial calculations 
fonnulas, 161-162 



spreadsheet 
defmitions of argwnents used, 162 
types of, 161-162 

Floppy disk system, Microsoft Works, 295-
297 
Folders 

Microsoft Works, 297-298 
saving in folders, 26 

Font characters, use of, 40 
Fonts 
changing, 13 
database, 220 
downloadable fonts, 350-351 
Draw, 89-90, 106 
editing, Resource Editor, 323-325 
embedding, 332 
font list, 39 
fontresources,47 
initial fonts, choosing, 12-13 
installed fonts, 48 
LaserWriter, 350 
outlined fonts, 48 
permanent fonts, 290 
scaled fonts, 47-48 
size,46,47 
spreadsheet, 138-139 
tips for use, 139 

style,46 
Works and, 290-291 

Foreign language, diacritical characters, 
40-41 

Formatting 
character fonnats, 46-49 
database,218-223 
document formats, 56-58 
Draw,89-94 
paragraph fonnats, 49-56 
spreadsheet, 135-142 

See also specific applications. 
Forms, preprinted forms, line spacing, 53 
Formulas 
functions and 
arguments, 154 
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date/time functions, 156-160 
entering functions, 154-155 
fmancial calculations, 161-162 
number format functions, 160-161 
parts of, 154 
statistical functions, 161 
sum a range of numbers, 155-156 

shortcuts for, 163 
spreadsheet, 130, 133 
basic fonnula unit, 149-150 
comparison operators, 151-152 
identification by Works, 133 
mathematical operators, 151 
maximum number of characters, 130 
precedence, 153 

Form view, database, 212-213, 216 
Free-fonn shapes, Draw, 85, 86, 115-116 
Freezing objects, Draw, 112 
Full-duplex mode, modems, 239 
Functions 

and formulas 
arguments, 154 
date/time functions, 156-160 
entering functions, 154-155 
fmancial calculations, 161-162 
number format functions, 160-161 

parts of, 154 
statistical functions, 161 
sum a range of numbers, 155-156 

Future value of investment, spreadsheet 
calculation, 161 

G 

Go To Page, text selection, 34 
Graphics 
bit-mapped graphics, 23, 76 
data sharing, to word processor, 20-21 
exporting,338-339 
hidden characters, 41-43 
nnporting,339-340 
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object-oriented graphics, 23, 76 
Graphics compounds 
creating, 102 
saving, 103 
template, 103 

Grids 
charts 
linear grid, 186 
logarithmic grid. 186-187 

Draw settings, 91-92 
Group Picture, Draw, 91 

H 

Half-duplex mode, modems, 239 
Handles around objects, Draw, 78-79, 97 
Hard disk system, Microsoft Works, 300 
Hard-wired transfers, telecommunications, 

271 
Hayes modem 
AT command set, 263-264 
non-Hayes modem, 267 
testing with AT command, 264 

Headers and footers, 56, 58 
printing, 345 

Help 
command-specific help, 15 
icon, 2. 
module-specific help, 13-14 
review of Help window, 14 

Hidden graphics characters, use of, 41-43 
Homonym option, spell checker, 66-67 
HyperCard stack, icon, 4 
Hyphens 
spell checker and, 60 
useof,43 

I 

Icons 
communications document, 2 

Communications Stationery document, 3 
database document, 2 
Database Stationery document, 3 
Help, 2 
HyperCard stack, 4 
macro file, 3 
Main Works, 2 
preference flle, 3 
spelling dictionary, 3 
spreadsheet document, 2 
Spreadsheet Stationery document, 3 
text-only flle, 3 
undefmed flle, 4 
word processing document, 2 
word processing Stationery document, 3 
Works Desktop document set, 2 

Illusttation,charts,205-207 
Image size discrepancies, printing, 354-355 
Image Writer, 13, 47, 48, 56, 106, 342, 352-

354 
advantages of, 351 
paper quality, 353-354 
print density, 353 
print settings, 352 
resolution, 354 
ribbon freshness, 352-353, 354 

Importing text 
spreadsheet, 338 
word processor 
pasting text, 336 
Text-only document, opening, 336-337 

Indentation, 49,50 
ruler markings, 50 
setting indents, 50 

Index scale, charts, 192-193 
INIT initialization resource, Microsoft 

Works, 291 
Insertion points shortcuts, text selection, 

33-34 
Int, number fonnat functions, 160 
Internal rate of return, spreadsheet 

calculation, 161 
Italics, printing, 58 
Iteration, spreadsheet, 125 



J 

Justification 
Draw,89 
margins, 54 

K 

Keyboard entry 
Draw features, 98-99 
spreadsheet, 135 

Keyboard shortcuts 
command-key equivalents, 8 
database,213-215 
documents, 5-6 
macro-key equivalents, 7 
spell checker, 67 
spreadsheet, 128-129 

Keypad, special keys, Works communica-
tion · 

module, 256 

L 

Labels 
Print merge, 74 
spreadsheet, 131, 133_134 

Landscape orientation, 57 
~rprinting,354-355 
improving quality, 355 
special paper, 355 
tonercarbidges,355 
~rWriter, 13, 48, 56, 205, 339, 342, 
348-

351, 354-355, 360 
cleaning tips, 360 
dialog boxes, 349-350 
fonts, 350 
printing area, 350 
set-up for, 348-349 

Layers,sp~sheet, 122-123 
Left-aligned tab, 52, 53 

Index 385 

Legends,chans,l86 
Ligature characters, use of, 41 
Linear grid, 186 
Line charts, 180-182 
illustration, adding, 205-207 

Lines, Draw, 83-84, 89 
Line spacing, 49, 53 
preprinted fonns, 53 
types used, 53 

Linguists' Software, 41 
Linking, column text, 101 
Linotronic L-300P, 357 
List view, database, 213 
Logarithmic grid, 186-187 

M 

MacBinary, data transfer protocols, 245, 
269-270 

MacDraw, 107 
MacPaint, 206 
bit-mapped graphics, 23,76 

Macros 
examples of 
CompuServe communications scripts, 

284-285 
place number macro, 283-284 
spreadsheet month column headers, 284 
spreadsheet number series macro, 282-

283 
key assignments, 277 
limitations of, 281 
macro files 
adding macros to, 279 
icon, 3 
merging macros, 279 
opening, 278-279 
printing, 281-282 

macro-key equivalents, 7 
pauses, 280-281 
Playback And command, 279-280 
playback of, 277 
recording new macro, 275-277 
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saving macros, 277-278 
startup, Microsoft Works, 302 
uses of, 282-285 

MacTools, 27 
Mail merging. See Print merging 
Main Works, icon, 2 
Margins, 56, 57 _ 
changing, 345 
justified margins, 54 
setting, 57 

Matching records, database, 230-231 
Mathematical operators, formulas, 151 
Measuring objects, Draw, 110-111 
Memory requirements, Microsoft Works, 
287, 

288,289 
Menus 
changing name of, Resource Editor, 319-

321 
Menu Master, command-keys, 331 

Micro-scrolling, 12, 31 
Microsoft Word, 164 
Microsoft Works 
CDEV (Control DEVice), 292-293 
customization of Works, 307-313 
desk accessory utilities, 305-306 
disk management, 294-300 
custom disks, 298-300 
floppy disk system, 295-297 
Folders, 297-298 
hard disk system, 300 

disks/contents of, 294-295 
documents, opening documents, 4-5 
document size, 288 
fdeconfiguration,294 
finding files, checkpoints for, 301 
icons, meaning of, 2-3 
INIT initialization resource, 291 
keyboard shortcuts 
commands, 6-8 
dialog boxes, 9-11 
documents, 5-6 

Mac models used with, 287 

memory requirements, 287, 288, 289 
MultiFinder, 303-304 
RAM cache, 304, 305 
RAM disk, 289, 304 
start-up, 4 
startup, 301-302 
automatic startup, 301-302 
macros, 302 

System ftle resources, 290-291 
System resources, 289-290 
versions/updates, 293 

Microspaces, use of, 44-45 
Mixed cell references, 147 
Modems, 238-244 
acoustic-connect modems, 238 
adaptive call sequencing, 249 
asynchronous communication, 242 
baud rates, 239,241-242 
cables, connector types, 239-240 
Data Terminal Ready, 240 
data transfer speed, 269-270 
data transmission standards, 243-244 
direct-connect modems, 238 
full-duplex mode, 239 
half -duplex mode, 239 
manual control 

Hayes AT command set, 263-264 
reason for use, 262 
testing, AT command, 264 

non-Hayes modem, 266 
protocols, 243-244 
serial port attachment, 238 
signal lines, 240, 241 
smart modems, 238,267-269 
adaptive dialing, 267 
answers, detection of, 268 
dialing directory power, 268 
multi-tasking, 268-269 

synchronous communication, 243 
tone sets, answer and originate, 239 

Modified internal rate of return, 
spreadsheet calculation, 161 

Module-specific help, 13-14 



Mouse 
pointers, modifying, 325-327 
shortcuts 
database,213-215 
spreadsheet, 128-129 

spreadsheet entry, 135 
MsWorksDict file, 59,62 
MsWorksHyrnn file, 66 
MsWorksHyrnn Table, 66 
MsWorksPrefpreference file, 59,66 
Multiplan, 164 
Multiple-key sorting, database, 227 
Multiple labels, Print merging, 74 
Multi-Scrap, 305 
Multi-tasking, smart modems, 268-269 

N 

Net present value, spreadsheet calculation, 
162 

No Gaps Between Pages, printing, 345 
Noise on phone line 
telecommunications, 248-249 
Works communication module, 248-249 

Non-delimited text, 16 
Normal fdes, saving, 35 
Note pa~ spreadsheet, cell notes, 132-133 
Number fonnat functions 

fonnulas, 160-161 
spreadsheet 
Abs, 161 
lot, 160 
Rand, 161 
Round, 160 
Sign, 161 

0 

Object-oriented graphics, 16,334,339 
Draw,23, 76 

Operators, spreadsheet 

Index 387 

comparison operators, 151-152 
mathematical operators, 151 
precedence, 153 

Ovals, Draw, 84-85 

p 

Page breaks 
printing, 346 
spreadsheet, 141-142 
removing, 141 
setting, 141 
vertical and horizontal, 142 

Page numbers, printing, 58 
Pages,printing,347 
Page Setup command, printing, 342 
Paper size, 56, 57 
options for, 57 
paper size/orientation, printing, 343-344 

Paragraph fonnats, 49-56 
alignment, 50, 53-54 
different fonnats for paragraphs, 54-56 
indentation, 49, SO 
line spacing, 49, 53 
tabs, 49, 51-53 

Parameter RAM (PRAM}, 308 
Parity bit, 246-247 
Pasting 
charts,199 
Draw, objects from, 96 
text 
tips for, 340 
word processor, 336 

Patterns 
changing, Resource Editor, 321-323 
Draw, 82, 87-88 

Pauses, macros, 280-281 
Payments of investment, spreadsheet 

calculation, 162 
Personal ID, editing, Resource Editor, 330-

331 
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Photographs, of Mac screen, 356-357 
Phototypesetting, 357 
Pictures, data sharing, 23 
Pie charts, 175-176 
data fonnatting for, 199-200 
exploded pie chart, 204-205 
3-D pie chart, 203 

Place markers, setting, 36-37 
Place number macro, 283-284 
Playback And command, macro, 279-280 
Polygons, Draw, 85, 86, 115-116 
Porbldtorienuuion,57 
Precedence, formulas, 153 
Preference file, icon, 3 
Preprinted forms, line spacing, 53 
Present value of invesnnent, spreadsheet 

calculation, 162 
Printing 
canceling printing, 347 
Copies, 34 7-348 
Pages,347 

charts,198 
color, 356 
Fifty Percent Reduction, 345 
headers and footers, 345 
image size discrepancies, 354-355 
Image Writer, 352-354 
~rprinting,354-355 

LaserWriter, 348-351, 354-355, 360 
macro flies, 281-282 
margins, 345 
No Gaps Between Pages, 345 
page breaks, 346 
Page Setup command, 342 
paper feed, non-stop printing, 348 
paper size/orientation, 343-344 
printer maintenance, 357-360 
print preview, 346 
quality, options for, 348 
screen printing, 351 
shortcuts, 34 7 
Tall Adjusted option, 345 
types of files and, 342 

Print merging, 71-74 

database 
missing database files/records and, 73 
record selection, 74 
setting up for, 72-73 

Multiple labels, 74 
previewing document, 73 
use of, 71-72 

Print orientation, 56,57 
landscape orientation, 57 
portraitorientation,57 

Q 

Quick options, spell checker, 63 
Quikeys, 302 

R 

RAM disk, Microsoft Works, 289 
Rand, number format functions, 161 
Rate returned on investment, spreadsheet 

calculation, 162 
Recalculation, spreadsheet 
automatic vs. manual, 123-124 
order of, 126-127 

Records, database, 215-216 
Rectangles, Draw, 84-85 
Relative cell references, 146 · 
Renaming 
documents, 26 
fields in database, 219, 222 

Repetitive entry, techniques for, database, 
223-224 

Reports feature, database, 235 
Resizing 
charts, 197-198 
objects in Draw, 108, 115 

Ribbon freshness, Image Writer, 352-353, 
354 
Rich Text Files, 337 



saving, 35 
Right-aligned tab, 52, 53 
Round, number format functions, 160 
Rows, database, 215 
Ruler, Draw, 110-111 
Ruler markings, indentation, 50 
Rules, database, 231-233 

s 
Saving 
communication_ documents_ 255 
database, formats for, 235 
documents, 24-25 
in folders, 26 
graphics compounds, 103 
macros, 277-278 
spreadsheet 
SYLK format, 163-164 
Text with Values and Formulas, 164-165 
Text with Values Only, 164 

word processor 
Export Text-only, 35 
Normal files, 35 
Rich Text Files, 35 
stationery files, 35 

Scale,chads,187-188 
Scientific notation, 130 
Scrapbook, exporting text, 335-336 
Screen printing, 351 
Scroll bars, vertical and horizontal, 12 
Scrolling, micro-scrolling, 12, 31 
Search for data, database, finding single 

records, 229-230 
Send to Back, Draw, 93 
Serial pon attachment, modems, 238 
Series cbans, data location, 200 
Shift-clicking, text selection, 33 
Sign, number format functions, 161 
Signal lines, modems, 240, 241 
Skipped words file, spell checker, 64-65 
Smart modems, 238 
See also, Modems. 

Smart Scrap, 305 
Sorting 
database, 226-227 
spreadsheet, 147-149 

Spacing 
microspaces, 44-45 
objects in Draw, 111-112 

Index 389 

Special characters. See Characters 
Spell checker, 58-67 
adding/deleting words, 62 
All options, 62 
homonym option, 66-67 
icon,3 
keyboard shortcuts, 67 
location of, 59 
for one word, 63-64 
for part of document, 63 
Quick options, 63 
setting options, 59-60 
size, 59 
skipped words file, 64-65 
spell check process, 60-62 

Splitting windows 
database, 219 
spreadsheet, 136 
word processor, 37-39 

Spreadsheet 
active area, 121-122 
boilerplate, 70-71 
cell entries, 129-133 
cell notes, 132-133 
cell reference, 131 
formulas, 130, 133 
functions,131-132 
labels, 131, 133 
values, 130, 133 

cell references 
absolute cell references, 146-147 
mixed cell references, 147 
relative cell references, 146 

cell selection, moving, 118-119 
circular reference, 124 
components of, 118 
copying cells, 142-143 
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database and, use of functions, 224-226, 
228-229 

data sharing 
database information, 21 
data from word processor, 18-20 
data to word processor, 18 

edit bar, 134-135 
enter/return keys, use of, 119 
exporting text, 337-338 
Fill Down and Fill Right, 144-145 
formatting 
~rders, 137-138 
cell attributes, setting, 139-140 
color, 139 
column width, 135-136 
fonts, 138-139 
page breaks, 141-142 
splitting windows, 136 

formulas, 149-163 
importing text, 338 
iteration, 125 
keyboard entry, 135 
keyboard shortcuts, 128-129 
layers, 122-123 
macros, examples of, 282-283, 284 
mouse, 119 
entry, 135 
shortcuts, 128-129 

moving cells, 143 
multiple cells, selection of, 119-121 
for non-computational tasks, 127 
non-numerical characters, 134 
overwriting cells, 146 
paste with options, 144 
recalculation 
automatic vs. manual, 123-124 
order of, 126-127 

saving 
SYLK fonnat, 163-164 
Text with Values and Formulas, 164-165 
Text with Values Only, 164 

sorting, 14 7-149 
order of, 149 

process in, 148-149 
selected cells and, 147-148 

variables, limitations of, 127 
See also Formulas. 

Spreadsheet document, icon, 2 
Spreadsheet Stationery document, icon, 3 
Spread text, Draw, 94 
Squares, Draw, 107 
Start and stop bits, 242, 246 
Stationery files 
creating files, 29 
opening files, 30 
saving, 35 

Statistical functions 
fonnulas, 161 
spreadsheet 
Average, 161 
Count, 161 

Subtitle, charts, 185 
Sum a range of numbers, formulas, 155-
156 
SuperPaint, 206 
SYLK format, 337, 338 

saving spreadsheet, 163-164 
Synchronous communication, modems, 
243 
System file resources, Microsoft Works, 
290-

291 
System resources, Microsoft Works, 289-
290 

T 

Tab-delimited data, 16, 17,333 
Tables, data sharing, from word processor 

to spreadsheet, 19 
Tabs, 49,51-53 

different stops, setting, 52 
setting tab, 51 



spaces exchanged for, 19 
types of tab stops, 52-53 

Tall Adjusted option, printing, 345 
Telecommunications 
call waiting problem, 247-248 
conditioned lines, 249 
data fonnat, 246-24 7 
data transfer protocols, 244-245 

ASCIT, 244-245 
MacBinary, 245,269-270 
XMODEM, 245, 269-270 

data transfer speed, 269-270 
hard-wired transfers, 271 
modem, 238-244 
noise on phone line, 248-249 
tenns/definitions related to, 272-273 
See also Modems Works communication 

module. 
Templates 
Blank Works documents, 29 
graphics compounds, 103 

Tempoll,302 
Text 
charts, 185-186 
Draw, 81-82,94, 105-106 
See also Word processor. 

Text-only document, opening, 336-337 
Text-only ftle, 54 
database, opening, 235-236 
icon, 3 

Text with Values and Fonnulas, saving 
spreadsheet, 164-165 

Text with Values Only, saving spreadsheet, 
164 

3-D pie chart, 203 
Time, printing, 58 
Time/date separator, changing, Resource 

Editor, 329-330 
Title, charts, 185 
Toner cartridges, laser printing, 355 
Tone sets, modems, answer and originate, 
239 
Tracing graphics, 116 

u 
Undefined file, icon, 4 
Undo, 23-24 
cautions about, 24 

Ungroup Picture, Draw, 91 

v 

Index 391 

Values, spreadsheet, 130, 133 
constant values, 130 
identification by Works, 133 

Variables, limitations of, spreadsheet, 127 

w 
Windows 
optimization, 11-12 
resizing, 11-12 
split-window, word processor, 37-39 
spreadsheet, splitting windows, 136 

Word processor 
boilerplate, 69-70 
boilerplate text, 68-71 
data sharing 
data from spreadsheet, 18 
data to spreadsheet, 18-20 
graphics, 20-21 

exporting text 
Clipboard, 334-335 
Export option, 336 
Scrapbook, 335-336 

fonnatting 
character formats, 46-49 
document formats, 56-58 
paragraph formats, 49-56 

icon, 2 
importing text 
pasting text, 336 
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Text-only document, opening, 336-337 
place markers, setting, 36-37 
Print merging, 71-74 
saving, 35 
special characters, 39-45 
spell checker, 58-67 
split-window, 37-39 
text selection, 32 
Go To Page, 34 
insertion points shortcuts, 33-34 
shift-clicking, 33 

Works communication module 
ANSI escape sequences, 259-262 
character display attributes, 261 
cursor movement, 260 
cursor position save and restore, 261 
erase screen and line, 261 
line editing, 260-261 
mode selection, 262 

call progress prompts, 253 
call waiting problems, 247-248 
communication parameters, setting, 249-

251 
connection quality, 270 
control code commands, 257-258 
data format, 246-24 7 
data transfer speed, 269-270 
delete key, action of, 258-259 
dialing phone, 252-253 
dialog box, contents, 249-251 
Echo Off/Echo On, 256 

escape key, action of, 259 
hanging up phone, 255 
hard-wired transfers, 271 
keypad, special keys, 256 
manual modem control 
direct commands, 264-265 
examples of use, 265-266 
Hayes AT command set, 263-264 
reason for use, 262 
testing, AT command, 264 

modes of operation, 246 
noise on phone line, 248-249 
non-Hayes modem, 266 
non-modem calls, 256-257 
receiving text and ftles, 254 
saving communications documents, 255 
sending text and files, 254-255 
smart modems, 267-269 
adaptive dialing, 267 
answers, detection of, 268 
dialing directory power, 268 
multi-tasking, 268-269 

ttansmission errors, 270-271 
waiting for call, 253 

Works Desktop document set, icon, 2 

X 

XMODEM, data transfer protocols, 245, 
269-270 



Learn the Works from a Pro. 
Gordon McComb, author of a dozen computer books, knows how to really get 
inside a program and bring his readers with him. Here he reveals undocumented 
or little-known hints for getting the most out of Microsoft Works 2-the best
selling integrated software package that might be the only software you need to 
run your home or business. In this book you'll fmd out how to apply the full 
power and flexibility of MS Works 2 to your specific requirements. 

This book contains scores of tips for getting the most from Works 2, including 
how to: 

• use the upgraded, powerful draw module to create sophisticated charts and 
graphics 

• turn Works into an effective page-layout tool for desktop publishing 

• integrate the database and word processing modules for powerful mail-merge 
applications 

• use the communications module to access electronic mail services and huge 
databases; then import downloaded information into other Works modules 

• optimize printing for high-quality hard copy 

• use third-party add-in software to beef up performance 

• save time with keyboard shortcuts 

• customize Works for your individual needs with ResEdit 

Gordon McComb has written U books on microcomputer topics, including 
PC Presentation Graphics and WordPerfect 5.0 Macros and Templates. 

9 7805J 347227 

52 2 

r 
N 0-553-34722-5>2295 34722·5 • IN U.S. $22.95 (IN CANADA $27 .95) • BANTAM COMPUTER BOOK 


